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Overview
Client Accounting is divided into the:

 Trial Balance (Workpapers) tab, from where you can configure the financial data 
source, perform an opening review, modify the prior year balances, or generate 
workpapers for a client.

 Assets tab, where you can create and maintain an asset register.

 Reports tab, from where you can generate financial statements for a client. 

Client Accounting is accessed from the Client page > Client Accounting tab. 

Related topics
About accounts
Trial Balance (Workpapers) tab
Assets tab
Reports tab
See “Migrating an existing ledger” on page 214 for an overview of the steps to take 
when migrating.
Perform an opening review
Modify prior year balances
Workpapers
Statutory Reporter
Assets
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About accounts
Data from your general ledger is used in MYOB Client Accounting to generate, for 
example, workpapers or reports. The general ledger contains:

 header

 detail

accounts. 

Header accounts are used to group related detail accounts to help organise the 
accounts list.

Account information

The following conventions apply when adding accounts:

 Both header and detail accounts can be added to a ledger. 

 Header accounts must be assigned an account classification. 

 Detail accounts must be assigned an account classification and an account type. 

 Each account is represented by a unique five-digit number. The first digit of the 
account code indicates the account’s classification. 

 Header accounts are displayed in bold type.

 Added accounts are displayed in italics in the appropriate place in the Chart of 
Accounts. Header accounts are displayed in bold and italics. 

Related topics
Trial Balance (Workpapers) tab

Classification Prefixes Account types

Asset (1-xxxx) Bank, Accounts Receivable, Other Current Asset, 
Fixed Asset, Other Asset

Liability (2-xxxx) Credit Card, Accounts Payable, Other Current 
Liability, Long Term Liability, Other Liability

Equity (3-xxxx) Equity

Income (4-xxxx) Income

Cost of Sales (5-xxxx) Cost of Sales

Expense (6-xxxx) Expense

Other Income (8-xxxx) Other Income

Other Expense (9-xxxx) Other Expense
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Assets tab
Reports tab
See “Migrating an existing ledger” on page 214 for an overview of the steps to take 
when migrating.
Perform an opening review
Modify prior year balances
Workpapers
Statutory Reporter
Assets
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Trial Balance (Workpapers) tab

Note: The name of this tab depends on whether you’re licensed for Workpapers. If 
you are licensed for Workpapers, it is the Workpapers tab. Otherwise, it is the 
Trial Balance tab.

Workpapers is integrated with the software’s general ledger solutions (AccountRight 
suite) and with Document Manager. 

Workpapers enables you to create and maintain electronic workpapers for your 
clients. The Trial Balance (or Workpapers) tab displays the financial periods created 
for the selected client and the properties of each period. A list of the To Do items 
associated with each workpaper period are also displayed. 

Note: If you do not have a Workpapers licence, you can still access the following 
features from the Tasks bar or by right-clicking on an account:
– Workpapers homepage (Add period, Open period, Delete period, Define 
GST accounts)
– Prepare Workpapers subsection in Tasks bar (Import client’s balances)
– Journals subsection in Tasks bar (all features)
– Accounts subsection in Tasks bar (all features)
– Finalise Workpapers subsection in Tasks bar (Create PDF - for a completed 
period).

The main features of Trial Balance (Workpapers)

 General Ledger integration — Client Accounting is tightly integrated to the 
AccountRight general ledger products.

 Historical workpapers files — completed workpaper files are kept on the 
system for historical purposes. Workpapers from the previous year are easily 
accessed. The status of each workpaper file for a client can be quickly viewed.

 Document Manager integration — the system is integrated with the Document 
Manager application. Documents from Document Manager can be linked to 
accounts in the workpaper period. A PDF report on the workpapers period can 
be produced which can then be imported into Document Manager.

 Approvals — enables progress tracking of completing, reviewing and approving 
workpapers.

 Security — workpapers are a historical record, in electronic format, of the 
financial results for a client for a period. Security prevents an unauthorised user 
from approving workpapers. Approved workpapers cannot be edited. 
Calculation fields in a workpaper cannot be edited. This ensures accuracy of 
data. An audit trail keeps track of all the changes in status and any amendments 
to a workpaper.
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 Rollover — when creating a new period there is the option of rolling over from 
the previous period. The rollover process attaches new workpapers to the 
accounts in the new period using the previous period as a guide. Documents 
with the Rollover option selected are re-linked to the same accounts in the new 
period.

 To Do items — enables tracking and management of the current workpapers 
tasks. 

 Templates — a standard list of workpaper templates have been provided with 
Client Accounting.

 Printing — reports and workpapers associated with the workpapers period can 
be printed. 

 Processing Journals — as workpapers are prepared, adjustment journals can be 
created. These journals can be posted to the client’s general ledger on 
completion of the workpapers. This means you can work on the journals and 
finalise the work before committing the transactions. 

 Accounts — As part of the workpaper process there is often a need to create a 
new account in the underlying ledger. In Client Accounting you can create 
accounts which will be posted to the general ledger on completion of the 
workpapers. 

 Client configuration — Configure the client’s general ledger details. 

 Launching a ledger — Launch the general ledger application enabling changes 
to be made to the client’s general ledger whilst accessing their information in 
Client Accounting.

 Adjustments — Adjustments can be made to prior year balances that are stored 
within a configured AccountRight general ledger. The Modify Prior Year Balance 
feature does not update the AccountRight file with these adjustments. The 
modified balances are stored separately and used by MYOB Client Accounting 
only.

Note: Adjustments can only be made if an AccountRight general ledger is 
configured as the source of financial data for a client.

 Opening Review — A comparison can be made of the account balances from 
the current general ledger product with the corresponding account balances in 
the client's AccountRight file. Where there are differences between the two, the 
Opening Review feature posts journals to the AccountRight ledger in order to 
align it with the general ledger product.

Note: The Opening Review feature is only available if an AccountRight 
general ledger is configured as the source of financial data for a 
client.
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Related topics
Assets tab
Reports tab
See “Migrating an existing ledger” on page 214 for an overview of the steps to take 
when migrating.
Workpapers
Statutory Reporter
Assets
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Assets tab
Assets is used to create, manage and monitor fixed assets to produce depreciation 
rates for taxation purposes. MYOB Assets Live is a desktop application that stores and 
accesses data in the cloud.

The main features of MYOB Assets Live

 It can be used as a standalone product or it can be integrated with the following 
general ledgers:

 AccountRight v19.8 or earlier

 AccountRight v2013.0 or later

 MAS general ledger

 (Australia) Accounts general ledger

 MYOB AO Classic general ledger

 Essentials Accounting or Cashbook or Practice general ledger.

 Essentials — Accounting and Connected ledgers.

 AE Ledger

 AO Ledger.

 Contains multi-year support.

 Add and edit assets.

 List all assets that are held or sold for a client.

 Group assets into categories (control groups).

 Calculate depreciation for taxation purposes.

 Calculate depreciation for accounting purposes.

 Include private use percentages.

 Calculate the profit / loss / capital gains on the sale of an asset.

 Create journals to automatically post to the underlying general ledger.

 Generate Tax schedule and Journal summary reports.

 Generate a small business pool schedule and/or a low value pool schedule.

 Calculate depreciation for assets in a small business or low value pool.

 Can only be used with clients (not contacts or suppliers) that are either open or 
closed.

 Transfer an asset to a different control group.

 Sell assets.

 Reverse the sale of an asset.



AE, AU, NZ PM Client Accounting User Guide | 19

Note: Only one asset register can be created for a client.

Related topics
Trial Balance (Workpapers) tab
Reports tab
See “Migrating an existing ledger” on page 214 for an overview of the steps to take 
when migrating.
Ledger details
Workpapers
Statutory Reporter
Assets
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Reports tab
Statutory Reporter is used to produce professional quality statutory reports for non-
reporting entities. It works directly over client data from the:

 MYOB AccountRight range of SME accounting products, or 

 Essentials Accounting or Cashbook. 

Report settings can be configured to suit the reporting requirements of each client. 
Financial statements for the selected client can be previewed and generated. 

The main features of Statutory Reporter

 Report directly over data in your client’s company file.

 (Australia) Generate reports based on XYZ compliant master templates.

 Customise report content for your entire practice or for an individual client.

 Receive updated content from MYOB whilst retaining your customisations.

 Utilise client data already stored in MYOB, e.g., client name, director’s names.

 Apply security settings to control user access to a variety of features.

 Modify text content and display options directly from the report preview.

 Move accounts between report sections directly from the report preview.

 Customise the grouping of accounts which will be summarised in a single line for 
the final reports.

 Automatically summarise sections of the Balance Sheet by selecting the 
corresponding note in your report set.

 Export reports to Microsoft Word, Microsoft Excel and PDF.

 File reports into MYOB Document Manager.

 Change the font and style of the reports.

 Display or hide page numbers and account codes.

 Modify page margins.

 Display company logos and watermarks.

 Display rounded balances, with rounding adjustments calculated and allocated 
automatically.

Related topics
Assets tab
Trial Balance (Workpapers) tab
See “Migrating an existing ledger” on page 214 for an overview of the steps to take 
when migrating.
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Ledger details
Workpapers
Statutory Reporter
Assets
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Getting started with Client Accounting
There are a few things that are good to know before you start using Client Accounting. 
The details here should get you started. 

How do I find my way around?

To access Client Accounting, click the Client Accounting tab in the Client page. You’ll 
then see the following tabs (click the links for more information):

 Trial Balance (Workpapers) tab

 Assets tab, where you can create and maintain an asset register.

 Reports tab. 

What do I need to do first?

1. Select a source of financial data for a client – see Configuring the client for the 
steps.

2. If you use AccountRight 19 or earlier, and you haven’t got it installed in the 
default location, you’ll need to tell Client Accounting where to find it – see 
Configuring accounting product locations for the steps.

How do I migrate my existing ledger?

You can migrate any of the following types of general ledger to an AEAO Ledger:

 AO Classic

 Accounts

 MAS.

See “Migrating an existing ledger” on page 214 for an overview of the steps to take 
when migrating.
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Configuring Client Accounting
It is recommended that Client Accounting is configured prior to using its features. To 
configure Client Accounting it is advisable to complete the following tasks:

 Configuring the client

 Configuring accounting product locations (if these products are not installed in 
the default locations).

Configuring the client

As part of the client configuration process, a source of financial data for the client 
must be selected. The financial data source records the location of the client’s 
company file on your system. The client’s general ledger data is imported from this 
file. When the client sends through a new company file, it is this file on your system 
that is updated and replaced.

A warning message is displayed on the Client Accounting > Trial Balance (or 
Workpapers) tab if a financial data source is not configured for the client. Click Edit 
Configuration Details on the Tasks bar or click the Configure a financial data source 
hyperlink to configure the client’s financial data source.

If you configured a client incorrectly, you can remove the configuration settings, 
allowing you to start the process again. See “Removing Configuration Details from a 
ledger” on page 198.

The following can be configured as a client's financial data source:

 “Configuring an AccountRight 2013.0 or later file as the data source” (see page 
24)

 “Configuring an AccountRight 19 or earlier file as the data source” (see page 27)

 “Configuring a MAS ledger as the data source” (see page 29)

 (Australia) “Configuring an Accounts ledger as the data source” (see page 29)

 “Configuring an AO Classic general ledger as the data source” (see page 30)

 “Configuring an Essentials general ledger as the data source” (see page 32)

Related topics
Configuring accounting product locations
Perform an opening review
Modify prior year balances



AE, AU, NZ PM Client Accounting User Guide | 24

Configuring an AccountRight 2013.0 or later file as the data source

There are two types of AccountRight files that can be configured as the client’s 
financial data source for Client Accounting:

 AccountRight v19 or earlier

 AccountRight 2013.0 or later (where you can select a file from your local or 
network library or an online library).

Note: Ensure that you know which version of client files you will need to access so 
that you can select the appropriate option.

To use an online AccountRight 2013.0 or later file, you must have configured your 
Practice my.MYOB Settings.

To configure an AccountRight 2013.0 or later company file as the client’s financial 
data source 

1. Open the client’s Client Accounting > Trial Balance (or Workpapers) tab.

2. Click Edit Configuration Details on the Tasks bar (or the Configure a financial 
data source hyperlink in the message).
The Client Configuration window opens. 

3. Select AccountRight 2013.0 or later from the Product drop-down.

4. Enter the appropriate Data connection details.

a. Click the ellipse button on the File location field.

The Select Company File window opens listing all the files in the Local and 
Network libraries. If you have configured your Practice my.MYOB Settings, a 
list of all online files to which your practice MYOB Login has access, will also 
be displayed. 

Navigate to the location of the company file using one of the following 
methods available in the Select Company File window:

 Search all libraries tab

A list of all libraries (local, network and online) are displayed. You can use 
the Search field to locate the file. You can also sort the search results in the 
Select Company File window.

 Browse tab

Browse individual libraries of your local, network or online folders to locate 
the company file. 

 Search field.

Type any part of the file name or company name in the Search field and 
click the Search button to locate the file.

../Practice_Manager/Practice_my.MYOB_settings.htm
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b. Select the appropriate online client company file.

c. Click Select file.

Tip: You can also press [Enter] to select the highlighted file.

On the Client Configuration window, the File location and File path fields 
will be automatically filled with the selected online company file and its 
URL, respectively.

The client’s Entity type and Industry type are automatically filled once the 
company file is selected.

Note: The Entity type and Industry type fields are both used by Statutory 
Reporter to configure and produce reports. 

d. Enter the Username and Password for the client’s file. 

5. Select the appropriate option for Prior Year Balances:

 Use AccountRight balances 

 Use modified balances.

6. Click OK.
Client Accounting retrieves the account balances from the selected 
AccountRight file using the MYOB Login that has been specified for the 
employee that is currently logged into MYOB. The client’s balances are 
displayed on the Trial Balance (or Workpapers) tab. 

Logging into my.MYOB for AccountRight 2013.0 or later

If you have selected an AccountRight 2013.0 or later file, the Log into my.MYOB 
window opens if:

 the currently logged in employee has a specified MYOB Login but this is the first 
time that they have attempted to access an AccountRight 2013 file using Client 
Accounting. 

 the currently logged in employee does not have an MYOB Login specified.

In order to access an AccountRight 2013 file using Client Accounting, the current 
employee’s MYOB Login will need to be granted File User access to the selected file. 
If the current employee’s MYOB Login does not have File User access to the selected 
file, MYOB AE/AO will grant them automatic access.

1. Enter the my.MYOB password.

2. Click Yes to continue.
The financial data from the configured AccountRight file is displayed.
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If you do not have your MYOB Login details specified, then the Edit my.MYOB 
details window opens. This will only need to be done the first time.
If you do not have task permissions granted for MYOB Login, then you must 
contact your system administrator. 

Other notes about employees accessing clients’ AccountRight 2013.0 or later files

 If you delete an employee, MYOB AE/AO will remove that employee’s File User 
access to any AccountRight 2013 files to which they have previously been 
added.

 If you make an employee inactive, MYOB AE/AO will remove that employee’s 
File User access to any AccountRight 2013 files to which they have previously 
been added.

 If you change an employee’s MYOB Login, MYOB AE/AO will remove the original 
login’s File User access to any AccountRight 2013 files to which they have 
previously been added.

 If you apply Team Security to a client, MYOB AEAO will not remove the File User 
access to the client’s AccountRight 2013 file for all employees who do not 
belong to the Responsibility team for that client.

 If you remove an employee from the Responsibility Team for a client that has 
Team Security applied, MYOB AEAO will remove the File User access to the 
client’s AccountRight 2013 file for that employee.

 When a client, who has the Team Security setting applied, is configured with an 
AccountRight 2013 file in Client Accounting, that AccountRight file will be 
hidden in the Select Company File window when this window is opened from 
another client by any employee that is not a member of the responsibility team 
for the client for which the file is configured.

 If you enter an End Date for a partner on the Responsibility tab for a client, who 
is configured with an online AccountRight file in Client Accounting and has Team 
Security applied, the partner’s file user access to the client’s AccountRight 2013 
file will automatically be removed.

 If you perform a bulk responsibility update to remove a partner or employee 
from multiple client responsibility teams, the removed partner/employee will 
automatically have their file user access removed from any online AccountRight 
files that are configured against clients that have the Team Security setting 
applied.

If AccountRight 2013 files are not listed

If the Select Company File window does not list any AccountRight files in My Library 
or a network library, you must check:

 that the MYOB AccountRight Library service is running.

 Select Services under the Administrative Tools section in the Windows 
Control Panel.
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 Right-click on the MYOB AccountRight Library item and select Start.

 the firewall settings on the computer that contains the network library.

 Select Windows Firewall in the Windows Control Panel.

The Windows Firewall screen opens.

 Select Advanced Settings.

The Windows Firewall with Advanced Security screen opens.

 Select Inbound Rules.

 Double-click on MYOB API Services in the list of Inbound Rules.

The MYOB API Services Properties screen opens.

 Select the All programs that meet the specified conditions option on the 
Programs and Services tab.

 Click OK.

Note: You will need to restart MYOB AE/AO before attempting to select a 
file from the network library.

Related topics
Configuring an AccountRight 19 or earlier file as the data source
Configuring a MAS ledger as the data source
(Australia) Configuring an Accounts ledger as the data source
Configuring an AO Classic general ledger as the data source
Configuring an Essentials general ledger as the data source
Configuring accounting product locations
Perform an opening review
Modify prior year balances

Configuring an AccountRight 19 or earlier file as the data source

There are two types of AccountRight files that can be configured as the client’s 
financial data source for Client Accounting:

 AccountRight 19 or earlier

 AccountRight 2013.0 or later (where you can select a file from your local or 
network library or an online library).

Note: Ensure that you know which version of client files you will need to access so 
that you can select the appropriate option.
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To configure an AccountRight 19 or earlier company file as the client’s financial data 
source

1. Open the client’s Client Accounting > Trial Balance (or Workpapers) tab.

2. Click Edit Configuration Details on the Tasks bar or the Configure a financial 
data source hyperlink.
The Client Configuration window opens. 

3. Select AccountRight 19 or earlier from the Product drop-down.

4. Enter the location of the file in the File location field. 
or
Click the ellipse button on the File location field and navigate to the location of 
the client’s company file. Click Open to select the file. The select file is reflected 
in the File location field.

5. Enter the Username and Password if the client’s file requires them for access. 

6. Select the client’s Entity Type from the drop-down. 

7. Select the client’s Industry Type from the drop-down.

Note: The Entity Type and Industry Type fields are both used by Statutory 
Reporter to configure and produce reports. 

8. Select the appropriate option for Prior Year Balances:

 Use AccountRight balances 

 Use modified balances.

9. Click OK.

Related topics
Configuring an AccountRight 2013.0 or later file as the data source
Configuring a MAS ledger as the data source
(Australia) Configuring an Accounts ledger as the data source
Configuring an AO Classic general ledger as the data source
Configuring an Essentials general ledger as the data source
Configuring accounting product locations
Perform an opening review
Modify prior year balances
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Configuring a MAS ledger as the data source

Note: Statutory Reporter only works with an AccountRight or Essentials data source. 
If a MAS ledger is the source of financial data for a client, Statutory Reporter 
will not be available for use for that client. 
Workpapers will be available for use if the client’s data source is a MAS ledger.

To configure a MAS ledger as the client's financial data source

1. Open the client’s Client Accounting > Trial Balance (or Workpapers) tab.

2. Click Edit Configuration Details on the Tasks bar or the Configure a financial 
data source hyperlink.
The Client Configuration window opens.

3. Select MAS from the Product drop-down.

4. Enter the location of the MAS ledger in the MAS ledger field. 
or
Click the ellipse button on the MAS ledger field and navigate to the location of 
the client’s MAS ledger in the Select Ledger window. Click OK.

5. Click OK.

Related topics
Configuring an AccountRight 19 or earlier file as the data source
Configuring an AccountRight 2013.0 or later file as the data source
(Australia) Configuring an Accounts ledger as the data source
Configuring an AO Classic general ledger as the data source
Configuring an Essentials general ledger as the data source
Configuring accounting product locations
Perform an opening review
Modify prior year balances

Configuring an Accounts ledger as the data source

Australia only

Note: Statutory Reporter only works with an AccountRight or Essentials data source. 
If an Accounts ledger is the source of financial data for a client, Statutory 
Reporter will not be available for use for that client. 
Workpapers will be available for use if the client’s data source is an Accounts 
ledger.
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To configure an Accounts ledger as the client's financial data source

1. Open the client’s Client Accounting > Trial Balance (or Workpapers) tab.

2. Click Edit Configuration Details on the Tasks bar or the Configure a financial 
data source hyperlink.
The Client Configuration window opens.

3. Select Accounts from the Product drop-down.

4. Enter the location of the Accounts ledger in the Accounts ledger field. 
or
Click the ellipse button on the Accounts ledger field and navigate to the location 
of the client’s Accounts ledger. 

Tip: If you have an MYOB AE Assets 2.4 Accounts ledger which you are 
migrating to MYOB Assets Live, please ensure that you select a 
current year ledger. 

5. Click OK.

Related topics
Configuring an AccountRight 19 or earlier file as the data source
Configuring an AccountRight 2013.0 or later file as the data source
Configuring a MAS ledger as the data source
Configuring an AO Classic general ledger as the data source
Configuring an Essentials general ledger as the data source
Configuring accounting product locations
Perform an opening review
Modify prior year balances

Configuring an AO Classic general ledger as the data source

Note: Statutory Reporter only works with an AccountRight or Essentials data source. 
If an AO Classic general ledger is the source of financial data for a client, 
Statutory Reporter will not be available for use for that client. 
Workpapers will be available for use if the client’s data source is an AO Classic 
general ledger.

In order to be able to integrate Client Accounting with a MYOB AO Classic general 
ledger you must have MYOB AO Classic v16.0.4 (Australia) or later / v16.0.2 (NZ) or 
later installed.
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To configure an AO Classic general ledger as the client's financial data source

1. Open the client’s Client Accounting > Trial Balance (or Workpapers) tab.

2. Click Edit Configuration Details on the Tasks bar or the Configure a financial 
data source hyperlink.
The Client Configuration window opens.

3. Select AO Classic GL from the Product drop-down.

4. Enter the location of the AO Classic general ledger in the AO Classic ledger field. 
or
Click the ellipse button on the AO Classic ledger field to open the Select Ledger 
window from where you can select the appropriate AO Classic general ledger. 
The Select Ledger window lists the Code, Name and Year End Date of the 
client’s ledgers. Click OK.

5. Click OK.

If you cannot access your specific AO Classic general ledger (AE)

You may need to add two configuration keys in order to access your MYOB AO Classic 
database.

Note: If you have any problems connecting to your AO Classic database, please 
contact MYOB Support.

1. Select Maintenance > User defined > Configuration on the main menu.
The Maintenance - Configuration window opens.

2. In the first empty row of the table, add the:
Key Name — AoDatasource
Key Value — the path of AO Classic, e.g.,C:\MYOBAO\Data

3. Press [Enter] or [Tab].

4. In the first empty row of the table, add the:
Key Name — AOBinProfile 
Key Value — the Key Value can be:

 blank (the default database is used) 

 if you would like to use a specific database enter the database name.

5. Press [Enter] or [Tab].

6. Click OK.
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If you cannot access your specific AO Classic general ledger (Australia AO)

Note: If you have any problems connecting to your AO Classic database, please 
contact MYOB Support.

If you cannot access your specific AO Classic general ledger (New Zealand AO)

If you are having problems connecting to your AO Classic database, ensure that the 
settings in Maintenance > Maintenance Map > AO Classic Settings are valid. If you 
continue to have problems, please contact MYOB Support.

Related topics
Configuring an AccountRight 19 or earlier file as the data source
Configuring an AccountRight 2013.0 or later file as the data source
Configuring a MAS ledger as the data source
(Australia) Configuring an Accounts ledger as the data source
Configuring accounting product locations
Perform an opening review
Modify prior year balances

Configuring an Essentials general ledger as the data source

An Essentials general ledger can be either:

 Accounting

 Cashbook

 Ledger.

In order to be able to integrate Client Accounting with any of the Essentials general 
ledgers you must have:

 access to the specific Essentials product

 configured your Practice my.MYOB Settings.

When an Essentials general ledger is imported into Client Accounting, a hierarchical 
classification is introduced to the general ledger. Classifications (e.g., Class-001) are 
further organised into header accounts (e.g., Type-0001) and detailed accounts (e.g., 
1-1000).

First steps to using Essentials Accounting with Client Accounting

To use Client Accounting with your clients’ Essentials Accounting files, you must first 
link your LiveAccounts login to your MYOB Login. There are two ways to do this:

1. Using my.myob.com

../Practice_Manager/Practice_my.MYOB_settings.htm
https://my.myob.com
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a. Login to my.myob for your region.

b. From the homepage launch MYOB Essentials that will take you to the linking 
page.

c. Enter your existing LiveAccounts login information.

d. Link your my.myob account to your LiveAccounts details and proceed to 
using the product.

2. Go directly to the Essentials launch page (Australia / New Zealand)

To configure an Essentials general ledger as the client's financial data source

1. Open the client’s Client Accounting > Trial Balance (or Workpapers) tab.

2. Click Edit Configuration Details on the Tasks bar or the Configure a financial 
data source hyperlink.
The Client Configuration window opens.

3. Select Essentials from the Product drop-down.

4. Enter the File location in the Data connection details section.
or 
Click the ellipse button on the File location field.
The Select Company File window opens listing all the active (in bold) and 
suspended (greyed out) Essentials Accounting, Cashbook and/or Practice Ledger 
files. 

a. Select the appropriate Essentials Accounting or Cashbook or Practice Ledger 
file.

either:

Type any part of the file name or company name in the Search field and 
click the Search button to locate the file. You can also sort the search results 
in the Select Company File window.

or

Sort the file list in the Select Company File window.

or

Use the scroll bar to search for the file.

The Ledger Type column distinguishes a file from being an Essentials 
Accounting file or an Essentials Cashbook or an Essentials Practice Ledger 
file.

b. Click Select file.

https://essentials.myob.com.au/LA/myob_login.html
https://essentials.myob.co.nz/LA.CO.NZ/myob_login.html
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Tip: You can also press [Enter] to select the highlighted file.

On the Client Configuration window, the File location field will be 
automatically filled with the selected company file.

The client’s Entity type is automatically filled once the company file is 
selected.

Note: The Entity type is used by Statutory Reporter to configure and 
produce reports. 

5. (Australia) If your ledger uses departments, tick the This ledger uses 
departments text box.
The Edit department settings dialog opens. 
See Configuring department settings for information about setting up 
departments for this ledger.

6. Click OK.

Related topics
(Australia) Configuring department settings
Configuring an AccountRight 19 or earlier file as the data source
Configuring an AccountRight 2013.0 or later file as the data source
Configuring a MAS ledger as the data source
Configuring an AO Classic general ledger as the data source
Configuring accounting product locations
Perform an opening review
Modify prior year balances

Configuring department settings

Australia only

Department settings can be configured for Essentials general ledgers and 
AccountRight 2013.0 or later files.

Note: Departmental reporting for AccountRight only supports Chart of Accounts. 
Please define the settings as subcode. After selecting the subcode, add the 
main account code which defines the department names. The main code 
should be the header account, which contains all department names defined 
as the description of the sub accounts.
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Department settings let you report on different profit or cost centres within the same 
organisation. This is useful in situations where combined figures aren’t appropriate – 
for example, if an entity:

 owns several rental properties, and wants to show income and expenses for 
each one separately

 operates more than one branch, and wants to report on the performance of 
each one separately.

 has more than one type of business.

Before you can configure department settings for your ledger, you need to work out 
whether the account codes use prefixes (leading digits) or suffixes (trailing digits) to 
indicate departments. 

Using account code prefixes for departments

The following example uses a 1-digit prefix (in bold) for each rental property:

 1000 – Property 1

 1200 – Rent Received

 1340 – Rates

 2000 – Property 2

 2200 – Rent Received

 2340 – Rates

This is the approach used by AO general ledger. 

To configure practice department settings for prefixes

If your ledger uses prefixes to indicate departments:

1. In the Edit department settings window, select Prefix from the Departments 
are defined by drop-down. 
Additional fields display.

2. If you are using Accounts general ledger, select the Prefix separator option. The 
separator defaults to ‘.’ – type a different separator if you use something else.
Otherwise, type the number of digits in the account code prefix in the Prefix 
length field.

3. Specify the account to use as the department name in reports:

 Select Use the name of the first account in the department if the first 
account in the department has the name that you want to use in reports.

 Select Use the name of a specific account in the department if there is a 
specific account that has the name you want to use in reports. Type the 
code for that account in the Main code field.
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4. If accounts without a department all have the same prefix, type that prefix in 
the Prefix of accounts without a department field. This field will have the 
number of characters you entered in the Prefix length field.

5. Click OK.
You are returned to the Client Configuration window. 

Using account code suffixes for departments

The following example uses a 2-digit suffix or subcode (in bold) for each rental 
property, included after the main account code:

 200 – Rent Received

 200/01 – Rent Received property 1

 200/02 – Rent Received property 2

 340 – Rates

 340/01 – Rates Property 1

 340/02 – Rates Property 2

This is the approach used by MAS and Reporter.

To configure practice department settings for suffixes

If your ledger uses suffixes to indicate departments:

1. In the Edit department settings window, select Suffix from the Departments 
are defined by drop-down. 
Additional fields display.

2. Type the number of account code digits that are used before the suffix in the 
Number of digits before suffix field.

3. Specify the account to use as the department name in reports:

 Select Use the name of the first account in the department if the first 
account in the department has the name that you want to use in reports.

 Select Use the name of a specific account in the department if there is a 
specific account that has the name you want to use in reports. Type the 
code for that account in the Main code field.

4. Click OK.
You are returned to the Client Configuration window. 

Related topics
Configuring an Essentials general ledger as the data source
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Configuring accounting product locations

In order to open a client’s company file in AccountRight 19 or earlier, Client 
Accounting must use the accounting application — that is, the AccountRight range of 
products — that corresponds to the selected client’s company file. If these products 
are not installed in the default locations, then the Accounting Product locations must 
be manually configured.

Note: If the software is unable to find the accounting product a warning is displayed. 
Browse to and select the program file of the accounting application. 

To configure the accounting product location

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Accounting 
Product Locations.
The Accounting Product Locations window opens.

2. For each accounting product to be used, click the ellipse button and navigate to 
the location of the accounting product program file. 
The program file is named either Myob.exe or Myobp.exe.

3. Click Open.

4. Click OK.

Related topics
Configuring the client
Perform an opening review

Modify prior year balances
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Workpapers
In Workpapers, the client’s accounts and balances are reviewed. The balances within the accounts 
are calculated and substantiated. Documents can be linked to accounts within the workpaper to 
substantiate each account’s balance. If the balance for the account is different to the client’s 
balance, an adjustment journal must be added. When the accounts, workpapers and documents 
have been reviewed and approved, the adjustment journals and the created accounts are posted to 
the client’s ledger. All data entered into a workpaper will be automatically rolled over to subsequent 
workpaper periods. A PDF report can be printed for review purposes. The workpaper period is then 
marked as complete.

The procedure to complete a workpaper period is:

1. “Configuring workpapers” (see page 42)

2. “Accessing workpapers” (see page 46)

3. “Workpapers homepage” on page 39

4. “Creating and opening workpaper periods” (see page 51)

5. “Preparing workpapers” (see page 57)

6. “Completing workpapers” (see page 130).
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Workpapers homepage
The Workpapers homepage lists all your workpapers periods currently in progress across all your 
clients. 

The Workpapers homepage provides these features: 

 Task permission security to restrict access to this homepage. See “Security and task 
permissions” on page 43

 You can customise the homepage view using the Field Chooser menu. 

 You can group your data by any field in the homepage.

 You can initiate tasks using the hyperlinks in the Tasks bar or from the Menu system.

Using Workpapers homepage

1. Click the Workpapers icon  on the toolbar to open the homepage.

2. From the Field chooser drag Outstanding ToDos onto the homepage grid. 

3. Click Outstanding ToDos to open the relevant ToDo list for that client. 
All functionality to add and update the ToDo list is available. Changes made on the ToDo list 
are reflected on the Workpapers homepage immediately.

4. Select the checkbox for required entries and:

a. select Export to Excel icon .

b. select the Print icon .

What is in the grid

The features available on the homepage grid are explained here:

Column Features and Description

Checkbox 
column

Select the checkbox for each entry to be included in the data 
exported to an excel spreadsheet or to be printed. 

Client name Each Client name identifies a client who has at least one In-
progress workpaper within the date range. Each client may have 
more than one entry in the grid. A client with no In Progress 
workpaper periods will not appear on the homepage
Click on the client name to the Workpaper period for the client.
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Related topics
Configuring workpapers
Accessing workpapers

Client code This can be added to the grid from the Field chooser.

Status All Workpaper periods that are ‘In Progress’ or ‘Not started’ are 
included in the grid. 

Period start 
date

The date on which the workpaper period starts.

Period end 
date

The date on which the workpaper period ends.

No. of 
workpapers

The number of workpapers including the number of linked 
documents. 

In Progress The number of workpapers which have In Progress status.

Waiting 
Approval

The number of workpapers awaiting approval.

Rework The number of workpapers requiring rework. 

Approved The number of workpapers approved.

Outstanding 
ToDos

The Field chooser allows you to add the Outstanding ToDos field 
to the homepage grid. By clicking Outstanding ToDos listed in the 
grid you will open the relevant ToDo list. 
All functionality to add and update the ToDo list for your client is 
available. Changes made on the ToDo list are reflected on the 
Workpapers homepage immediately.

Partner, 
Office, 
Department, 
Company

The Field chooser allows you to add Partner, Office, 
Department, Company to the grid. This identifies the assigned 
Partner, Office, Department, Company as entered in the 
Responsibilities tab for this client.

(AE) Manager, 
Employee

The Field chooser allows you to add Manager and Employee to 
the grid as identified in the Responsibilities tab for the client.
If you have created additional responsibility types these will also 
be included in the Field chooser. 

Year The Field chooser allows you to add Year to the homepage. This 
is the year of workpaper.

Family Group The Field chooser allows you to add Family Group to the 
homepage. This is as entered on client Main page.

Column Features and Description
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Creating and opening workpaper periods
Opening an existing period
Select Period
Adding a new period
Status of Selected Period
To Do items
Preparing workpapers
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Configuring workpapers 
Before you start to use Workpapers, it is important to configure it correctly for use. To configure 
Workpapers:

 Decide how to organise and manage the data associated with preparing workpapers for each 
client. See “Organising and managing your data” on page 42.

 Configure a financial data source for each client for which workpapers are being generated. 

As part of the client configuration, record a location for the client’s company file on your 
system. During the Workpapers task, the client’s general ledger data is imported from this file. 
When the client sends through a new company file, it is this file on your system that must be 
updated and replaced.
A warning message is displayed on the Client Accounting > Trial Balance (Workpapers) tab if a 
financial data source is not configured for the client. Use the Configure a financial data source 
hyperlink or click Edit Configuration Details on the Tasks bar to configure the client. See 
“Configuring the client” on page 23.

 Configure the Accounting Product locations for the client’s associated accounting application if 
these products are not installed in the default locations. 

In order to open the client’s company file in AccountRight, Accountants Division needs to use 
the accounting application — AccountRight range of products — that corresponds to the 
selected client’s company file. The accounting product locations must be manually configured 
if these products are not installed in the default locations. See “Configuring accounting product 
locations” on page 37.

 Configure the task permissions for those who will be working on the workpapers. See “Security 
and task permissions” on page 43. 

See MYOB AE Employee Group Security and Task Permissions for more information.

Related topics
Organising and managing your data
Accessing workpapers
Workpapers homepage
Creating and opening workpaper periods
Configuring workpapers
Preparing workpapers

Organising and managing your data

When preparing workpapers for your client, the client will supply company files and source 
documents. These files are stored safely on your system in a way that ensures that they are easy to 
find and they are accessible to the people who need to use them.

The following are recommendations for conventions of storing workpapers data:

../Practice_Manager/Employee_group_security.htm
../Practice_Manager/Task_permissions.htm
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 Files stored in a common location — all files used in workpaper preparation — client ledgers 
and source documents — should be stored in a location that can be accessed by all staff 
members who prepare workpapers. While preparing the workpapers, documents will be linked 
to the workpapers period. Staff members must have access to these documents to be able to 
open them using Workpapers.

 Organised directory structure — the following directory structure is recommended to ensure 
that files are easy to find:

 Data — the top level directory. 

 ClientCode — the code for the client in the software. The client’s company file should be 
placed within this folder.

 Period — the year of the workpaper’s period. The source documents for each period 
should be placed within this folder.

 Clearly named files — when saving client files to your network it is important to ensure that 
these are clearly named so that is immediately apparent what the file contains. Source 
documents should include the client code, period year and clearly define what the file 
contains, e.g. 2009-ABBOTRA-BankStatement-August.xls.

However the data is organised, it is useful to have a clear set of guidelines and procedures for storing 
data in place before preparing workpapers. It is important to document these and make all staff 
aware of these procedures to ensure consistency.

Related topics
Accessing workpapers
Workpapers homepage
Creating and opening workpaper periods
Preparing workpapers
Setting the status on a workpaper or document
Deleting workpapers and source documents
Deleting a period
Completing the period

Security and task permissions

Task permissions are used to define the permissions for staff team members using Workpapers. 
Certain actions can be controlled and whether they are performed by a particular staff security 
group. For example, some staff members may be restricted from approving or deleting workpapers. 

See Setting up Employee Security Groups for more information on security groups.

The following table lists the task permissions which can be set for Workpapers and what actions the 
permission will enable or prevent the staff team member from performing.

../Practice_Manager/Employee_group_security.htm
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To configure Workpapers task permissions

1. Navigate to Maintenance > Maintenance Map (AO) > Security > Task Permissions. 
The task permissions open in the Maintenance - Task Permissions page. 

2. Select MYOB Workpapers from the Product drop-down. 

3. Select the Security Group from the Group drop-down.
Security groups are used to group employees who will use the same features of the 
application. Employees can be grouped for various reasons, e.g., they are at the same staff 
level or they perform similar duties.

Task Function

#View Workpaper Homepage Causes the Workpaper icon to be displayed. 
Allows the staff team member to open the 
Workpapers homepage to view and manage all 
the Workpapers that they have In Progress. 
See “Setting the status on a workpaper or 
document” on page 155.

#Approve Workpaper Allows the staff team member to approve a 
workpaper. A staff team member can set the 
status of a workpaper to approved. See 
“Setting the status on a workpaper or 
document” on page 155.

#Delete Workpaper Allows the staff team member to delete an 
attached workpaper from a workpaper period. 
See “Deleting workpapers and source 
documents” on page 117.

#Delete Workpaper Period Allows the staff team member to delete 
workpaper periods which have not been 
started. See “Deleting a period” on page 56.

#Modify Completed Period Allows the staff team member to open and 
modify a completed workpaper period. A 
warning message is displayed indicating that 
the period has been completed and the 
balances and workpapers may have rolled over 
to a new period. See “Completing the period” 
on page 168.

#Define Balance Forward 
Accounts

Allows the staff team member to define, 
modify and remove balance forward accounts. 
See “Defining Balance Forward Accounts” on 
page 83.



AE, AU, NZ PM Client Accounting User Guide | 45

4. Click  beside the Client or Maintenance entries.
This will expand the list of permissions for that Group Description. 

5. Click the Allow checkbox.
A tick is displayed in the checkbox. This will enable the staff team member to perform the 
selected action. 
Click the Allow checkbox again.
A tick is not displayed in the checkbox. This will prevent the staff team member from 
performing the selected action. 

6. Repeat Step 4. to Step 5. for each security group associated with MYOB Workpapers. 

7. Click OK.
This saves any changes and closes the Maintenance - Task Permissions page. 

Related topics
Setting the status on a workpaper or document
Deleting workpapers and source documents
Deleting a period
Completing the period
Configuring workpapers
Organising and managing your data
Workpapers homepage
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Accessing workpapers
The Workpapers homepage allows you to view all the workpapers that are ‘In Progress’ for your 
clients. To do this, click the Workpapers icon on the toolbar. For details see “Workpapers 
homepage” on page 39.

Alternatively for each client, Workpapers is accessed from the Client page > Client Accounting > Trial 
Balance (Workpapers) tab. You can create or access existing workpaper periods for the selected 
client. 

To access Workpapers for one client 

1. Click .
The Find Clients page opens.

2. Enter search criteria in the Search for field.
The search criteria can be based on Name and Code, Tax File Number or ABN. Click the 
appropriate search criteria option and type in the details.
Alternatively, if you can navigate easily to the client, double-click on the client entry. Proceed 
to Step 5.

3. Click Search or press [Enter].
The search results are displayed.

4. Double-click the client entry. 
The Client page opens.

5. Click the Client Accounting tab.

6. Click the Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers). 

Related topics
Workpapers homepage
Configuring workpapers
Creating and opening workpaper periods
Opening an existing period
Select Period
Adding a new period
Status of Selected Period
To Do items
Preparing workpapers
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About the Trial Balance (Workpapers) tab

Note: The name of this tab depends on whether you’re licensed for Workpapers. If you are licensed 
for Workpapers, it is the Workpapers tab. Otherwise, it is the Trial Balance tab.

The Trial Balance (Workpapers) tab displays the financial periods created for the selected client and 
the properties of each period. A list of the To Do items associated with each workpaper period are 
also displayed. 

The tab is divided into the following sections:

Select Period

The Select Period table displays all the workpaper periods that have been created for the selected 
client. 

The status for a workpaper period can be:

 Not Started

 In Progress 

 Completed.

The Add period option on the Tasks bar enables the addition of a new workpaper period. See 
“Adding a new period” on page 51.

The Open period option on the Tasks bar enables a period to be opened. See “Opening an existing 
period” on page 53.

Configured Ledger Details

The Configured Ledger Details section displays information on the type, name, current year start 
date and current year end date of the configured ledger. This section appears after a ledger has been 
configured. (See “Configuring the client” on page 23.)

Status of Selected Period

The Status of Selected Period section displays information about the period which is selected in the 
Select Period table. See “Creating and opening workpaper periods” on page 51.

To Do items

To Do items enable tracking and management of the workpapers tasks that are being worked on. 
The To Do items which have been created for workpaper periods for a selected client are listed in 
the To Do table of the Trial Balance (Workpapers) tab. The To Do item should be given a subject 
description that is unique so that it can be easily identified. 

See “To Do items” on page 172 for more information.

The status of a To Do item can be:

 Not started
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 Planned

 In Progress

 Complete

 Risk

 Problem.

The status is used to indicate progress on the To Do item to other staff members.

Tasks bar options on the Trial Balance (Workpapers) tab

Option Description

Add period Add a new workpaper period.

See “Adding a new period” on page 51.

Open period Open an existing workpaper period.
“Opening an existing period” on page 53

Delete period Delete a period (for example, if an error has been made 
when creating a workpapers period).
See “Deleting a period” on page 56.

Define GST 
accounts

Select the accounts where amounts for GST  Collected and 
GST Paid will be recorded.
This option is not available if you have an AE/AO Ledger or 
Cashbook ledger.

Import client file Import an MYE file and load data from a ledger that cannot 
be directly connected to.
See “Importing a client file” on page 201.

Update GST chart Updates the entire Chart of Accounts with GST codes from 
the imported legacy ledger, based on the ledger name of 
your legacy application. This feature should only be used for 
ledgers imported prior to 2016.2.
If there are multiple ledgers with the same name, you will 
be prompted to select the correct ledger.

Note: If there are more than 100 account codes, this 
process may take a few minutes.

Manage accounts For AE/AO ledger you can add, edit and delete accounts from 
one location. You can also add, edit and delete account type 
groups.

See “Managing accounts for AE/AO ledger” on page 72.
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Define balance 
forward accounts

Nominate balance forward accounts for source accounts.
See “Defining Balance Forward Accounts” on page 83.

Edit Configuration 
Details

Select a location for the client’s general ledger. 
See “See “Migrating an existing ledger” on page 214 for an 
overview of the steps to take when migrating.” on page 22.

Perform Opening 
Review

Compare the account balances from the current general 
ledger product with the corresponding account balances in 
the client's AccountRight file. 
See “Perform an opening review” on page 184.

Modify Prior Year 
Balances

Enable adjustments to be made to the prior year balances 
that are stored within a configured AccountRight ledger.
See “Modify prior year balances” on page 194.

Launch ledger This option on the Tasks bar enables you to open your 
Ledger application. You can make changes to the client’s 
general ledger whilst accessing their information in Client 
Accounting.
See “Launching a ledger” on page 179.

Create new AE/AO 
Ledger

This options enables you to create a new AE/AO Ledger 
using Essentials Cashbook.
See “Creating and viewing your client’s AE/AO ledger” on 
page 181.

Define Income 
Allocation

This option enables you to allocate profit or loss from a 
business between partners or unit holders.
See “Defining income allocation” on page 197.

View AE/AO 
ledgers

This option enables you to view the details of your AE/AO 
Ledger.
See “Creating and viewing your client’s AE/AO ledger” on 
page 181.

Delete AE/AO 
ledger

This option enables you to delete an AE/AO Ledger.
See “Deleting a ledger” on page 198.

Remove 
Configuration 
Detail

Removes the configuration details from a configured ledger 
for a client. If no ledger is configured, this link is disabled.
See “Removing Configuration Details from a ledger” on 
page 198.

Option Description
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Related topics
Configuring workpapers
Workpapers homepage
Creating and opening workpaper periods
Opening an existing period
Select Period
Adding a new period
Status of Selected Period
To Do items
Preparing workpapers

Migrate to AE/AO 
ledger

This option enables you to migrate your existing AO Classic, 
Accounts (Australia), or MAS general ledgers to an MYOB 
AE/AO ledger.
See “Other features of mapping accounts” on page 208.

Migration 
summary

Show the status of a migration to AE/AO ledger.

View migration log View the migration log for any ledger that has been 
migrated. The migration log lists any errors or warnings that 
should be fixed or taken into consideration.

Option Description
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Creating and opening workpaper periods
Workpaper periods are created and opened from the client’s Client Accounting > Trial Balance tab 
(called the Workpapers tab if you are licensed for Workpapers). Find and select the client for which 
a new workpaper period is to be added or to open an existing workpaper period. 

Before preparing workpapers for a client, add the period for which the workpapers are being 
prepared. The first time a workpaper period is created for a client, the date range which the period 
covers must be specified. 

For subsequent years, the rollover option can be used to roll an existing period over into a new 
workpaper period. The start date of the new period will be determined by the end date of the 
previous period.

Related topics
Adding a new period
Opening an existing period
Rolling over into a new period from a completed period
Deleting a period
Preparing workpapers
Workpapers homepage

Adding a new period

A new workpaper period can be added that is either:

 an annual financial period, or

 a portion of the financial period that is required.

Note: A future year period can also be added for those with AccountRight or Essentials Accounting 
or Cashbook general ledgers.

For instance, you may choose to have a monthly, quarterly, or bi-annual workpaper period.

Note: When you add a period, this then defaults as the current period.
With Essentials Accounting or Cashbook you can also add a prior period.

To add a new annual period

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers) tab.

2. Click Add period on the Tasks bar.
The New Workpaper Period window opens.

3. In the Date range section:
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c. Enter the Description of the Workpaper period. This can be up to 100 characters. 

d. Enter the period Starting from date.

Enter the date in the format dd/mm/yyyy or select the date from the drop-down calendar. 

e. Enter the period Ending on date.

Enter the date in the format dd/mm/yyyy or select the date from the drop-down calendar. 

The starting from and ending on dates default to the dates of the current financial year, 
minus one year, as specified by the selected general ledger which has been configured for 
the client.

4. In the Define GST Account section:

a. Select from the drop-down the account where amounts for GST  Collected will be 
recorded. 

b. Select from the drop-down the account where amounts for GST Paid will be recorded. 

Note: The GST accounts mandatory check has been removed. If you have elected not to 
use GST calculation for a particular workpaper period, you are no longer prompted 
to define GST accounts.

5. Click Add.
The new period is created and opened in the Prepare Trial Balance (Workpapers) table. See 
About the Prepare Trial Balance (Workpapers) table for information about how to use this 
table.

To add a new periodic period

Periodic reporting periods can be used for workpapers and are based on an underlying periodic 
general ledger. For instance, your periodic reporting period could be monthly or quarterly.

Note: The Year to date balances for accounts are based on the configuration of your general ledger. 
For example, if your general ledger is configured to quarterly reporting, then quarterly 
reporting periods can be created in Workpapers.

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Add period on the Tasks bar.
The New Workpaper Period window opens.

3. In the Date range section:

a. Enter the Description of the Workpaper period. This can be up to 100 characters. 
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b. Enter the period Starting from date.

Enter the date in the format dd/mm/yyyy or select the date from the drop-down calendar. 

c. Enter the period Ending on date.

Enter the date in the format dd/mm/yyyy or select the date from the drop-down calendar. 

In order to add a future year period for an AccountRight, Essential Accounting or Cashbook 
general ledger, select the appropriate future dates as required.
In order to add a prior year period for an Essential Accounting or Cashbook general ledger, 
select the appropriate prior dates as required.

4. In the Define GST Account section:

a. Select from the drop-down the account where amounts for GST  Collected will be 
recorded. 

b. Select from the drop-down the account where amounts for GST Paid will be recorded. 

Note: The GST accounts mandatory check has been removed. If you have elected not to 
use GST calculation for a particular workpaper period, you are no longer prompted 
to define GST accounts.

5. Click Add.
The new periodic period is created and opened in the Prepare Trial Balance (Workpapers) 
table. See About the Prepare Trial Balance (Workpapers) table for information about how to 
use this table.

Related topics
Workpapers homepage
Configuring workpapers
Opening an existing period
Rolling over into a new period from a completed period
Deleting a period
Preparing workpapers

Opening an existing period

To open an existing period

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers) tab.

2. In the Select Period table, select the period to be opened.
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3. For AE/AO Ledgers and Essentials Cashbook ledgers, you can skip this step - go to Step 4.
Before you open the period, check if GST Collected and GST Paid have been selected for the 
period:

a. Click Define GST accounts on the Tasks bar. 

The Define GST Accounts dialog opens. 

b. From the dropdown, select the account where amounts will be recorded for:

 GST  Collected

 GST Paid. 

c. Click OK.

4. Double-click on the selected period.
or 
Select the period and click Open period on the Tasks bar.
The Prepare Trial Balance (Workpapers) table opens in a new window. See About the Prepare 
Trial Balance (Workpapers) table for information about how to use this table.

5. Click OK.

Related topics
Workpapers homepage
Adding a new period
Rolling over into a new period from a completed period
Deleting a period
Preparing workpapers

Rolling over into a new period from a completed period

When creating a new period, there is the option of rolling over the previous period. The start date 
of the new period is determined by the end date of the previous period.

Note: You can only roll over into a new period when the previous period has been completed.

The roll over process starts when the new period is opened. The time taken to roll over an existing 
period into a new period will vary depending on the number of accounts and workpapers in the 
previous period.

The roll over process:

 Imports the closing balances from the previous period into the new period as the accountant’s 
balances. 
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 Attaches new workpapers to the accounts in the new period using the previous period as a 
guide. Those workpapers, which were completed and attached to accounts in the previous 
period, will be recreated and attached to the same accounts in the new period. Only those 
workpapers with the Rollover option selected will be generated and attached. See “Adding 
workpapers” on page 85.

 Documents with the Rollover option selected will be linked again to the same accounts in the 
new period. See “Linking Document Manager source documents” on page 89 or “Linking 
external source documents” on page 98.

To roll over into a new period

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers) tab.

2. Click Add period on the Tasks bar.
The New Workpaper Period window opens.

3. Click the Rollover from completed period checkbox.
The new period will start from the end of the previous period.

Note: The Rollover from completed period option is only available if and when the 
previous period is completed. The status of the previous period must be complete. 
If the previous period is complete and the option is still not available, close the 
New Workpaper Period window and click the Refresh option on the Tasks bar.

4. Select the period to roll over from, on the Period drop-down.

5. Click Add.
To create and open the new period when rollover is complete. 
The new period is listed in the Workpapers > Select Period table.

Note: Opening the new period will start the rollover process. The time taken to roll over 
the existing period into a new period will vary depending on the number of 
accounts and workpapers in the previous period.

Related topics
Adding a new period
Opening an existing period
Deleting a period
Preparing workpapers
Adding workpapers
Linking Document Manager source documents
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Deleting a period

If an error has been made when creating a workpapers period, the Delete button can be used to 
delete the period. 

Workpaper periods with a status of “Not Started” can be deleted. This means that no actions have 
been performed on the period.

Workpaper periods that are “In Progress” can also be deleted after removing any attached 
workpapers, documents, journals, To Do items (AE), and comments. See Deleting workpapers and 
source documents, Deleting adjustment journals, and Deleting a comment in a workpaper for more 
information.

Note: In MYOB AO, currently there is no option to remove a To Do item after it has been added. If 
a To Do item is present in the workpaper period, the period cannot be deleted.

Click Refresh on the Tasks bar to refresh the status of the period. 

To delete a period

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers) tab.

2. In the Select Period table, select the period to be deleted. 

3. Click Delete period on the Tasks bar.
The Confirm Delete Workpaper window opens.

Note: If the workpaper period is “In Progress”, and there are still attached workpapers, 
documents, journals, To Do items (AE), or comments, a warning message will 
appear instructing you to remove these items first. 
In MYOB AO, if there are To Do items in the workpaper period, the period cannot 
be deleted.

4. Click Yes. 
The selected workpapers period is deleted.

Related topics
Adding a new period
Opening an existing period
Rolling over into a new period from a completed period
Preparing workpapers
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Preparing workpapers
In Workpapers, the client’s accounts and balances are reviewed. Using Workpapers, the balances 
within the accounts can be calculated and substantiated. Documents can be linked to accounts 
within the workpaper to substantiate each account’s balance. If the balance for the account is 
different to the client’s balance, an adjustment journal must be added. 

An overview of the procedure involved in preparing a client’s workpaper:

 Import the client’s balances — the client’s accounts and balances are reviewed. If a financial 
data source for the client has been configured and selected, then the client balances are 
imported automatically. Configure the client (see “Configuring the client” on page 23) and 
accounting product location (see “Configuring accounting product locations” on page 37). If a 
new client company file has recently been received, then the client balances will need to be 
imported again and updated. See “Importing the client’s balances” on page 69.

 Attach and complete workpapers — this must be done for each account to substantiate the 
balances for the account. See “Adding workpapers” on page 85 for more information on 
attaching workpapers. See “Opening workpapers” on page 108 for more information on 
completing workpapers. 

 Link source documentation — source documents can be linked to each account to 
substantiate the calculated balances for the account. If Document Manager is installed, files 
are linked to accounts in the period using Document Manager. See “Linking Document 
Manager source documents” on page 89. If Document Manager is not installed, external files 
can be linked to the accounts in the period. See “Linking external source documents” on 
page 98. You can have multiple links to a single PDF source document by linking to different 
bookmarks. 

 Rollover from prior period — include workpaper data from a previous period. See “Rolling 
data over from a prior period” on page 118.

 Update workpaper template — update the selected workpaper to the latest master template. 
See “Updating your workpaper template” on page 120.

 Add journals — if the balance calculated during workpaper preparation is different to the 
client’s balance, adjustment journals must be added to correct the client’s balances. See 
“Adding a new adjustment journal” on page 122.

 Review and approve the workpapers and source documentation — to track the progress on 
completing, reviewing and approving workpapers. When a workpaper or document requires 
review or approval it can be assigned as an approvals task to a responsible staff member. Once 
the workpaper or document has been reviewed and completed it is marked as approved. See 
“Managing, tracking and approving workpapers” on page 154.

 Post journals and accounts — the adjustment journals and new accounts that have been 
created must be exported. The ledger file must be updated. See “Posting journals and 
exporting new accounts” on page 161.

 Create PDF — produces a PDF file which contains the reports, workpapers and linked 
documents from the period. The PDF report can be printed for review or saved as a record on 
your system. See “Creating the PDF report” on page 164.
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 Complete the period — once the Workpaper preparation has been reviewed, approved and 
completed, and the journals and new accounts have been posted to the client’s company file, 
the workpaper period can be marked as complete. See “Completing the period” on page 168.

Once the Workpapers period is marked as complete, information within the period cannot be 
edited or additions made. Information within the period can only be opened and viewed and 
reports printed. This restricted access is controlled by a security task permission. The task 
permission can be modified to enable staff members to open and modify completed periods. 
See “Security and task permissions” on page 43.

Related topics
About the Prepare Trial Balance (Workpapers) table
Configuring workpapers
Workpapers homepage
Accessing workpapers
Creating and opening workpaper periods
Importing the client’s balances
Adding workpapers
Opening workpapers
Linking Document Manager source documents
Linking external source documents
Adding a new adjustment journal
Managing, tracking and approving workpapers
Posting journals and exporting new accounts
Creating the PDF report
Completing the period
Opening an existing period
Accounts
Opening workpapers
Adding workpapers and source documents
Opening source documents
Deleting workpapers and source documents
Adjustment journals
Printing reports and workpapers

About the Prepare Trial Balance (Workpapers) table

Note: The name of this table depends on whether you’re licensed for Workpapers. If you are 
licensed for Workpapers, it is the Prepare Workpapers table. Otherwise, it is the Prepare 
Trial Balance table.
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Tip: The Prepare Trial Balance (Workpapers) table displays when you add or open a period — 
see Adding a new period or Opening an existing period for information about how to display 
this table.

The Prepare Trial Balance (Workpapers) table shows the closing balance for each account for the 
period and the adjusted balance after the balances have been calculated and substantiated. The 
table lists the following types of accounts in the general ledger:

 Detail accounts, are those accounts to which transactions have been allocated

 Header accounts, which are displayed in bold, group related detail accounts together and are 
used to organise the accounts list

Accounts that are added to the table are displayed in italics in the appropriate place in the chart of 
accounts. Balances that are in credit are displayed in red.

If there was an account code in the last period that does not exist in this period, it is displayed in the 
table and marked as “(Prior Period)”. Its value is shown in the Last Period and Variance columns. The 
Movement, Client Balance, DR, CR, and Final Balance values will contain no values. Task bar 
functions and right-click functions will not work on these accounts. If the prior period is opened for 
modification and the ledger balances are refreshed, these accounts will be removed from the 
current period’s trial balance screen.

Note: If the Last Period and Variance columns aren’t selected in the field chooser, account codes 
from a previous period will not be displayed.

The last entry in the table displays the Profit/loss as a result of adjusting journals from within 
workpapers. If the profit/loss balance is a positive balance, the amount is displayed in black with a 
Dr. If the profit/loss balance is a negative balance, the amount is displayed in red with a Cr. The trial 
balance totals at the bottom of the table do not include the profit/loss values. The totals must 
balance to zero.

There are several checkbox filters above the table, described below:

Note: The Include Movement, Include Last Period, and Include Quantities checkboxes can now be 
found in the Field Chooser. See “Adding and removing columns in the Trial Balance 
(Workpapers) table” on page 68.

Checkbox Description

Show only 
used accounts

Shows only used accounts in the table.

Show zero 
balance 
acounts

Shows only accounts that have a zero balance.
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Prepare Trial Balance (Workpapers) Tasks bar options

The available Tasks bar options change as you move to different pages or windows.

Unposted 
journals

If the Unposted journals checkbox is selected:

 The Client Balance shows the balance excluding unposted 
journals.

 The Debits and Credits from unposted journals are 
displayed.

 The final balance shows the final balance of the account 
(Client balance with debits and credits applied).

 The quantity column displays unposted quantities.

Option Description

Import client’s 
balances

Import the client’s balances into a workpaper period. 
See “Importing the client’s balances” on page 69.

Refresh ledger 
balances

Refreshes the ledger balances for the workpaper period.

Refresh workpaper 
balances

Identifies workpapers that require an update based on 
account balances, and refreshes any balances and red 
flags as necessary.
Note: This process may take a while depending on the 
number of workpapers to be processed. When refreshing 
balances, a progress bar is displayed for the calculations 
being performed.

Refresh account 
groups

If you have workpapers that have Account Group 
Amounts (such as Tax workpapers), use Refresh account 
groups to update the account group amounts in these 
workpapers. 
This must be used if there is a change to the account 
group structure whereby accounts have been added or 
removed from an account group.

Add workpaper Attach a workpaper to an account in the table. 
See “Adding workpapers” on page 85. 

An  icon identifies a workpaper. 

Checkbox Description



AE, AU, NZ PM Client Accounting User Guide | 61

Link document Link documents to accounts in the table. 
See “Linking Document Manager source documents” on 
page 89 and “Linking external source documents” on 
page 98. 
An  icon identifies a linked document.

Rollover from prior 
period

Include data in a current workpaper from a previous 
period.
See “Rolling data over from a prior period” on page 118.

Update to latest 
template

Update a selected workpaper to the latest master 
template. 
See “Updating your workpaper template” on page 120.

Open workpaper Open a selected workpaper or document.
See “Opening workpapers” on page 108 and “Opening 
source documents” on page 110.

View all workpapers View a list of all documents — workpapers and 
documents — which have been attached or linked to 
accounts in the table. From the Trial Balance 
(Workpapers) window you can also open, link and delete 
workpapers and documents. 
See “Viewing a list of all workpapers and source 
documents” on page 104.

Move workpaper Move a workpaper to a different account (and rename it, 
if required).
See “Moving a workpaper” on page 116.

Delete workpaper Delete a selected workpaper or document. 
See “Deleting workpapers and source documents” on 
page 117.

Refresh document If Document Manager is installed, use Refresh document 
to refresh the Document Manager files which are linked 
to accounts within the period. Click Refresh document 
and if the name of a Document Manager file has changed, 
it will be updated in the table.

Add comment Add comments to an account. Comments are identified 
with an  in the column next to the Status column in the 
table. Place your cursor on the icon to view the 
comments. Right-click on the icon to edit or delete the 
comments. 
See “Account comments” on page 105.

Option Description
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Journals Tasks bar options

The options under Journals on the Tasks bar provide easy access to all of the functions associated 
with viewing and adding journals. See “Adjustment journals” on page 121.

Accounts Tasks bar options

If there are accounts missing from the client’s general ledger, use the options under Accounts on the 
Tasks bar to add, edit or delete accounts. See “Accounts” on page 70.

To do item Create a new To Do item. To do items can be used to 
assign and track tasks which must be completed in order 
to finish workpaper preparation. 
See “Working with To Do items” on page 174.

View audit trail View the audit trail of an account, workpaper or 
document. The audit trail is a record showing who has 
added, accessed, edited and deleted workpaper 
documents for a selected account, a selected workpaper 
or document. 
See “Viewing the audit trail” on page 160.

Preview account 
groups

Show the accounts from the Prepare Trial Balance 
(Workpapers) table in a tree structure.
See “Previewing accounts” on page 69.

View adjusted trial 
balance

Generates a PDF of the Adjusted Trial Balance report. See 
“Printing reports and workpapers” on page 169.

Option Description

View all View a list of all journals which have been added to the 
period. From the Journals window you can also add new 
entries, edit and delete existing journal entries. 
See “Viewing adjustment journals” on page 124.

View for account View the journals for a selected account.

Add Add adjustment journals to the period. 
See “Adding a new adjustment journal” on page 122.

Post journals and 
accounts

Post the adjustment journals and new accounts added in 
Workpapers to the client ledger.
See “Posting journals and exporting new accounts” on 
page 161.

Option Description
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Approvals Tasks bar options

You can set the status to indicate the progress on completing workpapers and documents for the 
workpapers period using the options under Approvals on the Tasks bar. See “Setting the status on a 
workpaper or document” on page 155.

Note: (New Zealand) These options are only available if you’re licensed for Workpapers.
(Australia) If you’re not licensed for Workpapers, these options will be available on the Tasks 
bar under Farm reporting.

Option Description

Manage accounts For AE/AO ledger you can add, edit and delete accounts 
from one location. You can also add, edit and delete 
account type groups.

See “Managing accounts for AE/AO ledger” on page 72.

Add account Add an account to the chart of accounts in the Prepare 
Trial Balance (Workpapers) table. 
See “Adding header and detail accounts” on page 75.

Edit account Edit accounts which have been added during workpaper 
preparation. Only the account name can be edited. 
See “Editing an added account” on page 78.

Delete account Delete accounts which have been added during 
workpaper preparation. 
See “Deleting an added account” on page 79.

View transactions View workpaper account transactions.
See “Viewing transactions” on page 80.

Define Balance 
Forward Accounts

Nominate balance forward accounts for source accounts.
See “Defining Balance Forward Accounts” on page 83.

Option Description

Current status View the current status of a selected workpaper.

In Progress Set the status of a workpaper or document to In Progress.

Awaiting Approval Set the status of a workpaper or document to Awaiting 
Approval. 

Rework Set the status of a workpaper or document to Rework.

Approved Set the status of a workpaper or document to Approved.
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Farm reporting Tasks bar options (Australia)

The options under Farm reporting on the Tasks bar provide farm calculation functions to users who 
aren’t licensed for Workpapers. See “Preparing workpapers” on page 57. 

Finalise Workpapers Tasks bar options

The options under Finalise Workpapers on the Tasks bar guide you through the process of finalising 
the workpapers. Not all the options are available under Finalise Workpapers when the period is first 
opened. As the workpapers job progresses new options become available.

Option Description

Add workpaper Attach a workpaper to an account in the table. 
See “Adding workpapers” on page 85. 

An  icon identifies a workpaper. 

Rollover from prior 
period

Include data in a current workpaper from a previous 
period.
See “Rolling data over from a prior period” on page 118.

Update to latest 
template

Update a selected workpaper to the latest master 
template. 
See “Updating your workpaper template” on page 120.

Open workpaper Open a selected workpaper or document.
See “Opening workpapers” on page 108 and “Opening 
source documents” on page 110.

View all workpapers View a list of all documents — workpapers and 
documents — which have been attached or linked to 
accounts in the table. From the Trial Balance 
(Workpapers) window you can also open, link and delete 
workpapers and documents. 
See “Viewing a list of all workpapers and source 
documents” on page 104.

Delete workpaper Delete a selected workpaper or document. 
See “Deleting workpapers and source documents” on 
page 117.

Current status View the current status of a selected workpaper.

In progress Set the status of a workpaper or document to In Progress.

Awaiting approval Set the status of a workpaper or document to Awaiting 
Approval.

Rework Set the status of a workpaper or document to Rework.

Approved Set the status of a workpaper or document to Approved.
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Right-click menu options

Option Description

Create PDF Produce a PDF file which contains the reports, workpapers 
and linked documents from the period. 
See “Creating the PDF report” on page 164.

Complete the 
period

After the journals and new accounts have been posted to 
the client’s company file and the workpaper period is 
finalised, the period can be marked as complete. 
See “Completing the period” on page 168.

Option Description

Field Chooser Opens the Field Chooser when you right click in the column 
header title area at the top of the window. This allows you to 
add or remove columns in the Trial Balance (Workpapers) 
table.
See “Adding and removing columns in the Trial Balance 
(Workpapers) table” on page 68.

Expand Expand an account.

Collapse Collapse an account.

Expand All Expand all accounts.

Collapse All Collapse all accounts.

Add workpaper Add a workpaper to an account. 
See “Adding workpapers and source documents” on page 84.

Link document Link a document to an account. 
See “Adding workpapers and source documents” on page 84.

Add comment Add a comment to an account in the Prepare Trial Balance 
(Workpapers) table. 
See “Account comments” on page 105.

Open workpaper Open a workpaper. 
See “Opening workpapers” on page 108.

Rollover from 
prior period

Include data in a current workpaper from a previous period.
See “Rolling data over from a prior period” on page 118.

Update to latest 
template

Update a selected workpaper to the latest master template.
See “Updating your workpaper template” on page 120.
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Icons on the Prepare Trial Balance (Workpapers) table

Add Journal Add a journal to an account. 
See “Adjustment journals” on page 121.

View 
transactions

View workpaper account transactions.
See “Viewing transactions” on page 80.

Current Status View the current status of a selected workpaper.

In Progress Set the status of a workpaper or document to In Progress. 

Awaiting 
Approval

Set the status of a workpaper or document to Awaiting 
Approval.

Rework Set the status of a workpaper or document to Rework.

Approved Set the status of a workpaper or document to Approved.

Icon Description

Workpapers can be configured to compare the calculated balance 
in the workpaper to the balance of the account to which the 
workpaper is attached. If the balances do not match an  is 
displayed next to the workpaper to flag the discrepancy.

An icon in the status column displays the current status for the 
workpapers, documents and account. The status can be:

 In Progress

 Awaiting Approval

 Rework

 Approved

See “Setting the status on a workpaper or document” on 
page 155 for information on how to change the status on an 
account. 
A legend at the bottom of the table displays each icon and its 
meaning. 

Comments can be added to an account. They are identified with 

a  in the column next to the Status column. Place your cursor 
on the icon to view the comments for the account. Right-click on 
the icon to edit or delete the comments. 
See “Account comments” on page 105.

Option Description
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Related topics
Preparing workpapers
Configuring workpapers
Workpapers homepage
Accessing workpapers
Creating and opening workpaper periods
Importing the client’s balances
Adding workpapers
Opening workpapers
Linking Document Manager source documents
Linking external source documents
Adding and removing columns in the Trial Balance (Workpapers) table
Adding a new adjustment journal
Managing, tracking and approving workpapers
Posting journals and exporting new accounts
Creating the PDF report
Completing the period
Opening an existing period
Accounts
Opening workpapers
Adding workpapers and source documents
Opening source documents
Deleting workpapers and source documents

This icon specifies an added workpaper. It is displayed as a sub-
row below the account.
Double-click the sub-row to open and view the workpaper.

This icon specifies a linked document. It is displayed as a sub-row 
below the account.
Double-click the sub-row to open and view the document.

An  at the beginning of the workpaper sub-row indicates that 
the workpaper is a linked workpaper. The account that the 
workpaper is actually attached to is indicated in square brackets - 
[1-1000 account name] - after the workpaper name.

An  at the start of an account row indicates that the row can be 
expanded. Click the  to expand the row and view the attached 
documents. Click the  to collapse the row.

Icon Description
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Adjustment journals
Printing reports and workpapers

Adding and removing columns in the Trial Balance (Workpapers) table

To add or remove columns in the Trial Balance (Workpapers) table, you can use the Field Chooser. 
It includes the following columns:

To change columns using the Field Chooser

1. In the Prepare Trial Balance (Workpapers) table, right-click and select Field Chooser.
The Field Chooser window displays.

2. Select the fields you wish to have displayed in the table by selecting and clearing the 
checkboxes next to each field.
The Trial Balance (Workpapers) table will update according to your selection.

3. Close the Field Chooser window when you are finished.

Column Description

(AU) Quantity The quantity for the account. Only appears when there is a 
value.

Movement The difference between the closing balance and the opening 
balance. The closing balance takes into consideration any 
adjustment journals created in Workpapers and yet to be 
included in the configured general ledger.

Client bal. 
(YTD)

The account value, imported from the ledger.

Dr Any debits from adjustment journals on the account.

Cr Any credits from adjustment journals on the account.

Final The client balance, taking into account debits and credits from 
adjustment journals.

Last Period The balances for the last period for each account.
If a new workpaper period is created and not rolled over from 
the previous workpapers period, the comparative figures will be 
populated with values from either the underlying ledger or the 
Modified balances. These values will depend on the 
configuration settings used by Statutory Reporter. (Not 
applicable to MAS or Accounts products.)

Variance The difference between the final period and the last period.
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Related topics
About the Trial Balance (Workpapers) tab

Previewing accounts

You can display the accounts in the Prepare Trial Balance (Workpapers) table in a tree view to make 
it easier to preview a financial statement.

Note: The Quantity and Variance columns will not appear in this view.

To preview accounts

1. Click Preview accounts on the Tasks bar.

Note: A message displays if you have unallocated accounts. Click Yes to continue.

2. A window displays showing a tree view of the accounts.

To use the preview accounts tree

The preview accounts tree uses a standard windows folder structure. Each folder corresponds to an 
account group, and lists the account ranges or individual accounts that have been assigned to that 
group. Click  to expand and view the contents of a folder. Click  to collapse and hide the contents 
of a folder. 

Note: Master account group allocations are marked with an .

(Australia) If you have AE/AO Ledger, click on the account to view transactions for the account – see 
“Viewing transactions” on page 80.

Importing the client’s balances

Workpapers is used to review the client’s accounts and balances. Before preparing workpapers it is 
recommended that a financial data source for the client is configured. As part of the client 
configuration, record a location for the client’s company file on your system. If a financial data 
source for the client has been configured, the client balances are imported automatically into the 
period. 

If a new client company file has recently been received then the client balances must be imported 
again and updated. 

If the client has not been configured, you will be asked to do so when importing the client’s balances. 
Configure the client (see “Configuring the client” on page 23) and accounting product location (see 
“Configuring accounting product locations” on page 37).
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Use the Add account option to add accounts that are missing from the client ledger.

Note: The start and end dates of the workpapers period must match the period dates on the client 
ledger being imported.

To import client’s balances

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Import client’s balances on the Tasks bar.
A confirmation dialog opens.
The dialog confirms the location of the client’s company file on your system. The client’s 
general ledger data is imported from this file. Check that this file is correct. If the path and file 
are not correct, then the client must be reconfigured. 

3. Click Yes to import the balances. Click No to cancel. 
The Import Client’s Balances confirmation dialog opens to indicate that the client’s balances 
have been imported.

4. Click OK.
The client’s balances for the period are imported from the client’s general ledger file. The 
balances are displayed in the Prepare Trial Balance (Workpapers) table. 

Related topics
Opening an existing period
Accounts
Adding workpapers and source documents
Opening workpapers
Completing workpapers
Opening source documents
Adjustment journals
Managing, tracking and approving workpapers
Posting journals and exporting new accounts

Accounts

If there are accounts missing from the client’s general ledger, use the options under Accounts on the 
Tasks bar to add accounts. These newly added accounts can also be edited or deleted as necessary. 

Added accounts must adhere to the following conventions:
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 Both header and detail accounts can be added to the ledger. Header accounts are used to 
group related detail accounts to help organise the accounts list. 

 There are eight account classifications. See “About accounts” on page 13.

 Header accounts must be assigned an account classification. 

 Detail accounts must be assigned an account classification and an account type. 

 Each account is represented by a five digit number and must be unique. The first digit of the 
account code indicates the account’s classification. 

Added accounts are displayed in italics in the appropriate place in the chart of accounts. Header 
accounts are displayed in bold italics. 

Note: After the account has been added, only the account name can be edited. If other fields 
require editing (such as account type or account number), then the account must be deleted 
and re-added with the correct information.

Added accounts are displayed in italics in the appropriate place in the chart of accounts. Header 
accounts are displayed in bold and italics. 

Note: After the account has been added, only the account name can be edited. If other fields 
require editing (such as account type or account number), then the account must be deleted 
and added again with the correct information.

When workpaper preparation has been completed, these newly added accounts are posted to the 
client’s company file. See “Posting journals and exporting new accounts” on page 161. After this 
process, the new accounts which have been added to the client ledger can no longer be edited. 

See “Account information” on page 13.

Related topics
Managing accounts for AE/AO ledger
Adding header and detail accounts
Editing an added account
Deleting an added account
Opening an existing period
Importing the client’s balances
Adding workpapers and source documents
Accounts
Opening workpapers
Completing workpapers
Opening source documents
Adjustment journals
Managing, tracking and approving workpapers
Posting journals and exporting new accounts
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Managing accounts for AE/AO ledger

For AE/AO ledger, you can add, edit and delete accounts from one location. You can also add, edit 
and delete account type groups. This is enabled for the workpaper periods “Not started” and “In 
progress”. Any account code updates will be reflected in View Journals, Trial Balance, and the 
Account links section in linked workpapers.

The fields available in the Manage Accounts window are summarised in the following table.

The fields available in the Manage Account Type Group window are summarised in the following 
table.

Note: When updating Account Codes, we recommend you do not update Account Codes in 
Cashbook online. This ensures any updated Account Code(s) are correctly shown when 
viewing, posting, or editing journals in that Workpaper period.

To add a header account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

Field Description

Search for an 
account

A search field that enables you to search for 
values in the Account No. and Account Name 
fields.

Account No. Chart of account number.

Account Name Name of the header account.

Account Type Type of the header account.

Account Type Group Subcategories of the header account.

Tax Code Type of tax account.

Field Description

Search for an 
account

A search field that enables you to search for 
values in the Account Type Group field.

Account Type Profit and Loss or Balance Sheet category.

Account Type Group Description of the main account.

Show Detailed in 
reports

Shows additional detail for each individual 
account under the account group.
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2. Click Manage Accounts in the Tasks bar.

3. In the top row, enter details for:

 Account No.

 Account Name

 Account Type in the drop-down

 Account Type Group in the drop-down

 Tax Code in the drop-down (if you do not want to enter a tax code, select “NA”).

4. In the last column, hit either the Enter key or Tab key to add the new account.

5. Click the Submit button.
The new account is posted to the ledger.

To edit a header account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Manage Accounts in the Tasks bar.

3. In the Manage Accounts window, find the account you wish to edit. You can use the search 
field at the top of the window to search for values in the Account No. and Account Name fields.

4. Click in a field you want to edit.

5. Enter the new details.

6. Click the Submit button.
The new account details are posted to the ledger.

To delete a header account

Note: You cannot delete an account that has workpapers, linked documents, or unposted journals 
attached, or which has any balances or transactions. You also cannot delete a system 
account.

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Manage Accounts in the Tasks bar.
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3. In the Manage Accounts window, find the account you wish to edit. You can use the search 
field at the top of the window to search for values in the Account No. and Account Name fields.

4. Select the account row.

5. Click the Delete button.

6. In the Delete window, click Yes.

7. Click Submit.
The account is removed from the ledger.

To add an account type group (account header)

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Manage Accounts in the Tasks bar.

3. In the Manage Accounts window, select the account.

4. Click on Manage Account Type Group.

5. In the first row of the Manage Account Type Group window, enter details in the Account Type 
and Account Type Group fields.
In the Show Detailed in reports field, select ‘Yes’ if you wish to show accounts individually 
under the group heading when running reports; otherwise, select ‘No’.

6. In the last column, hit either the Enter key or Tab key to add the new account type.

7. Click OK.
The account type group is added in the Manage Accounts window.

8. In the Manage Accounts window, click Submit.
The new account header is posted to the ledger.

To edit an account type group (account header)

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Manage Accounts in the Tasks bar.

3. In the Manage Accounts window, find the account you wish to edit. You can use the search 
field at the top of the window to search for values in the Account No. and Account Name fields.
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4. Select the account.

5. Click on Manage Account Type Group.

6. In the Manage Account Type Group window, click in a field you want to edit. You can use the 
search field at the top of the window to search for values in the Account Type Group field.

7. Enter the new details.

8. Click OK.
The account type group is updated in the Manage Accounts window.

9. In the Manage Accounts window, click Submit.
The new account header is updated in the ledger.

To delete an account type group (account header)

This will delete only account headers from the ledger; it does not delete accounts.

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Manage Accounts in the Tasks bar.

3. In the Manage Accounts window, find the account you wish to edit. You can use the search 
field at the top of the window to search for values in the Account No. and Account Name fields.

4. Select the account row.

5. Click on Manage Account Type Group.

6. Select the row with the account type you want to delete. You can use the search field at the 
top of the window to search for values in the Account Type Group field.

7. Click the Delete button.

8. In the Delete window, click Yes.

9. Click OK.

10. In the Manage Accounts window, click Submit.
The account header is removed from the workpaper or ledger; the accounts that were under 
the account header remain in the ledger under the preceding account header.

Adding header and detail accounts

This functionality applies to all products except for AE/AO Ledger.
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To add a header account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Add account on the Tasks bar.
The Add Account window opens.

3. Select the Header option.

4. Select the classification for the account from the Account Type drop-down. 
The Account Classification and Account Number prefix fields automatically update to reflect 
the correct classification for the selected account.

5. Enter the account number into the Account Number field. 
The account number must be unique.

6. Enter the Account Name.
The Account Name field is limited to a maximum of 30 alphanumeric characters.

7. Click OK. 
The header account is displayed in the table in bold italics in the appropriate place in the chart 
of accounts.

To add a detail account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Add account on the Tasks bar.
The Add Account window opens.

3. Select the Detail option.

4. Select the classification for the account from the Account Type drop-down. 
The Account Classification and Account Number prefix fields automatically update to reflect 
the correct classification for the selected account.

5. Enter the Account Number. 
The account number must be unique.

6. Enter the Account Name.
The Account Name field is limited to a maximum of 30 alphanumeric characters.
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7. Click OK. 
The detail account is displayed in the table in italics in the appropriate place in the chart of 
accounts.

Related topics
Editing an added account
Deleting an added account
Opening an existing period
Importing the client’s balances
Adding workpapers and source documents
Accounts
Opening workpapers
Completing workpapers
Opening source documents
Adjustment journals
Managing, tracking and approving workpapers
Posting journals and exporting new accounts

Adding accounts to an Essentials general ledger

As a hierarchical classification is introduced into a Essentials Accounting or Cashbook general ledger 
when it is imported into Client Accounting, it is not necessary to select an account type when adding 
extra accounts. 

This functionality applies to all products except for Practice Ledger.

1. Open the workpapers period.

See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Add account on the Tasks bar.
The Add Account window opens.

3. Select the classification for the account from the Account Classification drop-down. 

4. Select the Account Type from the drop-down. 

5. Enter the account number into the Account Number field. 
The account number must be unique. It is limited to a maximum of 10 alphanumeric 
characters. The Account Number field is a free text field and does not necessarily have to 
contain only numbers.
This is a mandatory field and you must enter a value.

6. Enter the Account Name.
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The Account Name field is limited to a maximum of 30 alphanumeric characters.
This is a mandatory field and you must enter a value.

7. Click OK. 
The added account is displayed in the table in italics in the appropriate place in the chart of 
accounts.

Related topics
Editing an added account
Deleting an added account
Opening an existing period
Importing the client’s balances
Adding workpapers and source documents
Accounts
Opening workpapers
Completing workpapers
Opening source documents
Adjustment journals
Managing, tracking and approving workpapers
Posting journals and exporting new accounts

Editing an added account

Only the Account Name of an added account can be edited. Added accounts are displayed in italics 
in the Prepare Trial Balance (Workpapers) table. 

This functionality applies to all products except for AE/AO Ledger.

To edit an added account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the account in the table.
or 
Click the checkbox in the first column of the selected account. 

3. Click Edit account on the Tasks bar.
The Edit Account window opens.
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Note: The Account Name field is the only field that can be edited. All other fields are 
disabled.

4. Edit the Account Name as required.

5. Click OK.

Related topics
Adding header and detail accounts
Deleting an added account
Opening an existing period
Importing the client’s balances
Adding workpapers and source documents
Accounts
Opening workpapers
Completing workpapers
Opening source documents
Adjustment journals
Managing, tracking and approving workpapers
Posting journals and exporting new accounts

Deleting an added account

Only newly added accounts can be deleted. Added accounts are displayed in italics in the Prepare 
Trial Balance (Workpapers) table.

This functionality applies to all products except for AE/AO Ledger.

To delete an added account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the account in the table.
or 
Click the checkbox in the first column of the selected account. 

3. Click Delete account on the Tasks bar.
The Confirm Account Delete confirmation dialog opens.

4. Click Yes to delete the account. Click No to cancel.
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Viewing transactions

For AE/AO Ledger, AccountRight Live, Essentials Cashbook, and Essentials Accounting, you can view 
the transactions in the Workpapers trial balance sheet, group and filter transactions, and export to 
Excel.

To view transactions

1. Open the Workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select one account in the table.
or 
Click the checkbox in the first column of the selected account. 

3. To display the transactions, either:

 click View transactions on the Tasks bar

 right-click on the account in the table and select View transactions.

Note: You can open multiple View Transactions windows to view different accounts, for example.

All the settings (e.g. group, filter) to change the display of transactions are retained. When 
you close the View Transactions window and reopen it, the display settings are the same.

The Summary section shows the following information:

The fields that are displayed in the View Transactions window are outlined in the table below.

Field Description

Opening Balance The opening balance of the transactions displayed in the 
table.

Net Change The difference between the opening and closing balances 
of the displayed transactions.

Closing Balance The closing balance of the transactions displayed in the 
table.

Field Description

Date Date of the transaction, in the format dd/mm/yyyy.

Type The type of transaction—withdrawal, general journal, 
deposit.

Reference The transaction reference number.
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To group transactions by field

1. In the View Transactions window, click and drag a column header (field) into the grouping bar 
“Drag a column header here to group by that column”.
The transactions are grouped by the data in that column.

2. To remove grouping, drag the column name from the grouping bar back into the transaction 
table.

3. If you want to further group transactions within each group, that is grouping within a group, 
drag a second column header into the grouping bar.
The transactions are displayed by the first column header, and then further groupings within 
each of those groups.

To filter transactions

1. In the View Transactions window, click in the filter bar just below the column header that you 
want to sort transactions for.

The filter bar has a  icon at the left.

2. In the filter bar field, either:

 select a data name from the drop-down

 type the data name.
The transactions that match the data name are displayed.

Note: You can use the asterisk character (*) as a wildcard. For example, type *BP* to find 
all transactions that contain ‘BP’ somewhere in the description.

Description A description of the transaction, such as the purpose.

Note: The line description is shown added to the contents of 
the Journal Note field for AccountRight Live, Practice 
Ledger, and Cashbook.

Debit Amounts debited for withdrawals and general journal 
transactions.

Credit Amount of credit for deposits.

Tax code The type of tax applying to each transaction.

GST Amount of goods and services tax for each transaction.

Field Description
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3. To remove the filter and display all transactions, click on the  icon on the field in the filter 
bar.

To display transactions by period

1. In the View Transactions window, enter the From date and To date.

Note: The dates must be within the workpaper period start and end dates.

2. Click on the Search button.
The transactions that occurred in that period are displayed.

To move columns

1. In the View Transactions window, click and drag a column header to the left or right to change 
the order in which the columns are displayed.

To export transactions to Excel

When you have selected transactions by grouping and filtering, you can export the transactions to 
Excel.

1. In the View Transactions window, click on the Export to Excel button.
An Excel spreadsheet will open, showing the selected transactions.

2. Save the spreadsheet.

Related topics
Adding header and detail accounts
Editing an added account
Opening an existing period
Importing the client’s balances
Adding workpapers and source documents
Accounts
Opening workpapers
Completing workpapers
Opening source documents
Adjustment journals
Managing, tracking and approving workpapers
Posting journals and exporting new accounts
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Defining Balance Forward Accounts

In SME software (such as AccountRight, Essentials, and Cashbook) only Income and Expense 
accounts are cleared to zero. This means in order to properly use this software with Client 
Accounting, it is necessary to do a manual journal entry at the beginning of each year to clear the 
balance of any Asset, Liability or Equity accounts that need to be cleared.

Workpapers can automatically transfer the balance in a specific account to other accounts at the end 
of the financial year, effectively clearing the balance of designated accounts to zero.

When you have configured an Essentials/Cashbook/PL or AR ledger, have prior year balances, and 
have defined account mappings for any balance forward accounts (detailed below), the system will 
create an unposted journal entry dated for the first day of the financial year, whenever you create 
a new workpaper period.

 A journal will not be automatically created if the workpaper period start date is not the same 
as the first day of the financial year.

 Journal entries are only created for accounts that have prior year closing balances.

To define a balance forward account

1. Open the Workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. In the workpaper, select the accounts to update.

3. Right-click the selection, and then click Set Balance forward account in the right-click menu. 
The “Balance forward” window appears.

4. In the To Account field, select the balance forward account. You can select the account in the 
dropdown list, or you can type in this field to search the list of available accounts.

5. Click OK to save your changes.

To view and modify balance forward accounts

1. Open the Workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. In the task bar, click Define Balance Forward Accounts. The Define Balance Forward Accounts 
window will appear.

3. Define the source account and balance forward account by clicking in the empty fields. You can 
select the account in the dropdown list, or you can type in this field to search the list of 
available accounts.
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Note: A row must have both a source account and balance forward account.

4. Click Save to save your changes.

To remove a balance forward account

1. In the “Define Balance Forward Accounts” window, select the account you wish to remove.

2. Click Delete. The row will be removed from the table.

Note: You can also press the Delete key to remove rows.

3. Click Save to keep your changes.

To generate a journal

1. Open the Workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. In the task bar, click Define Balance Forward Accounts. The Define Balance Forward Accounts 
window will appear.

3. In the “Define Balance Forward Accounts” window, click Generate Journal.

Note: This option only appears when you click Define Balance Forward Accounts from 
within a workpaper, and not from the Workpaper tab.

4. A journal will be automatically created based on the first day of the workpaper period, based 
on the closing balances of the previous year. Descriptions for these journal entries will be 
blank.

Note: If a balance forward journal already exists and hasn’t been posted, the system will 
ask you if you want to delete the existing entry and regenerate a new journal 
based on the updated account mappings.

Adding workpapers and source documents

During workpaper preparation, workpapers are attached and documents are linked to accounts in 
the period. The following types of files can be attached or linked to accounts or to the period:

 Workpapers — these documents are used to calculate and substantiate the balance in the 
account. 
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See “Adding workpapers” on page 85 and “Opening workpapers” on page 108.

 Document Manager files — if Document Manager is installed, Document Manager is used to 
link files on your system to the accounts in the period. Files are linked to accounts in the period 
to substantiate the calculations in the workpaper. 

See “Linking Document Manager source documents” on page 89 and “Opening source 
documents” on page 110. 

 External files — if Document Manager is not installed, external files can be linked on your 
system to the accounts in the period. Files can be linked to accounts in the period to 
substantiate the calculations in the workpaper. 

See “Linking external source documents” on page 98 and “Opening source documents” on 
page 110.

Related topics
Adding workpapers
Linking Document Manager source documents
Linking external source documents
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Moving a workpaper
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period

Adding workpapers

For each client account, use Add workpaper to attach workpapers which will substantiate or 
calculate the balance in the account. Workpapers can also be attached to the period and not linked 
to a specific account. Workpapers can be attached to either detail and header accounts.

Note: New workpapers must have a unique name.

Attached workpapers are stored in Workpapers. If a workpaper is deleted it is permanently deleted 
and cannot be restored. 

If the period has been rolled over from a previous period, new workpapers are automatically 
attached to the accounts in the new period using the previous period as a guide. Those workpapers 
which were completed and attached to accounts in the previous period, will be recreated and 
attached to the same accounts in the new period. Only those workpapers with the rollover option 
selected will be generated and attached.
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Note: You can add a workpaper to the next successive year period if you are configured with either:
AccountRight 2013.0 or later, or
Essentials Accounting or Cashbook
as the financial data source.

To add a workpaper to an account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the account in the table.
or 
Click the checkbox in the first column of the selected account. 

3. Click Add workpaper on the Tasks bar.

Tip: Another way of attaching workpapers to an account, is to Select the account in the 
table, right-click and select Add workpaper. 

The Add Workpaper window opens.
The Account field automatically displays the selected account. A different account can be 
selected using the drop-down.

4. In the Select workpaper template section, select the:

 Category — use the drop-down to filter the list of templates which are displayed in the 
Template drop-down. Only templates of the selected category will be displayed on the 
Template drop-down. Select All to see all templates regardless of category. 

 Template — use the drop-down to select the workpaper template to be attached to the 
selected account. If you know the name of the template, you can type in this field to 
search for it.

5. Enter a new Workpaper name. 
Rename the selected template to a something more appropriate for the client account. 

Note: Workpapers must have unique names. 
An error message is displayed if the Workpaper name is already in use. Click OK to 
create a workpaper with a suffix added to the workpaper name. Click Cancel to 
return to the Add Workpaper window.

6. Set the Rollover options, if available:

 Rollover this workpaper to the next period — click this checkbox to roll over the 
workpaper to the next period. During rollover, the previous workpapers period is used as a 
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base. If this option is selected, the current workpaper will be recreated and attached to 
the same account in the next period.

 Retain links to all external documents — click this checkbox to include links to all 
documents which are linked within the workpaper when it is rolled over into the next 
period.

In the workpaper, it is possible to add links to Document Manager files, if Document 
Manager is installed, or external files, if Document Manager is not installed. These linked 
documents can then be opened and viewed from within the workpaper. See “Completing 
workpapers” on page 130.

If Retain links to all external documents is selected, a list of all external documents is 
copied to the new workpaper when it is rolled over into the next period. 

7. Click Add.
The workpaper is attached to the selected account and displayed as a sub-row below the 
account in the Prepare Trial Balance (Workpapers) table. An  icon identifies a workpaper. 
The workpaper is also opened. 
For instructions on opening and viewing workpapers, see “Opening workpapers” on page 108 
for more information. 
From within the workpaper the workpaper properties, such as the name and the rollover 
options which have been configured, can be viewed. See “Viewing and editing the workpaper 
properties” on page 153.

To add a workpaper to the period

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select Non-account specific documents in the table.
or 
Click the Non-account specific documents checkbox in the table. 
This is the first item listed in the table.

3. Click Add workpaper on the Tasks bar.

Tip: Another way of attaching workpapers to a period, is to select Non-account 
specific documents in the table, right-click and select Add workpaper. 

The Add Workpaper window opens.

4. Leave the Account field blank.
The workpaper is being attached to the period and not to a specific account.

5. In the Select workpaper template section select:
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 Category — use the drop-down to filter the list of templates which are displayed on the 
Template drop-down. Only templates of the selected category are displayed on the 
Template drop-down. Select All to see all templates regardless of category. 

 Template — use the drop-down to select the workpaper template to be attached to the 
selected account.

6. Enter a new Workpaper name. 
Rename the selected template to a something more appropriate for the client account. 

Note: Workpapers must have unique names. 
An error message is displayed if the Workpaper name is already in use. Click OK to 
create a workpaper with a suffix added to the workpaper name. Click Cancel to 
return to the Add Workpaper window.

7. Set the Rollover options:

 Rollover this workpaper to the next period — click this checkbox to roll over the 
workpaper to the next period. During rollover, the previous workpapers period is used as a 
base. If this option is selected, the current workpaper will be recreated and attached to 
the same account in the next period.

 Retain links to all external documents — click this checkbox to include links to all 
documents which are linked within the workpaper when it is rolled over into the next 
period.

In the workpaper, it is possible to add links to Document Manager files, if Document 
Manager is installed, or external files, if Document Manager is not installed. These linked 
documents can then be opened and viewed from within the workpaper. 

If Retain links to all external documents is selected, a list of all external documents is 
copied to the new workpaper when it is rolled over into the next period. 

8. Click Add.
The workpaper is attached to the period and opens. The workpaper is displayed as a sub-row 

below Non-account specific documents in the table. An  icon identifies a workpaper. 
For instructions on opening and viewing workpapers, see “Opening workpapers” on page 108 
for more information.

Related topics
Opening an existing period
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Comments in workpapers
Completing workpapers
Viewing and editing the workpaper properties
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Linking clients in a workpaper

Accountants Enterprise only

If you have Workpaper Designer, you can add a Link client button into your workpapers, so that you 
can insert an account balance for a related entity – see Inserting an account code or description for 
more information.

To add a link to a client in a workpaper that includes a Link Client button:

1. Click Link Client.
The Link Workpaper Fields window displays.

2. Click [...] beside the Select Client field to select the client to link.
The Find Client dialog displays.

3. Type part of the name of the client in the Search for field and click Search.
A list of matching clients displays.

4. Select the client to link to and click OK.
The Select Workpaper Fields window redisplays.

5. Select a period from the Select period dropdown.
A list of accounts displays.

6. Select the account and click OK.
The workpaper redisplays showing the name of the linked client and the balance of the linked 
account. 

Note: Click Unlink client to remove the connection from the workpaper.

Related topics
Inserting an account code or description
Opening an existing period
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Comments in workpapers
Completing workpapers
Viewing and editing the workpaper properties

Linking Document Manager source documents

For each client account, Link Document is used to link documents which substantiate the 
calculations in the workpapers. If Document Manager is installed, files are linked to accounts in the 
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period using Document Manager. If Document Manager is not installed, external files can be linked 
to accounts in the period.

Before linking Document Manager files to the period, the file must be created in or imported into 
Document Manager. 

See Creating new documents with the Create Document wizard and Importing documents in 
Document Manager for more information.

When linking a Document Manager file to an account or period, a link is created between the 
account / period and the document which is stored in Document Manager. When using Delete, the 
link between the account and the document is deleted. The document is no longer linked to the 
workpaper account / period but is still available in Document Manager.

If a document link is broken, that is, by renaming the document or moving it to a different location, 
an error message is displayed as the original document cannot be found. You must re-link the 
document.

You can link a Document Manager file to:

 an account

 a period.

You can also link to bookmarks within a PDF Document Manager file.

An  icon identifies a linked document.

Related topics
Linking a Document Manager file to an account
Linking a Document Manager file to a period
Linking a Document Manager file containing references
Adding workpapers
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Linking a Document Manager file to an account

To link a Document Manager file to an account

1. Open the workpapers period.
See “Opening an existing period” on page 53.

../Document_Manager/Creating_new_documents.htm
../Document_Manager/Importing.htm
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The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the detail or header account in the table. 
or
Click the checkbox in the first column for the selected account. 
Document Manager files can be attached to both detail and header accounts.

3. Click Link document on the Tasks bar.

Tip: Another way of linking Document Manager files is to select the account in the 
table, right-click and select Link document.

The Link Document window opens.

4. Ensure that the correct account is displayed in the Account field. 

5. Click Search.
The Search for a document window opens.

6. When the Search for a document window displays, a default search is carried out, showing 
documents sorted in order of last reference.

Note: The number of records retrieved in this initial search is limited to 10. To retrieve 
all search results, click Search.

If you wish to refine the search, continue to the next step; otherwise, go to Step 10.

7. By default, the Current option is selected in Search Contacts. 
Only documents for the client for whom the workpapers period is being completed will be 
searched. 
If required, you can select the All option and click the ellipse button to select a new client.

8. Enter criteria into the Search Criteria fields to refine the search. 
Searches can be based on:

 Title and Author — enter the title of the document on the Title field and / or select the 
author on the Author drop-down.

 Reference no — select the Reference no option and enter the document reference 
number on the text field. 

 Display related entity documents — displays all the documents for any of the clients/
contacts listed on the Associated tab for the current contact/client and for the parent, 
children and siblings from the Billing Group tab. If this option is selected all the documents 
for clients/contacts in the same family group as the currently selected client/contact are 
displayed.

To display all documents for the selected client leave the search criteria blank and click Search.
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Documents that match the search criteria are displayed in the table. The total number of 
documents returned by the search is displayed at the top of the table.

9. To sort or filter the search results:

a. Click any column heading to sort the results alphabetically or numerically. 

b. Use the first row in the table to filter the search results.

In any of the Reference No, Client, Document Title and Author fields click the drop-down 
and select the value to filter on from the drop-down. 

The criteria on which to filter the search results can also be entered. Enter the value you 
wish to use as a filter into any of the Reference No, Client, Document Title or Author fields 
and press [Enter]. 

Use wildcards for advanced filtering. For example, to filter the results to view only those 
documents starting with C, enter C and an asterisk (*) into the Document Title field and 
press [Enter].

Click  to clear the search filter.

10. Find the document to be linked to the account in the table. 

11. Click the file checkbox. 
Click multiple checkboxes to link multiple documents.

12. Click OK.
The Search for a document window closes.

13. Ensure that the correct file name is displayed in the Name field. 
If multiple files are being linked then the file names are separated by a semi-colon (;).

14. Click Link.
The Document Manager file is linked to the selected account. The Document Manager file is 
displayed as a sub-row under the account in the table. An  icon identifies a linked document.

Note: If there already linked documents with the same name in the workpaper, you will 
be prompted to add a suffix to the names of the added documents. Click OK to add 
these documents with a suffix, or click Cancel to return to the window.

If you are adding multiple documents with similar names, you will be prompted to 
change these file names manually and try again.

For instructions on opening and viewing Document Manager files, see “Opening source 
documents” on page 110 for more information.
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Related topics
Linking a Document Manager file to a period
Linking a Document Manager file containing references
Adding workpapers
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Linking a Document Manager file to a period

To link a Document Manager file to a period

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click the Non-account specific documents checkbox. 
This is the first item listed in the table.

3. Click Link document on the Tasks bar.

Tip: Another way of linking Document Manager files to the period, is to select Non-
account specific documents in the table, right-click and select Link document.

The Link Document window opens.

4. Leave the Account field blank.
The Document Manager file is being linked to the period and not to a specific account. 

5. Click the Document Manager File option. 

6. When the Search for a document window displays, a default search is carried out, showing 
documents sorted in order of last reference.

Note: The number of records retrieved in this initial search is limited to 50. To retrieve 
all search results, click Search.

If you wish to refine the search, continue to the next step; otherwise, go to Step 10.

7. Enter criteria into the Search Criteria fields to refine the search. 
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Searches can be based on:

 Title and Author — enter the title of the document on the Title field and / or select the 
author on the Author drop-down.

 Reference no — select the Reference no option and enter the document reference 
number on the text field.

 Display related entity documents — displays all the documents for any of the clients/
contacts listed on the Associated tab for the current contact/client and for the parent, 
children and siblings from the Billing Group tab. If this option is selected all the documents 
for clients/contacts in the same family group as the currently selected client/contact are 
displayed.

To display all documents for the selected client leave the search criteria blank and click Search.
Documents that match the search criteria are displayed in the table. The total number of 
documents returned by the search is displayed at the top of the table.

8. To sort or filter the search results:

a. Click any column heading to sort the results alphabetically or numerically. 

b. Use the first row in the table to filter the search results. 

In any of the Reference No, Client, Document Title and Author fields click the drop-down 
and select the value to filter on from the drop-down. 

The criteria on which to filter the search results can also be entered. Enter the value you 
wish to use as a filter into any of the Reference No, Client, Document Title or Author fields 
and press [Enter]. 

Use wildcards for advanced filtering. For example, to filter the results to view only those 
documents starting with C, enter C and an asterisk (*) into the Document Title field and 
press [Enter].

Click  to clear the search filter.

9. Click OK.
The Search for a document window closes.

10. Ensure that the correct file name is displayed in the Name field. 

11. Click the Rollover this document to the next period checkbox.
This will include the document in the next rollover period. During rollover, the previous 
workpapers period is used as a base. If this option is selected the link to the document will be 
recreated and included on the same account in the next period. 

12. Click Link.
The Document Manager file is linked to the period. The Document Manager file is displayed as 
a sub-row below Non-account specific documents in the table. An  icon identifies a linked 
document.
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Note: If there already linked documents with the same name in the workpaper, you will 
be prompted to add a suffix to the names of the added documents. Click OK to add 
these documents with a suffix, or click Cancel to return to the window.

If you are adding multiple documents with similar names, you will be prompted to 
change these file names manually and try again.

For instructions on opening and viewing Document Manager files, see “Opening source 
documents” on page 110 for more information.

Related topics
Linking a Document Manager file to an account
Linking a Document Manager file containing references
Adding workpapers
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Linking a Document Manager file containing references

When you link a PDF file or Excel spreadsheet, you can specify the PDF bookmark or Excel worksheet 
as a reference. This is done in the Link Document window, which appears when you select either of 
these files for linking.

Note: Excel 2013, Excel 2016, and XLS, XLSX and XLSM file types are supported for adding Excel 
spreadsheets with references.

Note: This feature does not support password protected files. Only the “Entire document” 
reference option is available.

To link a Document Manager file (containing references) to an account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the detail or header account in the table. 
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or
Click the checkbox in the first column for the selected account. 
Document Manager files can be attached to both detail and header accounts.

3. Click Link document on the Tasks bar.

Tip: Another way of linking Document Manager files is to Select the account in the 
table, right-click and select Link document.

The Link Document window opens.

4. Ensure that the correct account is displayed in the Account field. 

5. When the Search for a document window displays, a default search is carried out, showing 
documents sorted in order of last reference.

Note: The number of records retrieved in this initial search is limited to 50. To retrieve 
all search results, click Search.

If you wish to refine the search, continue to the next step; otherwise, go to Step 10.

6. By default, the Current option is selected in Search Contacts. 
Only documents for the client for whom the workpapers period is being completed will be 
searched. 
If required, you can select the All option and click the ellipse button to select a new client.

7. Enter criteria into the Search Criteria fields to refine the search. 
Searches can be based on:

 Title and Author — enter the title of the document on the Title field and / or select the 
author on the Author drop-down.

 Reference no — select the Reference no option and enter the document reference 
number on the text field. 

 Display related entity documents — displays all the documents for any of the clients/
contacts listed on the Associated tab for the current contact/client and for the parent, 
children and siblings from the Billing Group tab. If this option is selected all the documents 
for clients/contacts in the same family group as the currently selected client/contact are 
displayed.

To display all documents for the selected client leave the search criteria blank and click Search.
Documents that match the search criteria are displayed in the table. The total number of 
documents returned by the search is displayed at the top of the table.

8. To sort or filter the search results:

a. Click any column heading to sort the results alphabetically or numerically. 
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b. Use the first row in the table to filter the search results. 

In any of the Reference No, Client, Document Title and Author fields click the drop-down 
and select the value to filter on from the drop-down. 

The criteria on which to filter the search results can also be entered. Enter the value you 
wish to use as a filter into any of the Reference No, Client, Document Title or Author fields 
and press [Enter]. 

Use wildcards for advanced filtering. For example, to filter the results to view only those 
documents starting with C, enter C and an asterisk (*) into the Document Title field and 
press [Enter].

Click  to clear the search filter.

9. Find the document to be linked to the account in the table. 

10. Click the file checkbox. 
Click multiple checkboxes to link multiple documents.

11. Click OK.
The Search for a document window closes. A list of documents is displayed in the Link 
Document window.
You can preview the Document Manager file by clicking on the hyperlink. Similarly, you can 
view any reference in the Document Manager file by clicking on the hyperlinked reference. The 
document is opened at the referenced page or worksheet. 

12. If the file contains bookmarks/worksheets, select the appropriate option from the Reference 
column drop-down.
If the file does not contain any bookmarks or additional worksheets, only the Entire document 
option will be available from the Bookmark drop-down. Hidden worksheets in Excel 
spreadsheets are not shown in the dropdown.
If the Entire document option is selected, a link is created to the first page of the PDF 
document. For Excel files, no worksheet is added.
The Document name field is automatically filled with the name of the file that is to be linked to 
the period. If you are linking to a PDF bookmark or Excel worksheet, then the bookmark/
worksheet name enclosed in brackets is added as a suffix to this value. You can change this 
value by deleting the existing text and entering a new Document name.

Note: The Document name value must be unique. An error message is displayed if the 
Document name is already in use.

13. If you have made an error and want to delete a document link in the Link Document window:

a. Select the row containing the document link.

b. Press [Delete], or click Delete.
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The document link is removed from the Link Document window.

14. Select the Roll Forward checkbox, if the linked document bookmarks will be rolled forward.
This will include the document in the next rollover period. During rollover, the previous 
workpapers period is used as a base. If this option is selected the link to the document will be 
recreated and included on the same account in the next period. 

15. Click Link.
The Document Manager file is linked to the selected account. The Document Manager file is 
displayed as a sub-row below the account in the table. If multiple documents are to be linked, 
multiple rows are displayed below the account in the table. An  icon identifies a linked 
document.

Note: If there already linked documents with the same name in the workpaper, you will 
be prompted to add a suffix to the names of the added documents. Click OK to add 
these documents with a suffix, or click Cancel to return to the window.

If you are adding multiple documents with similar names, you will be prompted to 
change these file names manually and try again. You can update the names by 
clicking in the Document name column of the Link Document window.

For instructions on opening and viewing Document Manager files, see “Opening source 
documents” on page 110 for more information.

Related topics
Linking a Document Manager file to an account
Linking a Document Manager file to a period
Adding workpapers
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Linking external source documents

If Document Manager is not installed, external files can be linked to the accounts in the period. 
When linking an external file to an account or period, a link is created between the account / period 
and the document which is stored on your system. When the document is opened the document 
stored on your system is opened. When using Delete, the link between the account / period and the 
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document is deleted, not the document itself. See “Deleting workpapers and source documents” on 
page 117.

You can link an account or period to specific bookmarks within a PDF document. You can also link 
accounts or periods to different bookmarks within the same PDF document.

If a document link is broken (i.e., by renaming the document or moving it to a different location), an 
error message is displayed as the original document cannot be found. You must re-link the 
document.

Note: Workpapers is not a document management system. When linking an external file to an 
account, a copy of the document is not archived. If the document is moved or deleted from 
your system it will not be available in Workpapers.

Related topics
Linking an external file to an account
Linking an external file to a period
Linking to references in an external file
Adding workpapers
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Linking an external file to an account

To link an external file to an account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the detail or header account in the table. 
or
Click the checkbox in the first column for the selected account. 

3. Click Link document on the Tasks bar.
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Tip: Another way of linking an external file to an account is to select the account in the 
table, right-click and select Link document.

The Link External File window opens.

4. Ensure that the correct account is displayed in the Account field. 

5. Click Browse in the Select external file section.
The Attach External File window opens.

6. Navigate to the location where the file is stored and find the file.

7. Click Open.

Note: If the Document name is already in use, a message will appear asking if you wish 
to add the document with a suffix attached. If you click OK, the document will be 
automatically added to the account.

8. Ensure that the path and filename in the File field are correct. 
The Reference field is disabled.
The Document name field is automatically filled with the name of the file that is to be linked to 
the account. This can be changed, if necessary, by deleting the existing text and entering a new 
document name.

Note: The Document name must be unique. An error message is displayed if the 
document name is already in use.

9. Enter a new unique name for the external file in the Document name field. 

10. Click the Rollover this document to the next period checkbox. 
This will include the document in the next rollover period. During rollover, the previous 
workpapers period is used as a base. If this option is selected the link to the document will be 
recreated and included on the same account for the next period. 

11. Click Link.
The external file is linked to the selected account. The external file is displayed as a sub-row 
below the account in the table. An  icon identifies a linked document.

Related topics
Linking an external file to a period
Linking to references in an external file
Adding workpapers
Viewing a list of all workpapers and source documents
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Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Linking an external file to a period

To link an external file to a period

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click the Non-account specific documents checkbox. 
This is the first item listed in the table.

3. Click Link document on the Tasks bar.

Tip: Another way of linking an external file to the period is to select Non-account 
specific documents in the table, right-click and select Link document.

The Link Document window opens.

4. Leave the Account field blank.
The external file is being linked to the period and not to a specific account. 

5. Click Browse in the Select external file section.
The Attach External File window opens.

6. Navigate to the location where the file is stored and find the file.

7. Click Open.

8. Ensure that the path and file name in the File field are correct. 
The Reference field is disabled. 
The Document name field is automatically filled with the name of the file that is to be linked to 
the period. This can be changed, if necessary, by deleting the existing text and entering a new 
Document name.

Note: The Document name must be unique. An error message is displayed if the 
Document name is already in use.
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9. Enter a new unique name for the external file in the Document name field. 

10. Click the Rollover this document to the next period checkbox. 
This will include the document in the next rollover period. During rollover, the previous 
workpapers period is used as a base. If this option is selected, the link to the document will be 
recreated and included on the same account in the next period. 

11. Click Link.
The external file is linked to the period. The external file is displayed as a sub-row below Non-
account specific documents in the table. An  icon identifies a linked document.

Related topics
Linking an external file to an account
Linking to references in an external file
Adding workpapers
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Linking to references in an external file

When you link a PDF file or Excel spreadsheet, you can specify the PDF bookmark or Excel worksheet 
as a reference.

Note: Excel 2013, Excel 2016, and XLS, XLSX and XLSM file types are supported for adding Excel 
spreadsheets with references.

Note: This feature does not support password protected files. Only the “Entire document” 
reference option is available.

To link to specific references in an external document

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the detail or header account in the table. 
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or
Click the checkbox in the first column for the selected account. 

3. Click Link document on the Tasks bar.

Tip: Another way of linking an external file to a selected account in the table, right-click 
and select Link document.

The Link External File window opens.

4. Ensure that the correct account is displayed in the Account drop-down field. 

5. Click Browse in the Select external file section.
The Attach External File window opens.

6. Navigate to the location where the PDF file is stored and find the file.

7. Click Open.

Note: If the Document name is already in use, a message will appear asking if you wish 
to add the document with a suffix attached. If you click OK, the document will be 
automatically added to the account.

8. Ensure that the path and filename in the File field are correct. 

9. If you are linking to a specific PDF bookmark or Excel worksheet, select the reference from the 
Reference drop-down.
If the external file does not contain any references, then a link will be created to the Entire 
Document.
The Document name field is automatically filled with the name of the file that is to be linked to 
the period. If you are linking to a PDF bookmark or Excel worksheet, then the bookmark/
worksheet name enclosed in brackets is added as a suffix to this value. You can change this 
value by deleting the existing text and entering a new Document name.

Note: The Document name must be unique. An error message is displayed if the 
Document name is already in use.

10. Select the Rollover this document to the next period checkbox. 
This will include the document in the next rollover period. During rollover, the previous 
workpapers period is used as a base. If this option is selected the link to the document will be 
recreated and included on the same account in the next period. 

11. Click Preview.
If you are linking to a specific PDF bookmark or Excel worksheet, the file opens at the specified 
reference.
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If you are linking to the entire file as it does not have any references, then the document opens 
at the first page. 
Preview the displayed information and check that the reference is correct.

12. Click Link.
The external file is linked to the selected account. The external file is displayed as a sub-row 
below the account in the table. An  icon identifies a linked document.

Related topics
Linking an external file to an account
Linking an external file to a period
Adding workpapers
Viewing a list of all workpapers and source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Importing the client’s balances
Adjustment journals
Opening an existing period
Opening Document Manager files

Viewing a list of all workpapers and source documents

Use the View all workpapers option on the Tasks bar to view a list of all workpapers and documents 
which are associated with the period. This option also enables you to add / link, open and delete 
workpapers and documents.

To view a list of all workpapers and source documents

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click View all workpapers on the Tasks bar.
The Trial Balance (Workpapers) window opens.
A list of all the documents for the period is displayed. The client and period details are 
displayed at the top of the window. From this window you can add, link, open and delete 
workpapers and / or documents.
Use the table headings to sort information within the table. Click the Document heading to 
sort the rows in the table alphabetically by document name. Click the Code heading to sort the 
rows in the table numerically by account number.
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3. Click Close.
The Trial Balance (Workpapers) window closes.

Related topics
Adding workpapers
Linking Document Manager source documents
Linking external source documents
Opening workpapers
Opening source documents
Deleting workpapers and source documents
Opening an existing period

Account comments

You can add a comment to any account listed in the Prepare Trial Balance (Workpapers) table. 

When a comment is added to an account, a comment icon  is placed in the column next to the 
Status column for the relevant account.

To view the comment, place your cursor on the comment icon. The comment is displayed in a text 
box.

Note: You cannot add multiple comments to the one account. But you can add further comments 
to an existing comment.

Related topics
Adding comments to an account
Editing comments on an account
Deleting comments from an account
Opening workpapers
Completing workpapers

Adding comments to an account

To add comments to a selected account in the Prepare Trial Balance (Workpapers) table

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select an account in the table.
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3. Click Add comment on the Tasks bar.
or
Right-click on the account in the table and select Add comment.
The Add Comment window opens.
The Account field is automatically filled with the selected account details. The Comments 
section contains the name of the person adding the comment, the current date and time of 
when the comment was added.

4. Enter comments in the text area.
Enter comments beneath the date and time stamp entry and the Reference: entry. This is a 
free format text area.

5. Click the Add button.
The comment is added to the account and the Add Comment window closes.

To add comments to the Trial Balance (Workpapers) table

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Add comment on the Tasks bar.
or
Right-click on the table and select Add comment.
The Add Comment window opens.

3. Select an account from the Account field drop-down.
The drop-down list contains the entire list of imported chart of accounts from the configured 
general ledger.

4. Enter comments in the text area.
Enter comments beneath the date and time stamp entry and the Reference: entry. This is a 
free format text area.

5. Click the Add button.
The comments are added to the account and the Add Comment window closes.

Related topics
Account comments
Editing comments on an account
Deleting comments from an account
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Editing comments on an account

To edit comments

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Right-click the comment icon for the selected account.

3. Select Edit comments.
The Edit Comment window opens. 
The Account field is automatically filled with the details of the selected account and cannot be 
changed.

4. Edit the comment as necessary.

5. Click OK.
The changes are saved to the comment.

To add more comments to an existing comment

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Right-click the comment icon for the selected account.

3. Select Edit comments.
The Edit Comment window opens. 
The Account field is automatically filled with the details of the selected account and cannot be 
changed.

4. Click Insert time.
This will insert your name and a date and time stamp as an entry line in the Comments text box 
area.

5. Enter your comments.

6. Click OK.
To save the changes to your comment.

Related topics
Account comments
Adding comments to an account
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Deleting comments from an account

Deleting comments from an account

To delete comments from an account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Right-click the comment icon for the selected account.

3. Select Delete comments.
A Delete confirmation message is displayed.

4. Click Yes.
To delete the comment.

Related topics
Account comments
Editing comments on an account
Adding comments to an account

Opening workpapers

Workpapers are used to calculate and substantiate the balance in the account. After workpapers 
have been attached to an account, the attached workpaper must be opened and completed. 

To open a workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Find the account with the associated workpaper in the table.

3. Click  to expand the account and view the documents.

If the workpaper is attached to the period, click  to expand Non-account specific documents 
and view the documents.

4. Double-click the workpaper. 
The workpaper opens in a new window.
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To open a workpaper using the Tasks bar

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Find the account with the associated workpaper in the table.

3. Select the workpaper.
Ensure that the checkbox is ticked.

4. Click Open workpaper on the Tasks bar.
The workpaper opens in a new window.

To open multiple workpapers

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click the checkboxes of all the workpapers or documents to be opened.

3. Click Open workpaper on the Tasks bar.
The workpapers open in new windows. 
If documents have been selected, the cover page of each selected document opens in a new 
window. Click the Open button to open the document. The document will then open in the 
associated application. See “Opening multiple documents” on page 113.

Related topics
Completing workpapers
Comments in workpapers
Workpaper To Do items
Viewing and editing the workpaper properties
Adding workpapers
Viewing a list of all workpapers and source documents
Opening source documents
Deleting workpapers and source documents
Managing, tracking and approving workpapers
Opening an existing period
Opening multiple documents
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Opening source documents

Source documents can be linked to accounts within the workpaper period to substantiate the 
balance of the account. If Document Manager is installed, files are linked to accounts in the period 
using Document Manager. If Document Manager is not installed, external files can be linked to the 
accounts in the period. 

See “Opening Document Manager files” on page 110 and “Opening external files” on page 112.

All documents have an associated cover page. The cover page enables progress tracking of reviewing 
and approving documents. When opening source documents, access the cover page first and then 
open the file. The source document opens in the associated application. See “Using the source 
document cover page” on page 114.

Related topics
Opening Document Manager files
Opening external files
Using the source document cover page
Viewing and editing the source document properties
Viewing a list of all workpapers and source documents
Linking Document Manager source documents
Deleting workpapers and source documents
Opening an existing period

Opening Document Manager files

All documents have an associated cover page. When opening source documents, access the cover 
page first and then open the file. The source document opens in the associated application. See 
“Using the source document cover page” on page 114.

Document Manager files which are opened in Workpapers are automatically checked out of 
Document Manager. Document Manager copies the file to the working directory and the item is 
locked to prevent others from making changes to the document. While a document is checked out 
and open, other staff members will have read-only access to the document.

If changes are made to the Document Manager file, it should be checked in before closing the 
document. Use the Check In option on the Document Manager toolbar. A new version of the 
document can be created. A new document or the original document can be replaced. See the 
Document Manager Check In process.

Changes cannot be made to the Document Manager file if its status is set to approved / complete. 
When opening a Document Manager file with a status of approved / complete a warning is 
displayed. Select Yes to open and view the file as read-only. 

For AE, see the Document Manager document approvals process.

../Document_Manager/Checking_in_documents.htm
../Document_Manager/Document_approvals.htm
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When a workpaper is closed while a PDF file is checked out, a warning message displays asking if 
you’d like to check in these documents first. You can check in your changes at this point, or dismiss 
the message and check in the changes later.

All of Document Manager’s features are available for use. See the Document Manager help for more 
information on using these features.

To open a Document Manager file

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. If the Document Manager file is linked to an account, find the account in the table. 

Click  to expand the account and view the documents.

If the document is linked to the period, click  to expand Non-account specific documents 
and view the documents.

3. Double-click the linked Document Manager file.
The cover page for the Document Manager file opens in a new window. 

4. Click Open.
This is located on the Document details section. 
The Document Manager file opens in the associated application. 
Document Manager files which are opened in Workpapers are automatically checked out of 
Document Manager. While a document is open and checked out other staff members will have 
read-only access to the document. 
If the Document Manager file has a status of Approved / Complete a warning is displayed. No 
changes can be made to the document. Click Yes to open and view the document in read-only 
mode. 
If the Document Manager file has a status of In Progress, changes can be made to the 
document. After making changes to the document, check in the document using the Check In 
option on the Document Manager toolbar. The document can be saved as a new version. A 
new document can be created or the original document can be replaced.

Note: If you wish to edit a PDF document, the default program for .pdf files in your 
operating system should be set to a PDF editor.

5. Close the Document Manager file.
You are returned to the cover page for the Document Manager file.
See “Using the source document cover page” on page 114.

../Document_Manager/Overview.htm
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Related topics
Opening external files
Using the source document cover page
Viewing and editing the source document properties
Viewing a list of all workpapers and source documents
Linking Document Manager source documents
Deleting workpapers and source documents
Opening an existing period

Opening external files

If Document Manager is not installed, external files can be linked to the workpaper period. When an 
external file is linked to an account or period, a link is created between the account and the 
document which is stored on your system. 

All source documents have an associated cover page. When opening external files, access the cover 
page first and then open the file. The external file, which is stored on your system, is opened in the 
associated application. See “Using the source document cover page” on page 114.

Note: Workpapers is not a document management system. When an external file is attached to an 
account, a copy of the linked document is not archived. If the document is moved or deleted 
from your system, it will not be available in Workpapers.

To open an external file

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. If the external file is linked to an account, find the account in the table. 

Click  to expand the account and view the documents.

If the document is linked to the period, click  to expand Non-account specific documents 
and view the documents.

3. Double-click the linked external file.
The cover page for the external file opens in a new window. 

4. Click the Open button.
This is located on the Document details section. 
The external file opens in the associated application. 
If changes have been made to the external file, ensure that the changes are saved prior to 
closing the file.
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5. Close the external file.
You are returned to the cover page for the Document Manager file.
See “Using the source document cover page” on page 114.

Related topics
Opening Document Manager files
Using the source document cover page
Viewing and editing the source document properties
Viewing a list of all workpapers and source documents
Linking external source documents
Deleting workpapers and source documents
Opening an existing period

Opening multiple documents

In the Prepare Trial Balance (Workpapers) table, multiple documents can be selected and opened 
at one time. All source documents have an associated cover page. The cover page allows you to view 
the progress of reviewing and approving documents. When opening multiple documents, the cover 
page of each document opens first. The document can then be opened from the cover page. 

To open multiple documents

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click the checkboxes of all the workpapers or documents to be opened in the table.

3. Click Open workpaper on the Tasks bar.
For documents, the cover page of each selected document opens in a new window. Click the 
Open button to open the document. The document will then open in the associated 
application. The selected multiple workpapers will each be opened in a new window.
See “Using the source document cover page” on page 114.

Tip: An alternative way of opening multiple documents from the Prepare Trial Balance 
(Workpapers) table is to click View all workpapers on the Tasks bar. In the Trial 
Balance (Workplaces) window, click the checkboxes of all the documents to be 
opened and click Open workpaper. Each document will open in a new window.

Related topics
Opening Document Manager files
Opening external files



AE, AU, NZ PM Client Accounting User Guide | 114

Using the source document cover page
Viewing and editing the source document properties
Viewing a list of all workpapers and source documents
Linking Document Manager source documents
Linking external source documents
Deleting workpapers and source documents
Opening an existing period
Using the source document cover page

Using the source document cover page

All source documents have an associated cover page. The cover page enables you to view the 
progress of reviewing and approving documents. When opening source documents, access the 
cover page first and then open the file. 

To use the source document cover page

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Find the source document in the table.

3. Double-click the source document to open it. 
See “Opening Document Manager files” on page 110 or “Opening external files” on page 112.
The document cover page opens. 
If the document is a Document Manager file, the Location field reads “Document Manager”. 
If the document is an external file, the Location field displays the path of the document. 

4. Click Open to open the document.

5. To enter additional information about the document:

a. Click the text field in the Notes table. 

b. Type text into the field.

6. Click Save to save the changes to the document cover page.
or
Click Close to close the document cover page. If you have not saved the changes you will be 
prompted to save the changes before closing the document cover page.

Related topics
Opening Document Manager files
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Opening external files
Using the source document cover page
Viewing a list of all workpapers and source documents
Linking Document Manager source documents
Linking external source documents
Deleting workpapers and source documents
Opening an existing period
Viewing and editing the source document properties

Viewing and editing the source document properties

From within the source document cover page, the source document properties which have been 
configured for the document can be viewed and edited. Use the Properties button on the cover page 
toolbar to access the source document properties. 

Note: Only the document rollover options can be edited.

To view and edit the source document properties

1. Open the source document cover page. 
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Properties on the toolbar.
The Workpaper Properties window opens.

3. Edit the source document properties as necessary. 
Only the document rollover options can be edited.

4. Click OK to save the changes or Cancel to close the window without saving. 

Related topics
Opening Document Manager files
Opening external files
Using the source document cover page
Viewing a list of all workpapers and source documents
Linking Document Manager source documents
Linking external source documents
Deleting workpapers and source documents
Opening an existing period
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Moving a workpaper

You can move a workpaper from one account to another. This is useful if you’ve added a workpaper 
to the wrong account.

You can also rename the workpaper during the move.

Note: When the workpaper is moved to the selected account, all linked accounts and values are 
updated.

To move a workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the workpaper or document in the table.

3. Click the checkbox next to the workpaper or document.

4. Click Move workpaper on the Tasks bar.
The Move Workpaper dialog is displayed.

5. Select an account from the To account dropdown. The workpaper will be moved to this 
account.

6. If you want to rename the workpaper, change the text in the Workpaper name field.

7. Set the Rollover options:

 Rollover this workpaper to the next period — tick this checkbox to roll over the 
workpaper to the next period. During rollover, the previous workpapers period is used as a 
base. If you tick this option, this workpaper will be recreated and attached to the same 
account in the next period.

 Retain links to all external documents — tick this checkbox to include links to all 
documents that are linked within the workpaper when it is rolled over to the next period. 
If you tick this option, a list of all external documents is copied to the new workpaper 
when it is rolled over to the next period. 

8. Click OK.

Related topics
Adding workpapers
Deleting workpapers and source documents
Linking Document Manager source documents
Opening source documents
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Viewing a list of all workpapers and source documents
Viewing and editing the source document properties
Using the source document cover page
Adjustment journals
Opening an existing period

Deleting workpapers and source documents

Single or multiple workpapers and documents can be deleted. 

When deleting workpapers and documents it is important to note:

 Approved workpapers and documents cannot be deleted. An error is displayed if an attempt is 
made to delete an approved workpaper or document. A warning is also displayed if an 
approved workpaper is included when deleting multiple workpapers and / or documents. 

 Deleting a workpaper permanently deletes the attached workpaper. The workpaper cannot be 
restored. Before using Delete, please double check that the workpaper is to be permanently 
deleted.

 Deleting a Document Manager file does not delete the document in Document Manager. The 
link between the workpaper period and the Document Manager file is deleted. The document 
is not available in Workpapers but is still available in Document Manager.

 Deleting an external file such as a spreadsheet or text file does not delete the document itself. 
The link between the workpaper period and the external file is deleted. The document is not 
available in Workpapers but remains on your system.

To delete a workpaper or document from the Prepare Trial Balance (Workpapers) table

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the workpaper or document in the table.

3. Click the checkbox next to the workpaper or document.

4. Click Delete workpaper on the Tasks bar.
The Delete Workpapers dialog is displayed.

5. Click Yes to confirm the deletion. Click No to cancel the deletion. 

To delete a workpaper or document using View all workpapers

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.
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2. Click View all workpapers on the Tasks bar.
The Trial Balance (Workpapers) window opens.

3. Click the checkboxes of the workpaper(s) and / or document(s) to be deleted.

4. Click Delete. 
The Delete Workpapers dialog is displayed.

5. Click Yes to confirm the deletion. Click No to cancel the deletion. 

To delete multiple workpapers or documents from the Prepare Trial Balance (Workpapers) table

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the workpapers and/or documents in the table.

3. Click the checkboxes next to the documents/workpapers to be deleted.

4. Click Delete.
The Delete Confirm dialog is displayed.

5. Click Yes to confirm the deletion. Click No to cancel the deletion. 

Related topics
Adding workpapers
Linking Document Manager source documents
Opening source documents
Viewing a list of all workpapers and source documents
Viewing and editing the source document properties
Using the source document cover page
Adjustment journals
Opening an existing period
Moving a workpaper

Rolling data over from a prior period

There will be times when errors are made or workpapers are mistakenly deleted or a workpaper was 
not automatically rolled over from the previous period. You can rollover individual workpapers from 
a previous period into the current period.

To roll data over from a workpaper in a prior period to the selected workpaper in the current period, 
the following conditions must be met:
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 the workpapers must be the same, i.e. workpaper name, template and linked to same account 
code.

 the workpaper must be available in the previous year.

 the workpaper must be in edit mode, not read only mode.

 the prior period must have been completed.

 the prior period must have been defined.

Note: All current workpaper data is lost when you rollover from a prior period.

To roll over workpaper data from a prior period

1. Roll over all data from a completed period.
See “Rolling over into a new period from a completed period” on page 54.

2. Open the new workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

3. Select the workpaper in the table.

4. Add the same workpaper to the same account code.
See “Adding workpapers” on page 85.

5. Select the newly added workpaper.

6. Click Rollover from the prior period on the Tasks bar.
A message will be displayed stating the period that data will be rolled over from. 

All current data will be lost.

7. Click Yes to continue.
A message is displayed to inform you that the rollover was successful.
If you open the workpaper, you will notice that the data content is that of the workpaper from 
the previous period.

If you have made an error and wish to revert to the original workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Delete the workpaper that is in error.
See “Deleting workpapers and source documents” on page 117.
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3. Add the same workpaper to the same account code.
See “Adding workpapers” on page 85.

4. Select the newly added workpaper.

5. Click Rollover from the prior period on the Tasks bar.
A message will be displayed stating the period that data will be rolled over from. 
All current data will be lost.

6. Click Yes to continue.
A message is displayed to inform you that the rollover was successful.
If you open the workpaper, you will notice that the data content is that of the workpaper from 
the previous period.

Related topics
Adding workpapers
Opening source documents
Viewing a list of all workpapers and source documents
Viewing and editing the source document properties
Using the source document cover page
Adjustment journals
Opening an existing period
Rolling over into a new period from a completed period
Updating your workpaper template

Updating your workpaper template

You can update a selected workpaper in the Prepare Trial Balance (Workpapers) table to the latest 
master workpaper template.

Note: When updating to the latest master workpaper template, your current workpaper data will 
be lost.

To update a workpaper template

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the workpaper in the table.

3. Click Update to latest template on the Tasks bar.
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A message will be displayed informing you which template version the workpaper is currently 
using and what the latest template version is. Current data in the workpaper may be lost if you 
update to the latest master workpaper template. You are requested to confirm your request.
If the selected workpaper is currently using the latest template version, you will receive a 
message informing you of this. Click OK to close the message.

4. Click Yes.
The selected workpaper is updated to the latest master template version.
A message will be displayed when the workpaper has been successfully updated to the latest 
template version.

5. Click OK.

Related topics
Adding workpapers
Opening source documents
Viewing a list of all workpapers and source documents
Viewing and editing the source document properties
Using the source document cover page
Adjustment journals
Opening an existing period
Rolling over into a new period from a completed period
Rolling data over from a prior period

Adjustment journals

In Workpapers, the client’s accounts and balances are reviewed. For each account, workpapers are 
attached and completed which calculate and substantiate the balances for the account. If balances 
calculated during workpaper preparation are different to the client’s balance, adjustment journals 
must be added to correct the client’s balances. The final adjusted profit/loss as a result of the 
adjusting journal is displayed as the last entry in the Prepare Trial Balance (Workpapers) table.

Related topics
Adding a new adjustment journal
Posting journals and exporting new accounts
Viewing adjustment journals
Editing adjustment journals
Deleting adjustment journals
Deleting journals posted to a legacy ledger
Opening workpapers
Managing, tracking and approving workpapers
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Opening an existing period

Adding a new adjustment journal

If balances calculated during workpaper preparation are different to the client’s balance, 
adjustment journals must be added to correct the client’s balances. 

Note: You will not be able to post a journal to an Essentials Accounting general ledger on or prior 
to a lock date.

To add an adjustment journal

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select the account in the table. 

3. Click Journals > Add on the Tasks bar.
An alternative way of adding an adjustment journal to an account, is to select the account in 
the table, right-click and select Add journal.
The Add Journal window opens.

4. Enter a Date.
The Date drop-down defaults to the end date of the period. 
To edit the date, enter a new date into the Date field in the format dd/mm/yyyy or select the 
date from the drop-down calendar.

5. Enter a note for the adjustment journal on the Journal note field. 
This is a mandatory field. 
The selected account is displayed as a row in the table.

6. (Australia) If you want to use quantities for this journal (for example, for farm accounting), tick 
the Enter quantities checkbox.

7. If this journal needs to be reversed (that is, if it is for a transaction that will occur in the future), 
tick the To be reversed checkbox.

Note: Transactions marked as To be reversed will be posted twice: first with the date 
specified as the transaction date, and then again on the first day of the following 
period. The two transactions are identical except that the sign of all of the 
amounts is reversed so that one transaction cancels the other.

8. Select an account code from the Account dropdown.
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If you need to create a new Account, click Add Account at the bottom of the window. The Add 
Account window displays. Refer to “Adding header and detail accounts” on page 75 for more 
information.
For Practice Ledgers, this button is Manage Accounts, which is identical to the Manage 
Accounts link in the Tasks bar. See “Managing accounts for AE/AO ledger” on page 72.
These buttons aren’t available for Accounts, AOGL, MAS, or AccountRight 19.xx.

9. To add GST, select Apply GST. This value is saved per workpaper. The GST Code and GST Type 
fields become editable. Modify these values as necessary.
For AEAO ledgers and Essentials Cashbook ledgers:

 Select the GST Code from the dropdown.

The GST Rate is set according to the code you select. 

For other ledgers:

 Select the GST Type from the drop-down (None, Collected or Paid).

The GST Rate is set according to the type selected.

The amount of GST calculated will be posted to the account selected on the Define GST 
Account dialog.

Note: Deselecting Apply GST will reset the GST Rate and GST Amount fields to zero, and 
change the GST Code to NTR.

10. Enter the quantity for the selected account in the Quantity field.

Note: The Quantity field is only available if you ticked the Enter quantities checkbox 
above.

Note: You can enter a negative amount in the Quantity field.

11. Enter the debit or credit adjustment amount for the selected account in the DR Amount and 
CR Amount fields respectively.

12. If required, enter a description for the adjustment in the Description field. (This field is 
optional.) As you type, any matching descriptions will appear in the field — press [Enter] or 
[Tab] to use the highlighted text.

Note: This field for each journal line item may be concatenated for some ledger types, 
due to field size limitations.
Accounts: maximum 61 characters.
AO Classic GL: maximum 77 characters.
MAS: maximum 60 characters.

13. Press [Enter].
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The balancing amount is automatically added into the corresponding DR Amount or CR 
Amount field in the next row. 

14. Enter the account number into the Account field or select the account number from the drop-
down. 

15. Ensure the amount in the DR Amount or CR Amount field is correct.
If the amount in the DR Amount or CR Amount field is incorrect, edit the amount and press 
[Enter]. 
The remainder required to balance the journal is automatically entered into the DR Amount or 
CR Amount field. 

16. Add further rows until the amounts have been correctly distributed between the accounts.
To delete a row, click the checkbox for the appropriate row and click Delete.
The journal entry totals are calculated and displayed at the bottom of the DR Amount or CR 
Amount columns. 
Before saving the journal entry ensure that the journal entry is balanced and the total reads 
0.00.

17. Click Add.
The table updates to show the added adjustment journal entry. The debit and credit amounts 
are added in the account row in the Debit and Credit columns. Each account’s adjusted balance 
is displayed in the Final column.
The Add Journal window clears and remains open for further data entry. 

18. Add further adjustment journals as necessary. 

19. Click Close when you have finished adding adjustment journals.

Related topics
Posting journals and exporting new accounts
Viewing adjustment journals
Editing adjustment journals
Deleting adjustment journals
Deleting journals posted to a legacy ledger
Opening workpapers
Managing, tracking and approving workpapers
Opening an existing period

Viewing adjustment journals

You can view a list of all the adjustment journals, or adjustment journals for a selected account 
which have been added to the period. Adjustment journals can also be added, edited and deleted. 
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To view all adjustment journals

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Journals > View all on the Tasks bar.
The Journals window opens.
The Journal Date and Journal Note are displayed in the header row as well as the checkbox 
which is used to select the journal. For AccountRight Live, Practice Ledger, and Cashbook, the 
journal line description is shown appended to the journal note field.
The Sequence, Account Name, Quantity, DR Amount/CR Amount, GST information, and 
Description are displayed in the detail rows.

Note: If an account code has been updated in an online ledger, the updates won’t be 
reflected in the Journals window. The original account code will be shown in this 
window, and the row will be highlighted in red.
If the journal has not yet been posted, you can update the account code to match 
the code in the online ledger. See “Editing adjustment journals” on page 126.
If the journal has already been posted, the account code cannot be updated. You 
are not required to update this journal, as the Ledger will reflect the correct 
account code. 

The Show drop-down is used to filter the list of journals which are displayed in the table. This 
drop-down is only relevant if you want to view and filter journals once they have been posted 
to the client ledger. See “Posting journals and exporting new accounts” on page 161.

3. Click Cancel.
The Journals window closes.

To view adjustment journals for a selected account

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click the checkbox for the selected account in the table. 

3. Click Journals > View for account on the Tasks bar.
The Journals for Account... window opens.
Only journals for the selected account are displayed in the table. 
The journal Date and Journal Date are displayed in the header row as well as the checkbox 
which can be used to select the journal. 
The Sequence, Account Name, Amount and Description are displayed in the detail rows.
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There will be three details lines below the detail row showing:

 The calculated GST amount and the account to which it will posted.

 The transaction amount minus the GST and the account to which it will posted.

 The transaction amount and the account to which it will posted. 

4. Click Cancel.
The Journals for Account... window closes.

Related topics
Adding a new adjustment journal
Editing adjustment journals
Deleting adjustment journals
Deleting journals posted to a legacy ledger
Posting journals and exporting new accounts
Opening workpapers
Managing, tracking and approving workpapers
Opening an existing period

Editing adjustment journals

View a list of adjustment journals and select an adjustment journal for editing. The journal date, note 
and amounts can be edited. Journals can be edited either before or after they are posted. You must 
have the appropriate task permissions to use this function: see “Security and task permissions” on 
page 43.

This feature is available for online ledgers (Essentials and AccountRight Live).

Note: Only journals that are in the latest active open workpaper period can be edited. This is only 
applicable to journals created in the Trial Balance/Workpapers view (not within online 
ledgers). Posted “To Be Reversed” journals cannot be updated.

To edit adjustment journals

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Journals > View all on the Tasks bar.
The Journals window opens.

3. Click the checkbox of the journal entry to be edited. 

4. Click Edit.
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The Edit Journal window opens.

5. Edit the journal entry, as necessary. 
In the table, the Date, Journal Note, Account, Quantity, DR Amount, CR Amount, and 
Description fields can be edited. Add further rows to the adjustment journal, as necessary.
If you need to create a new Account, click Add Account at the bottom of the window. The Add 
Account window displays. Refer to “Adding header and detail accounts” on page 75 for more 
information.
For Practice Ledgers, this button is Manage Accounts, which is identical to the Manage 
Accounts link in the Tasks bar. See “Managing accounts for AE/AO ledger” on page 72.
These buttons aren’t available for Accounts, AOGL, MAS, or AccountRight 19.xx.

Note: The Description field for each journal line item may be concatenated for some 
ledger types, due to field size limitations.
Accounts: maximum 61 characters.
AO Classic GL: maximum 77 characters.
MAS: maximum 60 characters.

The journal entry total is calculated and displayed at the bottom of the Amount column. 

6. (Australia) If you want to use quantities for this journal (for example, for farm accounting), tick 
the Enter quantities checkbox.

7. If this journal needs to be reversed (that is, if it is for a transaction that will occur in the future), 
tick the To be reversed checkbox.

Note: Transactions marked as To be reversed will be posted twice: first with the date 
specified as the transaction date, and then again on the first day of the following 
period. The two transactions are identical except that the sign of all of the 
amounts is reversed so that one transaction cancels the other.

8. To add GST, select Apply GST. This value is saved per workpaper. The GST Code and GST Type 
fields become editable. Modify these values as necessary.
For AE/AO ledgers and Cashbook ledgers, select the GST Code for this particular journal from 
the drop-down. For other ledgers, select the GST Type from the drop-down (None, Collected or 
Paid).
The GST Rate is set according to the code you select. 
The amount of GST calculated will be posted to the account selected on the Define GST 
Account dialog.

Note: Deselecting Apply GST will reset the GST Rate and GST Amount fields to zero, and 
change the GST Code to NTR.

9. Ensure that edited journal entry is balanced and the total reads 0.00.
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10. If you wish to delete any lines in the Journal, select the line item and click Delete.

11. Click Save to save the details in the Journals window. The Journals window updates to show 
the edited journal entry.

12. When you are done, click Cancel to close the Journals window.

After updating a posted journal, the application will post a reversal journal of the original journal 
(prefixed with “CANCELLED”), and post a new journal with the corrected entries. In the Workpaper 
database, the posted journal will be updated and an audit record will be created with the details of 
the original journal.

Related topics
Adding a new adjustment journal
Viewing adjustment journals
Deleting adjustment journals
Deleting journals posted to a legacy ledger
Posting journals and exporting new accounts
Opening workpapers
Managing, tracking and approving workpapers
Opening an existing period

Deleting adjustment journals

View a list of adjustment journals and select an adjustment journal to be deleted. 

To delete adjustment journals

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Journals > View all on the Tasks bar.
The Journals window opens.

3. Click the checkbox of the journal entry to be deleted. 

4. Click Delete.
A confirmation dialog is displayed.

5. Click Yes to confirm the deletion. Click No to cancel the deletion.

Related topics
Adding a new adjustment journal
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Viewing adjustment journals
Editing adjustment journals
Deleting journals posted to a legacy ledger
Posting journals and exporting new accounts
Opening workpapers
Managing, tracking and approving workpapers
Opening an existing period

Deleting journals posted to a legacy ledger

If you have posted journals in a legacy application's ledger (such as MAS, Accounts, or AOGL), and 
attempt to delete these journals in Workpapers, they will only be removed from the Workpapers UI. 
You need to also manually remove posted journals from within the legacy application to remove 
them entirely.

To delete journals posted to a legacy ledger

1. After deleting the journal in Workpapers, log into your legacy ledger (MAS, Accounts, or 
AOGL).

2. Open the ledger containing the poster journal.

3. Manually delete the posted journal entry.

Related topics
Adding a new adjustment journal
Viewing adjustment journals
Editing adjustment journals
Deleting adjustment journals
Posting journals and exporting new accounts
Opening workpapers
Managing, tracking and approving workpapers
Opening an existing period
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Completing workpapers
Workpapers can be made up of:

 Fields — text can be entered into fields. Fields can also be used to display variable information. 

 Static Text — constant text which cannot be edited and is displayed the same on every 
workpaper. 

 Formatting elements — formatting elements such as tables and lines which comprise the 
layout of the workpaper.

To complete the workpaper, click the Edit icon for the field you wish to update, and enter the 
information. 

Workpaper field types 

To complete the workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Enter information in the workpaper. 
A description of how to enter the information:

Field Type Description

Text This field type displays text entered by you.

Number This field type displays numbers entered by you.

Account number This field type displays an account selected from a drop-down 
list. All accounts that are displayed in the Prepare Trial 
Balance (Workpapers) table are available on the drop-down. 
The field may display the account number, the account 
description or both. 

Date The date can be entered or selected from a calendar. 

Document link This field type is used to add a link to a Document Manager 
file, if Document Manager is installed or an external file, if 
Document Manager is not installed. 

Automatic This field type displays variable information. This includes 
information such as the balance of a selected account, a 
calculated amount or dates - period start, period end. 
Automatic fields cannot be edited. 
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 Enter text — click the text field. Type text into the field.

 Enter a number — click the number field. Type a number into the field. 

 Select an account — click the field, click the  icon and select the account from the 

drop-down list. If an account has already been selected, the  icon is displayed.

 Select a date — click the field, enter the date or select the date from the drop-down 
calendar.

 Add a row to a table — click to place the cursor in a row. Click  to insert a row above 
the selected row.

 Delete a row from a table — click to place the cursor in the row to be deleted. Click  to 
delete the row. 

 Shift rows up and down a table — click to place the cursor in the row to be moved. Click 
the up and down arrows to the left of the row to shift the row up and down the table.

 Add comments — see “Comments in workpapers” on page 132.

 Link a document — see “Linking documents in a workpaper” on page 140.

 Linked accounts — Some workpapers contain information from linked accounts. You can 

refresh these values by clicking the  refresh icon. To link a workpaper value, click the  

icon. To unlink a work paper value, click the  icon.

Note: If there are account codes highlighted in red, this means that the account code has 
been modified or removed outside of Client Accounting. This only appears in 
workpapers that are in progress.
After the account code in the workpaper is updated to the matching code, the red 
highlighting is removed.

4. Click Save.
Changes are saved and the Trial Balance (Workpapers) window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes. 
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Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

If multiple accounts in the workpaper are selected and if the workpaper is configured to link to 
all referenced accounts, the workpaper will be displayed against all accounts it references in 
the Prepare Trial Balance (Workpapers) table. An  at the beginning of the workpaper sub-
row indicates that the workpaper is a linked workpaper. The account that the workpaper is 
actually attached to is indicated in square brackets - [1-1000 account name] - after the 
workpaper name. An  icon identifies a workpaper.

Related topics
Opening workpapers
Comments in workpapers
Workpaper To Do items
Adding workpapers
Viewing a list of all workpapers and source documents
Deleting workpapers and source documents
Opening an existing period
Comments in workpapers

Comments in workpapers

Use Comments to add additional information, remarks or queries for other staff members. During 
the review process you can add a comment to flag an area for review or mark an area that needs 
correction. Comments can be dragged and dropped in a workpaper - see “Moving comments in a 
workpaper” on page 136.

To add a new comment

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 

../Document_Manager%2FAccessing_Document_Manager_from_the_system_tray.htm%23
../Document_Manager%2FAccessing_Document_Manager_from_the_system_tray.htm%23
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The specific workpaper window opens.

3. Click to place the cursor where the comment is to be added. 

4. Click New comment on the toolbar.
A comment box opens. 
The comment box displays the name of the staff member editing the workpaper and today’s 
date. 
If a workpaper field is selected, the name of the field is displayed after Reference in the 
comment box. 

5. Enter the information for the comment. 
Information entered into the comment box is automatically saved. 

6. To close the comment box, click outside of the comment box in the workpaper area.

The comment closes and is identified by a comment icon  on the workpaper. The number 
increments as more comments are added to the workpaper. 

7. Click Save.
Changes are saved and the window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

Related topics
Viewing comments in a workpaper
Editing a comment in a workpaper
Moving comments in a workpaper
Deleting a comment in a workpaper

../Document_Manager%2FAccessing_Document_Manager_from_the_system_tray.htm%23
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Opening workpapers
Completing workpapers
Workpaper To Do items
Viewing and editing the workpaper properties

Viewing comments in a workpaper

To view a comment

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Find the comment to be viewed in the workpaper. 

4. Place the cursor over the  icon. 
A comment box opens for you to read the comment.

To show or hide all comments

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Click Show all comments on the toolbar. 
The comment boxes for all comments on the workpaper are displayed. 

4. Click Hide all comments on the toolbar.
The comment boxes for all comments on the workpaper are hidden.

Related topics
Comments in workpapers
Editing a comment in a workpaper
Moving comments in a workpaper
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Deleting a comment in a workpaper
Opening workpapers
Completing workpapers
Workpaper To Do items
Viewing and editing the workpaper properties

Editing a comment in a workpaper

To edit a comment

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Click the comment in the workpaper to be edited. 

The comment icon is highlighted red .

4. Click Edit comment on the toolbar.
A comment box opens. 

5. Edit the comment in the Reference section of the comment box. 
Information entered into the comment box is automatically saved. 

6. Close the comment.
To close the comment click outside of the comment box in the workpaper area.

7. Click Save.
Changes are saved and the window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.
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Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

Related topics
Comments in workpapers
Viewing comments in a workpaper
Moving comments in a workpaper
Deleting a comment in a workpaper
Opening workpapers
Completing workpapers
Workpaper To Do items
Viewing and editing the workpaper properties

Moving comments in a workpaper

To move a comment

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Add a comment.
See “Comments in workpapers” on page 132.

An  icon is displayed. 

4. Drag and drop the  icon to a different location within the workpaper where necessary.
The icon changes from yellow to red in colour when it is selected.

5. Click Save.
Changes are saved and the window remains open.

../Document_Manager%2FAccessing_Document_Manager_from_the_system_tray.htm%23
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or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

Related topics
Comments in workpapers
Viewing comments in a workpaper
Editing a comment in a workpaper
Deleting a comment in a workpaper
Opening workpapers
Completing workpapers
Workpaper To Do items
Viewing and editing the workpaper properties

Deleting a comment in a workpaper

To delete a comment

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Click the comment in the workpaper to be deleted.

The comment icon is highlighted red .

../Document_Manager%2FAccessing_Document_Manager_from_the_system_tray.htm%23
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4. Click Delete comment on the toolbar.
The comment is deleted. 

5. Click Save.
Changes are saved and the window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

Related topics
Opening workpapers
Completing workpapers
Comments in workpapers
Viewing comments in a workpaper
Editing a comment in a workpaper
Moving comments in a workpaper
Workpaper To Do items
Viewing and editing the workpaper properties
Adding workpapers
Viewing a list of all workpapers and source documents
Deleting workpapers and source documents
Opening an existing period

Adding an adjustment journal within a workpaper

The Add journal toolbar option in the Trial Balance (Workpapers) window enables you to create an 
adjustment journal automatically from a calculation field in the workpaper. For example, you may 

../Document_Manager%2FAccessing_Document_Manager_from_the_system_tray.htm%23
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want to create a journal using the variance amount in order to reconcile it to an account. See 
“Adding a new adjustment journal” (see page 122). The final adjusted profit/loss as a result of the 
adjusting journal is displayed as the last entry in the Prepare Trial Balance (Workpapers) table.

To add an adjustment journal from a workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Complete the workpaper.
See “Completing workpapers” (see page 130).

4. Click Add journal on the toolbar.
The Add Journal window opens.

5. Enter a Date.
The Date drop-down defaults to the end date of the period. 
To edit the date, enter a new date into the Date field in the format dd/mm/yyyy or select the 
date from the drop-down calendar.

6. Enter a note for the adjustment journal on the Journal Note field. 
This is a mandatory field. 
The selected account is displayed as a row in the table.

7. Enter the adjustment amount for the selected account on the Amount field.

8. Press [Enter].
The balancing amount is automatically added into the Amount field in the next row. 

9. Enter the account number into the Code field or select the account number from the drop-
down. 

10. Ensure the amount in the Amount field is correct.
If the amount in the Amount field is incorrect, edit the amount and press [Enter]. 
The remainder required to balance the journal is automatically entered into the Amount field. 

11. Add further rows until the amounts have been correctly distributed between the accounts.
To delete a row, click the checkbox for the appropriate row and click Delete.
The journal entry total is calculated and displayed at the bottom of the Amount column. 
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Before saving the journal entry ensure that the journal entry is balanced and the total reads 
0.00.

12. Click Add.
In the background, the table updates to show the added adjustment journal entry. The debit 
and credit amounts are added in the account row in the Debit and Credit columns. Each 
account’s adjusted balance is displayed in the Final column.
The Add Journal window clears and remains open for further data entry. 

13. Add further adjustment journals as necessary. 

14. Click Cancel when you have finished adding adjustment journals.

Related topics
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Opening source documents

Linking documents in a workpaper

You can link to documents when you are in a workpaper, provided the workpaper contains a 
Document Links table. You can link a Document Manager file (if you have Document Manager) or an 
external file, if you do not have Document Manager.

When you link a document in a workpaper, a  icon will be displayed next to the name of the 
document. You can reference an existing linked document anywhere within the workpaper by 

dragging and dropping the appropriate  icon to the required location. 

For the  icon, the D s to document and the number is sequentially incremented as more 
documents are linked to a workpaper. If a document is deleted, the document link and icon are 
removed. When another document is linked to the workpaper the next available number is used for 
the icon. A deleted icon number is not reused. 
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You can view the name of the document associated with a  icon, by placing your cursor on 
the icon. A text box pops up with a description of the document link, the name of the document and 
its location. Move your cursor to a different location and the text box disappears.

If a document link is broken (that is, by renaming the document or moving it to a different location), 
an error message will be displayed. You must re-link the document.

Related topics
Linking a Document Manager file within a workpaper
Linking an external file within a workpaper
Opening a linked document in a workpaper
Moving linked documents within a workpaper
Deleting a document link
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
Adding an adjustment journal within a workpaper
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Opening source documents

Linking a Document Manager file within a workpaper

To link to a Document Manager file within a workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Click on the Link document in the taskbar option of workpapers.

4. When the Search for a document window displays, a default search is carried out, showing 
documents sorted in order of last reference.
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Note: The number of records retrieved in this initial search is limited to 50. To retrieve 
all search results, click Search.

If you wish to refine the search, continue to the next step; otherwise, go to Step 9.

5. By default, the Current option is selected in Search Contacts. 
Only documents for the client for whom the workpapers period is being completed will be 
searched. 
If required, you can select the All option and click the ellipse button to select a new client.

6. Enter criteria into the Search Criteria fields to refine the search. 
Searches can be based on:

 Title and Author — enter the title of the document on the Title field and / or select the 
author on the Author drop-down.

 Reference no — select the Reference no option and enter the document reference 
number on the text field. 

 Display related entity documents — displays all the documents for any of the clients/
contacts listed on the Associated tab for the current contact/client and for the parent, 
children and siblings from the Billing Group tab. If this option is selected all the documents 
for clients/contacts in the same family group as the currently selected client/contact are 
displayed.

To display all documents for the selected client leave the search criteria blank and click Search.
Documents that match the search criteria are displayed in the table. The total number of 
documents returned by the search is displayed at the top of the table.

7. To sort or filter the search results:

a. Click any column heading to sort the results alphabetically or numerically. 

b. Use the first row in the table to filter the search results. 

In any of the Reference No, Client, Document Title and Author fields click the drop-down 
and select the value to filter on from the drop-down. 

The criteria on which to filter the search results can also be entered. Enter the value you 
wish to use as a filter into any of the Reference No, Client, Document Title or Author fields 
and press [Enter]. 

Use wildcards for advanced filtering. For example, to filter the results to view only those 
documents starting with C, enter C and an asterisk (*) into the Document Title field and 
press [Enter].

Click  to clear the search filter.

8. Find the document to be linked to the workpaper. 

9. Click the file checkbox. 
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Click multiple checkboxes to link multiple documents.

10. Click OK.
The Search for a document window closes.
If none of the selected documents contain bookmarks, the actions at Step 14 are carried out.
If your selected documents contain bookmarks, a list of documents is displayed in the Link 
Document window.
You can preview the Document Manager file by clicking on the hyperlink. The file is displayed 
in the appropriate application. If you selected a PDF or Excel Document Manager file, you can 
view any references by clicking on the hyperlinked reference. The document is opened at the 
referenced page/worksheet. 

11. If a PDF or Excel document is selected and it contains bookmarks/worksheets, select the 
appropriate option from the Reference column drop-down.
If a PDF or Excel document is selected and it does not contain references, only the Entire 
Document option will be available from the Reference drop-down.
If the Entire Document option is selected, a link is created to the first page of the PDF 
document.
The Workpaper name field is automatically filled with the name of the file that is to be linked 
to the period. If you are linking to a PDF bookmark or Excel worksheet, then the bookmark/
worksheet name enclosed in brackets is added as a suffix to this value. You can change this 
value by deleting the existing text and entering a new Workpaper name.

Note: The Workpaper name must be unique. An error message is displayed if the 
Workpaper name is already in use.

12. If you have made an error and want to delete a document link in the Link Document window:

a. Select the row containing the document link.

b. Press [Delete] or click Delete.

The document link is removed from the Link Document window.

13. Click Link.
The Document Manager file is linked to the workpaper. The name and location of the linked 
document is displayed in the Link column of the Document Links table of the workpaper. The 
document name is displayed in the Description column of the Document Links table. This can 

be changed by clicking the  icon.

An  icon will be displayed next to the table row. This icon can be dragged and dropped.

14. Click Save.
Changes are saved and the window remains open.
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or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

Related topics
Linking an external file within a workpaper
Opening a linked document in a workpaper
Moving linked documents within a workpaper
Deleting a document link
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
Adding an adjustment journal within a workpaper
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Opening source documents

Linking an external file within a workpaper

To link to an external document within a workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
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The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Click on the Link document in the taskbar option of workpapers.

4. Click Browse in the Select external file section.
The Attach External File window opens.

5. Navigate to the location where the file is stored and find the file.

6. Click Open.

7. Ensure that the path and filename in the File field are correct. 

8. If you are linking to a specific PDF bookmark or Excel worksheet, select it from the Reference 
drop-down.
If the external document does not contain any bookmarks or worksheets, then a link will be 
created to the Entire Document.
If you are not linking to a PDF or Excel document, then the Reference option will not be 
available.
The Workpaper name field is automatically filled with the name of the file that is to be linked 
to the period. If you are linking to a PDF bookmark or Excel worksheet, then the bookmark/
worksheet name enclosed in brackets is added as a suffix to this value. You can change this 
value by deleting the existing text and entering a new Workpaper name.

Note: The Workpaper name must be unique. An error message is displayed if the 
Workpaper name is already in use.

9. Click Preview.
If you are linking to a specific bookmark in a PDF document, the PDF document is opened in a 
PDF Reader at the bookmarked page.
If you are linking to the entire PDF document as it does not have any bookmarks, then the PDF 
document is opened in a PDF Reader at the first page. 
If you are not linking to a PDF document, the document opens in the appropriate application 
for you to preview.
Preview the information displayed and check that the bookmark is correct.

10. Click Link.
The document is linked to the workpaper. The name and location of the linked document is 
displayed in the Link column of the Document Links table of the workpaper. The document 
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name is displayed in the Description column of the Document Links table. This can be changed 

by clicking the  icon.

An  icon will be displayed next to the table row. This icon can be dragged and dropped.

11. Click Save.
Changes are saved and the window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 

workpaper by clicking the  Edit button, a warning message will display asking 
if you want to check in these saved PDF documents when you close the 
workpaper. Clicking Yes will check in all PDF documents. Clicking No will require 
you to check in these documents manually. These documents can be checked in 
manually using the Document Manager icon in the system tray. See Accessing 
Document Manager from the system tray.

Related topics
Linking a Document Manager file within a workpaper
Opening a linked document in a workpaper
Moving linked documents within a workpaper
Deleting a document link
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
Adding an adjustment journal within a workpaper
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
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Opening source documents

Opening a linked document in a workpaper

Once a document has been linked in a workpaper you can open the document to view it. You can 
either view a document in read-only mode, or you can edit the document by checking out the file.

Note: When editing a PDF document, ensure you have PDF editing software installed on your 
machine, and that it is set as the default program for editing PDF files.

Note: If a document link is broken (that is, the document has been renamed or moved to a different 
location), then you will not be able to open the document. You must re-link the document.

To open a linked document in the Document Links table

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Link a document.
See “Linking a Document Manager file within a workpaper” on page 141 or “Linking an external 
file within a workpaper” on page 144.

Once a document has been linked, a  icon will be displayed next to the name of the 
document. 
Once the document has been linked, a view button and an edit button are available when you 
select the document in the Link column of the Document Links table.

4. To view the document in read-only mode, click View.
The document is opened in the appropriate application. If you have linked to a specific 
bookmark in a PDF document, the document is opened at the selected bookmark.
To check out the document for editing, click Edit.
The document will be checked out and it will be opened in the appropriate application.

Note: If the document is already in Complete or Approved status, you cannot edit the 
document.

5. Close the document.
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You are returned to the Trial Balance (Workpapers) window.

To open a linked document using the document icon

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Link a document.
See “Linking a Document Manager file within a workpaper” on page 141 or “Linking an external 
file within a workpaper” on page 144.

Once a document has been linked, a  icon will be displayed next to the name of the 
document. 

4. Right-click on the  icon.
To view the document in read-only mode, click the View button.
The document is opened in the appropriate application. If you have linked to a specific 
bookmark in a PDF document, the document is opened at the selected bookmark.
To check out the document for editing, click the Edit button.
The document will be checked out and it will be opened in the appropriate application.

Note: If the document is already in Complete or Approved status, you cannot edit the 
document.

5. Close the document.
You are returned to the Trial Balance (Workpapers) window.

Related topics
Linking documents in a workpaper
Moving linked documents within a workpaper
Deleting a document link
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
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Adding an adjustment journal within a workpaper
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Opening source documents

Moving linked documents within a workpaper

You can reference an existing linked document anywhere within the workpaper by dragging and 

dropping the appropriate  icon to the required location.

To move a document link within a workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Link a document.
See “Linking a Document Manager file within a workpaper” on page 141 or “Linking an external 
file within a workpaper” on page 144.

Once a document has been linked, a  icon will be displayed next to the name of the 
document. 

4. Drag and drop the  icon to a location within the workpaper where it will be used as a 
reference.
The icon changes from blue to red in colour when it is selected.

5. Click Save.
Changes are saved and the window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
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The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

Related topics
Linking documents in a workpaper
Opening a linked document in a workpaper
Deleting a document link
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
Adding an adjustment journal within a workpaper
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Opening source documents

Deleting a document link

When a document is deleted, the document link and icon are removed. If another document is 
linked to the workpaper the next available number is used for the icon. A deleted icon number is not 
reused.

To delete a document from the Document Links table

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
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The specific workpaper window opens.

3. Select either the Description cell or Link cell of the document link to be removed.

You will notice a red at the right of the table for that entry.

4. Click the  icon.
The entire row is deleted from the Document Links table and the document link to the 

workpaper and  icon are removed. 

5. Click Save.
Changes are saved and the window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

To delete a document using the document icon

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
The specific workpaper window opens.

3. Select the  icon of the document to be deleted.
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Ensure that you are deleting the correct document. Place your cursor on the document icon to 
display a text box containing the name and description of the document.

4. Right-click on the document and select Delete document.

The  icon is removed and the document is deleted from the Document Links table.

5. Click Save.
Changes are saved and the window remains open.
or 
Click OK.
The window closes, and any changes made will be saved.
or
Click Cancel.
The window closes.

Note: If you have made any changes you will be prompted to save the changes before 
the window closes. 
If you have Document Manager, and you checked out PDF documents in this 
workpaper by clicking the Edit button, a warning message will display asking if you 
want to check in these saved PDF documents when you close the workpaper. 
Clicking Yes will check in all PDF documents. Clicking No will require you to check 
in these documents manually. These documents can be checked in manually using 
the Document Manager icon in the system tray. See Accessing Document Manager 
from the system tray.

Related topics
Linking documents in a workpaper
Opening a linked document in a workpaper
Moving linked documents within a workpaper
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
Adding an adjustment journal within a workpaper
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Opening source documents
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Workpaper To Do items

A list of all To Do items associated with a selected workpaper document can be viewed at the top of 
the Workpaper window. This only appears when there are To Do items present.

A description of the tasks that can be performed with To Do items:

 View a list of To Do items — by default the To Do table is hidden. Click  to show the table. 
Click  to collapse and hide the table.

 Add a To Do item — click the New To Do button on the toolbar to create a new To Do item. 
See “To Do items” on page 172.

 Open and edit a To Do item — find the item in the To Do table and double-click the item. The 
To Do item will open in the To Do window. See “Opening and editing a To Do item” on 
page 176.

Related topics
Opening workpapers
Completing workpapers
Comments in workpapers
To Do items
Opening and editing a To Do item
Working with To Do items
Printing To Do items
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Viewing and editing the workpaper properties

Viewing and editing the workpaper properties

From within the workpaper, properties such as the workpaper name and the rollover options which 
have been configured, can be viewed and edited. Use the Properties option on the Workpaper 
window toolbar to access the workpaper properties. 

To view and edit the workpaper properties

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Open a workpaper.
See “Opening workpapers” on page 108. 
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The specific workpaper window opens.

3. Click Properties on the toolbar.
The Workpaper Properties window opens.
The properties displayed include:

 Attached to account code — the account code and account name of the account to which 
the workpaper is attached. 

 Template category — the category to which the template belongs. Categories are used to 
classify and sort templates. 

 Workpaper name — the unique name of the workpaper. 

 Rollover this workpaper to the next period — determines whether the workpaper will be 
included in rollover. During rollover, the previous workpapers period is used as a base. If 
this option is selected, this workpaper will be recreated and attached to the same account 
in the next period.

 Retain links to all external documents — in the workpaper, it is possible to add links to 
Document Manager files, if Document Manager is installed or external files, if Document 
Manager is not installed. If Retain links to all external documents is selected, then a list of 
links to external files is copied to the new workpaper when it is rolled over into the next 
period. 

4. Edit the workpaper properties as necessary. 

5. Click OK to save the changes or Cancel to close the window without saving. 

Related topics
Opening workpapers
Completing workpapers
Comments in workpapers
Opening and editing a To Do item
Viewing and editing the workpaper properties
Adding an adjustment journal within a workpaper
Linking documents in a workpaper
Adding workpapers
Viewing a list of all workpapers and source documents
Opening an existing period
Opening source documents

Managing, tracking and approving workpapers

Note: (New Zealand) Approvals is only available if you are licensed for Workpapers. 
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Approvals can be used to track the progress on completing, reviewing and approving workpapers 
and documents. The workpapers and documents status can be set to easily see the progress on 
completing, reviewing and approving the workpapers and documents for the workpapers period. In 
the Prepare Trial Balance (Workpapers) table, the status icons indicate the progress on each 
workpaper and document. 

While work is progressing on workpapers and documents associated with an account, the status icon 
on the account indicates that work is In Progress. When all workpapers and documents linked to an 
account have been completed, reviewed and marked as approved the status icon on the account 
updates to indicate work on the account is Approved. Once approved, the Approved By and 
Approved Date fields within the header section of the workpaper are updated to reflect the action.

Related topics
Setting the status on a workpaper or document
Viewing the status of a workpaper or document
Viewing the audit trail
Opening workpapers
Adjustment journals
Opening an existing period

Setting the status on a workpaper or document

Each workpaper and document has a status associated with it. The status indicates the progress on 
completing, reviewing and approving the workpapers and documents for the workpapers period. 

When a workpaper or document requires review or approval, an approvals task can be assigned to 
the responsible staff member. When the approvals task is assigned, an email can be sent to the staff 
member notifying them that the workpaper or document requires review or approval. 

If you need to add additional comments to the approvals task after the status has been set, use the 
Current Status option. See “Viewing the status of a workpaper or document” on page 159.

To set the status on a selected workpaper or document

Note: Setting the status of a workpaper or document to Approved may require special permission. 
Task Permissions may have been configured which allow only certain staff members to 
perform this action.

Note: Setting a workpaper to Approved will make it read-only, and fields in the workpaper will not 
be editable.

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.
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2. Find the workpaper or document in the table.

3. Click the checkbox next to the workpaper or document.

4. Click the relevant status option on the Tasks bar.
The Approvals window opens. 

5. Set the Status information for the workpaper:

a. Select the status of the workpaper on the Status drop-down. 

b. Assign the approvals task to a staff member. 

Another staff member may be required to review or approve the workpaper.

 Click the ellipse button to find and select a new staff member.

The Find Employees window opens. 

 Enter the staff member’s name into the Search for text field and click Search. 

Alternatively, leave the search field blank and click Search to list all staff members. 

 Click the selected staff member that the workpaper will be assigned to. 

 Click OK.

c. Edit the subject as required.

d. Information regarding the approvals task can be entered into the Comment field. 

As the approvals task progresses additional information can be entered.

6. Set the Notification options for the approvals task:

a. Click the Send email checkbox to send an email to the responsible staff member to notify 
them that they have been assigned the approvals task. 

In the email, the approvals Subject field is displayed in the subject and the Comment field 
is displayed in the body. 

Note: An error will be displayed if the assigned person does not have an email address 
defined in the application.

b. Click the Edit email before sending checkbox to review the email before sending it to the 
assigned staff member. 

The email opens in the associated email program. The email can be reviewed and edited as 
necessary before clicking Send. 

7. Review the information in the Other section:

a. The staff member who is requesting the review or approval. 
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The Requested By field defaults to the currently logged in staff member. Click the ellipse 
button to find and select a new staff member.

b. Click the Priority drop-down to set the priority to Low, Medium or High.

c. The required completion date for the approvals task. 

The default entry for this field is the system date. Click the Due Date drop-down to select a 
new due date from the calendar.

8. Click Next to go to the History tab.
The History tab is displayed. 
The History tab shows a record of changes made to the approvals task. Information is 
automatically recorded in the table and cannot be altered. 
Click Export to Excel to export the information in the table to a Microsoft Excel spreadsheet.

9. Click Finish to save the status and assign the approvals task. 

Note: If you need to add additional comments to the approvals task after the status has 
been set, use the Current Status option. See “Viewing the status of a workpaper 
or document” on page 159.

To set the status on multiple workpapers or documents

Note: Setting a workpaper to Approved will make it read-only, and fields in the workpaper will not 
be editable.

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Find the workpapers or documents in the table.

3. Click the checkboxes of all the workpapers or documents. 

4. Click the relevant status option on the Tasks bar.
The Approvals window opens. 

5. Edit the approvals task as necessary. 

6. Set the Status information for the workpaper:

a. Select the status of the workpaper using the Status drop-down. 

b. Assign the approvals task to a staff member. 

Another staff member may be required to review or approve the workpaper.
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 Click the ellipse button to find and select a new staff member.

The Find Employees window opens. 

 Enter a staff member’s name into the Search for text field and click Search.

Alternatively, leave the search field blank and click Search to list all staff members. 

 Click the selected staff member that the workpaper will be assigned to. 

 Click OK.

c. Edit the subject as required.

d. Information regarding the approvals task can be entered into the Comment field. 

As the approvals task progresses additional information can be entered.

7. Set the Notification options for the approvals task:

a. Click the Send email checkbox to send an email to the responsible staff member to notify 
them that they have been assigned the approvals task. 

In the email the approvals Subject field is displayed in the subject and the Comment field 
is displayed in the body. 

Note: An error will be displayed if the assigned staff member does not have an email 
address defined in the application.

b. Click the Edit email before sending checkbox to review the email before sending it to the 
assigned staff member. 

The email opens in the associated email program. The email can be reviewed and edited as 
necessary before clicking Send. 

8. Review the information in the Other section:

a. The staff member who is requesting the review or approval.

The Requested By field defaults to the currently logged in staff member. Click the ellipse 
button to find and select a new staff member.

b. Click the Priority drop-down to set the priority to Low, Medium or High.

c. The required completion date for the approvals task. 

The default entry for this field is the system date. Click the Due Date drop-down to select a 
new due date from the calendar.

9. Click Next to go to the History tab.
The History tab is displayed. 
The History tab shows a record of changes made to the approvals task. Information is 
automatically recorded in the table and cannot be altered. 
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Click Export to Excel to export the information in the table to a Microsoft Excel spreadsheet.

10. Click Finish.
This will save the status and assign the approvals task. 

Note: If you need to add additional comments to the approvals task after the status has 
been set, use the Current Status option. 

11. Click Finish to save the approvals task. 

Related topics
Viewing the status of a workpaper or document
Viewing the audit trail
Opening workpapers
Adjustment journals
Opening an existing period

Viewing the status of a workpaper or document

Each workpaper and document can have a status associated with it. The status indicates the 
progress on completing, reviewing and approving the workpapers and documents for the 
workpapers period. 

The Status column in the Prepare Trial Balance (Workpapers) table indicates the progress on 
completing workpapers for each account. An icon in the Status column displays the current status 
for the account, workpaper or document. A legend at the bottom of the table displays each icon and 
its meaning. 

While work is progressing on workpapers and documents associated with an account, the status icon 
on the account indicates that work is In Progress. When all workpapers and documents linked to an 
account have been completed, reviewed and marked as approved the status icon on the account 
updates to indicate work on the account is Approved.

Use the Current Status option to view the current status of a selected workpaper or document. The 
Subject, Comment, Requested By, Priority and Due Date fields can be edited. 

To view the current status of a workpaper or document

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Find the workpaper or document in the table.

3. Click the checkbox next to the workpaper or document.
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4. Click Current status on the Tasks bar.
The Approvals window opens. 
View the status of the workpaper or document and the properties of the approvals task. See 
“Setting the status on a workpaper or document” on page 155.

5. If necessary, edit the Subject, Comment, Requested By, Priority and Due Date fields. 

6. Click Finish to save any changes made and close the window. 

Related topics
Setting the status on a workpaper or document
Viewing the audit trail
Opening workpapers
Adjustment journals
Posting journals and exporting new accounts
Opening an existing period

Viewing the audit trail

The Audit Trail displays a history of the actions performed on an account, workpaper or document. 
The Audit Trail lists the actions performed, the date and time on which the action was performed 
and the staff member who performed the action. This information can be exported to Microsoft 
Excel.

To view the audit trail for selected account or workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Find the account, workpaper or document in the table.

3. Click the checkbox next to the workpaper or document.

4. Click View audit trail on the Tasks bar.
The Audit Trail window opens. 

5. Sort the information, if required.

6. Click Export to Excel to export the audit records to a Microsoft Excel spreadsheet. 
The Save As window opens. 

a. Navigate to the location where the file is to be saved and enter a name for the file. 

b. Click the Save button to export and save the file.
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7. Click OK.
The Audit Trail window closes.

Related topics
Setting the status on a workpaper or document
Viewing the status of a workpaper or document
Opening workpapers
Adjustment journals
Opening an existing period
Posting journals and exporting new accounts

Posting journals and exporting new accounts

Workpapers are used to calculate and substantiate the balances within accounts. If balances 
calculated during workpaper preparation are different to the client’s balance, adjustment journals 
are added to correct the client’s balances. These journals must then be posted to the client’s 
company file. Any accounts added to the client’s ledger are also exported at this time.

When posting the journals and new accounts, the Include previously posted journals option can be 
used to post all journals including those that have been posted previously. This option can be used 
if a new company file has been copied to your system, that is, a company file which does not have 
the previously posted journals. 

If an Assets register is integrated with an underlying ledger, you can add Assets journal details as an 
unposted journal in the Workpapers trial balance table. The unposted journals appear in the 
Workpapers trial balance sheet. The journal can be viewed but not edited until you have posted the 
Assets journal.

If Client Accounting is integrated with an AccountRight ledger, select Post journals and accounts on 
the Tasks bar. 

If Client Accounting is integrated with a MAS, Accounts or AO Classic general ledger, select Create 
journal export file on the Tasks bar. You must then browse and select the location of the export 
journals file. 

To post the journals and accounts if you have an AccountRight general ledger

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Post journals and accounts on the Tasks bar.
The Confirm Posting Journals confirmation dialog is displayed.
The dialog confirms the location of the client’s company file on your system. The journals and 
new accounts will be exported and posted to this file. 
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Only journals which have not already been posted will be posted to the client’s general ledger. 

3. Click the Include previously posted journals checkbox to post all journals including those 
which have been posted previously. 
This option might be used if a new company file has been copied to your system. That is, a 
company file which does not have the previously posted journals. 

Note: Do not use the Include previously posted journals option if posting to the same 
client company file that has previously been posted to. This option will post 
journals which have been posted previously. If you post to the same company file 
twice, duplicate entries will be displayed in the client’s general ledger.

4. Click Yes. 
A Post Journals and New Accounts confirmation dialog is displayed confirming that the 
journals and new accounts were posted successfully.

5. Click OK.

To export journals for a MAS, Accounts or AO Classic general ledger

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Create journal export file on the Tasks bar.
The Export Journals window opens.

3. Enter the location of the Export Journal file.
or 

Click Browse to find the location.

4. Click OK.

To post journals to an AO Classic general ledger

Note: The Post option is only available for MYOB AO Classic v16.0.4 or later (Australia) / v16.0.2 or 
later (New Zealand).
If you are integrated with a MYOB AO Classic general ledger, the Employee Code must be the 
same in MYOB AE/AO as it is in MYOB AO Classic.

The Post option is only available if your financial data source is an AO Classic general ledger. The Post 
option will enable you to export the file to your local machine and post the results back to your AO 
Classic general ledger.

1. Open the workpapers period.
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See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Create journal export file on the Tasks bar.
The Export Journals window opens.

3. Enter the location of the Export Journal file.
or 
Click Browse to find the location.

4. Click Post.
The adjusted journals will be posted back to the general ledger for AO Classic and an export is 
created on your local machine.

To post the journals and accounts if you have an Essentials Accounting or Cashbook general ledger

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Post journals and accounts on the Tasks bar.
The Confirm Posting Journals confirmation dialog is displayed.
The dialog confirms the location of the client’s company file. The journals and new accounts 
will be exported and posted to this file. 
Only journals which have not already been posted will be posted to the client’s general ledger. 

Note: You will not be able to post a journal to the general ledger on or prior to a lock 
date.

3. Click Yes. 
A Post Journals and New Accounts confirmation dialog is displayed confirming that the 
journals and new accounts were posted successfully.

4. Click OK.

Related topics
Opening an existing period
Creating the PDF report
Completing the period
Managing, tracking and approving workpapers
Adding a new adjustment journal
Viewing the audit trail
Removing exported journals
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Removing exported journals

When you export journals from Workpapers to MAS or Accounts ledgers, Workpapers assumes that 
you have imported the resulting export file into the MAS or Accounts ledger. But if you do not import 
the export file into the MAS or Accounts ledger, and then import the latest client balances into 
Workpapers, Workpapers will incorrectly ignore the exported journal amounts when calculating it 
final balances. You must mark the journals as not exported in order for Workpapers to calculate the 
correct final balances.

This is not an issue if Client Accounting is integrated with AccountRight.

To mark journals as not exported

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click View all on the Tasks bar.
The Journals window opens.

3. Select the journals that have not been exported.
Ensure that the checkboxes are ticked.

4. Click Mark as not exported.
The selected journals are marked as not exported.

5. Click Close.
The Journals window closes.

Related topics
Opening an existing period
Creating the PDF report
Completing the period
Managing, tracking and approving workpapers
Adding a new adjustment journal
Viewing the audit trail
Posting journals and exporting new accounts

Creating the PDF report

The Create PDF option can be used to produce a PDF file which contains the reports, workpapers 
and linked documents from the workpaper period for the client. The PDF report can be printed for 
review or saved to your own system as a record. 
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Associated reports, workpapers and linked documents of the workpaper period are grouped under 
the relevant headings in the Create PDF window. By default all are selected. 

The Linked Documents section includes a list of all unique external files (and the directory path) and 
Document Manager files that have been linked to the actual workpaper or to the period. The 
following document types are supported when creating a PDF report:

 Adobe Acrobat (.pdf) up to 100 MB

 Microsoft Excel (.xls or .xlsx) up to 40 MB

 Microsoft Outlook (.msg)

 Microsoft Word (.doc or .docx) up to 40 MB.

Attempting to link documents that exceed the size limits may result in poor system performance.

If a Microsoft Excel file is included, the print area must be previously defined within the document. 
If no print area is set then the Excel file is used as it is. All sheets within a workbook will be included 
as part of the whole document.

Note: Unsupported document types (e.g., .txt) will be listed on the Create PDF window, but will not 
be included as part of the PDF report.

A document is only added once to the Linked Document list if:

 The same document has been linked to multiple workpapers.

 Different bookmarked sections of the same document have been linked to multiple 
workpapers or to the one workpaper.

 The same document is referenced with different workpaper names.

 The same document is located in only one location.

If the same document is stored in different locations and referenced from each of these locations, 
then two documents will be displayed in the Linked Document list.

If a document link is broken (i.e., by renaming the document or moving it to a different location), the 
document is included in the Linked Document list but an error message will be displayed. You must 
re-link the document.

Note: If you were using Document Manager and have since decided not to use Document Manager 
any more, then you will not be able to print any linked Document Manager files as Document 
Manager will not be available to extract the documents from the database.

To create the PDF report

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Create PDF on the Tasks bar.
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The Create PDF window opens. 
By default, all Reports, Workpapers and Linked Documents are selected.

Note: Attempting to attach several very large files may result in slow system 
performance on older workstations.

3. In the bottom left corner of the window, select one of the following:

 Default printing order prints reports in one section, and documents and workpapers (with 
attached documents, if present) in another section, in the order they were added to the 
workpaper.

Note: If a document is attached more than once, it will only be printed for the first 
account code it is attached to.

 Print linked documents separately prints the PDF with reports, workpapers, and linked 
documents in separate sections. 

4. Deselect the checkboxes of the reports, workpapers and linked documents that will not be 
included in the PDF report.

5. Click Preview. 
The Preparing documents progress bar is displayed. The time taken to create the PDF report 
will vary depending on the number of reports, workpapers and documents selected for 
inclusion.

Note: A PDF preview of the report is created. A PDF viewer must be installed for the 
report to be created. If a PDF viewer is not installed, an error is displayed.

The PDF report is created as Workpapers - client name - workpaper period.pdf and opens in 
the PDF viewer.
The report can be saved or printed as necessary.

6. Close the PDF report.

To import the PDF report into Document Manager

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Create PDF on the Tasks bar.
The Create PDF window opens. 
By default, all Reports, Workpapers and Linked Documents are selected.
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Note: Attempting to attach several very large files may result in slow system 
performance on older workstations.

3. In the bottom left corner of the window, select one of the following:

 Default printing order prints reports in one section, and documents and workpapers (with 
attached documents, if present) in another section, in the order they were added to the 
workpaper.

Note: If a document is attached more than once, it will only be printed for the first 
account code it is attached to.

 Print linked documents separately prints the PDF with reports, workpapers, and linked 
documents in separate sections. 

4. Deselect the checkboxes of the reports, workpapers and linked documents that will not be 
included in the PDF report. 

5. Click Share It.

Note: The Share It button is only available if Document Manager is installed. If 
Document Manager is not installed, then the Share It... button is disabled.

The Create Document wizard opens. 

6. On the Details tab review and edit the information as required:

a. The contact associated with the workpapers period is automatically selected. 

b. The title defaults to the Workpapers File and includes the client name and workpaper 
period dates.

The title can be edited as required. 

c. The username of the currently logged in staff member. 

Click the ellipse button to change the author. 

d. The Status drop-down defaults to a status of Complete.

e. The type of document being imported into Document Manager.

The Document Type drop-down defaults to a PDF document type.

f. The Date Created drop-down defaults to the system date. 

Click the drop-down to select a new date from a calendar. 
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g. The Outbound option is used if the document is being sent from the accountant and the 
Inbound option is used if it has been received. 

7. Click Next.
The Profiling tab is opened.

8. On the Profiling tab review and edit the information as required:

a. Select a Filing Cabinet in which to store the new document.

b. If the selected Filing Cabinet has assignments, select an assignment from the drop-down. 

If the selected Filing Cabinet does not have assignments the Assignment field will be 
inactive. 

c. Click  to select Category fields for the PDF report. 

d. Enter the Value for each category. 

9. Click Finish.
The Create Document wizard is closed and the PDF report is imported into Document 
Manager.

See the Document Manager Help for more information on importing files.

Related topics
Setting the status on a workpaper or document
Viewing the status of a workpaper or document
Opening workpapers
Opening an existing period
Completing the period
Managing, tracking and approving workpapers
Adding a new adjustment journal
Viewing the audit trail

Completing the period

When you have reviewed, approved and completed the workpaper preparation and posted the 
journals and new accounts to the client’s company file, the workpaper period can be marked as 
complete. 

Once the workpapers period is marked as complete, information within the period cannot be added 
or edited. Information in the period can only be viewed, opened and reports printed. 

../Document_Manager/Importing.htm
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Note: This process cannot be reversed. Ensure that the workpapers period has been reviewed, 
approved and finalised.

To complete the period

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click Complete the period on the Tasks bar.

Note: Journals and new accounts must be posted before completing the period. The 
Complete the Period option is disabled if journals and new accounts have not 
been posted.

The Confirm Complete the period dialog opens. 

3. Click Yes to complete the period. Click No to cancel. 
If there are outstanding To Do items for the workpapers period, a warning is displayed. Click 
Yes to complete the period with outstanding To Do items. Click No to cancel. 
If there are unapproved workpapers for the workpapers period a warning is displayed. Click 
Yes to complete the period with unapproved workpapers. Click No to cancel. 

4. The workpapers period is marked as complete. 
On the Client page > Client Accounting > Trial Balance (Workpapers) tab, the status of selected 
period updates to indicate that the preparation of workpapers has been finalised.
When a finalised period is opened a warning is displayed indicating that the period has been 
completed. Click OK to open the period with limited access. 

Related topics
Opening an existing period
Posting journals and exporting new accounts
Creating the PDF report
Printing reports and workpapers
(Australia) Exporting Ledger Data to Tax

Printing reports and workpapers

Reports and the workpapers associated with the workpapers job can be printed using the Print 
button located at the top of the Tasks bar. 



AE, AU, NZ PM Client Accounting User Guide | 170

A copy of workpapers attached to the Workpapers period can also be printed. These are listed under 
Prepare Workpaper (Documents) in the Print window. Source documents which are linked to a 
workpapers period cannot be printed. To print source documents, open the source document and 
use the Print option from within the document.

The following can be printed from the Print window:

 Adjusted Trial Balance report — contains information which is displayed in the Prepare Trial 
Balance (Workpapers) table. It lists the closing balances for header and detail accounts for the 
period and the adjusted balance after the balances have been calculated and substantiated.

 Journal Listing report — contains information about the adjustment journals added during 
workpaper preparation. At the top of the report the client name and period date range are 
specified. A table details the journal date and note, the balancing amounts and the account 
codes and names. Debits and credits are shown as Gross amounts, and GST is shown in a 
separate column.

 Accounts Added in Prepare Workpapers report — contains information about the accounts 
added during workpaper preparation. At the top of the report the client name and period date 
range are specified. A table lists the account codes and account names of accounts added 
during the workpaper preparation. 

 List of Document Manager Files report — if Document Manager is installed, Document 
Manager files which substantiate calculations can be linked to accounts in the period. This 
report lists the names of all the Document Manager files which have been linked to the 
accounts in the period. 

 List of External Files report — if Document Manager is not installed, external files which 
substantiate calculations can be linked to accounts in the period. This report lists the names of 
all the external files which have been linked to the accounts in the period. 

 Prepare Workpaper (Documents) — under Prepare Workpapers (Documents) in the Print 
window, a list is displayed of all workpapers attached to accounts in the period.

When the report prints, a footer is automatically included which displays the page number. 

To preview reports and workpapers

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click  on the Tasks bar.
The Print window opens.

3. Click the checkboxes of the reports and / or workpapers to be printed. 
Click the checkbox in the column heading to select or deselect all the reports and documents.

4. Click Preview.
The Print Preview window opens. 
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The title bar of the window indicates the client and period for which the reports have been 
generated. 

To print reports and workpapers

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click  on the Tasks bar.
The Print window opens.

3. Click the checkboxes of the reports and / or workpapers to be printed. 
Click the checkbox in the column heading to select or deselect all the reports and documents.

4. Click Print.

5. Select the printer and edit the printing preferences as necessary. 

6. Click OK.

Related topics
Opening an existing period
Completing the period
To Do items
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To Do items
To Do items enables tracking and managing the workpapers tasks that are being worked on. 

The To Do table lists:

 Subject — a short description of the To Do item. It is important to use a meaningful subject 
when creating a To Do item as it will be used to identify the To Do item in the future.

 Employee — the staff member to which the To Do item is currently assigned.

 Priority — the priority level of the To Do item. The priority can be set to High, Medium or Low. 

 Due Date — the date on which the To Do item is required to be completed.

 Status — the current status of the To Do item. The status can be Not started, Planned, In 
progress, Complete, Risk and Problem. Use the status to indicate progress on the To Do item to 
other staff members.

Workpaper To Do items can be accessed from a number of windows or tabs:

Workpapers homepage

The Workpapers homepage is opened by clicking the Workpapers icon on the Tool bar and provides 
the summary of all your In Progress Workpapers. This summarises what work you have for your 
clients currently. 

The Workpapers homepage provides easy Access to the Trial Balance (Workpapers) tab for each 
client represented is provided by hyperlinks. See “Workpapers homepage” on page 39.

To Do Workpaper window

A list of all To Do items associated with a selected period can be viewed using the To Do item option 
in the Trial Balance (Workpapers) window on the Tasks bar. To access the workpapers job, open the 
period. See “Opening an existing period” on page 53 for more information on opening the period.

The title bar of the To Do Workpaper window displays the start and end date of the current 
workpaper period. 

To open a To Do item:

1. Find the To Do item in the table.

2. Double-click the To Do item. 
The To Do window opens.
See “Opening and editing a To Do item” on page 176.

Workpaper window

A list of all To Do items associated with a selected workpaper document can be viewed at the top of 
the Workpaper window. First open the workpaper document. See “Viewing a list of all workpapers 
and source documents” on page 104 for more information on opening the workpaper document.

If there are To Do items associated with the workpaper they are displayed in a table at the top of the 
Workpaper window. By default the table is hidden, click  to show the table. Click  to collapse 
and hide the table.
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Use the column headings to sort the rows in the table alphabetically or numerically using the values 
in the selected column. Click the column heading once to sort in ascending order. Click the column 
heading again to sort in descending order.

To open a To Do item:

1. Find the To Do item in the table.

2. Double-click the To Do item. 
The To Do window opens.
See “Opening and editing a To Do item” on page 176.

Trial Balance (Workpapers) tab

The To Do items which have been created for workpapers or workpaper periods for a selected client 
are listed in the To Do table on the client’s Client Accounting > Trial Balance (Workpapers) tab. See 
“Accessing workpapers” on page 46.

Use the column headings to sort the rows in the table alphabetically or numerically using the values 
in the selected column. Click the column heading once to sort in ascending order. Click the column 
heading again to sort in descending order.

To open a To Do item:

1. Find the To Do item in the table.

2. Double-click the To Do item. 
The To Do window opens.
See “Opening and editing a To Do item” on page 176.

To Do tab (AE)

All the To Do items, including workpaper To Do items, for a selected client are listed in the To Do 
table on the client’s To Do tab. 

To open a To Do item:

1. Search for the client.

2. Select the client.

3. Navigate to Client page > To Do tab. 

4. Click the link in the Subject column to open the To Do item for the workpaper period.

My Homepage (AE)

Workpaper To Do items can be accessed from a customised Homepage for To Do items if this has 
been created. @@
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Note: Alternatively, a Workpapers homepage is provided as a standard feature of Workpapers. See 
“Workpapers homepage” on page 39.

To open a To Do item:

1. Navigate to the Homepage tab.

2. Click the To Do homepage link on the Tasks bar.

Related topics
Workpaper window
Working with To Do items
Opening and editing a To Do item
Printing To Do items

Working with To Do items

To Do items enables progress tracking and management of workpapers tasks. To Do items can be 
created for a workpaper period or for an individual workpaper. 

To add a To Do item to a period

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click To Do item on the Tasks bar.
The To Do Workpaper window opens. 

3. Click Add.
The To Do window opens. 
The properties of the To Do item are displayed on three tabs.

4. Enter the details of the To Do item on the Main tab.

5. Click Next. 
The History tab is displayed. 
The History tab shows a record of task assignments. Information is automatically recorded in 
the table and cannot be altered. 

6. Click Next.
The Notes tab is displayed. 
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The Notes tab lists all the notes which have been added for the To Do item. The information on 
the Notes tab cannot be altered.

Note: New notes are entered on the Main tab (see Step 2. above).

The table lists the Date each note was entered and the Title of each note. Click the note in the 
table to view the contents of the note in the text area. 

7. Click Finish.
To save and complete the To Do item.

To add a To Do item to a workpaper

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select and open a workpaper in the table.
The selected workpaper window opens.

3. Click New To Do on the toolbar.
The To Do window opens. 
The properties of the To Do item are displayed on three tabs.

4. Enter the details of the To Do item on the Main tab.

5. Click Next. 
The History tab is displayed. 
The History tab shows a record of task assignments. Information is automatically recorded in 
the table and cannot be altered. 

6. Click Next.
The Notes tab is displayed. 
The Notes tab lists all the notes which have been added for the To Do item. The information on 
the Notes tab cannot be altered.

Note: New notes are entered on the Main tab.

The table lists the Date each note was entered and the Title of each note. Click the note in the 
table to view the contents of the note in the text area. 

7. Click Finish.
To save and complete the To Do item.
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Related topics
Opening and editing a To Do item
Printing To Do items
Working with To Do items
To Do items

Opening and editing a To Do item

To Do items can be opened and edited from a variety of windows. See “To Do items” on page 172. 
This section focuses on opening and editing To Do items from the To Do Workpaper window and the 
Workpaper window.

To open and edit a To Do item from the To Do Workpaper window

A list of workpaper To Do items associated with a selected client can be viewed using the To Do item 
option on the Tasks bar under Prepare Trial Balance (Workpapers). 

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Click To Do item on the Tasks bar.
The To Do Workpaper window opens. 

3. Edit any fields on the Main tab in the To Do window.

4. Click Finish.
This saves the changes to the To Do item. 

To open and edit a To Do item from the Trial Balance (Workpapers) window

1. Open the workpapers period.
See “Opening an existing period” on page 53.
The Prepare Trial Balance (Workpapers) table is displayed.

2. Select and open the workpaper in the table.
The workpaper opens in a new window. A list of all To Do items associated with a selected 
workpaper document can be viewed at the top of the Workpaper window. By default the table 
is hidden. 

3. Click  to show the table. 

4. Find the To Do item. 

5. Double-click to open the To Do Item.
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The To Do window opens. 

6. Edit any fields on the Main tab in the To Do window.

7. Click Finish.
This saves the changes to the To do item. 

Related topics
To Do items
Printing To Do items
Working with To Do items
Opening an existing period

Printing To Do items

From the To Do window, all the information that has been recorded for the To Do item can be 
previewed and printed. The history of the To Do item can also be printed. 

To print a selected To Do item

1. Find the To Do item.
See “Opening and editing a To Do item” (see page 176).

2. Double-click to open the To Do item. 
The To Do window opens.

3. Click Print.
The Print options window opens.

4. Click the History checkbox. 
The print out will include a list of the task assignments for the To Do item. 

5. Click the Notes History checkbox. 
The print out will include all the notes that have been entered for the To Do item. 

6. Click Print or Print Preview.

a. Click Print to print the To Do item. 

Select the printer and click OK to send the To Do item to the printer.

b. Click Print Preview to view the output on-screen before sending it to a printer. 

Click the Printer icon to print the To Do item. The To Do item will be sent to your default 
printer.
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Other options at the top of the window enable you to:

 Zoom — click the Zoom option to zoom in or out for a better view.

     Page views — click to view one, two, three, four or six pages.

7. Click Finish.
The To Do item closes.

Related topics
To Do items
Opening and editing a To Do item
Working with To Do items
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Ledgers
You can use the Ledger options in the Tasks bar of the Trial Balance (Workpapers) tab to:

 Edit Configuration Details – see “See “Migrating an existing ledger” on page 214 for an 
overview of the steps to take when migrating.” on page 22

 Perform Opening Review – see “Perform an opening review” on page 184 (only available if an 
AccountRight ledger is configured as the financial data source for a client)

 Modify Prior Year Balances – see “Modify prior year balances” on page 194 (only available if an 
AccountRight ledger is configured as the financial data source for a client)

 Launch ledger – see “Launching a ledger” on page 179

 Create new AE/AO Ledger – see “Creating and viewing your client’s AE/AO ledger” on page 181

 Define Income Allocation – see “Defining income allocation” on page 197

 View AE/AO ledgers – see “Creating and viewing your client’s AE/AO ledger” on page 181

 Delete AE/AO ledger – see “Deleting a ledger” on page 198.

 Remove Configuration Detail – see “Removing Configuration Details from a ledger” on 
page 198.

Related topics
Launching a ledger
Creating and viewing your client’s AE/AO ledger
Perform an opening review
Modify prior year balances
Defining income allocation
Deleting a ledger

Launching a ledger

You are able to open the general ledger application that you have integrated with Client 
Accounting. You can then make changes to the general ledger whilst accessing the information in 
Client Accounting.

To open the general ledger application

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Launch ledger on the Tasks bar.
The Launch ledger option could be any one of:

 Launch AccountRight

 (Australia) Launch Accounts
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 Launch AE/AO Ledger

 (AO) Launch AO GL

 Launch Essentials

 Launch Cashbook

 Launch MAS.
The specific general ledger application opens.

If you have a MYOB AO Classic general ledger

 If you are integrated with a MYOB AO Classic general ledger, the Employee Code must be the 
same in MYOB AE/AO as it is in MYOB AO Classic.

 In order to be able to launch MYOB AO Classic from Client Accounting, you must have MYOB 
AO Classic v16.0.4 or later (Australia) / v16.0.2 or later (New Zealand) installed.

If you have an Essentials Accounting general ledger

If you have selected an Essentials Accounting file as the client’s financial data source, then launching 
Essentials Accounting from Client Accounting will open a browser window where you will be 
prompted to login using your MYOB Login.

You can save your username and/or password to streamline this process.

If you have an Essentials Cashbook general ledger

If you have selected an Essentials Cashbook file as the client’s financial data source, then launching 
Essentials Cashbook from Client Accounting will open a browser window where you will be 
prompted to login using your MYOB Login.

You can save your username and/or password to streamline this process.

Related topics
Trial Balance (Workpapers) tab
Assets tab
Reports tab
See “Migrating an existing ledger” on page 214 for an overview of the steps to take when migrating.
Creating and viewing your client’s AE/AO ledger
Perform an opening review
Modify prior year balances
Workpapers
Statutory Reporter
Assets
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Creating and viewing your client’s AE/AO ledger

Note: This feature is not enabled for all users. If this option isn’t available in the Tasks bar, please 
contact your client manager to enable this feature for your practice.

You can configure an AE/AO ledger as a client’s financial data source.

To create an AE/AO ledger for your client

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Create new AE/AO Ledger on the Tasks bar. The Create Ledger window is displayed.

3. Enter the Ledger name.

4. Select the Chart template by clicking the Browse button in this field, and searching for your 
ledger template file. The Client Accounting Templates Folder is shown by default.

 MYOB Standard Charts contains the predefined charts in CSV format for AOGL, Accounts, 
and MAS products and entity types. (In New Zealand, these are separated into farming and 
non-farming templates.) Files in this folder will always be overwritten and updated after a 
software update.

 Practice Charts can be used to store your practice’s own custom charts in CSV format. Files 
here will not be modified by the update process. See To create a Practice Chart for more 
information on creating this chart.

5. Select the Entity Type and Chart Type.

 If you have selected an MYOB Standard Chart, the Entity Type and Chart Type fields will be 
automatically filled in.

 If you have selected a Practice Chart, and your CSV file name is different to the MYOB 
naming convention, you may need to manually enter these fields. See To create a Practice 
Chart for more information.

6. Enter the Financial year end date.

Note: The opening balance date and financial start month are automatically calculated 
from the financial year end date.

7. Review the values in System Account Mapping, and modify any values if required. The mapped 
Account code values displayed here vary depending on the Entity and Chart Type.
If you have selected an MYOB Standard Chart, the values displayed here are defined by MYOB.
Any account codes that are present in the System Account Mapping, if also present in the CSV 
file, will be created as System Accounts.
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8. Click OK.
This configures the ledger. The ledger accounts are displayed in the Client Accounting > Trial 
Balance tab (called the Workpapers tab if you are licensed for Workpapers).

To create a Practice Chart

Note: When creating a Practice Chart CSV template, maintain the file format, structure, and 
column order. Headers should always be in the first row of the CSV file.
When reviewing the CSV file, we recommend opening the file using Notepad or similar text 
editing software. Opening CSV files in Excel may result in trailing zeros being removed from 
Account codes with decimal places.
Ensure System accounts specified in the table are in the practice chart so that the 
appropriate account type group is set. This can also be set manually using Manage Accounts 
— see Managing accounts for AE/AO ledger.

1. A chart template (Chart_Template.csv) can be found in Deploy/Client Accounting Templates/
MYOB Standard Templates. Open this template in Excel.

2. In the template, fill in the following values:

Column name Description

AccountCode If this value is not present, the record is ignored 
when creating charts.

AccountName Name of the account code. This field is optional. If 
this field is left blank, the value “*** unknown 
account ***” is used.

AccountType Defines the type of Account. Valid values are:

 Income

 Other Income

 Liabilities

 Equity

 Expense

 Other Expense

 Assets

 Cost of Sales

 Uncategorised.

If the value is not valid or no value is entered, the 
default value of “Uncategorised” is used.
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3. Save the CSV file using the following naming convention:

 MAS_<entity type> for MAS chart types

 (Australia) ACCOUNTS_<entity type> for Accounts chart types

 AOGL_<entity type> for AOGL chart types
where <entity type> is Individual, Partnership, or Company.

Note: You may choose to follow a different naming convention. However, you will be 
required to manually enter the Entity Type and Chart Type when creating a new 
AE/AO ledger.

AccountTypeGrou
p

If the Account Code is a Control Group, enter “Yes” as 
the value. For Child Accounts, enter the Account 
Code value associated with the Control Group to link 
them with the Account Type Group / Control 
Account. This field is optional.

TaxCode Contains the tax code. The valid code values (and 
their definitions) are:

 NA (No tax implied)

 (Australia) CAP (Capital acquisitions)

 (Australia) EXP (Export sales)

 (Australia) FRE (GST free)

 GST (Goods & Services Tax)

 (New Zealand) E (Exempt)

 (Australia) GNR (Not registered)

 (Australia) INP (Input taxed purchases)

 (Australia) ITS (Input taxed sales)

 NTR (Not reportable).(New Zealand) Z (Zero rate)

(New Zealand) I (GST on imported supplies).If no value 
is entered, the default value of NA is used.

Column name Description
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To view your client’s ledger

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click View AE Ledgers/View AO Ledgers on the Tasks bar.
The Select Company File window opens listing all the active (in bold) and suspended (greyed 
out) Essentials Accounting, Cashbook and/or Ledger files.
By default, if the client code of the ledger corresponds to the client code of MYOB AE/AO, then 
the ledger file is selected.
If there is no ledger displaying with the same client code, then the most recently created ledger 
file is selected.
You can also select any other ledger file if required.

3. Click Select file to view the ledger.

Related topics
Trial Balance (Workpapers) tab
Assets tab
Reports tab
Launching a ledger
See “Migrating an existing ledger” on page 214 for an overview of the steps to take when migrating.
Configuring an Essentials general ledger as the data source
Modify prior year balances
Workpapers
Statutory Reporter
Assets

Perform an opening review

The Perform Opening Review feature compares the account balances from the current general 
ledger product with the corresponding account balances in the client's AccountRight or Essentials 
Accounting ledger. Where there are differences between the two, the Perform Opening Review 
feature posts journals to the ledger in order to align it with the general ledger product. The updated 
ledger can then be used as the general ledger for the client.

Note: The Perform Opening Review feature is only available if an AccountRight ledger or Essentials 
Accounting ledger is configured as the financial data source for a client.

Related topics
Accessing the Opening Review Wizard
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Using the Opening Review Wizard

Accessing the Opening Review Wizard

To access the Opening Review Wizard, an AccountRight ledger or Essentials Accounting ledger must 
be configured as the financial data source for the client.

Accessing the Open Review Wizard for unconfigured client data

1. Configure the client. 
See “Configuring the client” on page 23 and “Configuring accounting product locations” on 
page 37.

2. Click OK.
A prompt is displayed requesting if you want to perform an opening review. 

3. Click Yes.
The Opening Review Wizard opens.

Accessing the Open Review Wizard for configured client data

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Perform Opening Review on the Tasks bar.
The Opening Review Wizard opens.

Related topics
Configuring the client
Using the Opening Review Wizard

Using the Opening Review Wizard

Three steps are involved in using the Opening Review Wizard:

 “Select the general ledger product” (see page 185)

 “Mapping accounts” (see page 187)

 “Confirming the opening review” (see page 192).

Select the general ledger product

1. Access the Opening Review Wizard.
See “Accessing the Opening Review Wizard” on page 185.
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The Select General Ledger Product window opens.

2. Select the general ledger product that is used for this client.

3. A ledger is automatically selected if a match is determined between the client ledger code and 
the client code in MYOB AE/AO.
Another ledger can be selected if the default selection is not the correct ledger.

Note: A warning message is displayed if there is a period discrepancy between the 
AccountRight file and the selected ledger. This must be corrected before 
proceeding.

a. Search for a new ledger by clicking the ellipses (...) button. The Select Ledger window 
appears.

b. Enter the ledger Code or Name on the Search field.

The list of ledgers in the table filters as information is entered to show those ledgers which 
correspond to the search criteria. 

c. Click  to clear the search.

d. Select the appropriate ledger in the table.

e. Click OK.

If you would like to import a CSV file (not available for Essentials Accounting):

a. Ensure the correct option is selected in Select General Ledger Product.

b. Select the CSV file that contains the accountant’s balances.

c. The Select File window opens.

d. Click the ellipse button at the end of the File to import field.

e. The Select File to Import window opens.

f. Navigate to the location where the CSV text file is stored.

g. Click Open.

Note: The CSV text file must adhere to a specific format. See “Format of CSV text file” on 
page 193.

The File to import field updates to show the path and filename of the selected CSV file. Ensure 
that the correct file is selected. 

4. Select the balances that are to be used for comparison:
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 Closing balances for the previous year

This option compares all accounts and updates balances for both the previous year and 
the current year.

 Closing balances for the current year

This option compares all accounts and updates balances for the current year only.

5. Click Next.
Proceed to “Mapping accounts” (see page 187).
or
Click Save as Draft.
This saves the ledger as a draft and closes the Opening Review Wizard.

Related topics
Mapping accounts
Confirming the opening review

Mapping accounts

The Map Accounts window enables selection of the account(s) on the AccountRight or Essentials 
Accounting chart that correspond to each account on the accountant's chart. These mappings are 
then used to compare the corresponding account balances between the two charts. Adjustments 
can be made to the AccountRight or Essentials Accounting accounts, where required, in order to 
align the balances with the equivalent accountant's accounts.

Map Accounts window options

Option Description

First column The accountant’s balance table displays the current 
mapped status of the account.

Add account Adds an account to the client’s chart of accounts.

Print Creates an Opening Review Mapping report in a text 
file. The report displays the Client Name, Client Code, 
the Opening Review details and the information in 
the Map Accounts table.

Clear all mappings Clears all mappings including automatic system 
mappings and any manual mappings made by you. A 
confirmation window is displayed requesting 
confirmation to clear the mappings. Click Yes.
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Searching for an account on the accountant’s chart

1. Type a value on the Search field. 
The list of accounts in the table filters as you type to show those accounts that contain the 
specified search criteria in any of the displayed columns. 

2. Click  to clear the search.

Including zero balances

1. Select Include zero balances.
All accounts are displayed, including those with zero balances.

Viewing and editing automatic mappings

The system maps some accountant's accounts automatically, including those that have exactly the 
same balance as an account on the client's chart, where no other accounts exist with the same 

balance. These mappings are displayed on the Map Accounts window with a  icon in the left 
hand column.

To edit the automatic mapping in the Map Accounts window:

1. Click the drop-down arrow in the Map to column. 
This lists the client’s chart of accounts.

2. Select the View suggested accounts option at the bottom of the list.
This enables viewing of a list of suggested mappings.

3. Select the View all accounts option to return to the full list of accounts.

4. Ensure that the Show unmapped accounts only checkbox is selected.

Restore default mappings Clears any changes made to the mappings and 
restores the account mappings to its original state. 
Any changes made will be lost. A confirmation 
window is displayed requesting confirmation to 
restore the default mappings. Click Yes.

Split Maps an accountant’s account to two or more client 
accounts. See “Mapping across multiple accounts” on 
page 189.

Show Client Balances Displays the client’s chart of accounts in a separate is 
to the right of the accountant’s chart of accounts.

Hide Client Balances Hides the client’s chart of accounts.

Option Description
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This hides those client accounts that have already been mapped.

5. Clear Include zero balances if it is selected to hide accounts with zero balances.

6. Select an account from the list.
Double-click on the account or highlight it and click Select.

Viewing and editing suggested mappings

The system suggests mappings for some accountant's accounts. These suggestions are based on the 
descriptions and balances of the accounts on the client's chart. Accountant's accounts, for which 

suggested mappings exist, are displayed on the Map Accounts window with a  icon in the left 
hand column.

To view the list of suggestions for an account in the Map Accounts window:

1. Click the drop-down arrow in the Map to column. 
This lists suggested accounts from the client's chart, with the most likely match listed first.

2. Select the View all accounts option at the bottom of the list.
This enables viewing of all accounts on the client's chart.

3. Select the View suggested accounts option.
This returns to the list of suggested mappings.

4. Ensure that the Show unmapped accounts only checkbox is cleared.
This displays all accounts, regardless of whether or not they have already been mapped.

5. Clear the Include zero balances checkbox, if it is selected, to hide accounts with zero balances.

6. Select an account from the list.
Double-click on the account or highlight it and click Select.

Mapping across multiple accounts

To map one accountant's account to two or more client accounts:

1. Open the Split Account window.
There are a number of ways to do this:

 Click Split located at the bottom of the Map Accounts window.

 Click Split located at the bottom of the Map to drop-down.

 Highlight two or more accounts on the Map to drop-down, then click Select.
The Split Account window enables you to select the client accounts to which you want to map 
the selected accountant's account.

2. Select all of the required client accounts.
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The Variance total at the bottom of the window displays the difference between the 
accountant's account balance and the sum of the client account balances.

3. The Journal amount field is used to distribute the variance across the selected client accounts. 
The value entered into the Journal amount field for each client account represents the amount 
that will be posted to that account upon completion of the Opening Review Wizard. The sum of 
the values in the Journal amount fields must equal the total Variance.

To map two or more accountant’s accounts to one client account:

1. Select the client account in the Map to column for the first accountant’s account.

2. Select the same client in the Map to column for the second accountant’s account.
It may be necessary to clear the Show unmapped accounts only checkbox in order to find the 
client account in the drop-down list.
A confirmation message is displayed stating that the selected client account has already been 
mapped to another accountant’s account.

3. Click the Keep existing mappings button.
This maps the client account to both accountant’s accounts.
For the first mapping, the Variance column displays the difference between the client’s 
account balance and the sum of the balances of all accountant’s accounts to which the client 
account has been mapped.
For the second and subsequent mappings, the Balance and Variance columns display a 
difference to the first mapping.

Mapping other accounts

Accountants accounts for which no automatic or suggested mappings exist are displayed in the Map 

Accounts window with an  icon in the left hand column. 

To map an unmapped account:

1. Click the drop-down arrow in the Map to column. 
This displays the client chart of accounts.

2. Ensure that the Show unmapped accounts only checkbox is selected.
This hides those client accounts that have already been mapped.

3. Clear the Include zero balances checkbox, if it is selected, to hide accounts with zero balances.

4. Select an account from the list.
Double-click on the account or highlight it and click Select.

Viewing the client chart of accounts

To display the client's chart of accounts in a separate list:
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1. Click Show Client Balances.
This is located at the bottom of the Map Accounts window.
The client’s chart of accounts is displayed in a separate list to the right of the accountant’s 
chart.

To search for an account on the client's chart:

1. Type a value in the Search field. 
The list of accounts in the table filters as you type to show those accounts that contain the 
specified search criteria in any of the displayed columns. 

2. Click  to clear the search.

3. Ensure that the Show unmapped accounts only checkbox is selected.
This hides those client accounts that have already been mapped.

4. Ensure that the Include zero balances checkbox is selected.
This displays all accounts on the client chart, including those with zero balances.

Adding a new client account

To add a new account to the client chart of accounts:

1. Click Add client account or Add account.
The Add Account window opens.

2. Specify the Account Classification, Account Code and Account Name of the new account.

3. Click OK.

Another way of adding a new account:

1. Type an account code or account that does not already exist.
This can be done either in the Map to field of the Map Accounts window or the Code field of 
the Split Account window.
The Opening Review Wizard account name window opens.

2. Specify the Account Name.
This Account Name defaults to the name of the selected accountant's account. 

3. Click Yes.

To edit an existing client account name on the client’s Chart of Accounts:

1. Type a new value in the Client account name field on the Map Accounts window.

Other features of mapping accounts

To clear a single mapping:
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1. Click the Map to field for the specific entry.

2. Delete the contents.

3. Press [Enter] to clear all mappings:

1. Click Clear all mappings.
This is located at the bottom of the Map Accounts window.

To restore the default mappings for all accounts:

1. Click Restore default mappings.
This is located at the bottom of the Map Accounts window.

Completing Map Accounts

To proceed to the Confirmation stage:

1. Click Next.
or
Click Save as Draft.
The Opening Review Wizard closes and you are returned to the Trial Balance (Workpapers) 
tab.
A message is displayed informing you that the opening review process has not been completed 
for the particular client.
To return to the Opening Review Wizard click Resume Opening Review on the Trial Balance 
(Workpapers) tab or Perform Opening Review on the Trial Balance (Workpapers) tab Tasks 
bar.

Related topics
Viewing and editing automatic mappings
Viewing and editing suggested mappings
Mapping across multiple accounts
Mapping other accounts
Viewing the client chart of accounts
Adding a new client account
Other features of mapping accounts

Confirming the opening review

The Confirmation window lists the journal entries that will be posted in the current year of the 
ledger upon completion of the wizard. The Perform Opening Review cannot be completed unless 
these journals balance to zero.

If the closing balances for the previous year option was chosen on the first page of the Opening 
Review Wizard, the system will also adjust the comparative balances for the previous year. It will not 
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update the AccountRight file or Essentials Accounting ledger with these adjustments. The modified 
balances are stored separately for use by the Client Accounting products only.

To complete the opening review

1. Click View modified closing balances.
To view a list of the modified closing balances.

2. Click Finish.
This completes the wizard, posts all journals and updates prior year balances.
or
Click Save as Draft.
The Opening Review Wizard closes and you are returned to the Trial Balance (Workpapers) 
tab.
A message is displayed informing you that the opening review process has not been completed 
for the particular client.

Resuming an opening review

If the Opening Review is saved as a draft, a message is displayed at the top of the Trial Balance 
(Workpapers) tab: The opening review has not been completed for this client.

To return to the Opening Review Wizard:

1. Click Resume Opening Review on the Trial Balance (Workpapers) tab.
or 
Click Perform Opening Review on the Tasks bar.

Related topics
Format of CSV text file
Select the general ledger product
Mapping accounts
Modify prior year balances

Format of CSV text file

Note: This is not supported in Essentials Accounting.

When importing the accountant’s balances into Perform Opening Review, balances from a CSV text 
file can be imported which have been previously exported from another program. The CSV text file 
which lists the account codes, account names and balances from the general ledger requires a 
specific format. The format of the CSV Text File is verified before the balances are imported. If the 
format is incorrect, an error is displayed. Open the file in Microsoft Excel or Notepad and format the 
file correctly using the instructions below.
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The CSV text file must be in one of two formats:

A three column file

 The columns must list the account code, account name, and amount.

 The first row shows the column headings. The column headings must read Account Code, 
Account Name and Amount. 

Note: There is a space in Account Code and Account Name.

 If the account name has a comma, the entire account name must be enclosed within double 
quotes, e.g., “Profits earned this year, losses this year”.

 The Amount column displays the balances. Credit balances must have a leading negative sign. 
Debit balances have no leading sign. Balances should be displayed in a plain numeric format 
with two decimal places and no dollar symbol. Balances must not have any separators 
(commas or spaces).

A four column file

 The columns must list the account code, account name, debit amounts and credit amounts.

 The first row shows the column headings. The column headings must read Account Code, 
Account Name, Debit and Credit. 

Note: There is a space in Account Code and Account Name.

 If the account name has a comma, the entire account name must be enclosed within double 
quotes, e.g., "Profits earned this year, losses this year".

 The Debit and Credit columns display the balances. All balances must be displayed as positive 
values. Balances should be displayed in a plain numeric format with two decimal places and no 
dollar symbol. Balances must not have any separators (commas or spaces).

Related topics
Select the general ledger product
Mapping accounts
Modify prior year balances

Modify prior year balances

The Modify Prior Year Balances feature enables adjustments to be made to the prior year balances 
that are stored within a configured ledger. This feature does not update the underlying ledger with 
these adjustments. The modified balances are stored separately and used by Client Accounting only.
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To access the Modify Prior Year Balances feature

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Modify Prior Year Balances on the Tasks bar.
The Client Accounting window opens.
A message is displayed asking you to select the prior year for which you would like to modify 
the account balances. 

3. Select the required year for which account balances are to modified.

4. Click OK.
The Modify Prior Year Balances window opens.

Related topics
Modifying account balances
Adding and editing an account
Searching accounts
Perform an opening review

Modifying account balances

To modify the balance of an account

1. Open the Modify Prior Year Balances window.
See “Modify prior year balances” on page 194.

2. Select the appropriate Debit or Credit cell for the account.

3. Type the modified balance into the cell.

4. Click OK.

Note: If the entered values do not balance, a warning message is displayed. The values 
must be balanced before proceeding.
Any modifications to prior year balances affect the selected year only. Each year 
must be updated separately. 
For example, if you modify the balance of a Balance Sheet account, you may have 
to make corresponding adjustments to the same account in subsequent years.

Related topics
Adding and editing an account
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Searching accounts
Perform an opening review

Adding and editing an account

To add a new account

1. Open the Modify Prior Year Balances window.
See “Modify prior year balances” on page 194.

2. Click Add account.
A blank row is added to the end of the table.

3. Enter an Account Code, Account Name and amount into the blank row.

4. Click OK.

Note: If the account code has been incorrectly entered, an error message is displayed 
informing you of an invalid account code format. Click OK, correct the error and 
click OK.

To edit an existing account name

1. Open the Modify Prior Year Balances window.
See “Modify prior year balances” on page 194.

2. Type a new account name in the specific cell in the Account Name column.

3. Click OK.

Saving modifications

1. Open the Modify Prior Year Balances window.
See “Modify prior year balances” on page 194.

2. Make the changes as required.

3. Click OK. 
This performs the following:

 Creates any new accounts in the file.

 Updates any modified descriptions in the file.

 Saves all modified balances for the selected year.
It will not:

 Update subsequent years. Balances must be manually modified for other years.
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Note: The modified balances are stored separately for use by Client Accounting only. The 
modified balances are not reflected in the underlying data file. 

Related topics
Modifying account balances
Searching accounts
Perform an opening review

Searching accounts

To search for an account

1. Open the Modify Prior Year Balances window.
See “Modify prior year balances” on page 194.

2. Type an Account Code or Account Name in the Search field. 
As you type, the first account that contains the specified search criteria in its Account Code or 
Account Name is highlighted.

Including zero balances

1. Click the Include zero balances checkbox.
This displays all accounts, including those with zero balances.

Related topics
Modifying account balances
Adding and editing an account
Perform an opening review

Defining income allocation

To define income allocation

1. Open the client’s Client Accounting > Trial Balance (Workpapers) tab.

2. Click Ledger > Define Income Allocation on the Tasks bar.
You will be redirected to MYOB Essentials Cashbook to define income allocations. 

Related topics
Creating and viewing your client’s AE/AO ledger
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Deleting a ledger
Importing a client file
Migrating an existing ledger
Other features of mapping accounts

Deleting a ledger

Note: This feature is not enabled for all users. If this option isn’t available in the Tasks bar, please 
contact your client manager to enable this feature for your practice.

To delete a ledger

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Ledger > Delete ledger on the Tasks bar.
The following error message is displayed:
Do you really want to delete the ledger?

3. Click Yes.
The ledger is deleted and the following message is displayed:
Ledger is deleted successfully.

Note: You cannot delete a ledger if the client has any period with a status of In progress 
or Complete.

Note: if you delete the ledger, the data remains until you click the refresh icon and 
import client balances.

Related topics
Creating and viewing your client’s AE/AO ledger
Importing a client file
Migrating an existing ledger
Other features of mapping accounts

Removing Configuration Details from a ledger

If you have configured a ledger for a client but made a mistake and wish to clear the configuration 
details so you can start again, you can use this feature to do so.
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This feature will only be enabled if a financial data source has been configured for the client.

To remove configuration details

1. Open the Client Accounting > Workpapers tab for a client.

2. Under the Ledger section in the Tasks bar, click Remove Configuration Detail.

3. A confirmation message displays. Click Yes to proceed with the removal.

4. A information message displays stating the details have been removed. Click OK.
The client will no longer have a source of financial data configured. See “Configuring the client” 
on page 23 to configure the client with a new data source.

Related topics
Configuring the client

Exporting Ledger Data to Tax

Australia only

If Tax is installed, you can export your ledger data to Tax and map the information to the Tax Return.

To populate Tax Return fields from the online ledger

1. Create a new Tax workpaper on the ledger for the current year. See “Adding workpapers” (see 
page 85) for more information.

Note: This workpaper must be based on the Tax Form type (Individual, Partner, 
Company, Trust) to be pre-filled.

The workpaper will be automatically populated with some values from the ledger (based on 
account group totals). Other fields may also be entered manually.

2. Once the workpaper is completed (see “Completing workpapers” (see page 130)) and any 
reports have been generated (see “Printing reports and workpapers” (see page 169)), navigate 
to the Tax homepage by clicking the Tax Button menu.

3. In the Tasks bar, click Import Ledger Data to import fields from the ledger via the workpaper.

Note: This will run in the background. If any errors are encountered, an error message is 
displayed and no fields will be updated. Otherwise, the Tax Return will be 
displayed in a new window.

4. In the Tax return, manually update any values as necessary.
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For more information, see Import Ledger Data (Framework) or Import Ledger Data (Series 6/8) in the 
Tax Online Help. These pages also contain details on which fields will be mapped from Client 
Accounting to Tax.

../Tax2016/Import_Ledger_Data.htm
../Tax2016_Profiles/Import_Ledger_Data.htm
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Importing a client file

Note: This feature is not enabled for all users. If this option isn’t available in the Tasks bar, please 
contact your client manager to enable this feature for your practice.

In order to import a client file, make sure that the configured ledger is Practice Ledger.

If you need to use ledger data that was prepared using a ledger that cannot be directly connected 
to, you can load the ledger data by importing an MYE, TXT or CSV file. 

An MYE or TXT file contains details about the client’s ledger being imported, and chart of accounts 
and journal transactions. A CSV file contains either chart of accounts, or chart of accounts and 
transactions.

To import an MYE client file

Note: - When you import an MYE file, the system identifies any accounts that need to be added to 
the chart of accounts, and adds all the journal transactions as journals to the ledger.
- If your MYE file exceeds the system limit for journal entries (16,000), an error message will 
display. To address this issue, decrease the number of transactions and consolidate prior 
period data.

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Ledger > Import client file on the Tasks bar.

3. In the Import Wizard window, Select the .MYE option under Choose file type.

4. In the Select file to import field, browse for the .MYE file to import.

5. Click Next.
A message displays with details of the client’s name, start date and end date.

6. If the details are correct, click Yes.
The system validates the file format.

7. Continue to Selecting account mapping options.

To import a TXT client file

Note: When you import a TXT file, the system identifies any accounts that need to be added to the 
chart of accounts, and adds all the journal transactions as journals to the ledger.

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).
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2. Click Ledger > Import client file on the Tasks bar.

3. In the Import Wizard window, Select the .TXT option under Choose file type.

4. In the Select file to import field, browse for the .TXT file to import.

5. Click Next.
A message displays with details of the client’s name, start date and end date.

6. If the details are correct, click Yes.
The system validates the file format.

7. Continue to Selecting account mapping options.

To import a CSV client file

Note: - Importing of CSV files is controlled by an XML configuration file, located in the Deploy 
folder. This file controls the mapping between columns in your CSV file and ledger fields. 
Additional information can be found in the XML file.
- CSV files containing up to 38,000 journal lines are supported. To import a CSV file with more 
than 38,000 journal lines, separate the CSV file into multiple files, ensuring that each file 
does not exceed the journal line limit, and perform a separate import for each file. You can 
also try decreasing the number of transactions and consolidating prior period data.

1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are 
licensed for Workpapers).

2. Click Ledger > Import client file on the Tasks bar.

3. In the Import Wizard window, Select the .CSV option under Choose file type.

4. In the Select file to import field, browse for the .CSV file to import.

5. Select the type of mapping to use from the Select template dropdown.

Note: - Choose the template that matches the client’s source file. If you’re not sure 
which one to select, contact your IT or MYOB Support
- The default options are Default Template and Quickbooks 2014 Template. If 
there are any other options listed, that means they have been customised for your 
site.

6. Click Next.
The system validates the file format.

7. Continue to Selecting account mapping options.
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Related topics
Selecting account mapping options
Selecting account mapping
Previewing mapped accounts
Other features of mapping accounts

Selecting account mapping options

The Select account mapping options window gives you options for importing a client’s chart of 
accounts. 

To select account mapping options

1. Tick the The chart of accounts in the file being imported is different to the chart in the ledger 
– I want to specify how to map the accounts to the ledger checkbox if you want to map the 
client’s chart of accounts to the ledger chart of accounts.
Do not tick this checkbox if the client’s chart of accounts is the same as your chart of accounts.

Note: If your chart of accounts is different from the client’s chart of accounts, ticking this 
box will let you map the client’s accounts to match your ledger accounts. 
Transactions will be posted using the new account(s) that you set in the Map 
Accounts window.

If the client’s chart of accounts is the same as your chart of accounts, then by not 
ticking the checkbox, any accounts found in the file being imported that do not 
exist in your chart will be added automatically. If an account exists in your chart 
that is the same as the account in the client’s chart, then no changes are required, 
and the transaction can be posted. All transactions will be posted with the original 
(client’s) account code.

Previous mappings of client data to your ledger are stored, so that for subsequent 
imports it is only necessary to map the accounts that have been added since the 
last import.

2. When you are importing a client’s file, you can choose whether to consolidate the transactions 
so that you have one transaction per account on a monthly or annual basis. Alternatively you 
can import all the transactions in the file.
If you want to include consolidated transactions, tick the Consolidate imported transactions 
into single monthly or annual transactions for each account checkbox. 
Leave the checkbox unticked to import all transactions in the file.

3. If you ticked the checkbox to consolidate imported transactions, you can then select one of the 
radio buttons, as follows:

 Monthly – select this option to import one transaction per month for each account
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 Annually – select this option to import one transaction per year for each account.

Note: View Transactions will only let you view the transactions that have been imported, 
so if you choose to import consolidated transactions, you will only be able to view 
one imported transaction per month or year (as selected).

4. Click Next to accept these settings.

5. If you ticked the first checkbox (to map the client accounts), continue to Selecting account 
mapping. If you left it empty, continue to Previewing mapped accounts.

Related topics
Selecting account mapping options
Selecting account mapping
Previewing mapped accounts
Other features of mapping accounts

Selecting account mapping

If you ticked the checkbox to map the client accounts, the Map Accounts window will open. The Map 
Accounts window enables you to select the account(s) on the Practice ledger chart that correspond 
to each account on the accountant's chart. You can make adjustments to the ledger accounts, where 
required, to align the balances with the equivalent accountant's accounts. 
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Map Accounts window options

The third column of the Map Accounts window (to the right of the Client account name column) 
displays the mapping status of each account, as shown in the following table.

Note: There is an interpretive key for these icons at the bottom of the Map Accounts window.

Viewing and editing automatic mappings

The system maps some accountants’ accounts automatically, including those that have the exactly 
the same balance as an account on the client's chart, where no other accounts exist with the same 

balance. These mappings are displayed on the Map Accounts window with an  icon in the left 
hand column.

Option Description

Include Automatically 
mapped accounts

Tick this checkbox to display all mapped accounts. 
Selected by default.

Add account Click this button to add a client account to the ledger’s 
chart of accounts.

Clear all mappings Click this button to clear all mappings, including 
automatic system mappings and any manual mappings 
you have made. 

A confirmation window displays requesting 
confirmation to clear the mappings. Click Yes.

Restore default 
mappings

Click this button to clear any changes you have made to 
the mappings and restore the account mappings to 
their original state. Any changes made will be lost.

A confirmation window displays requesting 
confirmation to restore the default mappings. Click Yes.

Icon Mapping status

Automatically mapped by the system to the chart of accounts –
see Viewing and editing automatic mappings

Mapped by the user to the chart of accounts

Possible mappings exist to the chart of accounts – see Viewing 
and editing suggested mappings

Has no mapping to the chart of accounts

Was previously mapped to the chart of accounts
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1. Select the account and click the drop-down arrow in the Map to column. 
The Mappings window displays, listing the client’s chart of accounts. 

Note: Press Esc if you want to dismiss the Mappings window.

2. Select the View suggested accounts option at the bottom of the list. 
This enables viewing of a list of suggested mappings. 

3. Select the View all accounts option to return to the full list of accounts. 

4. Ensure that the Show unmapped accounts only checkbox is selected. 
This hides those client accounts that have already been mapped. 

5. Deselect the Include zero balances checkbox if it is selected. 
To hide accounts with zero balances. 

6. Select an account from the list. 
Double-click on the account or highlight it and click Select.

Viewing and editing suggested mappings

The system suggests mappings for some accountant's accounts. These suggestions are based on the 
descriptions and balances of the accounts on the client's chart. Accountant's accounts, for which 
suggested mappings exist, are displayed on the Map Accounts window with an  icon in the left 
hand column.

1. Click the drop-down arrow in the Map to column. 
The Mappings window displays, listing suggested accounts from the client's chart, with the 
most likely match listed first.

Note: Press Esc if you want to dismiss the Mappings window.

2. Select the View all accounts option at the bottom of the list.
This enables viewing of all accounts on the client's chart.

3. Select the View suggested accounts option.
This returns to the list of suggested mappings.

4. Ensure that the Show unmapped accounts only checkbox is deselected.
This displays all accounts, regardless of whether they have already been mapped.

5. Deselect the Include zero balances checkbox if it is selected.
To hide accounts with zero balances.

6. Select an account from the list, or add a new account (see Adding a new client account).
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Double-click on the account or highlight it and click Select.

Mapping other accounts

Accountants accounts for which no automatic or suggested mappings exist are displayed in the Map 

Accounts window with an  icon in the left hand column. 

1. Click the drop-down arrow in the Map to column. 
The Mappings window displays, listing the client chart of accounts.

Note: Press Esc if you want to dismiss the Mappings window.

2. Ensure that the Show unmapped accounts only checkbox is selected.
This hides those client accounts that have already been mapped.

3. Deselect the Include zero balances checkbox if it is selected.
To hide accounts with zero balances.

4. Select an account from the list.
Double-click on the account or highlight it and click Select.

Adding a new client account

Note: If you are adding an account from the Mappings window, make sure that you select the View 
all accounts option before clicking Add account.

1. Click Add account.
The Add Account window opens.

2. Specify the Account type, Account type group, Account number, Account name and Tax Code 
for the new account.

3. Click OK.

Edit an existing client account code on the client’s Chart of Accounts

1. Type a new value in the Client account code field on the Map Accounts window.

Completing account mapping

When you have finished mapping accounts:

1. Click Next.
The Import MYE Wizard closes and you are returned to the Preview screen.

2. Click Finish to post the accounts to the ledger.
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3. Continue to Previewing mapped accounts.

Note: Any GST columns in the imported file will be ignored. Make sure to add any GST data 
manually.

Selecting account mapping options
Selecting account mapping
Previewing mapped accounts
Other features of mapping accounts

Previewing mapped accounts

In the Preview window, the final mapping of account codes is displayed. You can sort the data in 
each column if desired.

1. To export the data, click on Export to Excel.

2. When you have reviewed the data, click on Finish.
The client data is posted to your ledger.

Related topics
Selecting account mapping options
Selecting account mapping
Previewing mapped accounts
Other features of mapping accounts
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Migrating to an AE/AO ledger

Note: This feature is not enabled for all users. If this option isn’t available in the Tasks bar, please 
contact your client manager to enable this feature for your practice.

You can migrate existing general ledger of the following types to an AE/AO Ledger:

 AO Classic

 (Australia) Accounts

 MAS

Ledger details, Charts of Accounts and closing balances of the financial year are migrated from your 
existing general ledger to an AE/AO Ledger. The migration will always be for the full financial year.

To be able to migrate one of your existing ledgers to an AE/AO Ledger, ensure that you:

 have configured MYOB Logins with authorisation to migrate your existing ledger(s).

 migrate your existing ledger(s) on the last day of the current financial year.

Note: If migration is performed mid-year, the current year transactions are not 
migrated.

 migrate your existing ledger(s) before you roll-forward to the next financial year.

Depending on the classification, the tax types are determined after the migration of your existing 
ledger(s):

 Assets - CAP (Australia) / E (New Zealand)

 Cost of Sales - GST

 Equity - NTR

 Expenses - GST

 Income - GST

 Liabilities - NTR

 Other Expenses - NTR

 Other Income - NTR.

MAS classifications (Australia)

MAS accounts Account range

Assets 640 - 869

Cost of Sales 250 - 279
280 - 299

Equity 500 - 639
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Expenses 218 - 229
300 - 479

Income 230 - 249
190 - 196
216 - 217

Liabilities 870 - 999

Other Expenses 480 - 499

Other Income 100 - 189
197 - 209
210 - 215

MAS accounts Account range



AE, AU, NZ PM Client Accounting User Guide | 211

MAS classifications (New Zealand)

Accounts classifications (Australia)

MAS accounts Account range

Other Income 100 - 183

Expense 184

Other Income 185 - 189

Income 190 - 199

Other Income 200 - 218

Income 219 - 249

Cost of Sales 250 - 299

Expense 300 - 480

Equity 481 - 499

Equity (Trust Entities only) 500

Liabilities (Company, Trust, Club or 
Society entities)
Equity (Partnership, Individual 
entities)

501 - 549

Equity 550 - 639

Assets 640 - 811

Liabilities 812 - 906

Equity 907

Liabilities 908 - 999
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Accounts accounts Account range

Assets 800 - 809
820 - 828
829 - 869
892 - 894
700 - 719
870 - 891
895 - 899
650 - 655
658 - 673
656 - 657
674 - 699
739
720 - 738
766 - 769
770 - 790
760 - 765
740 - 759
791 - 794
795

Cost of Sales 11 - 31
32 - 38
39 - 40
105 - 110
130 - 139
111 - 129
140 - 209
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Equity 518 - 519
535 - 541
542 - 546
530 - 534
526 - 527
547
548
549
560 - 569
580 - 609
570 - 576
577 - 579
528 - 529
610 - 649

Expenses 41 - 89
280 - 494
520 - 525

Income 1 - 10
259 - 273
210 - 212
213 - 279
90 - 104

Liabilities 900 - 916
917 - 925
926 - 949
955
956 - 958
950 - 953
959
954
975 - 984
960 - 965
966 - 974
985
986 - 988
989 - 993
994 - 998
999

Accounts accounts Account range
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Note: The account code and account name will be migrated as one name for Header accounts. For 
example, Account code - 198, Account name - Savings Account is migrated as 198 Savings 
Account to the AE/AO Ledger.

Related topics
Migrating an existing ledger
Configuring the client

Migrating an existing ledger

Note: This feature is not enabled for all users. If this option isn’t available in the Tasks bar, please 
contact your client manager to enable this feature for your practice.

In order to migrate to an AE/AO ledger, you must have one of the following general ledgers 
configured in Client Accounting:

 (Australia) Accounts

 AO Classic 

 MAS.

See “Configuring the client” (see page 23) for more details.

Prior to migrating your existing ledger, ensure that any changes made to the ledger in Client 
Accounting have been posted back to the ledger.

If there are transactions from the previous year, these will be automatically rolled over for you to 
the new ledger. Any current year transactions will also be migrated as journal entries.

To migrate an existing ledger to an AE/AO ledger

1. Open the client’s Client Accounting > Trial Balance (Workpapers) tab.

2. Click Migrate to AE/AO Ledger on the Tasks bar.

3. The Migrate Data window opens.
The Source product field displays the general ledger type you are migrating.
The following ledger details are automatically retrieved from your existing ledger:

 Name – the name of the configured existing ledger

 Client code – the client code for the selected client’s ledger

Other Income 495 - 517

Accounts accounts Account range
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 Entity type – displays the entity type defined when you configured the ledger (see 
Configuring the client); select a different entity type from the dropdown if required

Note: The Entity type defaults to Company if the client is configured using legacy ledgers 
– edit as required.
(AE New Zealand) If you do not have Tax Manager, you will need to select the 
appropriate entity type in this field.

 Current year end date – the last day of the current year in the selected client’s ledger

 Start date for new AE/AO Ledger – the date from which you want to start using the AE/AO 
Ledger.

The table at the bottom of the window lists details for mandatory system accounts.

4. If you are using MYOB standard chart, the Ledger account values displayed in the table at the 
bottom of the window will be correct.
Otherwise, use this table to specify the account codes and names to use for these mandatory 
accounts. For each account in the list, click in the Ledger account column and type the correct 
value to use, or select a value from the drop-down.

Note: The specified codes will be displayed against these accounts after migration, in the 
Trial Balance (Workpapers) tab and the Manage Accounts window.

5. Click OK.
As the migration process starts, the Migration Summary window opens displaying the 
migration details, including the prior year balances available (From and To dates). You can view 
the status of the migration process.

Note: If the ledger you are migrating is out of balance, an error message will display. 
Make sure your existing ledger is in balance before trying again.

6. Click Close on the Migration Summary window when the migration is complete.
Once the migration is complete, view the migration log.

7. Click View migration log on the Tasks bar.
The Ledger migration log window opens.
The migration log lists any errors or warnings that should be fixed or taken into consideration.
You can view the migration log at any time for any ledger that has been migrated, simply by 
clicking View migration log on the Tasks bar for the particular ledger.
It is possible to export the migration log to Microsoft Excel, by clicking Export to excel.

8. Click Close on the Ledger migration log window when you have finished viewing the details.
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Note: You can view the allocation details by clicking Define Income Allocation on the 
Tasks bar. You can also see any warning or error messages related to the allocation 
process by clicking View migration log on the Tasks bar. 

Only the latest income allocation will be configured, irrespective of the migrated 
financial year. It is recommended to review the income allocations once the 
migration is complete.

Possible errors in the migration log

Any errors in the migration log are an indication that the data was not migrated.

 If the migration is initiated for a general ledger which has already been migrated to an AE/AO 
Ledger, the following error message is displayed (depending on your software):

The ledger already exists in the AE Ledger system.
The ledger already exists in the AO Ledger system.

 When the ledger balances are not the same and migration fails, the following error message is 
displayed:

Please balance the ledger and re-migrate.

Possible warnings in the migration log

Warnings in the migration log indicate that some data was not migrated. The reason for this is 
normally because the configured ledger does not support migration for such features. For example, 
for Account code ***, the account name is migrated as Unknown Account Name.

 The following warning message is displayed for every successful migration:

Please verify the GST rate for each account code.

Related topics
Other features of mapping accounts
Configuring the client
(AE) Migrating from AE Accounts – creating a partnership (individual)
(AE) Migrating from AE Accounts – creating a trust

Migrating from AE Accounts – creating a partnership (individual)

Accountants Enterprise in Australia only

Use the steps below if you are migrating from AE Accounts and creating a partnership (individual/
sole trader).

System accounts

In standard migration, the system accounts for AE Accounts are:
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 GST Payable

 GST Collected

 Retained earnings

 Current year earnings

Note: 1-585 will not exist in the drop down, however they will exist in the chart. Currently the 
prefixes are not being displayed in the migration drop-down.

Manage Accounts

Make the following changes under Manage Accounts.

1. Set up Income Allocation using the Tasks bar item in Client Accounting (first partner/individual)

Continue to add owners for all partners. Then use the Income Allocation to allocate the 
percentages required for each partner.

2. During the migration process, the system will automatically create Account Type Groups based 
on the partner names, and allocate the Account Type Groups to the existing accounts.

Related topics
Migrating an existing ledger
Migrating from AE Accounts – creating a trust

GST Payable 892

GST Collected 940

Retained earnings 1-585

Current year earnings 1-590

Owner Name Partner Name / Individual Name

Retained earnings acc no. 1-585

Retained earnings acc name Opening Balance

Current year earnings account acc no. 1-590

Current year earnings account acc 
name 

Share of profit



AE, AU, NZ PM Client Accounting User Guide | 218

Migrating from AE Accounts – creating a trust

Accountants Enterprise in Australia only

Use the steps below if you are migrating from AE Accounts and creating a trust.

1. System accounts
In standard migration, the system accounts for AE Accounts are:

Note: If you have Tax installed, you won’t need to select the Entity Type.

2. If you don’t use account 565, under Manage Accounts, create a new account to be used for the 
distribution journal.

Note: If you use account 565, this account will be automatically created during 
migration.

3. Create a journal for the distribution 

Note: This step is only required if you couldn’t create account 565 because it was in use.

Create a journal for the distribution, based on the data in the AE Accounts ledger.

Related topics
Migrating an existing ledger

GST Payable 892

GST Collected 940

Retained earnings 528

Current year earnings 1000 (NEW ACCOUNT)

Account No. Account 
Name

Account 
Type Tax Type

565 Distribution 
to 
beneficiaries

Equity NTR

DR 565 Distribution to beneficiaries Total

CR 1.590 Beneficiary one XXXXX

CR 2.590 Beneficiary two XXXXX

CR 3.590 Beneficiary three XXXXX
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Migrating from AE Accounts – creating a partnership (individual)

Importing balances for previous years

Note: This feature is not enabled for all users. If this option isn’t available in the Tasks bar, please 
contact your client manager to enable this feature for your practice.

If you have already migrated a ledger and want to bring in data from previous years (up to four years 
of data), use the Import Prior Year Balances option on the Tasks bar.

To import prior year balances

1. Open the client’s Client Accounting > Trial Balance (Workpapers) tab.

2. Click Import Prior Year Balances on the Tasks bar.

3. The Select Ledger window opens.

4. Select the type of general ledger you’re migrating from the Product field.

5. Under Data connection details, browse for the file containing the data to import.

6. Click OK.
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Balances from the previous four years are imported and an ' Import Successful' message displays.
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Workpaper template designer
Accountants Enterprise only

The MYOB Workpaper Template Designer (Designer) is a tool used to create and 
customise templates that will be used with MYOB Workpapers. The Designer is a rich 
text editor that provides basic word processing functionality, similar to Microsoft 
Word.

MYOB provides a number of master templates which are included as part of the 
Workpapers installation. These master templates cannot be edited. No additions can 
be made to the list of current master templates. The master templates are only 
updated during a new Workpapers release. Any changes made to the master 
templates by MYOB should not affect any practice templates created from the master 
templates. Practice templates are created by using the master templates or copying 
existing practice templates. 

You can create tables and calculation fields within practice templates. Practice 
templates can be exported and imported. This enables different offices to share 
templates. While a practice template is being customised or is incomplete, it cannot 
be used to produce live workpapers.

All data within a workpaper will be automatically rolled over into the next period. 
When you customise practice templates by inserting extra fields (such as calculations 
and dates), the data contained in these fields will be rolled over, by default, to the 
next period. You can change whether the data is automatically rolled over or not. 
Workpaper data can be retrieved from another workpaper in the same client, or in a 
different client.

Adjusting journals can be created directly from a workpaper with the variance and the 
account balance from a workpaper template being populated on the Add journal 
window. Journal entries can be generated for multiple lines, and reference different 
accounts for each one.

Workpaper variance can be compared with values within the workpaper, and not just 
the linked account. Multiple variance checks can also be performed within a single 
workpaper.

The format of a template relies on the use of tables. The behaviour within a template 
is controlled by fields which manage how data is entered, calculations are performed 
and data tables manipulated.

Note: Periodically save your template while you are customising it for your practice.
There is no undo function in the Designer.

To access the Designer

1. Obtain a configuration key for the Designer from MYOB and set the security task 
permissions.

2. Open and log on to MYOB AE.
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Click Start > Programs > MYOB Accountants Enterprise > MYOB AE to open 
Accountants Division.

3. Select Maintenance > Client Accounting > Workpaper Templates on the main 
menu.
The MYOB Workpaper Templates window opens.

Related topics
Overview of customising a master template
Master workpaper templates
Available master templates
Main menu and toolbar options
Practice workpaper templates
Customising practice templates
Formatting tables
Deleting fields
Viewing and editing field properties

Overview of customising a master template

Accountants Enterprise only

An overview of how to customise a master template to create a practice template:

1. Add a practice template, by either:

 copying a master template 

 copying an existing template.

2. Open the newly added practice template for editing.

3. Plan what changes you would like to make to the existing practice template.

4. Insert fields and/or edit and format existing content.

5. Save the changes to the practice template.

6. Change the status of the practice template from In progress to Approved.

7. Use the practice template in Workpapers.

Related topics
Master workpaper templates
Practice workpaper templates
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Main menu and toolbar options
Customising practice templates
Formatting tables
Deleting fields
Viewing and editing field properties
Main menu and toolbar options

Master workpaper templates

Accountants Enterprise only

MYOB provides a number of master templates which are normally included as part of 
the Workpapers installation. These master templates cannot be edited. No additions 
can be made the list of current master templates. The master templates are only 
updated during a new Workpapers release. Any changes made to the master 
templates by MYOB will not affect any practice templates created from the master 
templates.

Note: Master templates cannot edited.

To access the master templates

1. Open and log on to MYOB AE.
Click Start > Programs > MYOB Accountants Enterprise > MYOB AE.

2. Select Maintenance > Client Accounting > Workpaper Templates on the main 
menu.
The MYOB Workpaper Templates window opens.

3. Select the MYOB master templates option.
A list of available master templates is displayed. The list is sorted alphabetically 
based on the template description. This list cannot be changed.

To view a master template

A master template can only be viewed in read only mode. You can view the structure 
of the master template and the field properties and calculations used. You can copy 
text, but you cannot make any changes or save the document.

1. Access the MYOB master templates.
A list of available master templates is displayed. 

2. Select the master template to be viewed.

3. Click View document on the Tasks bar.
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or
Double-click the master template to be viewed.
The master template opens in the Designer window in read only mode.

Layout of a template

Every template is divided into three sections:

 Header

The fields in the header are pre-defined and are populated when the workpaper 
template is attached to a client file. All MYOB master templates contain the 
same header.

 Body

The body of the MYOB master template contains the actual calculations and 
workpaper details. All MYOB master templates contain a Notes section for 
entering free text and a Document Links section to link to source documents 
using Document Manager or Windows Explorer.

 Footer

The footer section of all MYOB master templates only contains the page 
number.

To view the properties of a master template

1. Access the MYOB master templates.
A list of available master templates is displayed. 

2. Select the master template whose properties are to be viewed.

3. Click View properties on the Tasks bar.
The MYOB Master Workpaper Template Details window opens. The 
information displayed in this window is read only.

Related topics
Available master templates
Workpaper template designer
Practice workpaper templates
Customising practice templates
Formatting tables
Deleting fields
Viewing and editing field properties
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Available master templates

Accountants Enterprise only

Template Name Category Country Description

Accounting for 
Investment

Assets Australia Reconciles investment accounts using purchases and 
sales over the year, also calculates market value

Accounting for 
Investments (Cost)

Assets Australia Reconciles investment accounts and calculates the cost 
summary and realised profit (or loss)

Annual Trust 
Distribution Statement

Other Australia For preparing a trust distribution statement for 
beneficiaries

Assets - GL 
reconciliation

Assets Australia An automated workpaper that compares data from 
Assets to the GL and provides a variance. You can drill 
down to the transactions to review the variance. Asset 
values in this template can be refreshed by clicking the 
“Refresh Assets data” button

Bank Loan analysis Liabilities Australia/
New 
Zealand

Reconciles the bank loan and calculates the current and
non-current portion of the outstanding bank loan 
amount

Bank Loans Liabilities Australia/
New 
Zealand

Identifies the current and non-current portion of 
outstanding bank loans

Bank Reconciliation Assets Australia/
New 
Zealand

Substantiates the cash value of the bank balance, i.e. a 
detailed reconciliation of the actual bank balance 
against the general ledger

Bank Reconciliation 
Foreign Currency

Asset New 
Zealand

Convert foreign currency bank accounts to NZ currency 
at a specified exchange rate

Bank Reconciliation 
(simple)

Assets Australia/
New 
Zealand

Reconciles the actual bank balance against the general 
ledger in a summary format

Borrowing Expenses Expenses Australia Amortises borrowing expenses incurred in obtaining 
finance

Carried Forward Issues Review Australia/
New 
Zealand

Lists issues that are to be carried forward to the next 
period

Carried Forward Losses Other Australia Calculates business loses to carry forward to the next 
financial year
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Client Retention 
Checklist

Other Australia/
New 
Zealand

Checklist from Chartered Accountants - compliance with
APES 320/ASQC 1.

Company Information 
Sheet

Other Australia Includes shareholders’ names, number of shares held, 
incorporation date and other information to be used as a
permanent record to roll forward every year.

Current Account — 
Interest on Overdrawn 
Account

Income New 
Zealand

Provides a worksheet for calculating interest on 
overdrawn current account balances

Current Account 
Reconciliation — Non-
Company 

Liabilities New 
Zealand

Provides a reconciliation of current account movements
and closing balance for non-shareholder current 
accounts (partners, beneficiaries, etc.)

Current Account 
Reconciliation — 
Shareholders

Liabilities New 
Zealand

Provides a reconciliation of shareholder current accoun
movements and closing balance

Dividend Paid - Net Equity New 
Zealand

Reconciles imputation credits and withholding tax to 
dividends paid, and allocates the amount due to each 
shareholder

Dividends Paid - 
Shareholder 
Distributions Statement

Expenses Australia Captures distributions to shareholders, including 
franking credits

Div 43 write-off Assets Australia Calculates the deduction for capital works under Division
43

Dividends Received Income Australia/
New 
Zealand

Substantiates the dividends received including the 
franked amounts and withholding tax

Dividend Received - 
Gross

Income New 
Zealand

Reconciles the ledger balance with the gross dividends.
The existing workpaper that reconciles to the net 
dividend will allow practices to choose to reconcile with
either net dividends or gross dividends.

Division 7A Loan - 
Unpaid Loan Balance

Other Australia Calculates the repayment and interest on unpaid loan 
balances

Division 7A Loan 
Summary

Other Australia Calculates the minimum repayment amount on loans

Division 7A Loan 
Summary (10 Years)

Other Australia Calculates the minimum repayment amount on loans 
with a 10 year term

Template Name Category Country Description
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Donations Expenses Australia/
New 
Zealand

Reviews any donations made for tax deductibility

Employee Contribution 
(Log Book)

Expenses Australia Calculates the amount of employee contribution based 
on the log book method

Employee Contribution 
(Stat Method)

Expenses Australia Calculates the amount of employee contribution based 
on the statutory method

Entertainment Expenses Australia A detailed breakdown of entertainment expenses 
including in-house dining, internal and external 
expenses to determine the deductible and FBT 
components

Entertainment - 
Adjustment required

Expenses New 
Zealand

Correctly calculates the GST adjustment that the client 
needs to be advised to enter into Box 9 of their next GST
return. The calculation takes the net non-deductible and
calculates GST as if this was the gross in the same way as
the GST on FBT contribution is calculated. This is based 
on the assumption that the client will have claimed 
100% of the GST on Entertainment expenses on their 
GST Return.

Entertainment – 50% 
GST Claimed

Expenses New 
Zealand

Assumes that the client has only claimed 50% of the GST
on each GST return, and that the effect of making a 
further adjustment in Box 9 would be trivial.

FBT Contribution on 
Motor Vehicles 

Income New 
Zealand

Calculates the amount an employee is required to 
contribute, in order to ensure that there will be no 
Fringe Benefit Tax for motor vehicles that are available 
for private use

Fixed Assets Assets Australia/
New 
Zealand

Summarises the fixed assets and reconcile the 
depreciation amounts to the asset schedule

Franking Account Liabilities Australia Summarises the debits and credits affecting the franking
account

General Notes Other Australia/
New 
Zealand

A general template for you to record notes or use as a 
base for creating a new practice template

Generic Asset Template Assets Australia/
New 
Zealand

A workpaper template that can be used as a basis for 
any new Asset-based workpaper

Template Name Category Country Description
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Generic Expense 
Template

Expenses Australia/
New 
Zealand

A workpaper template that can be used as a basis for 
any Expense-based workpaper

Generic Expenses 
Template (multiple GL 
Codes)

Expenses New 
Zealand

This is the same as the Generic Expense template but 
can have multiple account codes linked. The red flag icon
will not display on the Workpapers homepage when this
workpaper is out of balance.

Generic Income 
Template

Income Australia/
New 
Zealand

A workpaper template that can be used as a basis for 
any new Income-based workpaper

Generic Income 
Template (multiple GL 
Codes)

Income New 
Zealand

This is the same as the Generic Income Template but can
be linked to multiple account codes. The red flag icon 
will not display on the Workpapers homepage when this
workpaper is out of balance.

Generic Liability 
Template

Liabilities Australia/
New 
Zealand

A workpaper template that can be used as a basis for 
any new Liability-based workpaper

Generic Template Other Australia/
New 
Zealand

Use this template as a base to create a new practice 
template.

GST annual adjustment 
election

Other Australia A document designed to be printed and signed by the 
client declaring the use of the GST annual election rules
for small business entities

GST BAS Reconciliation Liabilities Australia Reconciles GST paid and GST collected against BAS

GST BAS Summary Liabilities Australia Provides a monthly schedule of the GST paid and GST 
received for BAS

GST Reconciliation Liabilities Australia/
New 
Zealand

Reconciles the amount of GST paid and outstanding with
the outstanding liability in the accounts

Hire Purchase Liabilities Australia/
New 
Zealand

Calculates net hire purchase liability using the sum-of-
digit method

Home Office Expenses Expenses New 
Zealand

Calculates home office expenses for tax deductibility

Imputation Credit 
Account

Other New 
Zealand

Reviews movements of Imputation Credit Accounts for 
the year

Template Name Category Country Description
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Income Tax Calculation Expenses Australia/
New 
Zealand

Calculates the tax payable. Input details on the non-
deductible or allowable items.

Income Tax Calculation 
(Detailed) - Company

Expenses Australia Calculates company tax payable with details on non-
deductible or allowable items

Income Tax Calculation 
(Detailed) - Trust

Expenses Australia Calculates trust tax payable with distribution to 
beneficiaries with details on non-deductible or 
allowable items

Income Tax Calculation 
(Generic)

Expenses Australia A generic income tax calculation allowing you to specify
all add back and less items

Income Tax Expenses21 Expenses Australia/
New 
Zealand

Calculates the amount of tax payable for a company 
based on the movement in tax liability and assets

Income Tax Integration 
- Company

Tax Australia Maps ledger values to Tax Return fields for a Company.

Income Tax Integration 
- Individual

Tax Australia Maps ledger values to Tax Return fields for an Individua

Income Tax Integration 
- Trust

Tax Australia Maps ledger values to Tax Return fields for a Trust.

Income Tax Integration 
- Partnership

Tax Australia Maps ledger values to Tax Return fields for a Partnership

Intercompany Loans Liabilities Australia Reconciles loan transactions for related entities

Intercompany Loans 
Reconciliation

Liabilities Australia/
New 
Zealand

Allows selection of a balance from a different client 
workpaper to compare to the current GL

Interest Expense 
Apportionment

Expenses Australia Calculates the proportion of interest expenses to be 
apportioned to the business

Interest Paid Expenses Australia/
New 
Zealand

Facilitates analysis of interest paid, allowing for a private
(non-deductible) portion based on a percentage

Interest Received Income Australia/
New 
Zealand

Substantiates the balance of the interest received on an
account, including withholding tax

Investment — Interest 
Bearing

Assets New 
Zealand

Lists various interest-bearing investments and provides 
for a reconciliation of the closing balance against the 
general ledger

Template Name Category Country Description
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Investment Property 
Cost Base

Assets Australia Calculates the property cost plus any buying and selling
costs, based on the ATO’s different element cost base

Investments — Shares Assets New 
Zealand

Lists various shares held for investment and calculates 
the current market value, gain or loss on disposal and 
gain or loss on shares held. It provides for the 
reconciliation of closing market value against the 
general ledger account balance. The closing value will 
roll-over to Opening value at the start of the next year.

Investments Summary Assets New 
Zealand

Acts as a lead schedule for the Investments — shares 
workpaper and Investments — interest bearing 
workpaper, but also provides a table for entering the 
closing balance of other types of investment. This 
summary then allows for the total reconciliation of all 
investments to a single general ledger account.

Issues for Client 
Attention

Review Australia/
New 
Zealand

Lists issues that are to be brought to the client’s 
attention

Issues for Partner 
Attention

Review Australia/
New 
Zealand

Lists issues that are to be brought to the partner’s 
attention

Job Review Checklist Review Australia/
New 
Zealand

A checklist of actions that must be taken into 
consideration when completing accounting or an audit

Livestock Income Australia For the valuation of livestock using tax and account 
values

Livestock Calculation - 
Closing Stock

Other Australia Performs closing stock calculations

Loan reconciliation Liability Australia A simple loan summary that allows you to enter the 
opening balance, interest and fees to reconcile to the 
loan balance

MV expenses Schedule Expenses Australia A detailed schedule of motor vehicle expenses including
private and business use and log book details

Other Debtors Assets Australia/
New 
Zealand

Lists any other debtors and to substantiate the balance 
in the general ledger

Prepayments Assets Australia/
New 
Zealand

Identifies a pre-paid amount and the period over which
it will be expensed in the profit and loss statement

Template Name Category Country Description
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Prepayments - Multiple Assets Australia/
New 
Zealand

Identifies multiple pre-paid amounts and the period 
over which they will be expensed in the profit and loss 
statement

Prepayments with 
Rollover

Assets Australia Summarises all prepayments for the year

Provision for Income 
Tax

Liabilities Australia/
New 
Zealand

Reconciles the balance of the income tax liability 
account including the opening balance, this year’s 
income tax and any instalments paid

Ratio Analysis Review Australia/
New 
Zealand

Calculates different ratios and provides quantitative 
analysis of information from the company’s financial 
statement.

Rental Property Income Australia/
New 
Zealand

Provides a 12-month schedule to calculate the amount 
of rent received and any deductions from monthly renta
property statements

Rent Received 
Reconciliation

Income Australia/
New 
Zealand

Provides a facility for calculating and reconciling rent 
received by multiplying the number of rent payments by
the rental rate

Review Points Review Australia/
New 
Zealand

Enables you to create a review list that also attaches to a
code and shows against the account

Service Fee Calculation Expenses Australia Determines the amount of service fee payable for 
service trusts with a percentage of wages, rent and 
depreciation

Schedular Income with 
GST

Income New 
Zealand

Facilitates reconciliation of the gross schedular income 
and withholding tax deducted (from IRD Summary of 
Earnings) and calculates GST to show the net amount 
received

Stock on Hand Assets Australia/
New 
Zealand

Lists stock values with its valuation method

Term Deposit Assets Australia/
New 
Zealand

Calculates term deposit investment balances and 
interest accrued

Trade Creditors Liabilities Australia/
New 
Zealand

Substantiates the trade creditors account including 
other payables during the year

Template Name Category Country Description
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Related topics
Workpaper template designer
Practice workpaper templates
Customising practice templates
Formatting tables
Deleting fields
Viewing and editing field properties

Practice workpaper templates

Accountants Enterprise only

Trade Debtors Assets Australia/
New 
Zealand

Substantiates the trade debtors account including any 
doubtful or bad debts written off during the year

Trade Debtors Listing 
(simple)

Assets Australia/
New 
Zealand

Substantiates the trade debtors account without 
doubtful or bad debts written off

Trade Debtors 
Reconciliation

Assets Australia/
New 
Zealand

Substantiates the trade debtors account including any 
doubtful or bad debts written off during the year, which
have been captured by separate accounts

Trust Beneficiary 
Distribution

Other Australia Reconciles accounting distribution with taxable 
distribution for trust beneficiaries

Trust Distributions 
Received

Income Australia Splits the income received from trusts into the 
appropriate income categories according to the trust 
statements, e.g. foreign income, capital gains and 
reconciling to the accounting distribution received

Trust information sheet Other Australia Summarises beneficiary, income distribution and 
administrative details of a trust account

Wages Reconciliation Expenses Australia/
New 
Zealand

Provides a summary of wages to reconcile to the lodged
BAS statements and the general ledger balance

Wages Reconciliation 
(Annual)

Other Australia Reconciles wages and salary with leave provisions

Work in Progress Assets Australia/
New 
Zealand

Lists work-in-progress values with its valuation method

Template Name Category Country Description
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Practice templates are master templates that have been customised for a practice. 
Practice templates can be created from master templates or existing practice 
templates.

You can create tables and calculation fields within practice templates. Practice 
templates can be exported and imported which enables different practices to share 
templates. While a practice template is being customised or is incomplete, it cannot 
be used in the production of live workpapers.

To access practice templates

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. The list includes the person 
who modified the template and the master template that was used to create 
the practice template. This list can be customised.
Practice templates can be added, edited and deleted from this list.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Importing templates
Exporting templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template
Opening a practice template for editing

Customising the list of practice templates

Accountants Enterprise only

To customise the displayed list of practice templates

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed.
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3. Sort the list of practice templates.
By default, the list is sorted alphabetically based on the template description.
Click on a column heading to sort by that heading. The list is updated based on 
the selection made.

4. Re-order the list columns.
To rearrange the order of the columns, click and drag a column heading to the 
location where you would like it to be.

Note: When the MYOB Workpaper Templates window is closed, any customisation 
made to the list order of practice templates is lost.

Related topics
Viewing practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Importing templates
Exporting templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template

Viewing practice templates

Accountants Enterprise only

Only practice templates with a status of In progress can be viewed. A warning 
message is received if you try to view a practice template with an Approved status.

To view a practice template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Ensure that the practice template to be viewed has a status of In progress.

4. Double-click the practice template to be viewed.
The practice template opens in the Designer window.
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Related topics
Customising the list of practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Importing templates
Exporting templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template

Adding a practice template

Accountants Enterprise only

When creating a practice template, you cannot create a blank template. You must 
always start with a master template or copy an existing practice template.

To add a practice template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Click Add on the Tasks bar.
The Add Workpaper Template window opens.

4. Enter a unique Template description.
The description is limited to a maximum of 100 alphanumeric characters. The 
description is not case sensitive.

Note: The Template description must be unique.

5. You can add a new template by:

 Copying from a master template. 

Click the Copy from MYOB Master option.

 Copying from an existing practice template. 

Click the Copy from a practice template option.

6. Select the template from the corresponding drop-down. If you know the name 
of the template, you can type in this field to search for it.
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By default, when a new template is added the Template status is In progress.

7. Select the practice template Category from the drop-down.

8. (Australia) If you have selected the Tax category, the Tax form type field is 
editable. Select the appropriate Tax Return Form for this workpaper template.

9. Select the Rollover workpaper to next accounting period option, if required.
Select this option if you want client workpapers that are created from this 
template to be rolled over into the next accounting period.

10. Select the Show a link in the Prepare Workpapers screen to all referenced 
account codes option, if required.
Select this option if you want this workpaper to be shown against all the account 
codes referenced in it, rather than only against the account code the workpaper 
was initially created for.

11. Click OK.
A new practice template is created.

Related topics
Customising the list of practice templates
Viewing practice templates
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Importing templates
Exporting templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template

Editing the practice template properties

Accountants Enterprise only

To edit the properties of a practice template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Select the practice template.
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Select the row containing the practice template or click the checkbox adjacent 
to the practice template.

4. Click Properties on the Tasks bar.
The Amend Workpaper Template Details window opens.

5. Edit the Template description, if required.
To edit the template description, delete the highlighted text and enter an 
appropriate description for the practice template. Alternatively, overtype any of 
the existing description.
The description is limited to a maximum of 100 alphanumeric characters. The 
description is not case sensitive.

Note: The Template description must be unique.

6. Change the Template status, if required.
Select the appropriate status from the drop-down; either Approved or In 
progress.

7. Change the practice template Category, if required.
Select the appropriate Category from the drop-down.

8. (Australia) If you have selected the Tax category, the Tax form type field is 
editable. Select the appropriate Tax Return Form for this workpaper template.

9. Select or deselect the Rollover workpaper to next accounting period option, if 
required.
Select this option if you want client workpapers that are created from this 
template to be rolled over into the next accounting period.

10. Select or deselect the Show a link in the Prepare Workpapers screen to all 
referenced account codes option, if required.
Select this option if you want this workpaper to be shown against all the account 
codes referenced in it, rather than only against the account code the workpaper 
was initially created for.

11. Click OK.
All changes made to the properties of the selected practice template are saved.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Changing the status of a practice template



AE, AU, NZ PM Client Accounting User Guide | 238

Deleting a practice template
Importing templates
Exporting templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template

Changing the status of a practice template

Accountants Enterprise only

A practice template with a status of In progress is unavailable for selection in 
Workpapers.

A practice template with a status of Approved is available for selection in 
Workpapers.

To change the status of a practice template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Select the practice template.
Select the row containing the practice template or click the checkbox adjacent 
to the practice template.

4. If the practice template has a status of Approved, click In Progress on the Tasks 
bar.
The status of the practice template is changed from Approved to In progress.

5. If the practice template has a status of In progress, click Approved on the Tasks 
bar.
The status of the practice template is changed from In progress to Approved.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Editing the practice template properties
Deleting a practice template
Importing templates
Exporting templates
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Reverting to MYOB master
Updating a practice template to an updated MYOB master template

Deleting a practice template

Accountants Enterprise only

Deleting a specific template does not delete any documents attached to any client 
that were created from the template. However, if the document attached to the 
client is marked as ‘roll over’ then when the next accounting period is created, the 
document cannot be rolled over. That is, the document is not provided in the next 
accounting period.

To delete a practice template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Select the practice template to be deleted.
Select the row containing the practice template or click the checkbox adjacent 
to the practice template.

4. Click Delete on the Tasks bar.
The Delete Workpaper Template window opens requesting confirmation of the 
deletion.

5. Click Yes.
The practice template is deleted.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Importing templates
Exporting templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template
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Importing templates

Accountants Enterprise only

Note: Only .xml file types can be imported.

To import a workpaper template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Click Import on the Tasks bar.
The Import Workpaper Template window opens.

4. Select the template to be imported.
Click the ellipse button at the end of the Import from file field.
Navigate and select the file from the Open window. Click Open.

5. Enter a Template description.
The description is limited to a maximum of 100 alphanumeric characters. The 
description is not case sensitive.

Note: The Template description must be unique.

6. Click OK.
The template is imported.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Exporting templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template
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Exporting templates

Accountants Enterprise only

Note: Practice templates are only exported in .xml format.

To export a practice template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Click Export on the Tasks bar.
The Save As window opens.

4. Navigate to the location where the template will be exported (or saved) to.

5. Enter a File name for the template.

6. The only option available for Save as type is MYOB Workpaper Template 
definitions (*.xml).

7. Click Save.
The practice template is exported.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Importing templates
Reverting to MYOB master
Updating a practice template to an updated MYOB master template

Reverting to MYOB master 

Accountants Enterprise only

You can always revert your practice template to the original MYOB master template. 
If you decide to do this, then any changes or customisations made to your practice 
template are lost and cannot be recovered.
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You cannot revert a practice template to a MYOB master template if the practice 
template was not originally created from a MYOB master template.

To revert a practice template to a MYOB master template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Select the practice template to be reverted to the master template.
Select the row containing the practice template or click the checkbox adjacent 
to the practice template.

4. Click Revert to MYOB master on the Tasks bar.
The Revert template to MYOB Master window opens.
The Template description field is automatically filled with the description of the 
selected practice template.
The MYOB Master used field is automatically filled with the master template 
originally used to create the practice template. This is also the master template 
that will replace the practice template.

Note: If the practice template was not created from a MYOB master 
template a message is displayed stating this fact. Click OK to close 
the message.

5. Read the warning notice on the Revert template to MYOB Master window.

6. Click Yes.
The practice template is reverted to the master template.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Importing templates
Exporting templates
Updating a practice template to an updated MYOB master template
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Updating a practice template to an updated MYOB master template

Accountants Enterprise only

There will be occasions when MYOB will update the existing master templates. The 
updated master templates will be available with a new release of Workpapers. If you 
have made no customisations to the practice template (which was originally created 
from the master template) then the practice template will be automatically updated. 
If the practice template has been customised then you have the option to update the 
practice template to the latest version of the master template.

Each customised practice template must be selected and reverted to the MYOB 
master template using Revert to MYOB master on the Tasks bar. See “Reverting to 
MYOB master” on page 241.

Any new master templates are automatically copied to the practice templates list 
when the new version of Workpapers is installed. Any practice templates that have 
not been customised will be automatically updated with the new version of the 
master templates.

Note: You do not have to update your customised practice template to the updated 
master template. 
You cannot retain the customisations to your practice template and update 
the master templates.

If you want to retain the customisation to your practice template and update the 
master templates:

 Export a copy of your practice templates.

See “Exporting templates” on page 241. You export a copy of your practice 
template so that you can see what changes you have made to it and then 
reapply them to the updated practice template.

 Update the practice template to the new version of the master templates.

See “Reverting to MYOB master” on page 241.

 Redo your customisations to the updated practice template.

Related topics
Customising the list of practice templates
Viewing practice templates
Adding a practice template
Editing the practice template properties
Changing the status of a practice template
Deleting a practice template
Importing templates
Exporting templates
Reverting to MYOB master
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Opening a practice template for editing

Accountants Enterprise only

Only practice templates with a status of In progress can be edited. A warning message 
is received if you try to edit a practice template with an Approved status.

To open a practice template

1. Access the Designer.
The MYOB Workpaper Templates window opens.

2. Select the Practice templates option.
A list of available practice templates is displayed. 

3. Ensure that the practice template to be edited has a status of In progress.

4. Double-click the practice template to be edited.
or 
Click Edit on the Tasks bar.
The practice template opens in the Designer window.

Related topics
Customising practice templates
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Main menu and toolbar options

Accountants Enterprise only

You will be familiar with the options available on the main menu and the toolbar as 
they are similar to any Microsoft program.

Some main menu and toolbar options enable you to customise a practice template to 
best suit the requirements of your practice, e.g., the addition of a company logo to a 
template using Insert > Image.

Main menu options

Option Description

File
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Save Select File > Save to save the practice template after 
editing. 
Or click the Save button on the toolbar to save the practice 
template.
When you save an edited practice template, the version 
number is incremented so that the original practice 
template is never replaced. 

Page Setup This option enables you to set up the margins and paper, 
headers and footers and columns of your template. 

Print Select this option to open the Print window from where 
you can select the appropriate printer to print your 
template.

Exit Select File > Exit to exit the Designer.

Edit

Cut Copy and remove the selected text or field from the 
template. This text or field can then be pasted somewhere 
else in the template.

Copy Make a copy of the selected text or field that can then be 
pasted somewhere else in the template.

Paste Insert the copied text or field at a specific location.

Delete Remove the selected text or field from the template.

Select All Selects all of the content in the template body.

View

Headers and Footers Select View > Headers and Footers to view and edit the 
headers and footers of the template. 
Double-click in the body of the template to move the focus 
from the headers and footers to the template body.

Insert

Field Select Insert > Field to open the Insert Field window and 
insert a selected field into the template. 
Or click Insert Field on the toolbar to open the Insert Field 
window.

Image Select Insert > Image to open the Open window which 
allows you to browse for an image to include in the 
template, e.g. company logo. Click Open.

Option Description
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Format

Bullets and 
Numbering

•  Select Format > Bullets and Numbering > Attributes to 
open the Bullets and Numbering window.
Select the appropriate bullet and numbering options 
available in this window to suit your template. Click OK.

•  Select Format > Bullets and Numbering > Increase Level 
to further indent selected bulleted or numbered text.

•  Select Format > Bullets and Numbering > Decrease 
Level to reduce the indent of the selected bulleted or 
numbered text.

Character Select Format > Character to open the Font window where 
you can select a different font style, font size and other 
character attributes for selected text of the template. Click 
OK.

Columns Select Format > Columns to open the Page Setup window 
on the Columns tab where you can configure page 
columns for the whole document. Click OK.
It is advisable not to insert page columns in an existing 
template. Use this option on a blank template document.

Headers and Footers Select Format > Headers and Footers to open the Page 
Setup window. Here you can select how the headers and 
footers are displayed on the page and their placement 
within the template. Click OK.

Image Select Format > Image to open the Image Attributes 
window. You can change the layout, position, size, distance 
and saving options of a selected image that was inserted 
into the template. Click OK.

Paragraph Select Format > Paragraph to open the Paragraph window 
where you can change the format, indents, frame and 
page breaks of selected text within a template. Click OK.

Styles Select Format > Styles to open the Styles window. From 
this window you can select an existing format style to 
apply to highlighted text. You can create a New format 
style using the New Style window which can then be 
reused. You can also modify or delete an existing style.

Table Select Format > Table to open the Table Properties 
window. You are able to change the frame, colour, 
background, margins, cell size and formatting of a selected 
table. Click OK.

Option Description
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Toolbar options

Tabs Select Format > Tabs to open the Tabs window. From this 
window you can change existing tab stop positions and 
alignments. You can also set new tab stop positions in the 
template. Click OK.

Text Background 
Colour

Select Format > Text Background Colour to open the Color 
palette. Apply a background colour to selected text. Click 
OK.

Text Colour Select Format > Text Colour to open the Color palette. 
Apply colour to selected text. Click OK.

Table

Insert Select Table > Insert > Table to insert a text display table 
into the template. See “Inserting a text display table” on 
page 280.

Delete Select Table > Delete > Table/Column/Row to delete a 
selected table (data entry or text display), column or row 
from the template.

Help

Help Select Help to access online help for the Designer.

Option Description

To save the template.

Insert Field To insert a field into the practice template. 
See “Customising practice templates” on page 249.

Delete Field To delete a field from the practice template.
See “Deleting fields” on page 288.

Field Properties To view and edit field properties. You can also 
double-click on a field to open its properties window.
See “Viewing and editing field properties” on 
page 289.

Cut

Option Description
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Copy

Paste

Switch between header and footer.

Go to the normal header.

Go to the first page header.

Remove the header and footer.

Font type
Click the drop-down arrow to select a different font 
type from the available list.

Font size
Click the drop-down arrow to select a different font 
size from the available list.

Bold text

Italicise text

Underline text

Left justify text

Centre text

Right justify text

Option Description



AE, AU, NZ PM Client Accounting User Guide | 249

Related topics
Opening a practice template for editing
Formatting tables
Customising practice templates
Deleting fields
Viewing and editing field properties

Customising practice templates

Accountants Enterprise only

Practice templates are master templates that have been customised for your 
practice. 

One way to customise practice templates is to insert additional fields that are 
required by your practice. 

We recommend that any additional fields that are inserted are included as part of a 
data entry table or text display table.

Tip: When customising a practice template by using a formula or function, ensure 
that you refer to any field names exactly. You must match the characters and 
the case sensitivity of the field names. For example, d1 is different to D1.

To insert a new field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

Tip: A new data entry table may need to be inserted for the additional 
data. See “Inserting a data entry table” on page 269.

Bullet points

Version information
Click the icon to find the version number of the 
template. The version information is displayed as 
Year.Version.Revision, e.g., 2012.1.13.

Option Description
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3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select the field type to be inserted.
The first tab contains the list of standard fields used in Workpaper templates.
The second tab Other components contains functionality that is specific to 
individual templates, such as “Assets - GL reconciliation”.

5. Click OK.

6. Configure the field type.

7. Click OK.
The selected field type is placed at the insertion point.

8. Format the field type as necessary.

Tip: Double-click a field in a workpaper to launch the specific field 
window so that you can make further edits.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties
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Inserting an account amount

Accountants Enterprise only

To insert an account amount field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Account amount.

5. Click OK.
The Account Amount window opens.

6. Enter a Field name for the Account Amount field.
The Field name is automatically filled when the Account Amount window 
opens. You can accept the default or overwrite it. The system will allocate the 
next sequential number prefixed by a B for account fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the account code.
There are two options:

a. Show details for the linked account code. 

That is, the account the workpaper is linked to.

b. Show details for an account code in this workpaper.

If you select this option, then you must select the appropriate Field name 
from the drop-down.
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8. Select the Account balance display details.

a. Select the appropriate Display option from the drop-down. 

The default option is Adjusted closing balance.

b. Select the appropriate Format option from the drop-down for how the 
account balance is to be displayed. 

The default option is Number - 2 decimal places.

The Number - 2 decimal places and the Number - no decimal options 
display with no formatting and no commas, e.g., 2478.55. The Currency 
option displays the account balance with a thousands separator and a 
currency value as set by the regional settings, e.g., $2,478.55. With all 
options, negative numbers are displayed with a leading minus sign, e.g., -
2478.55. 

c. Tick the Include comma separators checkbox if you want to include a 
comma as a thousands separator.

Note: If you select Currency from the Format drop-down, this checkbox is 
disabled.

d. Select the Show this number when zero option, if required.

9. Select the Display a red flag icon in the Prepare Workpapers list if a 
discrepancy exists option, if required.

10. Click OK.
The Account Amount field is placed at the insertion point.
The Account Amount window and the Insert Field window close.

Related topics
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
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Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting an account code or description

Accountants Enterprise only

To insert an account code or description field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Account code or description.

5. Click OK.
The Account Code or Description window opens.

6. Enter a Field name for the Account Code or Description field.
The Field name is automatically filled when the Account Code or Description 
window opens. You can accept the default or overwrite it. The system will 
allocate the next sequential number prefixed by a A for account code and 
description fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the account code.
There are three options:
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 Show details for the linked account code

That is, show the code/description or both for the account the workpaper is 
linked to.

 User enters account code in the workpaper

If you select this option, then you must enter an account code when 
preparing the workpaper.

 Show details for the account code of linked client

Select this option to add a Link client button into the workpaper, so that 
you can insert an account balance for a related entity. 

8. Select the Account name display details.
You can select to display the Account code and description, the Account code 
only or the Account description only. The default option is Account code and 
description.

9. If the User enters account code in the workpaper option is selected, then the 
Rollover value to next period checkbox is selected by default. 
This means that entered Account code and description data will be displayed in 
the same field in the next rollover period. 
Deselect the Rollover value to next period checkbox, if you do not want the 
Account code and description value to be rolled over.

10. Click OK.
The Account Code or Description field is placed at the insertion point.
The Account Code or Description window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
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Deleting fields
Viewing and editing field properties

Inserting an Account group amount

Accountants Enterprise only

To insert an account group amount field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Account group amount.

5. Click OK.
The Account Group Amount window opens.

6. Enter a Field name for the Account Amount field.
The Field name is automatically filled when the Account Group Amount window 
opens. You can accept the default or overwrite it. The system will allocate the 
next sequential number prefixed by a N for account group fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the account group by clicking the Select account group button. The Select 
Account Group dialog box is displayed.

a. Search for the account group by entering the name in the search field, or 
browsing through the folder tree.

b. Highlight the group you wish to select.
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c. Click OK. The Account group is displayed under the button.

8. Select the Expected amount sign. The amount will be displayed as a positive 
number if it has the selected amount type.

9. Select the Account group display details.

d. Select the appropriate Format option from the drop-down for how the 
account balance is to be displayed. 

The default option is Number - 2 decimal places.

The Number - 2 decimal places and the Number - no decimal options 
display with no formatting and no commas, e.g., 2478.55. The Currency 
option displays the account balance with a thousands separator and a 
currency value as set by the regional settings, e.g., $2,478.55. With all 
options, negative numbers are displayed with a leading minus sign, e.g., -
2478.55. 

e. Tick the Include comma separators checkbox if you want to include a 
comma as a thousands separator.

Note: If you select Currency from the Format drop-down, this checkbox is 
disabled.

f. Select the Show this number when zero option, if required.

10. Select Allow manual override on Workpaper if you wish to have this value 
overwritten on the workpaper.

11. (Australia) If this calculation is to be mapped to a Tax Return field, select Field to 
be mapped to Tax Return.
The Tax Return field mapping code field is editable. Select the Tax Return field 
mapping code.

12. Click OK.
The Account Group Amount field is placed at the insertion point.
The Account Group Amount window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
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Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting a calculation

Accountants Enterprise only

The Calculation field is a special type of numeric field that enables you to add basic 
mathematical operations involving expressions and functions to a practice template. 
You can reference the field name of a:

 numeric field

 calculation field

 account amount field

 date field (in special circumstances)

in a calculation. 

Tip: In a formula, ensure that you refer to any field names exactly. You must match 
the characters and the case sensitivity of the field names. For example, d1 is 
different to D1.

Calculations can be performed within table rows. Fields are entered on a row by row 
basis in a table. Each cell of each row has the same field names and calculations.

The following basic arithmetic is supported:

 + addition

 - subtraction

 * multiplication

 / division

 ^ exponential

 () brackets.
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Functions

Calculations can use functions in their expressions. Four functions are currently 
defined:

 If (condition, true, false)

The If function corresponds to Microsoft Excel’s If function.
The most common use of this function is to avoid division by zero. 
Example: If (C1 = 0, 0, ((N5 - N4) /C1) * 365) when C1 is zero then the calculation 
result is also zero. However, if C1 is any other number the calculation returns 
the result ((N5 - N4)/C1) * 365.

 Days (date field 1, date field 2)

The Days function returns the number of days between two date fields.
Example: Days (D1,D2). This example accepts two date field names D1 and D2 
and returns the number of days between the two values. An absolute value is 
returned so the result will never be negative.

 FirstRow

The FirstRow function can only be used for calculations within data entry tables. 
The FirstRow function will return a true value when the calculation being 
performed is on the first row of a table.

 Above

The Above function can only be used for calculations within data entry tables. 
The Above function accepts a column field name and returns a numeric value for 
the column immediately above the row being calculated. For the first row in a 
table, the Above function will return a zero.

To insert a column sum calculation field in a practice template

Tip: Ensure that you refer to any field names exactly. You must match the 
characters and the case sensitivity of the field names. For example, d1 is 
different to D1.

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.



AE, AU, NZ PM Client Accounting User Guide | 259

4. Select Calculation.

5. Click OK.
The Calculation window opens.

6. Enter a Field name for the Calculation field.
The Field name is automatically filled when the Calculation window opens. You 
can accept the default or overwrite it. The system will allocate the next 
sequential number prefixed by a C for calculation fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the Calculation type to be Column sum of number field.
This option enables you to add the column of numbers selected from the drop-
down. This option is most commonly used within a data entry table.

8. Select the Format of the displayed calculation result from the drop-down.
The Number - 2 decimal places and the Number - no decimal options display 
with no formatting and no commas e.g., 2478.55. The Currency option displays 
the account balance with a thousands separator and a currency value as set by 
the regional settings, e.g., $2,478.55. With all options, negative numbers are 
displayed with a leading minus sign, e.g., -2478.55. 

9. Tick the Include comma separators checkbox if you want to include a comma as 
a thousands separator.

10. Select the Show this number when zero option, if required.

11. Select the This calculation is part of the Workpaper’s journal option, if 
required.
If this option is selected, when you prepare a workpaper and select to create a 
journal, the calculated amount will be automatically included in the new journal. 
Any calculation fields that have this option selected will be listed in the journal.
This option is most commonly used for the variance field so that a journal can be 
created automatically from the variance amount.

Note: Several fields in a single workpaper can be used to create 
workpaper journals.
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12. If you have selected the This calculation is part of the Workpaper’s journal 
option, and you want to include quantities rather than an actual balance (for 
example, for farm accounting):

a. Click the Edit journal settings... button.

The Edit journal settings window displays.

b. In the Account section, select the Post to the linked account option or 
select an account from the Post to the account selected in this field 
dropdown, depending on where you want the amount to be posted.

c. Select the Post as quantity option in the Balance type section.

d. Click OK.

13. Select the Rollover value to next period option, if required.
Select this option if the properties of the template have been flagged to be 
rolled over. This option enables you to select which field will be rolled forward to 
this amount.
For example, a closing balance of a workpaper can be rolled forward 
automatically to the opening balance in the next period.

a. Select the appropriate field that will display the calculated amount in the 
next period from the drop-down.

14. Select the This calculation is the number to balance the linked account against 
option, if required.
If this option is selected, then the result of this calculation is used to balance the 
linked account.
A red flag on the Prepare Workpapers table will be displayed when the result of 
this calculation in the attached document does not match the final account 
balance.

Note: You can use one or more calculations as balance checks. A red flag 
will display in the Prepare Workpapers table if any one of them is 
out of balance.

15. Select the Display a red flag icon in the Prepare Workpapers list if a discrepancy 
exists option, if required.

16. (Australia) If this calculation is to be mapped to a Tax Return field, select Field to 
be mapped to Tax Return.
The Tax Return field mapping code field is editable. Select the Tax Return field 
mapping code.

17. Click OK.
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The Calculation field is placed at the insertion point.
The Calculation window and the Insert Field window close.

To use a calculation result from another workpaper in a practice template

Tip: Ensure that you refer to any field names exactly. You must match the 
characters and the case sensitivity of the field names. For example, d1 is 
different to D1.

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Calculation.

5. Click OK.
The Calculation window opens.

6. Enter a Field name for the Calculation field.
The Field name is automatically filled when the Calculation window opens. You 
can accept the default or overwrite it. The system will allocate the next 
sequential number prefixed by a C for calculation fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the Calculation type to be Calculation result from another Workpaper.
This option enables you to select a calculation field from another workpaper 
template that will be used for this calculation. For example, you could use an 
existing calculation in the Income Tax Provision workpaper for the Income Tax 
Expense workpaper.
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a. Click Setup.

The Template Calculation Fields window opens.

b. Expand the Field Name by clicking the + adjacent to the Field Name.

The Field Name expands to list all of the associated fields and calculations. 
This list will not include any field names and calculations associated with the 
current practice template. This list will also not include any calculation fields 
that are embedded in table rows.

c. Select the appropriate calculation.

d. Click OK.

The Template Calculation Fields window closes. The selected template and 
calculation field are reflected in the Template and Field fields on the 
Calculation window. A Link button is displayed in the actual workpaper 
adjacent to the calculation.

8. Select the Format of the displayed calculation result from the drop-down.
The Number - 2 decimal places and the Number - no decimal options display 
with no formatting and no commas e.g., 2478.55. The Currency option displays 
the account balance with a thousands separator and a currency value as set by 
the regional settings, e.g., $2,478.55. With all options, negative numbers are 
displayed with a leading minus sign, e.g., -2478.55. 

9. Select the Show this number when zero option, if required.

10. Select the This calculation is part of the Workpaper’s journal option, if required.
If this option is selected, when you prepare a workpaper and select to create a 
journal, the calculated amount will be automatically included in the new journal. 
Any calculation fields that have this option selected will be listed in the journal.
This option is most commonly used for the variance field so that a journal can be 
created automatically from the variance amount.

Note: Several fields in a single workpaper can be used to create 
workpaper journals.

11. Select the Rollover value to next period option, if required.
Select this option if the properties of the template have been flagged to be 
rolled over. This option enables you to select which field will be rolled forward to 
this amount.
For example, a closing balance of a workpaper can be rolled forward 
automatically to the opening balance in the next period.

a. Select the appropriate field that will display the calculated amount in the 
next period from the drop-down.
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12. Select the This calculation is the number to balance the linked account against 
option, if required.
If this option is selected, then the result of this calculation is used to balance the 
linked account.
A red flag on the Prepare Workpapers table will be displayed when the result of 
this calculation in the attached document does not match the final account 
balance.

Note: You can use one or more calculations as balance checks. A red flag 
will display in the Prepare Workpapers table if any one of them is 
out of balance.

13. Select the Display a red flag icon in the Prepare Workpapers list if a discrepancy 
exists option, if required.

14. If this calculation is to be mapped to a Tax Return field, select Field to be 
mapped to Tax Return.
The Tax Return field mapping code field is editable. Select the Tax Return field 
mapping code.

15. Click OK.
The Calculation field is placed at the insertion point.
The Calculation window and the Insert Field window close.

To insert a customised calculation field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Calculation.

5. Click OK.
The Calculation window opens.

6. Enter a Field name for the Calculation field.
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The Field name is automatically filled when the Calculation window opens. You 
can accept the default or overwrite it. The system will allocate the next 
sequential number prefixed by a C for calculation fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the Calculation type to be Other calculation.
This option enables you to create your own calculation using the listed 
mathematical symbols and groupings. The calculation expressions are not case 
sensitive.

a. Consider the formula you would like to use.

b. Select the field to be included in the calculation using the drop-down.

c. Click Insert to place the field in the formula.

d. Continue creating your calculation formula and inserting fields as required.

Tip: Ensure that you refer to any field names exactly. You must match 
the characters and the case sensitivity of the field names. For 
example, d1 is different to D1.

8. Select the Format of the displayed calculation result from the drop-down.
The Number - 2 decimal places and the Number - no decimal options display 
with no formatting and no commas e.g., 2478.55. The Currency option displays 
the account balance with a thousands separator and a currency value as set by 
the regional settings, e.g., $2,478.55. With all options, negative numbers are 
displayed with a leading minus sign, e.g., -2478.55. 

9. Select the Show this number when zero option, if required.

10. Select the This calculation is part of the Workpaper’s journal option, if required.
If this option is selected, when you prepare a workpaper and select to create a 
journal, the calculated amount will be automatically included in the new journal. 
Any calculation fields that have this option selected will be listed in the journal.
This option is most commonly used for the variance field so that a journal can be 
created automatically from the variance amount.
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Note: Several fields in a single workpaper can be used to create 
workpaper journals.

11. Select the Rollover value to next period option, if required.
Select this option if the properties of the template have been flagged to be 
rolled over. This option enables you to select which field will be rolled forward to 
this amount.
For example, a closing balance of a workpaper can be rolled forward 
automatically to the opening balance in the next period.

a. Select the appropriate field that will display the calculated amount in the 
next period from the drop-down.

12. Select the Display a red flag icon in the Prepare Workpapers list if a 
discrepancy exists option, if required.
A red flag on the Prepare Workpapers table will be displayed when the result of 
this calculation in the attached document does not match the condition selected 
in Red flag settings.

13. If this calculation is to be mapped to a Tax Return field, select Field to be 
mapped to Tax Return.
The Tax Return field mapping code field is editable. Select the Tax Return field 
mapping code.

14. Click OK.
The Calculation field is placed at the insertion point.
The Calculation window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
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Formatting tables
Deleting fields
Viewing and editing field properties

Calculation examples

Accountants Enterprise only

Example 1

A workpaper may define three numeric fields - N1, N2 and N3. A calculation field, C1, 
can reference these numeric fields by name in order to perform mathematical 
operations. The following are all valid expressions:

 N1 + N2 + N3

 N1*(N2 - N3 +1) + ((N1 + N2 + N3)/3.09)

 N3^2 + N1

Example 2

Calculations may use the results of other calculations. A workpaper may contain two 
numeric (N1, N2) and two calculation fields (C1, C2) where:

C1 = N1 + N2
C2 = C1 * 1.1

C2 must always be calculated after C1 as the software will not automatically do this. 
Instead define a calculation sequence value, where:

 C1 has a sequence of 0 and C2 has a sequence of 1.

 lower sequence numbers allow their calculations to be performed before higher 
ones.

Example 3

Example of calculations in tables.

In the Designer only one row is visible:

In a workpaper each cell will have the same field names:

Header 1 Header 2 Header 3 Header 4

N1 N2 N3 C1=N1 + N2 + N3

Header 1 Header 2 Header 3 Header 4

N1 N2 N3 C1=N1 + N2 + N3

N1 N2 N3 C1=N1 + N2 + N3
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Example 4

Using the Days function (D1, D2):

D1 = 10/05/2012 
D2 = 17/05/2012 
then Days (D1, D2) = 7

Example 5

Using the FirstRow and Above functions:

If(FirstRow(), N1 + N2 - N3, Above (C1) + N2 - N3). 

This calculation enables running totals to be calculated.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

N1 N2 N3 C1=N1 + N2 + N3

N1

Row 1 N2 N3 C1 = N1 + N2 - N3

Row 2 N2 N3 C1 = C1 + N2 - N3

Row 3 N2 N3 C1 = C1 + N2 - N3
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Inserting a check box

Accountants Enterprise only

The Check box field is used to create a checklist in a practice template. Create a 
checklist to ensure that all factors have been considered when preparing a workpaper 
or to outline the procedure involved in preparing an entire workpaper file.

To insert a check box field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Check box.

5. Click OK.
The Check Box window opens.

6. Enter a Field name for the Check box field.
The Field name is automatically filled when the Check Box window opens. You 
can accept the default or overwrite it. The system will allocate the next 
sequential number prefixed by a X for check box fields.

If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the Display values.
There are two options:

 Tick

If this option is selected, a tick will be displayed in a check box when you 
select for a ‘yes’ response. Otherwise the check box will be blank.

 Tick and cross
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If this option is selected, a tick will be displayed in a check box for a ‘yes’ 
response, a cross for a ‘no’ response and blank if left unselected.

8. Select the Default value of the check box.
The available options are Blank (the default), Yes and No.

9. The Rollover value to next period checkbox is selected by default. 
This means that entered check box will be displayed in the same field in the next 
rollover period. 
Deselect the Rollover value to next period checkbox, if you do not want the 
check box value to be rolled over.

10. Click OK.
The Check box field is placed at the insertion point.
The Check Box window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting a data entry table

Accountants Enterprise only

The Data Entry Table is used when a workpaper requires an unlimited number of data 
entry lines. 

Plan and consider what data and information are to be included in your data entry 
table and how you want to set it out.
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Note: The number of columns in a Data Entry Table must fall within the range of 1 - 
15.
The number of rows in a Data Entry Table must fall within the range of 1 - 500.

To insert a data entry table in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new table is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Data entry table.

5. Click OK.
The Data Entry Table window opens.

6. Enter a Table name for the Data Entry Table field.
The Table name is automatically filled when the Data Entry Table window 
opens. You can accept the default or overwrite it. The system will allocate the 
next sequential number prefixed by a E for data entry tables.
If you decide to overwrite the default Table name, then enter a unique Table 
name. Conditions for the Table name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select the Top row is header option, if required.
If this option is selected then the first row of the data entry table is considered 
the header row.

8. Enter the Table column details.
The Table column details section contains three columns: Header, Data type 
and Required.

a. Edit the default entry that exists in the Table column details:
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 Select the Header cell and overtype the existing entry with a description of 
the field to be displayed in the practice template. 

 Select the Data type cell and select a data type from the drop-down. 

 Click the Required checkbox, if necessary.

If this option is selected, you must enter a value in this field or the data 
entry will be invalid.

b. To add another column:

 Click Add.

A new row is added to the Table column details.

 Edit the entries, as described above.

Note: The number of columns must fall within the range of 1 - 15.

c. To delete an entry:

 Select the entry to be deleted from the Table column details section.

 Click Delete.

The entry is deleted.

d. To view and edit the properties of a field:

 Select the field entry to be viewed from the Table column details section.

 Click Properties.

The appropriate window opens depending on the type of field selected.

 View and edit any details as required.

 If appropriate, select whether to Rollover to the next period.

 Click OK.

You are returned to the Data Entry Table window.

e. To organise the columns:

 Select the entry that needs to be moved in the sequence.

 Click the up or down arrow until the entry is positioned where required.

9. The Rollover to next period checkbox is selected by default. 
This means that selected table contents will be displayed in the next rollover 
period. If you have not deselect any Rollover value to next period checkboxes 
for individual columns, all data within the data entry table is rolled over to the 
next period.



AE, AU, NZ PM Client Accounting User Guide | 272

Deselect the Rollover value to next period checkbox, if you do not want data in 
the data entry table to be rolled over.

10. Click OK.
The Data Entry Table is placed at the insertion point.
The Data Entry Table window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting a date

Accountants Enterprise only

To insert a date field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.
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4. Select Date.

5. Click OK.
The Date window opens.

6. Enter a Field name for the Date field.
The Field name is automatically filled when the Date window opens. You can 
accept the default or overwrite it. The system will allocate the next sequential 
number prefixed by a D for date fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Select how the date will be entered. 
There are two options:

 User entered date

You will enter the date in the workpaper on completion.

 Automatic date of

The date can be generated automatically based on the selected criteria 
from the drop-down. The date can be automatically generated based on 
Today’s date, the Period start date, the Period end date, the Date of 
approval or the Date of preparation.

8. If the User entered date option is selected, then the Rollover value to next 
period checkbox is selected by default. 
This means that entered date will be displayed in the same field in the next 
rollover period. 
Deselect the Rollover value to next period checkbox, if you do not want the 
date value to be rolled over.

9. Click OK.
The Date field is placed at the insertion point.
The Date window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
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Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting a document link

Accountants Enterprise only

When inserting document links into a customised practice template, we 
recommended that document links are added into a data entry table. See “Inserting 
a data entry table” on page 269. Configure the data entry table to have 2 columns 
with one column labelled ‘Description’ and the other column labelled ‘Links’. 

If document links are added to a customised practice template, then the document 
link is persistent and cannot be edited or deleted. But if the document link is added 
as part of a data entry table in the customised practice table, then the link can be 
manipulated (edited, deleted) and multiple document links can be added as required.

To insert a document link field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Document link.

5. Click OK.
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The Document link window opens.

6. Enter a Field name for the Document link field.
The Field name is automatically filled when the Document link window opens. 
You can accept the default or overwrite it. The system will allocate the next 
sequential number prefixed by a L for document link fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. The Rollover value to next period checkbox is selected by default. 
This means that entered document link will be displayed in the same field in the 
next rollover period. 
Deselect the Rollover value to next period checkbox, if you do not want the 
document link to be rolled over.

8. Click OK.
The Document Link field is placed at the insertion point.
The Document link window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties



AE, AU, NZ PM Client Accounting User Guide | 276

Customising practice templates

Inserting a number

Accountants Enterprise only

To insert a number field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Select Number.

5. Click OK.
The Number window opens.

6. Enter a Field name for the Number field.
The Field name is automatically filled when the Number window opens. You can 
accept the default or overwrite it. The system will allocate the next sequential 
number prefixed by a N for number fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It must not start with a number, as this affects the calculations. 

 It must not contain any spaces. 

 It may contain an underscore as part of the name. 

 It is not case sensitive.

7. Enter the Default value for the number field.
The default value is 0.00.

8. Select the Format of the displayed number field from the drop-down.
The Number - 2 decimal places and the Number - no decimal options display 
with no formatting and no commas e.g., 2478.55. The Currency option displays 
the account balance with a thousands separator and a currency value as set by 
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the regional settings, e.g., $2,478.55. With all options, negative numbers are 
displayed with a leading minus sign, e.g., -2478.55. 

9. Tick the Include comma separators checkbox if you want to include a comma as 
a thousands separator.

10. Select the Show this number when zero option, if required.

11. Select the This number is part of the Workpaper’s journal option, if required.
If this option is selected, when you prepare a workpaper and select to create a 
journal, the amount will be automatically included in the new journal. Any 
number fields that have this option selected will be listed in the journal.
This option is most commonly used for the variance field so that a journal can be 
created automatically from the variance amount.

Note: Several fields in a single workpaper can be used to create 
workpaper journals.

12. If you have selected the This number is part of the Workpaper’s journal option, 
and you want to include quantities rather than an actual balance (for example, 
for farm accounting):

a. Click the Edit journal settings... button.

The Edit journal settings window displays.

b. In the Account section, select the Post to the linked account option or 
select an account from the Post to the account selected in this field 
dropdown, depending on where you want the amount to be posted.

c. Select the Post as quantity option in the Balance type section.

d. Click OK.

13. Select the Rollover value to next period checkbox, if required.
This checkbox is selected by default. This means that the number fields of the 
template have been flagged to be rolled over. You can select which number field 
will be rolled forward.

14. Select the appropriate Rollover value to next period option:

a. Same number field 

The number amount will be rolled over to the same number field. 

b. Select another number field

Select the appropriate field, that will display the number amount in the next 
period, from the drop-down.
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15. (Australia) If this calculation is to be mapped to a Tax Return field, select Field to 
be mapped to Tax Return.
The Tax Return field mapping code field is editable. Select the Tax Return field 
mapping code.

16. Click OK.
The Number field is placed at the insertion point.
The Number window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting text

Accountants Enterprise only

To insert a text field in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new field is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
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The Insert Field window opens.

4. Select Text.

5. Click OK.
The Text window opens.

6. Enter a Field name for the Text field.
The Field name is automatically filled when the Text window opens. You can 
accept the default or overwrite it. The system will allocate the next sequential 
number prefixed by a T for text fields.
If you decide to overwrite the default Field name, then enter a unique Field 
name. Conditions for the Field name:

 It is limited to a maximum of 30 alphanumeric characters. 

 It cannot start with a number, as this affects the calculations. 

 It cannot contain any spaces. 

 It can contain an underscore as part of the name. 

 It is not case sensitive.

7. Select how the text will be entered. 
There are two options:

 User entered text

You will enter the text when preparing the workpaper. You can enter a 
Default value or leave it blank. The Default value is displayed when the 
client workpaper is first created, but it can be overridden while preparing 
the workpaper.

 Automatic information of

The information for the text field can be automatically inserted based on 
the selected option from the drop-down. The automatic text options are 
Approved by user, Client name, Page number, Page count, Period date 
range, Practice name, Prepared by user, Source document details (for 
MYOB use only) and Workpaper name.

8. The Rollover value to next period checkbox is selected by default. 
This means that entered text value will be displayed in the same field in the next 
rollover period. 
Deselect the Rollover value to next period checkbox, if you do not want the text 
value to be rolled over.

9. Click OK.
The Text field is placed at the insertion point.
The Text window and the Insert Field window close.
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Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting a text display table 

Accountants Enterprise only

You are able to add a text display table to a practice template. A text display table is 
similar to a Microsoft Word table. A text display table only allows a limited number of 
entry lines whereas a Data Entry Table allows an unlimited number of data entry lines. 

Plan and consider what data and information are to be included in your text display 
table and how you want to set it out.

Note: The number of columns in a text display table must fall within the range of 1 
- 15.
The number of rows in a text display table must fall within the range of 1 - 100.

To insert a text display table in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new table is to be 
inserted.

3. Select Table > Insert > Table on the main menu.
The Insert Table window opens.
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4. Enter the number of rows of the text display table.
Or select the number of rows using the adjacent arrows.

Note: The number of rows in a text display table must fall within the range 
of 1 - 100.

5. Enter the number of columns of the text display table.
Or select the number of columns using the adjacent arrows.

Note: The number of columns in a text display table must fall within the 
range of 1 - 15.

6. Click OK.
The text display table is added at the insertion point in the practice template.

7. Additional rows and columns can be added to the text display table using Table 
> Insert on the main menu. 
Ensure that your mouse cursor is positioned within the table so that the options 
of adding columns and rows are enabled.

8. Insert other fields into the cells of the text display table, as required.

9. Save the practice template.

10. Close the practice template.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Deleting a text display table
Adding columns or rows to a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
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Deleting fields
Viewing and editing field properties

Adding columns or rows to a text display table

Accountants Enterprise only

Extra columns can only be added to a table if with the addition, the table does not 
become too large for the width of the template page. If the table does become too 
large for the template page, a warning message is displayed and the extra columns 
will not be added to the template.

Only one column or row can be added at any one time. To add more than one column 
or row, you must repeat the procedure below.

To add a column to a text display table

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Insert a text display table.
See “Inserting a text display table” on page 280.

3. Place the cursor in a cell of the table where the column is to added either to the 
left or right.

4. Insert a column:

a. Select Table > Insert > Column to the left, if the column is to be added to 
the left of the selected cell.

b. Select Table > Insert > Column to the right, if the column is to be added to 
the right of the selected cell.

An additional column is inserted either to the left or right of the selected cell.

To add a row to a text display table

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Insert a text display table.
See “Inserting a text display table” on page 280.

3. Place the cursor in a cell of the table where the row is to added either below or 
above.

4. Insert a row:
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a. Select Table > Insert > Row above, if the row is to be inserted above the 
selected cell.

b. Select Table > Insert > Row below, if the row is to be insert below the 
selected cell.

An additional row is inserted either above or below the selected cell.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
Deleting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Deleting a text display table

Accountants Enterprise only

To delete a text display table

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in a text display table.

3. Select Table > Delete > Table on the main menu.
The text display table is deleted.
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Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
Deleting columns or rows from a text display table
(Australia) Inserting an Assets - GL reconciliation table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Deleting columns or rows from a text display table

Accountants Enterprise only

To delete a column or row from a text display table

1. Open the practice template for editing.

See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in a cell of a text display table that is to be deleted.

3. To delete a column:

a. Select Table > Delete > Column on the main menu.
The column is deleted from the text display table.

4. To delete a row:

a. Select Table > Delete > Row on the main menu.
The row is deleted from the text display table.

Related topics
Inserting an account amount
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Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a data entry table
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
(Australia) Inserting an Assets - GL reconciliation table
Deleting fields
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Inserting an Assets - GL reconciliation table

Accountants Enterprise in Australia only

This is a combination of several pre-populated data entry tables that are specifically 
designed for assets to general ledger reconciliation.

To insert an Assets - GL reconciliation table in a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the practice template where the new table is to be 
inserted.

3. Click Insert Field on the toolbar.
or 
Select Insert > Field on the main menu.
The Insert Field window opens.

4. Click the Other components tab.

5. Select Assets - GL reconciliation.

6. Click OK.
The Data Entry Table window opens.
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Note: The Table name, Table column details and field properties are all 
automatically defined and pre-populated. You do not need to 
modify these values.

7. The Rollover to next period checkbox is selected by default. 
This means that selected table contents will be displayed in the next rollover 
period. If you have not deselect any Rollover value to next period checkboxes 
for individual columns, all data within the data entry table is rolled over to the 
next period.
Deselect the Rollover value to next period checkbox, if you do not want data in 
the data entry table to be rolled over.

8. Click OK.
The Asset - GL reconciliation table is placed at the insertion point.
The Data Entry Table window and the Insert Field window close.

Related topics
Inserting an account amount
Inserting an account code or description
Inserting an Account group amount
Inserting a calculation
Inserting a check box
Inserting a date
Inserting a document link
Inserting a number
Inserting text
Inserting a text display table
Workpaper template designer
Main menu and toolbar options
Formatting tables
Deleting fields
Viewing and editing field properties

Formatting tables

Accountants Enterprise only

As the format of the templates relies on the use of tables, it is recommended that a 
text display table is used to align the columns of a data entry table. Once the data 
entry table is formatted, the text display table is deleted.
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If you add a table into your practice template, it will be displayed with no borders. You 
will have to add any borders that you require.

If your practice has documentation standards that require corporate colours for 
tables, these can be added to any table.

Aligning a data entry table using a text display table

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor below the data entry table.

3. Press [Enter].
To add a new blank line.

4. Select Table > Insert > Table on the main menu.
The Insert Table window opens.

5. Change the number of Rows and Columns to what is required for your data 
entry table.

6. Click OK.
The Insert Table window closes. The text display table is inserted at the cursor 
position.

7. Resize each of the columns so that they align with the columns of the blank text 
display table.

8. Save the template.

9. Position the mouse cursor inside the text display table that was used as a ruler 
to format the data entry table.

10. Select Table > Delete > Table on the main menu.
The text display table that was used as a ruler is deleted.

11. Save the template.

Adding table borders

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Select all the cells of the table.

3. Select Format > Table on the main menu.
The Table Properties window opens.
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4. Select the All borders option in the Frame section.

5. Click OK.
The Table Properties window closes.

6. Save the template.

Using colours in tables

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Position the mouse cursor in the cell of the table that is to be coloured.
Or highlight a number of cells.

3. Select Format > Table on the main menu.
The Table Properties window opens.

4. Click the Other button in the Background section.
The Color palette opens.

5. Make your selection.
Click Define Custom Colors to further define your practice standard colours.

6. Click OK.
The Color palette closes.

7. Click OK.
The Table Properties window closes.

8. Save the template.

Related topics
Opening a practice template for editing
Customising practice templates
Viewing and editing field properties
Main menu and toolbar options
Deleting fields
Workpaper template designer

Deleting fields

Accountants Enterprise only
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To delete a field from a practice template

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Select the field to be deleted.

3. Click Delete Field on the toolbar.
The Confirm field deletion window opens.

4. Click Yes.
The selected field is deleted.

5. Save the template

Related topics
Opening a practice template for editing
Customising practice templates
Formatting tables
Main menu and toolbar options
Viewing and editing field properties
Workpaper template designer

Viewing and editing field properties

Accountants Enterprise only

To view and edit field properties

1. Open the practice template for editing.
See “Opening a practice template for editing” on page 244.

2. Select the field to be viewed or edited.

3. Click Field Properties on the toolbar.
The selected field window opens.

Tip: You can also double-click the field to open the selected field 
properties window.

4. View the field properties and edit as required.
See the appropriate section in “Customising practice templates” on page 249.

5. Click OK.
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Related topics
Opening a practice template for editing
Customising practice templates
Formatting tables
Main menu and toolbar options
Deleting fields
Workpaper template designer
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Assets
MYOB Assets Live is a desktop application that stores and accesses data in the cloud. 
It is included as a module of MYOB AE/AO Client Accounting. An internet connection 
is required to use MYOB Assets Live. It can be used in non-integrated or integrated 
mode with a general ledger. 

MYOB Assets Live enables you to manage an asset register for taxation purposes only. 
You must configure your MYOB AE/AO online services to access your online data. See 
Practice my.MYOB settingsPractice my.MYOB settings and Setting up my.MYOB logins 
for your practiceSetting up my.MYOB logins for your practice.

The key functions of MYOB Assets Live are:

 multi-year support

 add and edit assets

 list all assets that are held or sold for a client

 group assets into categories

 calculate depreciation for taxation purposes

 calculate depreciation for accounting purposes

 include private use percentages

 calculate the profit / loss / (Australia) capital gains on the sale of an asset

 submit journals to post to the underlying general ledger

 generates Tax schedule and Journal summary reports 

 (Australia) generates a small business pool schedule and/or a low value pool 
schedule

 (Australia) calculates depreciation for assets in a small business or low value 
pool 

 can only be used with clients (not contacts or suppliers) that are either open or 
closed.

Note: Only one asset register can be created for a client.

General ledgers compatible with MYOB Assets Live

 AccountRight 19 or earlier

 AccountRight 2013.0 or later

 MAS general ledger

 (Australia) Accounts general ledger

 MYOB AO Classic general ledger

 Essentials — Accounting and Connected ledgers.

 AE Ledger

../Practice_Manager/Practice_my.MYOB_settings.htm
../MYOB_AO_PM/Practice_my.MYOB_settings.htm
../Practice_Manager/Setting_up_my.MYOB_logins_for_your_practice.htm
../Practice_Manager/Setting_up_my.MYOB_logins_for_your_practice.htm
../MYOB_AO_PM/Setting_up_my.MYOB_logins_for_your_practice.htm
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 AO Ledger.

Related topics
About depreciation
Accessing an asset register
Assets tab
Getting started
Control groups
Asset years
Creating a new asset location
Creating an asset
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About depreciation
The following depreciation methods are used in MYOB Assets Live:

Note: (New Zealand) For Taxation purposes, depreciation is calculated on a monthly 
basis. For Accounting purposes, depreciation is calculated on a daily basis.

 Prime Cost depreciation is calculated as a percentage of the original cost and 
reduces the asset value to zero. If a depreciation limit is applicable to an asset, 
the limit is applied in taxation depreciation calculations. For assets whose 
original cost has been offset by balancing charges, the adjusted original cost will 
be used in taxation depreciation.

This depreciation method is not applicable to New Zealand for taxation 
purposes.

 (Australia) Straight Line depreciation is similar to Prime Cost depreciation, but 
the value of the asset depreciates using Prime Cost calculations to the salvage 
value rather than zero. If a depreciation limit is applicable to the asset, the limit 
is applied in taxation depreciation calculations. For assets whose original cost 
has been offset by balancing charges, the adjusted original cost will be used in 
taxation depreciation.

(New Zealand) Straight Line depreciation depreciates an asset every year by the 
same amount, which is a percentage of its original cost price. This method is 
sometimes called the cost price basis. In other words, in this method 
depreciation is worked out on the purchase price of the asset and the same 
amount is claimed each year.

 Diminishing Value depreciation is calculated on the asset’s opening written 
down value. If a depreciation limit is applicable, the asset’s opening written 
down value (for the purpose of calculating taxation depreciation) will equal the 
depreciation limit value less the accumulated depreciation.

 Immediate Write Off depreciation is calculated as equal to the original cost of 
the asset. In essence, the asset is written off at the end of the current period or 
the financial year the depreciation starts.

 (Australia) Units of Usage depreciation is calculated as a fraction of the current 
usage over maximum usage of the asset’s original cost.

 (Australia) Replacement Cost depreciation is calculated as a percentage of the 
asset’s replacement cost.

What MYOB Assets Live does

 Calculates the depreciation for each asset using the appropriate depreciation 
method for taxation and accounting.

 records depreciation journals for each asset. Where the ledger is configured to 
post entries to a general ledger, depreciation journals are posted for each Asset 
Control Group.

The depreciation journal includes:
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 Debit depreciation expense account

 Credit accumulated depreciation.
The private use depreciation journal includes:

 Debit Private Use balance sheet account

 Credit Private Use profit and loss account.

 If the asset has private use, this amount is calculated using the private use 
percentage.

Depreciation is calculated when you

 add an asset

 edit an asset

 (Australia) allocate or de-allocate assets to small business or low value pools

 sell an asset

 reverse the sale of an asset

 transfer an asset

 make a balancing adjustment

 add a new year.

Related topics
Accessing an asset register
Assets tab
Getting started
Control groups
Asset years
Creating a new asset location
Creating an asset
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Accessing an asset register
To access a client asset register

1. Find and select the client.

2. Click the Client Accounting tab.

3. If necessary, configure the financial data source for the client.
See “Configuring the client” on page 23 and “Configuring accounting product 
locations” on page 37.

4. Click the Asset tab.
The Asset Register is displayed.
If the client does not have an asset register, a blank asset register is 
automatically created.
When a blank asset register is created for a client, then:

 the depreciation calculation is for accounting and taxation purposes

 the journal entries are generated for taxation purposes (or accounting 
purposes in New Zealand — default is taxation)

 the status of the asset register is Blank

 Financial start month = 01/07 of the current year for Australia, 01/04 of the 
current year for New Zealand

 Financial end month = 30/06 of the following year for Australia, 31/03 of 
the following year for New Zealand

 it is in integrated mode.

Related topics
Assets tab
Configuring the asset register settings
Control groups
Asset years
Creating a new asset location
Creating an asset

Assets tab

MYOB Assets Live is used to create, manage and monitor assets to produce 
depreciation rates for accounting and taxation purposes.

Note: All the information displayed within the Assets tab is read only.
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The Assets tab is divided into two main areas:

Select year

The available fields in the Select year section of the Assets tab are explained in the 
following table.

General ledger details

The available fields in the General ledger section of the Assets tab are explained in 
the following table.

Field Description

Year end The year created for the asset register.
•  Multiple years are listed in descending order (i.e., 

with future years at the beginning of the list 
followed by prior years).

•  If MYOB Assets Live is in integrated mode and the 
asset year corresponds to the general ledger year, an 
asterisk (*) is displayed after the year.

Start date The start date of the created year for the asset register. 

End date The end date of the created year for the asset register.

Migration status The migration status for the selected year.
If the asset register has not been migrated, then the 
Migration status field is blank.

Status The status for the year is displayed:
•  When a new year is created for the asset register, 

the status of the year is No transaction.
•  When new assets are added or sold or transferred 

for the year, the status for the year is changed to In 
progress.

•  The status is changed to Finalise when you close or 
lock a created year.
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Related topics
Configuring the asset register settings
Control groups
Asset years
Creating a new asset location
Creating an asset

Field Description

General ledger status The status of the general ledger depends on whether it 
is supported or not by MYOB Assets Live:
•  If the configured general ledger is a supported 

general ledger, the general ledger name is 
displayed.

•  If the general ledger has not been configured, then 
the status is displayed as Not configured.

•  If the general ledger is not supported or none, then 
the status is displayed as Not supported.

Integration status This field displays the integration status between 
MYOB Assets Live and the general ledger. 
The integration status is:
•  Yes, if the configured general ledger is supported 

and the Integrate with the supported general 
ledger checkbox is selected in the Register settings 
window.

•  No, if the configured general ledger is supported 
and the Integrate with supported general ledger 
checkbox is not selected in the Register settings 
window.

•  No, if the general ledger is not supported.
•  No, if the general ledger is not configured.
•  No, if a general ledger is not available.

General ledger start date The general ledger start date for the current year is 
taken from the configured and supported general 
ledger. 
If the general ledger is not supported or configured, 
this field is not displayed.

General ledger end date The general ledger end date for the current year is 
taken from the configured and supported general 
ledger. 
If the general ledger is not supported or configured, 
this field is not displayed.
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Getting started
Once you have enabled the Assets tab and configured MYOB online services you are 
ready to use MYOB Assets Live. When you first start using MYOB Assets Live, use the 
following workflow as a guide: 

1. Accessing an asset register

2. Configuring the asset register settings

3. Adding the first asset year

4. Creating a control group

5. Opening an asset year

6. Creating a new asset location

7. Creating an asset

8. Adding successive asset years

Configuring the asset register settings

You must configure the Financial year details for the first year of the asset register. 
The financial year is a 12-month period. 

Note: The financial year details for an asset register cannot be edited in successive 
years.

To configure the asset register settings

1. Open the client’s Client Accounting > Assets tab.
See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Click Register settings on the Tasks bar.
The Register settings window opens.

3. Select the appropriate start of the financial year from the Start month drop-
down.

Note: You can only change the financial year details if no asset year has 
been created, i.e., when the asset register status is blank. If the 
asset year has already been created then the Start month and End 
month fields are read only. 

The End month is automatically calculated 11 months from the start month.
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4. Select the type of depreciation calculation by ticking the relevant checkbox:

 Taxation only

 Accounting only

 Accounting and Taxation.

5. Select whether the asset register will Integrate with the supported general 
ledger by ticking the checkbox.

Note: You can also use the asset register in non-integrated mode, i.e., it 
does not have to be integrated with a general ledger.

If you are in non-integrated mode, the Integrate with the supported general 
ledger checkbox will not be available.

6. Select what entries will be generated from depreciation calculations. If the type 
of depreciation is:

 Taxation only, then depreciation calculations will generate taxation entries 
automatically

 Accounting only, then depreciation calculations will generate accounting 
entries automatically

 Accounting and Taxation, then the default will be to calculate depreciation 
for taxation but you can change this to accounting.

7. Click OK.
Changes are saved to the asset register and the Register Settings window 
closes.

Related topics
Editing asset register settings
Control groups
Creating a control group
Editing a control group
Deleting a control group
Adding the first asset year
Opening an asset year
Creating a new asset location
Creating an asset
Getting started
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Editing asset register settings

The Register Settings window is the only place where you can select to use MYOB 
Assets Live in integrated or non-integrated mode.

Any changes in the register settings will impact the depreciation calculation and 
entries generated for the current year. 

The depreciation calculation entries can be posted as Taxation or Accounting 
journals.

Note: You can only edit the Financial year details for the asset register in the year it 
was created. 
You will not be able to edit the Financial year details in future years. 

To edit the asset register settings

1. Open the Register Settings window.
There are 2 ways to do this:

 Select Register settings on the Tasks bar of the Asset Register.
or

 Select Maintenance > Register settings on the main menu of the Assets 
Listing page.

2. Make the changes as required. See “Configuring the asset register settings” (see 
page 298). 

3. If the type of depreciation is changed from Taxation only or Accounting only to 
Accounting and Taxation then:

 The Accounting details will default from the Taxation details. 

 (Australia) if the Taxation details show the assets in either a low value or 
Small business pool then the Accounting details will show the Asset type as 
General Asset.

Alternatively, if the type of depreciation is changed from Accounting only to 
Accounting and Taxation then the Taxation details default from the Accounting 
details. 
In either case, the Depreciation Method will be Prime Cost.

4. Click OK.
Changes are saved to the asset register and the Register Settings window 
closes.

Related topics
Configuring the asset register settings
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Control groups
Asset years
Creating a new asset location
Assets Listing page
Creating an asset
Managing assets

Deleting an asset register

You can delete an entire asset register. 

Note: You cannot delete an asset register if an asset year is currently open.

An asset register with the status of No transaction can be deleted. This means that 
the asset register contains no added assets.

To delete an asset register

1. Open the client’s Client Accounting > Assets tab.
The Asset Register is displayed.

2. Click Delete register on the Tasks bar.
You are prompted with a message —
Are you sure that you want to delete ALL the data within the asset register? Data 
is permanently deleted and cannot be restored.

3. Two options are available:

a. Click Yes.

All the data created in the asset register for the client is deleted.

The status of the asset register is changed to blank.

The register settings remain as previously defined, they do not revert to the 
default settings.

If data migration was initiated, the status is reset and the migration status is 
not displayed and all migrated data is deleted.

b. Click No.

The message is closed and data in the asset register is not deleted.

Related topics
Configuring the asset register settings
Control groups
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Asset years
Creating a new asset location
Assets Listing page
Creating an asset
Managing assets

Asset years

An asset year is the financial year for your practice. Once the asset register settings 
have been configured you can:

 “Adding the first asset year” (see page 302)

 “Adding successive asset years” (see page 303)

 “Opening an asset year” (see page 304)

 “Deleting an asset year” (see page 304).

Adding the first asset year

To add the first asset year

1. Open the client’s Client Accounting > Assets tab.
See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Click Add year on the Tasks bar.

The Add Year window opens.

3. Enter the Year end.
The entered year is the period end for the asset register. 
The Year end field is limited to a maximum limit of 4 digits. This field must not 
be blank.
Start date field displays the start date for the year. The Start date is 
automatically generated when the year is entered based on first day of the 
Financial year details defined in the Register Settings window. 
End Date field displays the end date for the year. The End date is automatically 
generated when the year is entered based on the last day of the Financial year 
details defined in the Register Settings window.
If you are in integrated mode:

 the Start date and End date are the taken from the start and end dates of 
the general ledger.
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 the Year end value is taken from the general ledger.
If you are in non-integrated mode, the Year end value is the current year based 
on the current date.

4. Click Add.
The Add Year window closes. A new year is created. The year is displayed in the 
Select year table of the Assets Register.

Related topics
Asset years
Adding successive asset years
Deleting an asset year
Opening an asset year
Control groups
Creating an asset
Assets Listing page
Getting started

Adding successive asset years

When adding successive asset years, you effectively roll forward the asset register 
from the current year to the following year.

Note: In order to be able to add a successive asset year, you must ensure that the 
first asset year has been created.

To add successive asset years

1. Open the client’s Client Accounting > Assets tab.
See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Click Add year on the Tasks bar.
The next successive year is automatically created and displayed in the Select 
year table of the Asset Register. 
All the contents of the previous year are included in the next successive year 
that is created.

Related topics
Asset years
Adding the first asset year
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Opening an asset year
Deleting an asset year
Control groups
Creating an asset
Assets Listing page
Managing assets

Opening an asset year

There are 2 ways to open an asset year:

1. Double-click a year entry in the Select year table of the Assets tab.

2. Select the year in the Select year table of the Asset Register, then click Open 
year on the Tasks bar.
The Assets Listing page of the client’s selected year is opened.

Related topics
Asset years
Adding the first asset year
Adding successive asset years
Deleting an asset year
Control groups
Creating an asset
Assets Listing page
Getting started

Deleting an asset year

You cannot delete an asset year if:

 future years are available

or

 the Assets Listing page for that year is open.

To delete an asset year

1. Open the client’s Client Accounting > Assets tab.
See “Accessing an asset register” on page 295.
The Assets Register is displayed.

2. Select the year from the Select year table.
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3. Click Delete year on the Tasks bar.
You will be prompted with a message to confirm the deletion.

4. Click Yes.
The asset year is deleted and is no longer displayed in the Select year table of 
the Asset Register.

Related topics
Asset years
Adding the first asset year
Opening an asset year
Deleting an asset year
Control groups
Creating an asset
Assets Listing page
Managing assets

Control groups

An asset control group is the link between the asset register and the general ledger. 
Control groups enable you to organise assets with common characteristics together, 
e.g., cost limit, default depreciation rates and methods, private use percentage, etc. 
This is also where you set up the general ledger accounts that are later used when 
generating the journal entries (see “Journal summary - Taxation” on page 421). 

Asset control groups must be configured before assets can be added.

Common types of control groups are:

 (Australia) Motor vehicles — Tangible fixed assets such as vans, trucks and cars 
that are used for the operation of a business. 

 Plant and equipment — Plant applies to assets held within a workplace such as 
a factory or warehouse. Equipment applies to the assets within the plant that 
are used to generate revenue. 

 Office furniture and equipment — Office furniture applies to assets used within 
the office environment whether by employees being productive or business 
clients providing the business with income. Equipment applies to the assets 
contained within the office environment such as photocopiers and computers 
that are used in the course of business operations.

Control group template

To assist with setting up control groups quickly for a register you can load a previously 
saved template. See “Control group templates” on page 321.
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Rules when creating control groups

The following rules apply when creating control groups:

 A control group must only map to one general ledger account code. That is, you 
cannot have 2 or more control groups with the same Account code and account 
Name.

 A control group name must be entered. This is a mandatory field.

 The control group name must be unique.

 A control group can only be mapped to a detail account in your general ledger. 
You cannot map a control group to a header account. 

Once an Account code and Name have been selected and you have pressed [Enter], 
the fields should be entered in the active tabs for Taxation and Accounting. Either or 
both these tabs will be active according how the Asset Register is configured. The 
details include:

 Depreciation defaults which set the default method and rates assigned to each 
new assets in this control group. 

 Integrated accounts. These are the general ledger chart of account settings that 
will be used when the journal entries are created in the Journal Report. 

Control group templates 

The details of a control group you have just entered can be saved as a template. The 
templates can be re-used to facilitate creating other control groups. See “Control 
group templates” on page 321.

Related topics
Maintain Control Group window - Control group fields
Maintain Control Group window - Taxation tab fields
(AE) Maintain Control Group window - Accounting tab fields
Configuring the asset register settings
Creating a control group
Editing a control group
Deleting a control group
Adding the first asset year
Control group templates

Maintain Control Group window - Control group fields

The control group fields in the Maintain Control Group window:
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Buttons

Field Description

Account code This field displays the general ledger account code that will be 
used for the control group.
Only Balance Sheet accounts can be selected.
This is a mandatory field and must not be blank.

Name This is the unique name of the control group. It is a mandatory 
field.
The Name field is limited to a maximum of 50 alphanumeric 
characters.

Private use % The percentage of the asset control group value that is for private 
use.
The default value is 0.00.
Private use % is a percentage field with a range between 0 and 
100. It is limited to 5 digits including 2 decimal places.

Mapping 
status

The last column identifies whether the control group has been 
mapped to the general ledger or not. Two icons identify the 
mapping status:

 indicates that the control group has been mapped to general 
ledger account(s).

 indicates that the control group has not been mapped to 
general ledger account(s).

Button Description

Delete To delete a selected control group.

Save To save a newly created control group or to save changes 
made to an existing control group.

Close To close the Maintain Control Group window.

Save as template To save the information for a selected control group as a 
template, so that you do not have to enter all the information 
again. The related chart of account settings and depreciation 
defaults are saved. 
(Australia) The chart of account settings will also be saved for 
any small business or low value pool.
See “Control group templates” on page 321.
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Related topics
Maintain Control Group window - Taxation tab fields
Maintain Control Group window - Accounting tab fields
Creating a control group
Editing a control group
Deleting a control group
Adding the first asset year
Control groups
Control group templates

Maintain Control Group window - Taxation tab fields

The Taxation tab will be active in the Maintain Control Group window if the type of 
depreciation calculation selected in the Asset Register window is:

 Taxation only

 Accounting and Taxation.

The Taxation tab fields in the Maintain Control Group window are:

Depreciation defaults fields

Load template To use the information stored in an existing template to 
populate the fields of the Maintain Control Group window.
See “Control group templates” on page 321.

Button Description

Field Description

Depreciation 
method

Select the appropriate method for the control group from the 
drop-down. The available options are:
•  Diminishing value (default)
•  (AE Australia) Exempt from depreciation
•  Immediate write-off
•  (Australia) Prime cost
•  Straight line.

Motor vehicle
(Australia)

If the control group includes motor vehicles, select the Motor 
vehicle checkbox.
By default, the checkbox is not selected.
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Calculate depreciation using fields

The following are used as defaults when creating general assets.

(Australia) Any assets in a small business or low value pool will have the relevant rates 
and thresholds applied by MYOB Assets Live as defined by the ATO (this may vary 
from year to year).

Cost limit
(Australia)

Enter the cost limit for the motor vehicle. 
The default value is 0.00. 
The Cost limit field is limited to 16 digits including 2 decimal 
places.
The Cost limit field is only available if the Motor vehicle 
checkbox is selected.
This is only used as a default when creating general assets.
Any assets in a small business or low value pool will have the 
relevant cost limit applied by MYOB Assets Live as defined by 
the ATO (this may vary from year to year).

Field Description

Useful life
(Australia)

Enter useful life in years to calculate depreciation rate for 
depreciation method Straight line. Useful life is enabled only 
when straight line method is chosen.

Effective life
(Australia)

When the Effective life option is selected, the depreciation 
rate is calculated based on the entered years and months.
This option is selected by default.

Years
(Australia)

The Years field is only available if the Effective life option is 
selected.
This field displays the number of years defined as the default 
for the control group.
This field is limited to a value between 0 and 999.

Months
(Australia)

The Months field is only available if the Effective life option is 
selected.
This field displays the number of months defined as the 
default for the control group.
This field is limited to a value between 0 and 12 inclusive.

ATO 
commissioner’s 
effective life
(Australia)

The ATO commissioner’s effective life checkbox is selected if, 
you want to use the effective life of a depreciating asset as 
determined by the ATO’s Commissioner.

Field Description
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Integrated account fields

The following are the general ledger accounts associated with each control group and 
are used when creating the journals. See “Searching accounts” on page 324.

Depreciation rate
(Australia)

When this option is selected, the depreciation rate is 
calculated based on a defined rate that you enter in the Rate 
year 1 and/or Rate year 2+ fields.

(Australia) Rate 
year 1
(New Zealand) 
Rate year

This field is only available if the Depreciation rate option is 
selected.
This is a percentage field which is limited to 6 digits including 
2 decimal spaces.
The default value is 0.00. This field must contain a value 
between 0 and 100%.

Rate year 2+
(Australia)

The Rate year 2+ field is only available if the Depreciation 
rate option is selected.
This is a percentage field which is limited to 6 digits including 
2 decimal spaces.
The default value is 0.00. The Rate year 2+ field must contain 
a value between 0 and 100%.

Find Rate
(New Zealand)

This hyperlink opens the IRD Depreciation rate finder 
website. The link only appears when Straight line or 
Diminishing value is selected as the Depreciation method.

Field Description

Realisation Select the realisation account where the sale proceeds 
(credits) were originally coded to, in the general ledger (i.e., 
when you were coding the bank statements). 
When an asset is sold in the asset register, a journal will be 
created debiting the realisation account. 
Once all the relevant assets have been sold in the asset 
register, and all the journals have been posted, the realisation 
account should be zero in the general ledger.

Profit on sale Select the Profit on sale account where the profit amount 
from an asset sale will be posted.

Loss on sale Select the Loss on sale account where the loss amount from 
an asset sale will be posted.

Field Description
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Related topics
About accounts
Maintain Control Group window - Control group fields
Maintain Control Group window - Accounting tab fields
Creating a control group
Editing a control group
Deleting a control group
Adding the first asset year
Control groups
Control group templates

Maintain Control Group window - Accounting tab fields

The Accounting tab will be active in the Maintain Control Group window if the type 
of depreciation calculation selected Asset Register window is:

 Accounting only, or

 Accounting and Taxation.

The Accounting tab fields in the Maintain Control Group window are:

(Australia) Capital 
gain (Taxation)
(New Zealand) 
Capital gain

Select this account where the calculated capital gain of the 
asset sale will be posted.

(Australia) Private 
use (P&L)
(New Zealand) 
Private use

This account is where the private use proportion of 
depreciation will be posted to.
This only applies to general assets and immediately 
deductible assets. 
(Australia) For pooled assets (i.e., assets in a low value pool or 
small business pool), private use works differently, and there 
is another Private use account. See “Small business pool 
summary” on page 376 and “Low value pool summary” on 
page 375.

Depreciation 
expense

Select the Depreciation expense account where any expenses 
related to the depreciation of assets in the control group will 
be posted.

Accumulated 
depreciation

Select the Accumulated depreciation account where the 
calculated accumulated depreciation of the assets in the 
control group will be posted.

Field Description
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Depreciation default fields

Calculate depreciation using fields

The following are used as defaults when creating general assets.

Field Description

Depreciation 
method

Select the appropriate depreciation method for the control 
group from the drop-down. The available options are:
•  Diminishing value (default)
•  (AE Australia) Exempt from depreciation
•  Prime cost
•  (AE Australia) Straight line.

Motor vehicle
(Australia)

If the control group includes motor vehicles, select the Motor 
vehicle checkbox.
By default, the checkbox is not selected.

Cost limit
(Australia)

Enter the cost limit for the motor vehicle. 
The default value is 0.00. 
The Cost limit field is limited to 16 digits including 2 decimal 
places.
The Cost limit field is only available if the Motor vehicle 
checkbox is selected.
This is only used as a default when creating general assets.
Any assets in a small business or low value pool will have the 
relevant cost limit applied by MYOB Assets Live as defined by 
the ATO (this may vary from year to year).

Field Description

Useful life
(Australia)

Enter useful life in years to calculate depreciation rate for 
depreciation method Straight line. Useful life is enabled only 
when straight line method is chosen.

Effective life
(Australia)

When the Effective life option is selected, the depreciation 
rate is calculated based on the entered years and months.
This option is selected by default.

Years The Years field is only available if the Effective life option is 
selected and displays the number of years defined as the 
default for the control group.
This field is limited to a value between 0 and 999.
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Integrated account fields

The following are the general ledger accounts associated with each control group and 
are used when creating the journals. See “Searching accounts” on page 324.

Months The Months field is only available if the Effective life option is 
selected and displays the number of months defined as the 
default for the control group.
This field is limited to a value between 0 and 12 inclusive.

Depreciation rate
(Australia)

When this option is selected, the depreciation rate is 
calculated based on a defined rate that you enter in the Rate 
year 1 and/or Rate year 2+ fields.

(Australia) Rate 
year 1
(New Zealand) 
Rate Year

This is a percentage field which is limited to 6 digits including 
2 decimal spaces.
The default value is 0.00. This field must contain a value 
between 0 and 100%.
(Australia) The Rate year 1 field is only available if the 
Depreciation rate option is selected.

(Australia) Rate 
year 2+

The Rate year 2+ field is only available if the Depreciation 
rate option is selected.
This is a percentage field which is limited to 6 digits including 
2 decimal spaces.
The default value is 0.00. The Rate year 2+ field must contain 
a value between 0 and 100%.

Field Description

Realisation Select the realisation account where the sale proceeds 
(credits) were originally coded to, in the general ledger (i.e., 
when you were coding the bank statements). 
When an asset is sold in the asset register, a journal will be 
created debiting the realisation account. 
Once all the relevant assets have been sold in the asset 
register, and all the journals have been posted, the realisation 
account should be zero in the general ledger.

Profit on sale Select the Profit on sale account where the profit amount 
from an asset sale will be posted.

Loss on sale Select the Loss on sale account where the loss amount from 
an asset sale will be posted.

Field Description
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Related topics
About accounts
Maintain Control Group window - Control group fields
Maintain Control Group window - Taxation tab fields
Creating a control group
Editing a control group
Deleting a control group
Adding the first asset year
Control groups
Control group templates

Creating a control group

A control group must be created before you can enter and select information in the 
Taxation or Accounting tab. Either or both these tabs will be active depending on 
how the Asset Register is configured.

You can edit information about a control group after it has been created. See “Editing 
a control group” on page 317.

Tip: To move between fields in the Maintain Control Group window use [Tab].
To move to a previous field use [Shift][Tab].

See “Maintain Control Group window - Control group fields” on page 306 and 
“Maintain Control Group window - Taxation tab fields” on page 308 for more 
information regarding the fields in the Maintain Control Group window.

To create a control group

1. Open the client’s Client Accounting > Assets tab.

(Australia) Private 
use (P&L)
(New Zealand) 
Private use

This is where the private use proportion of depreciation will 
be posted to.
This applies to both general and immediately deductible 
assets. 

Depreciation 
expense

Select the Depreciation expense account where any expenses 
related to the depreciation of assets in the control group will 
be posted.

Accumulated 
depreciation

Select the Accumulated depreciation account where the 
calculated accumulated depreciation of the assets in the 
control group will be posted.

Field Description
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See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Click Maintain control group on the Tasks bar.
The Maintain Control Group window opens.

3. Click the first cell of the Account code column in the table.

4. The row displays the text Click here to add new control groups in the Account 
code column.Enter the Account code of the control group.
You can enter the Account code in 2 ways:

a. Type the Account code into the Account code cell.

The Name field will be automatically filled with the account name if you are 
in integrated mode. 

If you are in non-integrated mode, you will need to enter a name in the 
Name field. Proceed to Step 5.

b. Click the Account code cell.

A magnifying glass icon is displayed if you are in integrated mode.

 Click the magnifying glass icon.

The Find Chart of Accounts window opens from where you can search for 
the account or press [F9]. See “Searching accounts” on page 324.

You can search, filter and/or sort the Chart of Accounts. The default sorting 
in the Find Charts of Accounts window is in ascending account code order.

Click on a column header to change the sorting on that column in ascending 
or descending order.

 Select the account and click OK. 

Alternatively, double-click the selected general ledger account in the Find 
Charts of Accounts window to automatically fill the Account code field in 
the Maintain Control Group window.

If you have made an error during selection and have not yet clicked Save, 
press [ESC] to remove the entry.

5. Enter the account Name.
You can enter the account Name in 2 ways:

a. If you are in non-integrated mode, type the Name of the control group.

The Name field is limited to a maximum of 50 alphanumeric characters.

b. If you are integrated mode and have selected an Account code, the Name 
field is automatically filled.
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Note: The Name field must not be blank.

6. Enter the Private use % to be used by the assets within the control group.
The Private use % field is a percentage value limited to a maximum of 6 digits 
including 2 decimal places, ranging between 0 - 100%.

7. Press [Enter].
The control group will move from the entry line to the table.
If you have selected an account code that is not valid in the general ledger, an 
error message is displayed. Edit the account code and press [Enter].
The Taxation and Accounting tabs become available for input according to the 
configuration of the Asset Register.

8. On the Taxation tab: 

a. Select the Depreciation defaults.

See “Depreciation defaults fields” on page 308.

b. Select the appropriate options for Calculate depreciation using.

See “Calculate depreciation using fields” on page 309.

c. Select the Integrated accounts for the control group.

See “Integrated account fields” on page 310 and “Searching accounts” on 
page 324.

If you are in integrated mode, select the integrated accounts by clicking the 
magnifying glass button to open the Find Chart of Accounts window.

If you are in non-integrated mode, type the account code for each of the 
integrated account fields. The Integrated accounts fields are limited to a 
maximum of 50 alphanumeric characters.

9. On the Accounting tab: 

a. Select the Depreciation defaults.

See “Depreciation default fields” on page 312.

b. Select the appropriate options for Calculate depreciation using.

See “Calculate depreciation using fields” on page 312.

c. Select the Integrated accounts for the control group.

See “Integrated account fields” on page 313.

If you are in integrated mode, select the integrated accounts by clicking the 
magnifying glass button to open the Find Chart of Accounts window.
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If you are in non-integrated mode, type the account code for each of the 
integrated account fields. The Integrated accounts fields are limited to a 
maximum of 50 alphanumeric characters.

Note: You can [Tab] between the Integrated accounts fields. Account 
fields can be left blank. 

10. Click Save.
The control group is saved to the database and the Maintain Control Group 
window remains open.
If you have mapped the integrated accounts with a configured and supported 

general ledger, the Mapped with GL account(s) icon  will be displayed in 
the last column of the control group table.

11. Create another control group, if required, and Save the changes.

12. Click OK to save and close the window.
To close the window without making changes, click Cancel.
The Maintain Control Group window is closed.
If you click Cancel and you have unsaved changes you will be prompted to save 
or discard your changes before closing the Maintain Control Group window.

Related topics
Maintain Control Group window - Control group fields
Maintain Control Group window - Taxation tab fields
Maintain Control Group window - Accounting tab fields
Editing asset register settings
Rules when creating control groups
Editing a control group
Deleting a control group
Adding the first asset year
Control groups
Getting started
Control group templates

Editing a control group

You can edit the control group in the Maintain Control Group window once the 
control group has been created.
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Tip: To move between fields in the Maintain Control Group window use [Tab].
To move to a previous field use [Shift][Tab].

See “Maintain Control Group window - Control group fields” on page 306 and 
“Maintain Control Group window - Taxation tab fields” on page 308 for more 
information regarding the fields in the Maintain Control Group window.

To edit a control group

1. Open the Maintain Control Group window.
There are 2 ways to do this:

 Click Maintain control group on the Tasks bar of the Assets Register.

 Select Maintenance > Maintain control group on the main menu of the 
Assets Listing page.

2. Select the control group to be edited.

3. Edit the Account code of the control group.
You can edit the Account code in 2 ways:

a. If you are in non-integrated mode, highlight the Account code and overtype 
the existing text.

b. If you are in integrated mode, click the cell. The magnifying glass icon is 
displayed. Click the magnifying glass icon to open the Find Chart of 
Accounts window from where you can search for the account. See 
“Searching accounts” on page 324.

Select another account and click OK. Alternatively, double-click the selected 
general ledger account in the Find Charts of Accounts window to 
automatically fill the Account code field in the Maintain Control Group 
window.

Tip: If you have made an error during selection and have not yet clicked 
Save, press [ESC] to remove the entry.

4. Edit the Name.
You can edit the Name in 2 ways:

a. If you are in non-integrated mode, highlight the Name of the control group 
and overtype the existing text.

The Name field is limited to a maximum of 50 alphanumeric characters.

b. If you are in integrated mode and have selected an Account code, the Name 
field is automatically filled.



MYOB AO, AE, AU PM Client Accounting User Guide | 319

Note: The Name field must not be blank.

5. Edit the Private use % to be used by the assets within the control group.
The Private use % field is a percentage value limited to a maximum of 6 digits 
including 2 decimal places ranging between 0 - 100%.

6. Press [Enter].

7. Edit the Depreciation defaults.
See “Depreciation defaults fields” on page 308.

8. Edit the appropriate option for Calculate depreciation using.
See “Calculate depreciation using fields” on page 309.

9. Change the Integrated accounts to be used for the control group, if necessary.
See “Integrated account fields” on page 310 and “Searching accounts” on 
page 324.
If you are in integrated mode, select the integrated accounts by clicking the 
magnifying glass button to open the Find Chart of Accounts window.
If you are in non-integrated mode, overtype the account code for each of the 
integrated account fields. The Integrated accounts fields are limited to a 
maximum of 50 alphanumeric characters.

Tip: You can [Tab] between the Integrated accounts fields. 
You can also copy and paste accounts from one field to another.
Account fields can be left blank.

10. Click Save.
The control group is saved to the database and the Maintain Control Group 
window remains open.

11. Click OK to save and close the window.
If you wish to close the window without making changes, click Cancel.
The Maintain Control Group window is closed.
If you click Cancel and you have unsaved changes you will be prompted to save 
or discard your changes before closing the Maintain Control Group window.

Related topics
Maintain Control Group window - Control group fields
Maintain Control Group window - Taxation tab fields
Maintain Control Group window - Accounting tab fields
Rules when creating control groups
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Creating a control group
Deleting a control group
Adding the first asset year
Control groups
Managing assets
Control group templates

Deleting a control group

Note: A control group can only be deleted if it does not have any allocated assets.

To delete a control group that has no allocated assets

1. Open the client’s Client Accounting > Assets tab.
See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Open the Maintain Control Group window.
There are 2 ways to do this:

 Click Maintain control group on the Tasks bar of the Assets Register.

 Select Maintenance > Maintain control group on the main menu of the 
Assets Listing page.

The Maintain Control Group window opens.

3. Select the control group to be deleted.

4. Click Delete.
The Delete button is located below the control group table. 
A message is displayed requesting confirmation to delete the selected control 
group.

5. Click Yes.
The selected control group is deleted.

To delete a control group that has allocated assets

1. Open the client’s Client Accounting > Assets tab.
See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Open the Assets Listing page.
See “Opening an asset year” on page 304.
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3. Transfer the asset(s) to another control group.
See “Moving an asset to another control group” on page 325.

4. Select Maintenance > Maintain control group on the main menu.
The Maintain Control Group window opens.

5. Select the control group to be deleted.

6. Click Delete.
A message is displayed requesting confirmation to delete the selected control 
group.

7. Click Yes.
The selected control group is deleted.

Related topics
Maintain Control Group window - Control group fields
Maintain Control Group window - Taxation tab fields
Maintain Control Group window - Accounting tab fields
Rules when creating control groups
Creating a control group
Editing a control group
Adding the first asset year
Control groups
Managing assets
Moving an asset to another control group
Control group templates

Control group templates

You can save the following control group settings:

 the details of a control group

 related chart of account settings

 depreciation defaults

in a template so that they can be re-used.

The control group templates must have a unique name.

(Australia) The chart of account settings will also be saved in the template for any 
small business or low value pool(s) that have been set up.
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To save the details of a control group in a template

1. Create a control group.
Enter the Account code and Name, Depreciation defaults and Integrated 
accounts.
See “Creating a control group” on page 314.

2. Click Save as template.
The Save control group settings as a template window opens.

3. Enter a descriptive Template name.

4. Click OK.
The template is saved in your database.
If you save the control group template as a name that already exists, you will be 
warned that the template already exists. You can choose to overwrite the 
existing template by clicking Yes. Alternatively, click No, to return to the Save 
control group settings as a template window and enter a different Template 
name.

To update a template with the details of an edited control group

1. Edit the control group.
See “Editing a control group” on page 317.

2. Click Save as template.
The Save control group settings as a template window opens.

3. Enter the Template name that had been previously used with this control group.

4. Click OK.
As the template already exists, the Template already exists message opens.

5. Click Yes.
This will overwrite the existing template with the updated details of the control 
group.

To use a control group template

Note: Use a control group template that is in integrated mode with an asset register 
that is in integrated mode.
Use a control group template that is in non-integrated mode with an asset 
register that is in non-integrated mode.

1. Open the client’s Client Accounting > Assets tab.
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See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Open the Maintain Control Group window.
There are 2 ways to do this:

 Click Maintain control group on the Tasks bar of the Assets Register.

 Select Maintenance > Maintain control group on the main menu of the 
Assets Listing page.

3. Click Load template.
The Load control group template window opens.

4. From the list, select the control group template required.

5. Click OK.
The details of the control group saved within the template will populate the 
fields of the Maintain Control Group window.
If you select a control group template whose integration status is not 
compatible with the integration status of your asset register then you will 
receive a warning message. You must either change the integration status of 
your asset register (using Maintenance > Register Settings) or select a control 
group template that is compatible with the appropriate integration status of 
your asset register.
If a control group already exists in the Maintain Control Group window and you 
load a template for this control group, then the displayed settings will be 
overwritten.
(Australia) If the control group is for a small business pool or low value pool, and 
its chart of account settings were set up when the control group template was 
created, then these will also be imported when you use the control group 
template.

Note: The depreciation rates and methods etc., for any existing assets are 
left unchanged when you load a template. The settings loaded from 
the template will only be used as defaults when adding new assets. 
However the current chart of account settings will be used for all 
assets (in that control group) when printing the journals.

To delete a control group template

1. Open the client’s Client Accounting > Assets tab.
See “Accessing an asset register” on page 295.
The Asset Register is displayed.

2. Open the Maintain Control Group window.
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There are 2 ways to do this:

 Click Maintain control group on the Tasks bar of the Assets Register.

 Select Maintenance > Maintain control group on the main menu of the 
Assets Listing page.

3. Click Load template.
The Load control group template window opens.

4. From the list, select the control group template to be deleted.

5. Click Delete.
The selected template is removed from the list in the Load control group 
template window and from the database. It is no longer available for selection.

Related topics
Maintain Control Group window - Control group fields
Maintain Control Group window - Taxation tab fields
Maintain Control Group window - Accounting tab fields
Rules when creating control groups
Creating a control group
Editing a control group
Adding the first asset year
Control groups
Managing assets
Moving an asset to another control group
Searching accounts

Searching accounts

General ledger accounts can be searched for by Account code and Account name in 
the Find Chart of Accounts window.

The default sort order in the Find Chart of Accounts window is by ascending account 
code.

To search the Find Chart of Accounts window

1. Open the Find Chart of Accounts window.
This can be done in 2 ways:

 Click the magnifying glass icon on an account field in the Maintain Control 
Group window.

 Press [F9] on the Maintain Control Group window.
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2. In the search type field, select Account code or Account name from the drop-
down.

3. In the Search field, type at least the first 2 characters of the Account code.

4. Click Search.
The accounts listed in the Find Chart of Accounts window are filtered to display 
only those matching the search criteria.

Related topics
Creating a control group
Editing a control group
Maintain Control Group window - Taxation tab fields

Moving an asset to another control group

If you have allocated an asset to an inappropriate control group, you can correct the 
error by transferring the asset to a different control group. When transferring an 
asset to a different control group, no modification to data is made for any taxation 
dependent variables.

When transferring an asset to another control group, MYOB Assets Live:

 debits the new control group account with the cost of the asset.

 credits the original control group account with the original cost of the asset.

 debits the original accumulated depreciation account with the accumulated 
depreciation and the year-to-date depreciation.

 credits the new accumulated depreciation account with the accumulated 
depreciation and the year-to-date depreciation.

 debits the new depreciation expense account with the year-to-date 
depreciation.

 credits the old depreciation expense account with the year-to-date 
depreciation.

 debits the original private use expense account with the year-to-date private 
use amount.

 credits the new private use expense account with the year-to-date private use 
amount.
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Note: The selected asset can only be transferred in the year it was created.
You can only transfer an asset if more than one control group exists.
You must transfer an asset to a different control group from the original one.
An asset cannot be transferred to another control group if it has been sold in 
a future year.

To transfer an asset to another control group

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the asset that is to be transferred to another control group.
The row containing the asset must highlighted.

3. Click Move to another control group on the Tasks bar.
or
You can select Functions > Move to another control group on the right-click 
menu. 
The Transfer Asset window opens displaying the Asset code and Asset name of 
the selected asset.
The current control group that the asset has been assigned to is automatically 
listed in the Control group field.

4. Select the New control group from the drop-down.

5. Click OK.
The asset is transferred to the selected control group. The Assets Listing page is 
updated with the new control group for the selected asset. The Transfer asset 
window closes.

Related topics
Selling an asset
Reversing the sale of an asset
Deleting an asset
Editing an asset
Managing assets
Deleting a control group
Control group templates
(Australia) Transferring an asset to a pool
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Creating a new asset location

An asset can be allocated to a specific physical location where it is stored or used. You 
must configure the location association before it can be used.

Each asset location must be unique. You cannot enter a location that already exists.

You can assign the asset to one location in the General details section of the Create 
New Asset Wizard or when editing an asset.

To create an asset location

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Maintenance > Association > Location on the main menu.
The Maintenance - Location window opens.

3. In the first blank cell of the table, enter the Location of an asset.
The Location field is limited to a maximum of 50 alphanumeric characters.

4. Press [Enter].
The entry row moves into the table below.

5. Enter another asset location, if required.
Return to Step 3.

6. Click Close.
The Maintenance - Location window closes. The asset location is saved.

Related topics
Editing a control group
Deleting a control group
Creating an asset
Assets Listing page
Getting started

Editing an asset location

When you edit an asset location, the changes are reflected in all assets that are 
associated with the location.

To edit an asset location

1. Open the Assets Listing page.
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See “Opening an asset year” on page 304.

2. Select Maintenance > Association > Location on the main menu.
The Maintenance - Location window opens.

3. Select the location to be edited.

4. Edit the specific text.

5. Click Close.
The Maintenance - Location window closes. The edited asset location is saved.

Related topics
Creating a new asset location
Deleting a control group
Creating an asset
Assets Listing page
Managing assets

Deleting an asset location

Note: You cannot delete a location that has been associated with an asset. 

To delete an asset location that has no associations

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Maintenance > Association > Location on the main menu.
The Maintenance - Location window opens.

3. Select the asset location to be deleted.
The entire location row must be highlighted.

4. Press [Delete].
A message is displayed requesting confirmation of the deletion.

5. Click Yes.
The confirmation message closes and the location is deleted from the Location 
table.
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To delete an asset location that has been associated with assets

If a location is to be deleted but is associated with an asset, you must first re-assign 
the asset(s) to a different location(s). Once the asset location is not associated with 
any assets, it can be deleted.

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Create a new asset location, if required.
See “Creating a new asset location” on page 327.

3. Re-assign the assets that are associated with the location to be deleted, to a 
different location.
See “Editing the general details of an asset” on page 396.

4. Delete the asset location.
See “To delete an asset location that has no associations” on page 328.

Related topics
Creating a new asset location
Editing a control group
Creating an asset
Assets Listing page
Managing assets

Assets Listing page

The Assets Listing page lists all of the assets for a client. By default, the information 
is sorted in ascending order based on the asset code. The information can be re-
sorted and filtered according to individual requirements. 

You can customise the information that is displayed within the Assets Listing page by 
adding and removing columns using the right-click menu Field Chooser option.

The various sections on the Assets Listing page are:

Main menu options

Option Description

Maintenance

Register settings This option enables you to edit the configured asset 
register settings.
See “Editing asset register settings” on page 300.
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Other options

Tasks bar options

Maintain control group This option enables you to create and edit the 
configured control groups.
See “Editing a control group” on page 317.

Association - Location This option enables you to create, edit and delete the 
location of assets.
See “Creating a new asset location” on page 327, 
“Editing an asset location” on page 327 and “Deleting 
an asset location” on page 328.

Reports

Low value pool 
schedule
(Australia)

Generate a Low value pool schedule report.
See “Low value pool schedule” on page 417.

Small business pool 
schedule
(Australia)

Generate a Small business pool schedule report.
See “Small business pool schedule” on page 418.

Tax schedule Generate a Tax schedule report.
See “Tax schedule” on page 419.

Journal summary - 
Taxation

Generate a Journal summary - Taxation report.
See “Journal summary - Taxation” on page 421.

Accounting schedule Generate a Accounting schedule report.
See “Accounting schedule” on page 422.

Journal summary - 
Accounting

Generate a Journal summary - Accounting report.
See “Journal summary - Accounting” on page 424.

Option Description

Show cents Select the Show cents checkbox to display cents for all asset 
values in the Assets Listing table.
Deselect the Show cents checkbox to hide the cents for all 
asset values in the Assets Listing table.
By default, cents are not displayed in the Assets Listing table.

Option Description

Assets

Option Description
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Create new asset Click this option to open the Create New Asset Wizard 
which guides you through “Creating an asset” on page 344.

Edit asset Edit the selected asset’s details.
See “Editing an asset” on page 380.

Delete asset Delete the selected asset.
See “Deleting an asset” on page 397.

Move to another 
control group

Click this option to transfer an asset from one control group 
to another.
See “Moving an asset to another control group” on 
page 325.

Disposals

Sell Click this option to sell a selected asset.
See “Selling an asset” on page 399.

Unsell Click this option to reverse the sale of an asset.
See “Reversing the sale of an asset” on page 408.

Pools (Australia only)

Low value pool Click this option to obtain a summary of a selected low value 
pool and to map the low value pool to the relevant general 
ledger account code(s).
See “Low value pool summary” on page 375.

Small business 
pool

Click this option to obtain a summary of a selected small 
business pool and to map the small business pool to the 
relevant general ledger account code(s).
See “Small business pool summary” on page 376.

Transfer to low 
value pool

Click this option to transfer a single general asset to a low 
value pool.
See Transferring an asset to a pool.

Transfer to small 
business pool

Click this option to transfer a single general asset to a small 
business pool.
See Transferring an asset to a pool.

Journals

Submit journals Click this option to add Assets journal details to Workpapers 
as an unposted journal.
See “Submitting journals to Workpapers” on page 377.

Option Description
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Right-click menu options

To access the right-click menu:

1. Right- click anywhere on the Assets Listing page.
The right-click menu displays the available options.

Field Chooser options 

To access the Field Chooser options:

1. Right-click anywhere on the Assets Listing page.

2. Select Field Chooser.
The Field Chooser options are displayed as listed in the table.

Option Description

Function

Sell Select this option to sell an asset.
See “Selling an asset” on page 399.

Unsell Select this option to reverse the sale of an asset.
See “Reversing the sale of an asset” on page 408.

Move to another 
control group

Select this option to transfer an asset from one control group 
to another.
See “Moving an asset to another control group” on page 325.

Transfer to low 
value pool
(Australia)

Click this option to transfer a single general asset to a low 
value pool.
See Transferring an asset to a pool.

Transfer to small 
business pool
(Australia)

Click this option to transfer a single general asset to a small 
business pool.
See Transferring an asset to a pool.

Edit Select this option to edit the asset’s details.
See “Editing an asset” on page 380.

Delete Select this option to delete an asset.
See “Deleting an asset” on page 397.

Field Chooser Select this option to display a menu of Field Chooser options.
See “Field Chooser options” on page 332.
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Option Description

Accumulated 
depreciation

Accumulated depreciation is a calculated value, where:
If Asset Start Date >= Year Start Date
then,
Accumulated Depreciation = 0
If Asset Start Date < Year Start Date
then,
Accumulated Depreciation = Base Cost - Opening Written 
Down Value

Accumulated 
private use

Accumulated private use is the calculated sum of all prior 
years’ private use amount.

Acquisition date The date the asset was acquired.

Adjusted base cost The adjusted base cost defined for the selected asset. This 
field will only display a value if the asset Start date is prior 
to the asset register Year start date and the selected 
depreciation method is Prime cost.

Adjusted 
depreciation

The adjusted depreciation is calculated as the depreciation 
expense minus the private use amount.

Assessable The calculated profit for a sold asset. This field is blank for 
active assets.

Asset code * The asset code defined for the asset register for the 
selected year. 

Asset name * The asset name defined for the asset register for the 
selected year.

Asset type The asset type can be:
•  general asset (GA)
•  (Australia) immediate deductible asset (IDA)
•  (Australia) small business pool (SBP)
•  (Australia) low value pool (LVP).

ATO 
commissioner’s 
effective life
(Australia) 

The ATO commissioner’s effective life column displays 
whether the ATO commissioner’s effective life checkbox 
has been selected or not. A Yes or No is displayed.
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Average private use 
%
(Australia) 

This is the average private use of an asset held in a small 
business pool. For example, if the asset was added to a pool 
with 5% private use in year 1 and 15% private use in year 2, 
the average private use is 10%. 
This value is used when determining the taxable 
termination value of an asset that is sold from a small 
business pool. 
This is only displayed after the asset is sold.

Base cost
(Australia) 

This is the cost after applying any Motor Vehicle cost limit.

Change in private 
use
(Australia) 

The change in private use is an adjustment to the small 
business pool total to take into account changes in the 
private use % between the years. This is calculated by MYOB 
Assets Live using a formula as prescribed by the ATO. See 
the Private use adjustment section in “Editing the taxation 
details for a small business pool asset” on page 388.

Closing w.d.v The Closing Written Down Value is the value of the asset at 
year end after depreciation, and other adjustments such as 
change in private use, sale proceeds, loss or profit on sale 
etc., have been accounted for.

Contribution type
(Australia) 

The contribution type is only relevant for pools. It 
represents the different categories of transactions that have 
contributed changes in the pool. These are set 
automatically by MYOB Assets Live and are used in 
reporting.
If you work with pools a lot, you should consider sub-
grouping the Assets Listing page by the contribution type. 
See “Sorting, filtering and grouping your assets” on 
page 342.
The following contribution types are available:
•  Opening balance — assets that existed in the pool last 

year. These are depreciated at the Year 2+ rate.
•  Partly depreciated — assets that have been previously 

depreciated, e.g., general assets moved into a pool or 
assets that you have loaded from another accountant’s 
schedule. These are depreciated at the Year 2+ rate.

•  Purchases pooled — assets added to the register this 
year. These are depreciated at the Year 1 rate and are 
adjusted for private use percentage.

•  Disposals – pooled assets that have been sold this year. 

Option Description



MYOB AO, AE, AU PM Client Accounting User Guide | 335

Control group * The control group that the specific asset has been assigned 
to.

Cost * The purchase cost of the asset.

Cost limit The cost limit of the selected asset.

Deductible The calculated loss for a sold asset. This field is blank for 
active assets.

Depreciation end 
date

The Depreciation end date is the end date used when 
calculating depreciation for this asset for the year, e.g., for 
general assets this is normally the sale date.

Depreciation 
expense *

Depreciation for this asset for the year, based on the 
depreciation rate and method (before taking into account 
any private use).

Depreciation rate * Depreciation rate that has been applied to this asset when 
calculating the depreciation for this year. 
If Depreciation type = Immediate deductible asset, then the 
Depreciation rate = 100%.

Depreciation rate 
year 1

The Depreciation rate year 1 defined for the selected asset.
If the Depreciation rate option is not selected, then this 
field is blank.

Depreciation rate 
year 2+

The Depreciation rate year 2 and successive years defined 
for the selected asset.
If the Depreciation rate option is not selected, then this 
field is blank.

Depreciation start 
date

The Depreciation start date is the start date used when 
calculating depreciation for this asset for the year, e.g., for 
general assets this is normally the purchase date.

Diminishing value 
depreciation

The depreciation for assets that are depreciated on the 
Diminishing Value method (once any private use is taken 
into account).

Disposal date This is the date on which an asset is sold or disposed.

Effective life 
months
(Australia) 

The effective life in months defined for the selected asset.
If the Effective life checkbox has not been selected, then 
this field is blank.

Effective life years
(Australia) 

The effective life in years defined for the selected asset.
If the Effective life checkbox has not been selected then this 
field is blank.

Option Description
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Is motor vehicle
(Australia) 

A Yes is displayed in this column if the asset is a motor 
vehicle. 
A No is displayed in this column if the asset is not a motor 
vehicle.

Location This column displays the location of the asset. 

Method * The depreciation method used when calculating 
depreciation for this asset:
•  (Australia) PC - Prime cost
•  (New Zealand) SL - Straight line
•  DV - Diminishing value
•  W - Immediate deductible asset (write off).

Motor vehicle write 
off
(Australia) 

This is the additional depreciation that is applied to motor 
vehicles in a small business pool. 
For example, up to 31 December 2013, the first $5,000 of a 
motor vehicle is written off in the year of purchase. Any 
balance over $5,000 is then also depreciated at the first 
year rate (15%). If the motor vehicle cost is under $5,000 
then the depreciation will be the cost (or the cost value 
after reducing it for any private use).
If the motor vehicle was acquired on or after 1 January 
2014, then the immediate write off of $5,000 no longer 
applies due to the Mineral Resource Rent Tax Repeal and 
Other Measures Bill 2014 (MRRT).
The allowable write off threshold may change from year to 
year as prescribed by the ATO. MYOB Assets Live will 
automatically apply the correct write off amount in each year.

Number of days
(Australia) 

The number of days that have been applied when 
calculating the depreciation for the asset. For example, for 
general assets this will take into account the purchase and 
sale date(s).

Number of months
(New Zealand)

The number of months that have been applied when 
calculating the depreciation for the asset. For example, for 
general assets this will take into account the purchase and 
sale date(s).
This is shown only in the Accounting Grid.

Opening w.d.v. * The Opening Written Down Value for the specific asset.
This is effectively last year’s Closing w.d.v.

Option Description
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Prime cost 
depreciation

The depreciation for assets that are depreciated on the 
Prime Cost method (once any private use depreciation is taken 
into account).

Private use amount The private user proportion of depreciation for the year.
For example, if the Depreciation expense for the year is 
$1,000, and the Private use % is 10%, then the Private use 
amount will be $100.
(Australia) This only applies to general assets and 
Immediately deductible assets, not assets in a small 
business or low value pool.

Start date * The date the asset will start to be depreciated from. 
This is the date when you first use it, or install it ready for 
use, for any purpose, including a private purpose.
This is usually the purchase date, but may be later. For 
example, if it has to be shipped or installed prior to first use.

Option Description
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Taxable termination 
value
(Australia) 

The Taxable termination value applies to assets in a small 
business pool:
•  It is the Termination value (i.e., sale or insurance 

proceeds) reduced by the average private use.
For example, if you have an asset in a small business pool 
and sell it for $20,000, and it has had an average private 
use % of 10%, the Taxable termination value will be 
$18,000.

•  If the asset had a cost limit applied at the time of 
purchase, the Taxable termination value is further 
adjusted to take that into account.

The small business pool total will be reduced by the Taxable 
termination value.

Note: This will often mean that the closing w.d.v. of the 
individual asset that has been sold from the pool, 
will not be zero. 

Having a sold asset with a closing w.d.v not equal to zero 
may seem strange, however this is just an anomaly of the 
way that small business pools work.
The closing w.d.v’s of the individual sold assets are 
aggregated in later years into a Consolidated Sold Asset and 
continue to be depreciated into the future years. 
This way the pool as a total, continues to be depreciated 
correctly. 
The Taxable termination value is also used (together with 
the Taxable value) when determining if the pool total is 
under the pool write off threshold.

Option Description
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Taxable value
(Australia) 

The Taxable value only applies to assets in a small business 
pool:
•  This is the taxable value of the asset in a small business 

pool and is that value that the depreciation is calculated 
on. 

•  This is also known as the Pool Contribution as it is the 
amount added to the small business pool when the asset 
is added to the register (after taking into account any 
motor vehicle cost limit and any private use).

•  This is reduced each year as depreciation is applied. 
Example
If a motor vehicle with 60% private use and a cost of 
$90,000 is purchased in 2013 and is added to the SB Pool:
•  The Motor Vehicle cost limit of $57,466 is applied.
•  The 60% Private use is deducted from this. 
•   Resulting in a Taxable value (Pool contribution) of

$22,986.40 (being $57,466 x 40%) 
Because this is a motor vehicle purchased in 2013, an 
immediate write off of $5,000 applies. The depreciation is 
calculated as:
•  First $5,000
•  Plus 15% on the balance:

15% x ($22,986.40 – $5,000) = $2,698
•  The total depreciation for this asset is:

$5,000 + $2,698 = $7,698

Note: There are special rules when Taxable value is 
calculated for previously depreciated assets (i.e., 
assets added to the register this year, but that had a 
start date in a previous year):
The Taxable value is instead based on the opening 
w.d.v as entered by the user.
The cost limit is not applied, as that is only applied in 
the year of purchase, and should already have been 
taken into account in the opening w.d.v..
The Private use % may or may not be applied, 
depending on if the Asset came from an existing 
pool checkbox has been selected.
A change in private use adjustment may or may not 
be applied, depending on if the Asset came from an 
existing pool checkbox has been selected and if the 
Change in private use window has been updated.

The Taxable value is also used (together with any Taxable 
termination value(s) when determining if the pool total is 
under the pool write off threshold.

Option Description
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* Default columns that are displayed on the Assets Listing page.

Related topics
Customising the Assets Listing page

Termination value The termination value is the amount received for the asset 
when it was sold or disposed.

Total depreciation
(Australia) 

Total depreciation is the depreciation expense plus any 
motor vehicle write off applied to an asset in a small 
business pool.

Units The units defined for the selected asset. 

Value for 
depreciation *

This is the value that depreciation is calculated on (i.e. the 
Depreciation expense will be the value for depreciation 
multiplied by the relevant rate).
In Australia, the Value for depreciation applies to general 
assets not small business pool assets (see Taxable value 
above for assets in a small business pool). 
For the Diminishing Value depreciation method:
If the asset is a previously depreciated asset (i.e., the start 
date is prior to the year start date), then
Value for depreciation = Opening Written Down Value
If the asset was purchased in this year, then
Value for depreciation = Base cost
For the Prime Cost depreciation method (Australia) / 
Straight Line depreciation method (New Zealand):
If the asset is a previously depreciated asset (i.e., the start 
date is prior to the year start date) and if the Adjusted Base 
Cost is greater than zero, then
Value for depreciation = Adj. Base Cost
Otherwise
Value for depreciation = Base cost
However, if the base cost is less than zero, then the Value 
for depreciation will be reset to zero.
For Immediate Deductible Asset depreciation method:
If the asset is a previously depreciated asset (i.e., the start 
date is prior to the year start date), then
Value for depreciation = 0
If the asset was purchased in this year, then
Value for depreciation = Cost

Option Description



MYOB AO, AE, AU PM Client Accounting User Guide | 341

Sorting, filtering and grouping your assets
Creating an asset
Editing an asset
Viewing assets

Customising the Assets Listing page

You can add, remove and rearrange columns on the Assets Listing page. Once you 
have customised your Assets Listing page, the customisations will be retained for 
future use.

To add columns to the Assets Listing page

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Field Chooser from the right-click menu.
A list of field chooser options are displayed.

3. Select one of the list of field chooser options. 

4. Drag the selected option to the required location on the column heading row.

To remove columns from the Assets Listing page

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Field Chooser from the right-click menu.
A list of field chooser options are displayed.

3. Select a column heading on the Assets Listing page that is no longer required.

4. Drag the selected column heading to the Field Chooser menu or away from the 
table.

To rearrange columns on the Assets Listing page

1. Open the Assets Listing page.

2. Drag and drop selected column headings where required within the column 
heading row.

Related topics
Sorting, filtering and grouping your assets
Assets Listing page
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Creating an asset
Editing an asset
Viewing assets

Sorting, filtering and grouping your assets

To sort assets in the Assets Listing page

Click on a column heading to sort the list alphabetically, based on the values in that 
column. 

Click the column heading again to reverse the sort order. 

Click the column heading a third time to clear the sort order.

To filter assets in the Assets Listing page

1. Click on a column in the Filter bar. 

2. The Filter bar is identified by the  in the left most column.

3. Select a value from the drop-down list for the column. 
The list will only show entries that match the value selected in the filter.

4. You can use wildcards when entering filters:

 To find all entries in the column beginning with D, enter d* in the filter.

 To find all entries in the column containing the characters FAMILY, enter 
*family* in the filter.

 To find all entries ending in D, enter *d in the filter.

5. Click  to remove the filter.

To group assets in the Assets Listing page

You can also change how assets are listed on the page, by dragging one or more of 
the available column headings to the Group bar 

. This will group the items in the list by the 
column heading(s) you have selected.

For example, you can view the assets by control group rather than by Asset code. 
When you drag the required group heading to the Group bar, the list will be reset to 
reflect your chosen option. You can add another group heading either before or after 
those already selected to further sub-group the items.

To view all items, remove all the grouping options from the Group bar.
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Tip: (Australia) If you have a lot of assets in a small business pool, a good way to 
organise the Asset Listing page is to group by Asset type and then sub-group 
by Contribution type.

Related topics
Assets Listing page
Creating an asset
Editing an asset
Viewing assets
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Creating an asset
Prior to creating an asset, you will find relevant information on these help pages:

 “Editing asset register settings” (see page 300)

 “Adding the first asset year” (see page 302)

 “Creating a control group” (see page 314)

 “Taxation Assets” (see page 344)

 “Accounting Assets” (see page 344)

 “Accounting and Taxation Assets” (see page 345).

Creating assets is assisted by the Create New Asset Wizard.

Refreshing the data 

If there are a number of employees using the same database and creating new assets, 
use the Refresh button on the Tasks bar to update the Assets Listing page with the 
latest information.

Related topics
Taxation Assets
Accounting Assets
Accounting and Taxation Assets

Taxation Assets

When creating a Taxation only asset you need to record:

 Assets details 

 Taxation details

 General details – these are optional.

The steps for creating an asset depend on the asset type:

 “Creating a new general asset” (see page 345)

 (Australia) “Creating a low value pool asset” (see page 354)

 (Australia) “Creating a small business pool asset” (see page 363).

Accounting Assets

When creating an Accounting only asset in MYOB Assets Live you need to record:

 Assets details

 Accounting details required to calculate depreciation
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 General details – these are optional.

See “Creating a new general asset” (see page 345) for the steps to create an 
Accounting only asset.

Accounting and Taxation Assets

When creating an Accounting and Taxation asset in MYOB Assets Live you need to 
record:

 Assets details

 Taxation details

 Accounting details

 General details – these are optional.

The steps for creating an asset depend on the asset type:

 “Creating a new general asset” (see page 345)

 (Australia) “Creating a low value pool asset” (see page 354)

 (Australia) “Creating a small business pool asset” (see page 363).

Related topics
Editing an asset
Deleting an asset
Getting started

Creating a new general asset

A new general asset must be created in the current year. The asset can be purchased 
in the current year or in a prior year.

Taxation asset

Creating a new general asset with the Create New Asset Wizard is a 3-step process:

 “Setting asset details” (see page 346)

 “Setting taxation details for a General asset (GA)” (see page 348)

 “Setting general details” (see page 353).

Accounting asset

Creating a new general asset with the Create New Asset Wizard is a 3-step process:

 “Setting asset details” (see page 346)

 “Setting accounting details for a General asset (GA)” on page 351
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 “Setting general details” (see page 353).

Accounting and Taxation

Creating a new general asset with the Create New Asset Wizard is a 4-step process:

 “Setting asset details” (see page 346)

 “Setting taxation details for a General asset (GA)” (see page 348)

 “Setting accounting details for a General asset (GA)” on page 351

 “Setting general details” (see page 353).

Related topics
Setting asset details
Setting taxation details for a General asset (GA)
Setting accounting details for a General asset (GA)
(Australia) Setting general details for a small business pool (SBP) asset
Editing an asset
Viewing assets
Deleting an asset
Creating a control group

Setting asset details

In the first step of the Create New Asset Wizard, you will enter the asset detail, asset 
type and the allocated control group for the new asset.

What taxation details you are asked for is determined by the asset type you select in 
this step. 

Note: When creating a new asset you must already have a control group configured. 
A message will be displayed if you attempt to create a new asset without 
having a control group configured. Click Yes to open the Maintain Control 
Group window and “Creating a control group” on page 314.

To enter the details for a new general asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Click Create new asset on the Tasks bar.
or 
Press [F4].
The Create New Asset Wizard opens.
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3. Enter the Asset code.
This is a mandatory field and must not be blank.
The Asset code is limited to a maximum of 50 alphanumeric characters.

4. Enter the Asset name.
This is a mandatory field and must not be blank.
The Asset name is limited to a maximum of 200 alphanumeric characters.

5. Select the Asset type from the drop-down.
For Taxation only or Accounting and Taxation assets the asset type can be:

 General asset

 (Australia) Immediate deductible asset

 (Australia) Small business pool 

 (Australia) Low value pool.
For Accounting only assets the asset type can be:

 General asset

 (Australia) Immediate deductible asset

Note: (Australia) You cannot create new assets of Immediate deductible 
asset type. If you select Immediate deductible asset, you will be 
asked to create a General asset with a depreciation method of 
Immediate write off.

6. Select whether the depreciation calculated will be reported for Accounting or 
Taxation. This selection only applies where the asset is an Accounting and 
Taxation asset. 

7. Select control group for the asset from the drop-down.
An asset must be associated with a control group. 

8. Click Next.

 If the asset is a Taxation or Accounting and Taxation asset then the next 
step will require Taxation details to be entered. 

 If the asset being created is an Accounting asset then the next step will 
require Accounting details to be entered.

Related topics
Setting taxation details for a General asset (GA)
(Australia) Setting taxation details for a low value pool (LVP) asset
(Australia) Setting taxation details for a small business pool (SBP) asset
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Setting accounting details for a General asset (GA)
(Australia) Setting general details for a small business pool (SBP) asset
Editing an asset
Viewing assets
Deleting an asset
Creating a control group

Setting taxation details for a General asset (GA)

This will be Step 2 of the Create New Asset Wizard for Taxation only or Accounting 
and Taxation assets. In this scenario you are entering the taxation details for the 
general asset (GA).

This step will not be seen if you are creating an Accounting only asset.

To enter the taxation details for a general asset:

1. In the first step for Asset details you have selected General asset from the Asset 
type drop-down.

2. Enter the Acquisition date of the asset.
By default, this field is automatically filled with the Year start date.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.
If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

3. Enter the Start date for the asset.
By default, this field is automatically filled with the Acquisition date that you 
entered above.
The Start date must not be after the Year end date for the year period.
If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

4. Select the Depreciation method from the drop-down.
By default, the depreciation method is taken from what was configured in the 
control group for the asset.
The depreciation method can be overwritten at an individual asset level.

5. Enter the Cost of the asset.
The default value is 0.00. 
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.
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6. Enter the Opening written down value of the asset.
The default value is 0.00 and it is a read only field.
An Opening written down value can be entered, if the Start date is prior to the 
current financial year.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. (Australia) Select the Motor vehicle checkbox, if your asset is a motor vehicle.

8. (Australia) Enter the Cost limit of the motor vehicle.
This field is only available if the Motor vehicle checkbox was selected.
The default value is 0.00.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

Note: Up to 31 December 2013:
If the cost of the general asset is less than the immediate write off 
threshold of $6,500, then you can claim an immediate write off for 
the asset.
If you add it as a general asset, MYOB Assets Live will not 
automatically write off the asset.
You should go back to the first step and select the type of asset to 
be immediate deductible asset instead. 
The immediate write off for general assets acquired between 1 
January 2014 and 11 May 2015 was decreased from $6,500 to 
$1,000. On 12 May 2015 it was increased to $20,000 and this 
applies until 30 June 2017.

9. Select the appropriate options in the Calculate decline in value section.
You can select either:

a. (Australia) Effective life

 (Australia) Enter the number of Years and Months or select the ATO 
commissioner’s effective life option.

The Years field is limited to a maximum of 3 digits and must be a value 
between 0 and 999. 

The Months field must be a value between 0 and 12.

b. Depreciation rate

 Enter the percentage depreciation Rate year 1 (Australia) / Rate year% 
(New Zealand).

 (Australia) Enter the percentage depreciation Rate year 2+.

They must be a value between 0 and 100%.
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10. Select the appropriate options in the Other values section.

a. (Australia) Enter the Adjusted base cost.

Enter a value in this field if your asset Start date is prior to the asset register 
Year start date and the selected depreciation method is Prime cost.

This field is not available for use if the asset Start date is greater than or 
equal to the asset register Year start date.

This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

b. Enter the Private use % for the asset.

The value must be between 0 and 100%.

c. Select the Private use bal sheet a/c to be used, if a portion of the asset is to 
be used for private use.

For example, this would normally be the shareholder’s current account - 
being the shareholder who is using this asset for private use.

Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account 
to be used for posting journals regarding private use of the asset.

The Accumulated depreciation and Accumulated private use fields are 
calculated fields and are read only.

The Accumulated private use field is enabled if you create an asset where 
the Start date is prior to the Year start date.

11. Click Next.

 If the asset being created is an Accounting and Taxation asset then continue 
to “Setting accounting details for a General asset (GA)” (see page 351). 

 (Australia) If the asset being created is a Taxation only asset then continue 
to “Setting general details for a small business pool (SBP) asset” (see page 
373). 

Related topics
(Australia) Setting general details for a small business pool (SBP) asset
Setting asset details
Setting accounting details for a General asset (GA)
Editing an asset
Viewing assets
Deleting an asset
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Setting accounting details for a General asset (GA)

This will be Step 2 of the Create New Asset Wizard for Accounting only assets. It will 
be Step 3 for Accounting and Taxation assets. This step will not be seen if you are 
creating a Taxation only asset. 

In this step of the Create New Asset Wizard you record the accounting details for a 
general asset (GA).

If this is step 3, that is an Accounting and Taxation asset, then some of the fields in 
this step are filled in for you from the Taxation details entered or modified in the 
previous step. These fields include:

 Acquisition date

 Start date

 Cost entered

 Opening written down value

 Private use

 Accumulated depreciation

 Accumulated private use

 Private use balance sheet a/c.

To enter the accounting details for a general asset

1. In the first step for Asset details you selected:

 General asset from the Asset type drop-down. 

2. Enter the Acquisition date of the asset.
By default, this field is automatically filled with the Year start date.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.
If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

3. Enter the Start date for the asset.
By default, this field is automatically filled with the Acquisition date that you 
entered above.
The Start date must not be after the Year end date for the year period.
If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

4. Select the Depreciation method from the drop-down.
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By default, the depreciation method is taken from what was configured in the 
control group for the asset.
The depreciation method can be overwritten for each asset.

5. Enter the Original Cost of the asset.
The default value is 0.00. 
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

6. Enter the Opening written down value of the asset.
The default value is 0.00 and it is a read only field.
An Opening written down value can be entered, if the Start date is prior to the 
current financial year.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. Select the appropriate options in the Calculate decline in value section.
You can select either:

a. Enter the number of years for Useful life. Useful life is applicable if the asset 
is being depreciated using the Straight line method only.

or 

b. Enter the Depreciation rate as a percentage for Rate year 1% (Australia) / 
Rate year% (New Zealand)

(Australia) Enter the Depreciation rate as a percentage for Rate year 2+%.

These fields must be a value between 0 and 100%.

(New Zealand) You can click the Find Rate link to view the IRD rate finder 
website.

8. Select the appropriate options in the Other values section.

a. Enter the Private use % for the asset.

The value must be between 0 and 100%.

b. Select the Private use bal sheet a/c to be used, if a portion of the asset is to 
be used for private use.

For example, this would normally be the shareholder’s current account - 
being the shareholder who is using this asset for private use.

Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account 
to be used for posting journals regarding private use of the asset.
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c. The Accumulated depreciation and Accumulated private use fields are 
calculated fields and are read only.

d. The Accumulated private use field is enabled if you create an asset where 
the Start date is prior to the Year start date.

9. Click Next.
Continue to “Setting general details” on page 353.

Related topics
(Australia) Setting general details for a small business pool (SBP) asset
Setting asset details
Editing an asset
Viewing assets
Deleting an asset

Setting general details

The last step in the wizard will be either Step 3 or Step 4 of the of the Create New 
Asset Wizard depending the Asset Register Settings. You can enter general details of 
the asset, the data is optional.

To enter the asset’s general details

1. Ensure that you have completed “Setting taxation details for a General asset 
(GA)” on page 348 and “Setting accounting details for a General asset (GA)” on 
page 351.

2. Enter the Serial number.
This is the serial number of the asset, if available.
The Serial number field is limited to a maximum of 50 alphanumeric characters.

3. Enter the Units.
The asset quantity, if available or relevant. For example, if you have six office 
chairs as an asset, the value of the Units would be 6.
The Units must be a value between 0 and 9999.

4. Select the appropriate Location of the asset from the drop-down.
This is the physical location of the asset. 
The available options are those that have been configured using Maintenance > 
Location. See “Creating a new asset location” on page 327.
If you want to add another location, click the Click to add location option from 
the drop-down. The Add Location window opens for you to create another 
location. See “Creating a new asset location” on page 327. Once you have 
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completed creating another location the drop-down will be refreshed with the 
new option(s) so that it can be selected at this stage.

5. Enter the Insurance details of the asset, if appropriate.

a. Enter the Insurer details.

The Insurer field is limited to a maximum of 50 alphanumeric characters.

b. Enter the Premium due date.

By default, the Premium due date field is automatically filled with the Year 
start date, if you are in integrated mode.

Enter the date in the format dd/mm/yyyy or select the date from the drop-
down calendar. A blank date (the None option) can be selected from the 
drop-down calendar.

c. Enter the insurance Premium amount.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

d. Enter the Insured value of the asset.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

6. Enter any Notes.
The Notes section is a free format text field and it does not contain any 
formatting functions.

7. Click Finish.
The Create New Asset Wizard closes. The newly created asset is added to the 
database for the selected year and is displayed on the Assets Listing page. 

Related topics
Setting asset details
Setting taxation details for a General asset (GA)
Editing an asset
Viewing assets
Deleting an asset

Creating a low value pool asset

Australia only

A new low value pool asset can be added to the current year. The asset can be:

 added as a purchase in the current year, or
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 loaded as a previously depreciated asset if it was purchased in a prior year.

A low value pool asset can only be created for assets that are less than $20,000.

When creating a low value pool asset, we recommend the following workflow:

1. Map the relevant general ledger account codes for the low value pool using the 
Low value pool summary window.
See “Low value pool summary” on page 375 for more information.

2. Create the low value pool asset using the Create New Asset Wizard.
Creating a new Taxation only asset in a low value pool asset with the Create 
New Asset Wizard is a 3-step process:

 “Setting asset details for a low value pool (LVP) asset” (see page 355)

 “Setting taxation details for a low value pool (LVP) asset” (see page 357)

 “Setting general details for a low value pool (LVP) asset” (see page 362).

Note: When creating a new asset you must already have a control group configured. 
A message will be displayed if you attempt to create a new asset without 
having a control group configured. Click Yes to open the Maintain Control 
Group window and “Creating a control group” on page 314. 

Related topics
Creating a new general asset
Creating a small business pool asset
Low value pool summary
Setting asset details
Setting taxation details for a low value pool (LVP) asset
Setting accounting details for a General asset (GA)
Setting general details for a small business pool (SBP) asset
Editing the general details of an asset
Editing the taxation details for a low value pool asset

Setting asset details for a low value pool (LVP) asset

Australia only

In the first step of the Create New Asset Wizard, you will enter the asset detail, asset 
type and the allocated control group for the new asset.

What taxation details you are asked for is determined by the asset type you select in 
this step. 
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Note: When creating a new asset you must already have a control group configured. 
A message will be displayed if you attempt to create a new asset without 
having a control group configured. Click Yes to open the Maintain Control 
Group window and “Creating a control group” on page 314.

To enter the details for a new low value pool (LVP) asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Click Create new asset on the Tasks bar.
or 
Press [F4].
The Create New Asset Wizard opens.

3. Enter the Asset code.
This is a mandatory field and must not be blank.
The Asset code is limited to a maximum of 50 alphanumeric characters.

4. Enter the Asset name.
This is a mandatory field and must not be blank.
The Asset name is limited to a maximum of 200 alphanumeric characters.

5. Select the Asset type from the drop-down.
For Taxation only or Accounting and Taxation assets the asset type can be:

 General asset

 Immediate deductible asset

 Small business pool 

 Low value pool.
For Accounting only assets the asset type can be:

 General asset

 Immediate deductible asset

Note: You cannot create new assets of Immediate deductible asset type. 
If you select Immediate deductible asset, you will be asked to 
create a General asset with a depreciation method of Immediate 
write off.

6. Select whether the depreciation calculated will be reported for Accounting or 
Taxation. This selection only applies where the asset is an Accounting and 
Taxation asset. 
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7. Select control group for the asset from the drop-down.
An asset must be associated with a control group. 

8. Click Next.

 If the asset is a Taxation or Accounting and Taxation asset then the next 
step will require Taxation details to be entered. 

 If the asset being created is an Accounting asset then the next step will 
require Accounting details to be entered.

Related topics
Setting taxation details for a General asset (GA)
Setting taxation details for a low value pool (LVP) asset
Setting taxation details for a small business pool (SBP) asset
Setting accounting details for a General asset (GA)
Setting general details for a small business pool (SBP) asset
Editing an asset
Viewing assets
Deleting an asset
Creating a control group

Setting taxation details for a low value pool (LVP) asset

Australia only

This will be Step 2 of the Create New Asset Wizard for Taxation only or Accounting 
and Taxation assets. In this scenario you are entering the taxation details for the low 
value pool asset (LVP). 

This step will not be seen if you are creating an Accounting only asset. 

To enter the taxation details for a new low value pool asset

1. In the first step for Asset details you selected Low value pool from the Asset 
type drop-down.

2. Enter the Acquisition date of the asset.
By default, this field is automatically filled with the Year start date.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.
If you enter a date prior to the Year start date for the year period, this asset will 
be added as a previously depreciated asset and will be depreciated at Year 2+ 
rates.
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The Start date field for the asset is automatically filled with the Year start date.
Low value pooled assets are always depreciated for the full year regardless of 
when they were purchased, therefore there is no need to enter a start date.

3. Enter the Cost of the low value pool asset.
The default value is 0.00. 
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.
An asset can only be added to a low value pool if its cost is less than $20,000. 
If you add a low value pooled asset whose cost is greater than $20,000, a 
message will be displayed to inform you of this. Decide whether you would still 
like to add the asset to the low value pool by clicking Yes or No. You can also 
select the Don’t ask again checkbox, so as not to receive this message again 
under similar circumstances.

4. Enter the Opening written down value of the asset.
An Opening written down value can only be entered, if the Acquisition date is 
prior to the current financial year, e.g., if you are loading a previously 
depreciated asset from another accountant’s schedule.
The default value is 0.00.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

5. Select the Asset came from an existing LV Pool checkbox, if required.
The Asset came from an existing LV Pool checkbox is only available for any 
previously depreciated assets that are being added to the pool.
Select this checkbox if you are, e.g., adding assets that came from another 
accountant. 
This will result in the following rules being applied:

 The pool contribution (taxable value) will not be reduced again by the 
Private use%, as it was already reduced in the original pool.

 No journal will be created to transfer the asset into the pool. The pool 
account balance is already correct when the original trial balance was 
placed into the general ledger.

 If a change in private use is later applied, selecting the Asset came from an 
existing LV Pool checkbox will result in the Tax year added to pool value 
being based on the acquisition date rather than the year it was added to the 
register.

If you are adding the assets from general assets, then the Asset came from an 
existing LV Pool checkbox must be deselected.
The Asset came from an existing LV Pool checkbox will be selected by default 
when you are migrating low value pooled assets from another system.
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6. Enter the Private use % for the asset.
The value must be between 0 and 100%.
The Pool contribution (Taxable value) is calculated.
The Calculate decline in value section contains a number of read only fields:

 Depreciation Rate

This field is based on the Start date. It changes from 18.75% to 37.5% 
depending on whether the asset has already been depreciated in previous 
years.

 Calculated depreciation

This is field is calculated as the Pool contribution (Taxable value) multiplied 
by the Depreciation rate.

 Total depreciation 

This is the sum of the calculated depreciation.

 Termination value 

This is only relevant once an asset has been sold and you are “Editing the 
taxation details for a low value pool asset” on page 386.

 Taxable termination value 

This is only relevant once an asset has been sold and you are “Editing the 
taxation details for a low value pool asset” on page 386.

 Closing written down value 

This is calculated once the Cost or Opening written down value has been 
entered, based on the other values above.

7. Click Next.

 If the asset being created is an Accounting and Taxation asset then 
continue to “Setting accounting details for a low value pool (LVP) asset” 
(see page 360). 

 If the asset being created is a Taxation only asset then continue to “Setting 
general details for a low value pool (LVP) asset” (see page 362). 

Related topics
Low value pool summary
Setting asset details
Setting general details for a small business pool (SBP) asset
Setting taxation details for a low value pool (LVP) asset
Setting taxation details for a small business pool (SBP) asset
Setting taxation details for a General asset (GA)
Editing the general details of an asset
Editing the taxation details for a small business pool asset
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Editing the taxation details for a low value pool asset

Setting accounting details for a low value pool (LVP) asset

Australia only

This will be Step 2 of the Create New Asset Wizard for Accounting only assets. It will 
be Step 3 for Accounting and Taxation assets. This step will not be seen if you are 
creating a Taxation only asset. 

In this step of the Create New Asset Wizard you record the accounting details for an 
asset.

If this is step 3, that is an Accounting and Taxation asset, then some of the fields in 
this step are filled in for you from the Taxation details entered in the previous step. 

To enter the accounting details for an asset

1. In the first step for Asset details you selected:

 Low value pool from the Asset type drop-down. 

2. Enter the Acquisition date of the asset.
By default, this field is automatically filled with the Year start date.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.
If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

3. Enter the Start date for the asset.
By default, this field is automatically filled with the Acquisition date that you 
entered above.
The Start date must not be after the Year end date for the year period.
If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

4. Select the Depreciation method from the drop-down.
By default, the depreciation method is taken from what was configured in the 
control group for the asset.
The depreciation method can be overwritten for each asset.

5. Enter the Original Cost of the asset.
The default value is 0.00. 
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.
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6. Enter the Opening written down value of the asset.
The default value is 0.00 and it is a read only field.
An Opening written down value can be entered, if the Start date is prior to the 
current financial year.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. Select the appropriate options in the Calculate decline in value section.
You can select either:

a. Enter the number of years for Useful life. Useful life is applicable if the asset 
is being depreciated using the Straight line method only.

or 

b. Enter the Depreciation rate as a percentage for Rate year 1%

and

Enter the Depreciation rate as a percentage for Rate year 2+%.

These fields must be a value between 0 and 100%. 

8. Select the appropriate options in the Other values section.

a. Enter the Private use % for the asset.

The value must be between 0 and 100%.

b. Select the Private use bal sheet a/c to be used, if a portion of the asset is to 
be used for private use.

For example, this would normally be the shareholder’s current account - 
being the shareholder who is using this asset for private use.

Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account 
to be used for posting journals regarding private use of the asset.

c. The Accumulated depreciation and Accumulated private use fields are 
calculated fields and are read only.

d. The Accumulated private use field is enabled if you create an asset where 
the Start date is prior to the Year start date.

9. Click Next.
Continue to “Setting general details for a low value pool (LVP) asset” on 
page 362.
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Related topics
Setting general details for a small business pool (SBP) asset
Setting asset details
Editing an asset
Viewing assets
Deleting an asset

Setting general details for a low value pool (LVP) asset

Australia only

The last step in the wizard will be either Step 3 or Step 4 of the of the Create New 
Asset Wizard depending the Asset Register Settings. You can enter general details of 
the asset, the data is optional.

To enter the asset’s general details

1. Ensure that you have completed “Setting taxation details for a low value pool 
(LVP) asset” on page 357 and “Setting accounting details for a low value pool 
(LVP) asset” on page 360.

2. Enter the Serial number.
This is the serial number of the asset, if available.
The Serial number field is limited to a maximum of 50 alphanumeric characters.

3. Enter the Units.
The asset quantity, if available or relevant. For example, if you have six office 
chairs as an asset, the value of the Units would be 6.
The Units must be a value between 0 and 9999.

4. Select the appropriate Location of the asset from the drop-down.
This is the physical location of the asset. 
The available options are those that have been configured using Maintenance > 
Location. See “Creating a new asset location” on page 327.
If you want to add another location, click the Click to add location option from 
the drop-down. The Add Location window opens for you to create another 
location. See “Creating a new asset location” on page 327. Once you have 
completed creating another location the drop-down will be refreshed with the 
new option(s) so that it can be selected at this stage.

5. Enter the Insurance details of the asset, if appropriate.

a. Enter the Insurer details.

The Insurer field is limited to a maximum of 50 alphanumeric characters.
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b. Enter the Premium due date.

By default, the Premium due date field is automatically filled with the Year 
start date, if you are in integrated mode.

Enter the date in the format dd/mm/yyyy or select the date from the drop-
down calendar. A blank date (the None option) can be selected from the 
drop-down calendar.

c. Enter the insurance Premium amount.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

d. Enter the Insured value of the asset.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

6. Enter any Notes.
The Notes section is a free format text field and it does not contain any 
formatting functions.

7. Click Finish.
The Create New Asset Wizard closes. The newly created asset is added to the 
database for the selected year and is displayed on the Assets Listing page. 

Related topics
Setting asset details
Setting taxation details for a General asset (GA)
Editing an asset
Viewing assets
Deleting an asset

Creating a small business pool asset

Australia only

A new small business pool asset can be added to the current year. The asset can be:

 added as a purchase in the current year, or

 loaded as a previously depreciated asset if it was purchased in a prior year.

Taxation only asset

When creating a Taxation only small business pool asset, we recommend the 
following workflow:
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1. Configure the control group using the Maintain Control Group window and see 
“Creating a control group” on page 314.

2. Map the relevant general ledger account codes for the small business pool using 
the Small business pool summary window. 
See “Small business pool summary” on page 376 for more information.

3. Create the small business pool asset using the Create New Asset Wizard.
Creating a new Taxation only small business pool asset with the Create New 
Asset Wizard is a 3-step process:

 “Setting asset details for a small business pool (SBP) asset” (see page 365)

 “Setting taxation details for a small business pool (SBP) asset” (see page 
366)

 “Setting general details for a small business pool (SBP) asset” (see page 
373).

Accounting and Taxation asset

When creating an Accounting and Taxation small business pool asset, we 
recommend the following workflow:

1. Configure the control group using the Maintain Control Group window and see 
“Creating a control group” on page 314.

2. Map the relevant general ledger account codes for the small business pool using 
the Small business pool summary window. 
See “Small business pool summary” on page 376 for more information.

3. Create the small business pool asset using the Create New Asset Wizard.
Creating a new Taxation only small business pool asset with the Create New 
Asset Wizard is a 4-step process:

 “Setting asset details for a small business pool (SBP) asset” (see page 365)

 “Setting taxation details for a small business pool (SBP) asset” (see page 
366)

 “Setting accounting details for a small business pool (SBP) asset” (see page 
371)

 “Setting general details for a small business pool (SBP) asset” (see page 
373). 

Note: If you attempt to create a new asset without having a control group 
configured a message is displayed. Click Yes to open the Maintain 
Control Group window and see “Creating a control group” on 
page 314. 
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Related topics
Creating a new general asset
Small business pool summary
Setting asset details
Setting taxation details for a small business pool (SBP) asset
Setting accounting details for a General asset (GA)
Setting general details for a small business pool (SBP) asset
Editing the general details of an asset
Editing the taxation details for a small business pool asset

Setting asset details for a small business pool (SBP) asset

Australia only

In the first step of the Create New Asset Wizard, you will enter the asset detail, asset 
type and the allocated control group for the new asset.

What taxation details you are asked for is determined by the asset type you select in 
this step. 

Note: When creating a new asset you must already have a control group configured. 
A message will be displayed if you attempt to create a new asset without 
having a control group configured. Click Yes to open the Maintain Control 
Group window and “Creating a control group” on page 314.

To enter the details for a new small business pool (SBP) asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Click Create new asset on the Tasks bar.
or 
Press [F4].
The Create New Asset Wizard opens.

3. Enter the Asset code.
This is a mandatory field and must not be blank.
The Asset code is limited to a maximum of 50 alphanumeric characters.

4. Enter the Asset name.
This is a mandatory field and must not be blank.
The Asset name is limited to a maximum of 200 alphanumeric characters.

5. Select the Asset type from the drop-down.
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For Taxation only or Accounting and Taxation assets the asset type can be:

 General asset

 Immediate deductible asset

 Small business pool 

 Low value pool.
For Accounting only assets the asset type can be:

 General asset

 Immediate deductible asset

Note: You cannot create new assets of Immediate deductible asset type. 
If you select Immediate deductible asset, you will be asked to 
create a General asset with a depreciation method of Immediate 
write off.

6. Select whether the depreciation calculated will be reported for Accounting or 
Taxation. This selection only applies where the asset is an Accounting and 
Taxation asset. 

7. Select control group for the asset from the drop-down.
An asset must be associated with a control group. 

8. Click Next.

 If the asset is a Taxation or Accounting and Taxation asset then the next 
step will require Taxation details to be entered. 

 If the asset being created is an Accounting asset then the next step will 
require Accounting details to be entered.

Related topics
Setting taxation details for a General asset (GA)
Setting taxation details for a low value pool (LVP) asset
Setting taxation details for a small business pool (SBP) asset
Setting accounting details for a General asset (GA)
Setting general details for a small business pool (SBP) asset
Editing an asset
Viewing assets
Deleting an asset
Creating a control group

Setting taxation details for a small business pool (SBP) asset

Australia only
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This will be Step 2 of the Create New Asset Wizard for Taxation only or Accounting 
and Taxation assets. In this scenario you are entering the taxation details for the low 
small business pool asset (SBP). 

This step will not be seen if you are creating an Accounting only asset. 

To enter the taxation details for a new small business pool asset 

1. In the first step for Asset details you selected Small business pool from the 
Asset type drop-down.

2. Enter the Acquisition date of the asset.
By default, this field is automatically filled with the Year start date.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.
If you enter a date prior to the Year start date for the year period, this asset will 
be added as a previously depreciated asset and will be depreciated at Year 2+ 
rates.
The Start date field for the asset is automatically filled with the Year start date.

Note: Small business pooled assets are always depreciated for the full 
year regardless of when they were purchased, therefore there is no 
need to enter a start date.

3. Enter the Cost of the small business pool asset.
The default value is 0.00. 
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.
If the cost of the small business pool asset is less than $20,000, then you should 
claim an immediate write off for the asset by adding it as an immediate 
deductible asset instead. If you add the asset to the small business pool, then 
you will not receive the immediate write off. A message will be displayed to 
inform you of this and asking you whether you still want to add the asset to the 
small business pool. Click Yes or No. You can also select the Don’t ask again 
checkbox, to not receive this message again under similar circumstances.
The immediate write off for general assets acquired between 1 January 2014 
and 11 May 2015 was decreased from $6,500 to $1,000. On 12 May 2015 it was 
increased to $20,000 and this applies until 30 June 2017.

4. Enter the Opening written down value of the asset.
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An Opening written down value can only be entered, if the Acquisition date is 
prior to the current financial year, e.g., if you are loading a previously 
depreciated asset from another accountant’s schedule.
The default value is 0.00.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

5. Select the Asset came from an existing SB Pool checkbox, if required.
The Asset came from an existing SB Pool checkbox is only available for any 
previously depreciated assets that are being added to the pool.
Select this checkbox if you are, e.g., adding assets that were from another 
accountant. 
This will result in the following rules being applied:

 The pool contribution (taxable value) will not be reduced again by the 
Private use %, as it was already reduced in the original pool.

 No journal will be created to transfer the asset into the pool. The pool 
account balance is already correct when the original trial balance was 
placed into the general ledger.

 If a change in private use is later applied, selecting the Asset came from an 
existing SB Pool checkbox will result in the Tax year added to pool value 
being based on the acquisition date rather than the year it was added to the 
register.

If you are adding the assets from general assets, then the Asset came from an 
existing SB Pool checkbox must be deselected.
The Asset came from an existing SB Pool checkbox will be selected by default 
when you are migrating small business pooled assets from another system.

6. Select the Motor vehicle checkbox, if the asset is a motor vehicle.
The Cost limit of the motor vehicle field is only relevant if the Motor vehicle 
checkbox was selected. The Cost limit field is automatically filled with the ATO 
value relevant for the current tax year.
If the asset was a previously depreciated asset loaded from say another 
accountant’s schedule, the Cost limit field can be edited. You should enter the 
Cost limit that was applied at the time the asset was first pooled in the other 
system, as this will be used at a later date when you dispose of the asset (to 
calculate the Taxable termination value).
If the asset is a motor vehicle:

 the pool contribution (Taxable value) is limited to the Cost limit.

 depreciation for the first year will include the motor vehicle immediate 
write off amount in addition to the Year 1 rate, to the amount of the Cost 
limit.
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7. Enter the Private use % for the asset.
The value must be between 0 and 100%.

8. Click the Private use adjustment ellipsis button.
The ellipsis button is only enabled if the asset has been depreciated in previous 
years, i.e., the acquisition date was prior to this financial year.
The Private use adjustment window opens. This is where adjustments are made 
to the pool total because of changes in the private use percentage.

a. Select the Asset was first used under the ATO’s “simplified depreciation” 
rules checkbox, if required.

If the checkbox is selected, a different reduction factor is used when 
calculating the Private use adjustment amount.

b. Enter the Tax year the asset was allocated to a pool.

For previously depreciated assets, this field defaults to the financial tax year 
that the asset was acquired. 

You can change the default if required. For example, it may be necessary to 
change the default tax year if you are loading an asset from a schedule 
provided by another accountant.

Note: If the asset has been part of the pool for < 1 year or > 4 years, there 
is no adjustment for private use.

c. Enter the Private use last year %.

This field will automatically default to the value entered in the main screen. 
This value can be changed if required.

d. Enter the Private use this year %.

This field will automatically default to the value entered in the main screen. 
This value can be changed if required. 

If a change to the Private use this year % is made here, it will also be 
reflected in the Private use % field of the main screen.

Note: If the difference in private use percentage between different years 
is less than 10%, then there is no adjustment in the private use.

e. Enter the Asset value.

The Asset value is defined by the ATO to be the cost of the asset less its 
depreciation since it was first used or installed ready for use, at the time it 
was first added to the pool. The cost should include any additions made to 
the asset, after taking into account its depreciation.
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If the Asset came from an existing SB pool checkbox is selected, then the 
Asset value defaults to the cost. You should edit the Asset value field if, for 
instance, you are loading this asset from another accountant’s schedule and 
the asset value was not the same as the cost.

If the Asset came from an existing SB pool checkbox is deselected, then the 
Asset value field defaults to the opening written down value in the year it 
was first added to the pool (and cannot be edited).

The Private use adjustment is calculated.

f. Click OK.

You are returned to “Setting taxation details for a small business pool (SBP) 
asset” on page 366.

The Pool contribution (Taxable value) is calculated.
The Calculate decline in value section contains a number of read only fields:

 Depreciation Rate

This field is based on the Start date. It changes from 15% to 30% depending 
on whether the asset has already been depreciated in previous years.

 Calculated depreciation

This is field is calculated as the Pool contribution (Taxable value) multiplied 
by the Depreciation rate.

 MV immediate write off 

If you purchased a motor vehicle, an immediate write off of $5,000 is used 
in the calculations up to 31 December 2013. 

If you purchased a motor vehicle on or after 1 January 2014, no immediate 
write off is calculated.

Note: This is defined by compliance regulations issued from the ATO.

 Total depreciation 

This is the sum of the calculated depreciation and the MV immediate write 
off.

 Termination value 

This is only relevant once an asset has been sold and you are “Editing the 
taxation details for a small business pool asset” on page 388.

 Taxable termination value 

This is only relevant once an asset has been sold and you are “Editing the 
taxation details for a small business pool asset” on page 388.

 Closing written down value 
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This is calculated once the Cost or Opening written down value has been 
entered, based on the other values above.

9. Click Next.

 If the asset being created is a Accounting or Accounting and Taxation asset 
then continue to “Setting accounting details for a small business pool (SBP) 
asset” (see page 371). 

 If the asset being created is a Taxation only asset then continue to “Setting 
general details for a small business pool (SBP) asset” (see page 373). 

Related topics
Small business pool summary
Setting asset details
Setting taxation details for a low value pool (LVP) asset
Setting taxation details for a General asset (GA)
Setting general details for a small business pool (SBP) asset
Editing the general details of an asset
Editing the taxation details for a small business pool asset

Setting accounting details for a small business pool (SBP) asset

Australia only

This will be Step 2 of the Create New Asset Wizard for Accounting only assets. It will 
be Step 3 for Accounting and Taxation assets. This step will not be seen if you are 
creating a Taxation only asset. 

In this step of the Create New Asset Wizard you record the accounting details for an 
asset.

If this is step 3, that is an Accounting and Taxation asset, then some of the fields in 
this step are filled in for you from the Taxation details entered in the previous step.

To enter the accounting details for an asset

1. In the first step for Asset details you selected:

 Small business pool from the Asset type drop-down. 

2. Enter the Acquisition date of the asset.
By default, this field is automatically filled with the Year start date.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.



MYOB AO, AE, AU PM Client Accounting User Guide | 372

If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

3. Enter the Start date for the asset.
By default, this field is automatically filled with the Acquisition date that you 
entered above.
The Start date must not be after the Year end date for the year period.
If you are loading an asset that has been previously depreciated, enter a date 
prior to the Year start date.

4. Select the Depreciation method from the drop-down.
By default, the depreciation method is taken from what was configured in the 
control group for the asset.
The depreciation method can be overwritten for each asset.

5. Enter the Original Cost of the asset.
The default value is 0.00. 
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

6. Enter the Opening written down value of the asset.
The default value is 0.00 and it is a read only field.
An Opening written down value can be entered, if the Start date is prior to the 
current financial year.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. Select the appropriate options in the Calculate decline in value section.

You can select either:

a. Enter the number of years for Useful life. Useful life is applicable if the asset 
is being depreciated using the Straight line method only.

or 

b. Enter the Depreciation rate as a percentage for Rate year 1%

and

Enter the Depreciation rate as a percentage for Rate year 2+%.

These fields must be a value between 0 and 100%. 

8. Select the appropriate options in the Other values section.

a. Enter the Private use % for the asset.

The value must be between 0 and 100%.
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b. Select the Private use bal sheet a/c to be used, if a portion of the asset is to 
be used for private use.

For example, this would normally be the shareholder’s current account - 
being the shareholder who is using this asset for private use.

Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account 
to be used for posting journals regarding private use of the asset.

c. The Accumulated depreciation and Accumulated private use fields are 
calculated fields and are read only.

d. The Accumulated private use field is enabled if you create an asset where 
the Start date is prior to the Year start date.

9. Click Next.
Continue to “Setting general details for a small business pool (SBP) asset” on 
page 373.

Related topics
Setting general details for a small business pool (SBP) asset
Setting asset details
Editing an asset
Viewing assets
Deleting an asset

Setting general details for a small business pool (SBP) asset

Australia only

The last step in the wizard will be either Step 3 or Step 4 of the of the Create New 
Asset Wizard depending the Asset Register Settings. You can enter general details of 
the asset, the data is optional.

To enter the asset’s general details

1. Ensure that you have completed “Setting taxation details for a small business 
pool (SBP) asset” on page 366 and “Setting accounting details for a small 
business pool (SBP) asset” on page 371.

2. Enter the Serial number.
This is the serial number of the asset, if available.
The Serial number field is limited to a maximum of 50 alphanumeric characters.

3. Enter the Units.
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The asset quantity, if available or relevant. For example, if you have six office 
chairs as an asset, the value of the Units would be 6.
The Units must be a value between 0 and 9999.

4. Select the appropriate Location of the asset from the drop-down.
This is the physical location of the asset. 
The available options are those that have been configured using Maintenance > 
Location. See “Creating a new asset location” on page 327.
If you want to add another location, click the Click to add location option from 
the drop-down. The Add Location window opens for you to create another 
location. See “Creating a new asset location” on page 327. Once you have 
completed creating another location the drop-down will be refreshed with the 
new option(s) so that it can be selected at this stage.

5. Enter the Insurance details of the asset, if appropriate.

a. Enter the Insurer details.

The Insurer field is limited to a maximum of 50 alphanumeric characters.

b. Enter the Premium due date.

By default, the Premium due date field is automatically filled with the Year 
start date, if you are in integrated mode.

Enter the date in the format dd/mm/yyyy or select the date from the drop-
down calendar. A blank date (the None option) can be selected from the 
drop-down calendar.

c. Enter the insurance Premium amount.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

d. Enter the Insured value of the asset.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

6. Enter any Notes.
The Notes section is a free format text field and it does not contain any 
formatting functions.

7. Click Finish.
The Create New Asset Wizard closes. The newly created asset is added to the 
database for the selected year and is displayed on the Assets Listing page. 

Related topics
Setting asset details
Setting taxation details for a General asset (GA)
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Editing an asset
Viewing assets
Deleting an asset

Low value pool summary

Australia only

You can view a summary of the taxation values of all the assets in a low value pool. 
From the Low value pool summary window you can also map and edit the general 
ledger accounts for the low value pool. 

To map a general ledger account to a low value pool

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Click Low value pool on the Tasks bar.
The Low value pool summary window for the asset year opens.

3. If the general ledger is not integrated, enter the general ledger account code 
and name for each relevant account. 
These details will appear in the Journal summary report.

4. If the general ledger is integrated, click the magnifying glass icon associated 
with the selected integrated account.
The Find Chart of Accounts window opens from where you can search for the 
account or press [F9]. See “Searching accounts” on page 324.

a. You can search, filter and/or sort the Chart of Accounts. The default sorting 
in the Find Charts of Accounts window is in ascending account code order.

Click on a column header to change the sorting on that column in ascending 
or descending order.

b. Select the account and click OK. 

Alternatively, double-click the selected general ledger account in the Find 
Charts of Accounts window to automatically fill the appropriate field in the 
Low value pool summary window.

5. Repeat the above step to add or change another integrated account, as 
required.

6. Click Close.
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To view the low value pool summary

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Click Low value pool on the Tasks bar.
The Low value pool summary window for the asset year opens.
Most of the information in this window is read only.

3. Click Close.

Related topics
Setting asset details
Setting taxation details for a small business pool (SBP) asset
Setting general details for a small business pool (SBP) asset
Setting taxation details for a low value pool (LVP) asset
Setting taxation details for a General asset (GA)
Setting taxation details for a small business pool (SBP) asset
Editing the general details of an asset
Editing the taxation details for a low value pool asset

Small business pool summary

Australia only

You can view a summary of the taxation values of all the assets in a small business 
pool. From the Small business pool summary window you can also map and edit the 
general ledger accounts for the small business pool.

To map a general ledger account to a small business pool

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Click Small business pool on the Tasks bar.
The Small business pool summary window for the asset year opens.

3. If the general ledger is not integrated, enter the general ledger account code 
and name for each relevant account. 
These details will appear in the Journal summary report.

4. If the general ledger is integrated, click the magnifying glass icon associated 
with the selected integrated account.
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The Find Chart of Accounts window opens from where you can search for the 
account or press [F9]. See “Searching accounts” on page 324.

a. You can search, filter and/or sort the Chart of Accounts. The default sorting 
in the Find Charts of Accounts window is in ascending account code order.

Click on a column header to change the sorting on that column in ascending 
or descending order.

b. Select the account and click OK. 

Alternatively, double-click the selected general ledger account in the Find 
Charts of Accounts window to automatically fill the appropriate field in the 
Small business pool summary window.

5. Repeat the above step to add or change another integrated account, as 
required.

6. Click Close.

To view the small business pool summary

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Click Small business pool on the Tasks bar.
The Small business pool summary window for the asset year opens.
Most of the information in this window is read only.

3. Click Close.

Related topics
Setting asset details
Setting taxation details for a small business pool (SBP) asset
Setting taxation details for a General asset (GA)
Setting general details for a small business pool (SBP) asset
Editing the general details of an asset
Editing the taxation details for a small business pool asset

Submitting journals to Workpapers

If an Assets register is integrated with an underlying ledger, you can add Assets 
journal details as an unposted journal in the Workpapers trial balance table.

(Australia) Capital gain and Profit are posted combined under the “Profit on Sale” 
account. 
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(New Zealand) Capital gain will be posted under the “Capital Gain” account, and the 
Profit on Sale (also known as depreciation recovered) will be posted on the mapped 
“Profit on Sale” account.

Note: At least one asset must be created to submit journals.

Asset journals are submitted for posting based on selecting either “Taxation” 
or “Accounting” in the Register settings window. If you select “Taxation”, 
then taxation journals will be submitted. If you select “Accounting”, then 
accounting journals are submitted.

To submit a journal

1. Open the Client Accounting > Assets tab.

2. Click Submit journals on the Tasks bar.

Note: The Assets journals period end date must match the Workpapers 
period end date to submit journals. 

The Workpapers period must be an open period; you cannot send 
journals to a completed Workpapers period.

3. In the window Submit assets journals for posting? click Yes.
The journals are submitted to Workpapers for posting.

Note: You can also resubmit journals with new entries; the resubmitted journal 
updates the existing journal in Workpapers with the account codes that have 
a difference in value.

4. In the window Asset journals have been submitted successfully, click OK.

5. To view the Assets accounts, open the Workpapers trial balance sheet.

6. Click View all in the Tasks bar.
The journals are displayed in the Journals window.

Related topics
Posting journals and exporting new accounts
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Managing assets
When managing assets, you may need to:

 “Viewing assets” (see page 379)

 “Editing asset register settings” (see page 300)

 “Deleting an asset register” (see page 301)

 “Editing a control group” (see page 317)

 “Deleting a control group” (see page 320)

 “Moving an asset to another control group” (see page 325)

 “Adding successive asset years” (see page 303)

 “Deleting an asset year” (see page 304)

 “Editing an asset location” (see page 327)

 “Deleting an asset location” (see page 328)

 “Editing an asset” (see page 380)

 “Deleting an asset” (see page 397).

Viewing assets

The Assets Listing page lists all of the assets for a client. By default, 100 assets are 
displayed on the Assets Listing page. If you have more than 100 assets, you will be 
able to use pagination control to go to the:

 next page

 last page

 previous page

 first page.

You can also enter a page number in the text field to jump directly to the required 
page.

To view assets in multiple years

You can have multiple years open at the same time. If you have 2 successive asset 
years open and you add or sell an asset in the current year, click the Refresh icon on 
the Tasks bar to view the updated listing in the future year.

Related topics
Assets Listing page
Customising the Assets Listing page
Sorting, filtering and grouping your assets
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Editing an asset

You can edit an asset that is:

 created within the current year period

 rolled forward from a prior year period.

An immediate deductible asset can only be edited in the current year period.

Any changes made to an asset may result in the depreciation being re-calculated for 
the current year and for any available subsequent years.

Some changed can only be made in the year the asset was added to the register. For 
example, the Cost price can only be edited in the first year, however the Private use 
% can be edited in any year as it may change from year to year.

While an asset is open for editing, you cannot delete, move, transfer, or sell the asset. 
You also cannot post journals when editing an asset for the given period.

To edit an asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Edit the Asset code.
The Asset code can only be edited in the first year the asset is created. 
Otherwise this field is disabled and you will not be able to edit the Asset code.
The Asset code must be unique. It is a mandatory field and a value must be 
entered.

5. Edit the Asset name.
If you edit the Asset name, the changes are reflected in all years of the asset 
register that the asset is part of.
The Asset type and Control group fields cannot be edited once the asset has 
been created. They are read only fields.
If you want to move the asset to a different control group, see “Moving an asset 
to another control group” on page 325.
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6. Edit the fields within the Taxation tab, as required. This tab will be available 
Taxation only or Accounting and Taxation assets.
See the relevant information:

 “Editing the taxation details of a general asset” on page 382 

 (Australia) “Editing the taxation details for an immediate deductible asset” 
on page 385

 (Australia) “Editing the taxation details for a small business pool asset” on 
page 388

 (Australia) “Editing the taxation details for a low value pool asset” on 
page 386.

7. Click the Accounting tab, as required. This tab will be available Accounting only 
or Accounting and Taxation assets.
See the relevant information:

 “Editing the accounting details of a general asset” on page 392 

 (Australia) “Editing the taxation details for an immediate deductible asset” 
on page 385

8. Click the General details tab.

9. Edit the fields within the General details tab as required.
See “Editing the general details of an asset” on page 396.

10. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Setting taxation details for a General asset (GA)
(Australia) Setting taxation details for a small business pool (SBP) asset
Editing the taxation details of a general asset
(Australia) Editing the taxation details for an immediate deductible asset
(Australia) Editing the taxation details for a small business pool asset
Editing the general details of an asset
Managing assets
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Editing the taxation details of a general asset

To edit the taxation details for a general asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the general asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Edit the asset Acquisition date, if necessary.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.
If you are editing an asset that has been previously depreciated, enter an 
Acquisition date prior to the Year start date.

5. Edit the Start date for the asset.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar.
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date for the year period.
If you are editing an asset that has been previously depreciated, enter a date 
prior to the Year start date.

6. Select a different Depreciation method from the drop-down, if necessary.

7. Edit the Cost of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

8. Edit the Opening written down value of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

9. (Australia) Select the Motor vehicle checkbox, if your asset is a motor vehicle.

10. (Australia) Edit the Cost limit of the motor vehicle.
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This field is only available if the Motor vehicle checkbox was selected.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

Note: Up to 31 December 2013:
If you edit the cost of the general asset so that it is less than the 
immediate write off threshold of $6,500, then you can claim an 
immediate write off for the asset. If you leave it as a general asset, 
MYOB Assets Live will not automatically write off the asset.
If you attempt to add an asset which is less than $6,500 as a general 
asset, a message will be displayed prompting you to add it as an 
immediate write off asset instead.
On or after 1 January 2014:
If you attempt to add an asset that was acquired between 1 January 
2014 and 11 May 2015, the immediate write off threshold is $1,000 
or less. From 12 May 2015, the threshold is $20,000.

11. (Australia) Select different options for the Calculate decline in value section.
You can select either:

a. Effective life

 Edit the number of Years and Months or select the ATO commissioner’s 
effective life option.

The Years field is limited to a maximum of 3 digits and must be a value 
between 0 and 999. 

The Months field must be a value between 0 and 12.

b. Depreciation rate

 Edit the percentage depreciation Rate year 1.

 Edit the percentage depreciation Rate year 2+.

These fields are limited to 6 digits including 2 decimal spaces. They must be 
a value between 0 and 100%.

12. (New Zealand) In the Calculate decline in value section, enter the percentage 
depreciation in Rate year %.
The Find Rate hyperlink opens the IRD Depreciation rate finder website.

13. Select the appropriate options in the Other values section.

a. (Australia) Edit the Adjusted base cost.

Enter a value in this field if your asset Start date is prior to the asset register 
Year start date and the selected depreciation method is Prime cost.
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This field is not available for use if the asset Start date is greater than or 
equal to the asset register Year start date.

This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

b. Edit the Private use % for the asset.

The value must be between 0 and 100%.

c. Select a different Private use bal sheet a/c to be used, if a portion of the 
asset is to be used for private use.

For example, this would normally be the shareholder’s current account - 
being the shareholder who is using this asset for private use.

Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account 
to be used for posting journals regarding private use of the asset.

The Accumulated depreciation and Accumulated private use fields are 
calculated fields and are read only.

The Accumulated private use field is enabled if you create an asset where 
the Start date is prior to the Year start date.

14. Edit the General details of the asset.
See “Editing the general details of an asset” on page 396.

15. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Setting taxation details for a General asset (GA)
(Australia) Setting taxation details for a small business pool (SBP) asset
Editing an asset
(Australia) Editing the taxation details for an immediate deductible asset
(Australia) Editing the taxation details for a small business pool asset
(Australia) Editing the taxation details for a low value pool asset
Editing the accounting details of a general asset
(Australia) Editing the accounting details for an immediate deductible asset
Editing the general details of an asset
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Editing the taxation details for an immediate deductible asset

Australia only

To edit the taxation details for an immediate deductible asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the immediate deductible asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Edit the asset Acquisition date, if necessary.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.

5. Edit the Start date for the asset.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar.
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date for the year period.

6. Edit the Cost of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. Edit the Private use % for the asset.
The value must be between 0 and 100%.

8. Select a different Private use bal sheet a/c to be used, if a portion of the asset is 
to be used for private use.
For example, this would normally be the shareholder’s current account - being 
the shareholder who is using this asset for private use.
Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account to 
be used for posting journals regarding private use of the asset.
The Accumulated private use field is a calculated field and is read only.
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The Accumulated private use field is enabled if you created an asset where the 
Start date is prior to the Year start date.

9. Edit the General details of the asset.
See “Editing the general details of an asset” on page 396.

10. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Setting taxation details for a General asset (GA)
Setting taxation details for a small business pool (SBP) asset
Editing an asset
Editing the taxation details of a general asset
Editing the taxation details for an immediate deductible asset
Editing the taxation details for a small business pool asset
Editing the taxation details for a low value pool asset
Editing the accounting details of a general asset
Editing the accounting details for an immediate deductible asset
Editing the general details of an asset

Editing the taxation details for a low value pool asset

Australia only

To edit the taxation details for a low value pool asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the low value pool asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Edit the asset Acquisition date, if necessary.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
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Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date. If you enter a date 
prior to the Year start date for the year period, this asset will become a 
‘previously depreciated asset’ and will be depreciated at the Year 2+ rate. 
The Start date field for the asset is automatically updated to the Year start date.
Low value pooled assets are always depreciated for the full year regardless of 
when they were purchased, therefore there is no need to enter a start date.

5. Edit the Cost of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

6. Edit the Opening written down value of the asset, as required.
The Opening written down value can only be edited, if the Acquisition date is 
prior to the current financial year. For example, if you are loading a previously 
depreciated asset from another accountant’s schedule.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. Select the Asset came from an existing LV Pool checkbox, if required.
The Asset came from an existing LV Pool checkbox is only available for any 
previously depreciated assets that are being added to the pool.
Select this checkbox if you are, for example adding assets that were from 
another accountant. 
This will result in the following rules being applied:

 The pool contribution (taxable value) will not be reduced again by the 
Private use%, as it was already reduced in the original pool.

 No journal will be created to transfer the asset into the pool. The pool 
account balance is already correct when the original trial balance was 
placed into the general ledger.

 If a change in private use is later applied, selecting the Asset came from an 
existing LV Pool checkbox will result in the Tax year added to pool value 
being based on the acquisition date rather than the year it was added to the 
register.

If you are adding the assets from general assets, then the Asset came from an 
existing LV Pool checkbox must be deselected.

8. Edit the Private use % for the asset.
The value must be between 0 and 100%.
The Pool contribution (Taxable value) is updated as are all the values in the 
Decline in value section.
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The last statement in the window lets you know the year that the asset was 
pooled in case you need to go back to the first year and change something about 
that asset.

9. Edit the General details of the asset.
See “Editing the general details of an asset” on page 396.

10. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Setting taxation details for a General asset (GA)
Setting taxation details for a small business pool (SBP) asset
Setting taxation details for a low value pool (LVP) asset
Editing the taxation details of a general asset
Editing the taxation details for an immediate deductible asset
Editing the taxation details for a small business pool asset
Editing the accounting details of a general asset
Editing the accounting details for an immediate deductible asset
Editing the general details of an asset
Managing assets

Editing the taxation details for a small business pool asset

Australia only

To edit the taxation details for a small business pool asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the small business pool asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Edit the asset Acquisition date, if necessary.
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Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date. If you enter a date 
prior to the Year start date for the year period, this asset will become a 
‘previously depreciated asset’ and will be depreciated at the Year 2+ rate. 
The Start date field for the asset is automatically updated to the Year start date.
Small business pooled assets are always depreciated for the full year regardless 
of when they were purchased, therefore there is no need to enter a start date.

5. Edit the Cost of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

6. Edit the Opening written down value of the asset, as required
The Opening written down value can only be edited, if the Acquisition date is 
prior to the current financial year. For example, if you are loading a previously 
depreciated asset from another accountant’s schedule.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. Select the Asset came from an existing SB Pool checkbox, if required.
The Asset came from an existing SB Pool checkbox is only available for any 
previously depreciated assets that are being added to the pool.
Select this checkbox if you are, for example adding assets that were from 
another accountant. 
This will result in the following rules being applied:

 The pool contribution (taxable value) will not be reduced again by the 
Private use %, as it was already reduced in the original pool.

 No journal will be created to transfer the asset into the pool. The pool 
account balance is already correct when the original trial balance was 
placed into the general ledger.

 If a change in private use is later applied, selecting the Asset came from an 
existing SB Pool checkbox will result in the Tax year added to pool value 
being based on the acquisition date rather than the year it was added to the 
register.

If you are adding the assets from general assets, then the Asset came from an 
existing SB Pool checkbox must be deselected.

8. Select or deselect the Motor vehicle checkbox, as required.
The Cost limit of the motor vehicle is only relevant if the Motor vehicle 
checkbox was selected. The Cost limit field is automatically filled with the ATO 
value relevant for this tax year.
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If the asset was a previously depreciated asset loaded from, say another 
accountant’s schedule, the Cost limit field can be edited. You should enter the 
Cost limit that was applied at the time the asset was first pooled in the other 
system, as this will be used at a later date when you dispose of the asset (to 
calculate the Taxable termination value).
If the asset is a motor vehicle:

 the pool contribution (Taxable value) is limited to the Cost limit.

 depreciation for the first year will include the motor vehicle immediate 
write off amount in addition to the Year 1 rate, to the amount of the Cost 
limit.

9. Edit the Private use % for the asset.
The value must be between 0 and 100%.

10. Edit the Private use adjustment.
The ellipsis button is only enabled if the asset has been depreciated in previous 
years with a probability of a change in private use.
The Private use adjustment window opens. This is where adjustments are made 
to the pool because of changes in the private use percentage.

a. Click the Private use adjustment ellipsis button.

The ellipsis button is only enabled if the asset has been depreciated in 
previous years (i.e., the acquisition date was prior to this financial year).

The Private use adjustment window opens. This is where adjustments are 
made to the pool because of changes in the private use percentage.

b. Select or deselect the Asset was first used under the ATO’s “simplified 
depreciation” rules checkbox, as required.

If the checkbox is selected, a different Reduction factor is used when 
calculating the Private use adjustment amount.

c. Edit the Tax year the asset was allocated to a pool.

This will default to the appropriate tax year depending:

 if the asset was loaded as a previously depreciated asset or as a purchase.

 if the Asset came from an existing SB Pool checkbox is selected or not.

For previously depreciated assets, you can change the default if required. 
For example, it may be necessary to change the default Tax year if you are 
loading an asset from a schedule provided by another accountant.

Note: If the asset has been part of the pool for < 1 year or > 4 years, there 
is no adjustment for private use.
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d. Edit the Private use last year %.

For assets loaded as a previously depreciated asset, the Private use last 
year % field will automatically default to the value entered on the Edit 
Asset window. This value can be changed if required.

For assets loaded as a purchase, this is a read only field and displays the 
private use percentage that was entered for the asset in the previous year.

Tip: To change the private use % for the previous year, you must do this 
in the previous year’s asset register as the depreciation and closing 
written down calculations may be affected.

e. Edit the Private use this year %.

This field will automatically default to the Private use % entered on the 
main screen. This value can be changed if required. If this value is changed 
here, the Private use % will be updated on the Edit Asset window.

Note: If the difference in private use percentage between years is less 
than 10%, then there is no adjustment in the private use.

f. Edit the Asset value.

The Asset value is defined by the ATO as the cost of the asset less its 
depreciation since it was first used or installed ready for use, at the time it 
was first added to the pool. The cost should include any additions made to 
the asset, after taking into account its depreciation.

This field defaults to the cost (for an asset originally loaded as a purchase) 
or the opening written down value (for an asset loaded as a previously 
depreciated asset).

The Assets value field can only be edited for previously depreciated assets. 
You would edit this field, if, for instance, the opening written down value 
was not correct at the time you added the asset to the pool.

The Private use adjustment is calculated.

g. Click OK.

You are returned to Edit Assets window.

The Pool contribution (Taxable value) is updated as are all the values in the 
Decline in value section.
The last statement in the window lets you know the year that the asset was 
pooled in case you need to go back to the first year and change something about 
that asset.

11. Edit the General details of the asset.
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See “Editing the general details of an asset” on page 396.

12. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Editing an asset
Setting taxation details for a General asset (GA)
Setting taxation details for a small business pool (SBP) asset
Editing the taxation details of a general asset
Editing the taxation details for an immediate deductible asset
Editing the taxation details for a small business pool asset
Editing the accounting details of a general asset
Editing the accounting details for an immediate deductible asset
Editing the general details of an asset
Managing assets

Editing the accounting details of a general asset

The Accounting tab will be available for Accounting only or Accounting and Taxation 
assets. 

To edit the accounting details of a general asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the general asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Edit the asset Acquisition date, if necessary.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.
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If you are editing an asset that has been previously depreciated, enter an 
Acquisition date prior to the Year start date.

5. Edit the Start date for the asset.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar.
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date for the year period.
If you are editing an asset that has been previously depreciated, enter a date 
prior to the Year start date.

6. Select a different Depreciation method from the drop-down, if necessary.

7. Edit the Original Cost of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

8. Edit the Opening written down value of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

9. Select the options for the Calculate decline in value section.

a. Edit the number of years for Useful life. Useful life is applicable if the asset 
is being depreciated using the Straight line method only.

or 

b. Edit the Depreciation rate as a percentage for Rate year 1%

and

Edit the Depreciation rate as a percentage for Rate year 2+%.

These fields must be a value between 0 and 100%.

10. Select the appropriate options in the Other values section.

a. Edit the Private use % for the asset.

The value must be between 0 and 100%.

b. Select a different Private use bal sheet a/c to be used, if a portion of the 
asset is to be used for private use.

For example, this would normally be the shareholder’s current account - 
being the shareholder who is using this asset for private use.

Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account 
to be used for posting journals regarding private use of the asset.
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c. The Accumulated depreciation and Accumulated private use fields are 
calculated fields and are read only.

d. The Accumulated private use field is enabled if you create an asset where 
the Start date is prior to the Year start date.

11. Edit the General details of the asset.
See “Editing the general details of an asset” on page 396.

12. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Editing an asset
Editing the taxation details of a general asset
(Australia) Editing the taxation details for an immediate deductible asset
(Australia) Editing the taxation details for a small business pool asset
Editing the accounting details of a general asset
(Australia) Editing the accounting details for an immediate deductible asset
Editing the general details of an asset

Editing the accounting details for an immediate deductible asset

Australia only

The Accounting tab will be available for Accounting only or Accounting and Taxation 
assets. 

To edit the accounting details of an immediate deductible asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the immediate deductible asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Edit the asset Acquisition date, if necessary.
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Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar. 
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date.

5. Edit the Start date for the asset.
Enter the date in the format dd/mm/yyyy or select the date from the drop-down 
calendar.
Click Today on the drop-down calendar to use the current date.
You must not enter a date that is after the Year end date for the year period.

6. Edit the Original Cost of the asset.
This is a numeric field that is limited to a maximum of 17 digits including 2 
decimal places.

7. Edit the Private use % for the asset.
The value must be between 0 and 100%.

8. Select a different Private use bal sheet a/c to be used, if a portion of the asset is 
to be used for private use.
For example, this would normally be the shareholder’s current account - being 
the shareholder who is using this asset for private use.
Click the magnifying glass icon to open the Find Chart of Accounts window 
where you can search for and select the appropriate Balance Sheet account to 
be used for posting journals regarding private use of the asset.

9. The Accumulated private use field is a calculated field and is read only.

10. The Accumulated private use field is enabled if you created an asset where the 
Start date is prior to the Year start date.

11. Edit the General details of the asset.
See “Editing the general details of an asset” on page 396.

12. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Editing an asset
Editing the taxation details of a general asset
Editing the taxation details for an immediate deductible asset
Editing the taxation details for a small business pool asset
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Editing the taxation details for a low value pool asset
Editing the accounting details of a general asset
Editing the accounting details for an immediate deductible asset
Editing the general details of an asset

Editing the general details of an asset

To edit the asset’s general details

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the asset to be edited.
The row containing the selected asset is highlighted.

3. Click Edit asset on the Tasks bar.
or
You can select Edit from the right-click menu.
The Edit Asset window opens.

4. Click the General details tab.

5. Edit the Serial number of the asset, if available.
The Serial number field is limited to a maximum of 50 alphanumeric characters.

6. Edit the Units.
This is the asset quantity, if available. For example, if you have six office chairs as 
an asset, the value of the Units would be 6.
The Units must be a value between 0 and 9999.

7. Select a different Location for the asset from the drop-down, if necessary.
This is the physical location of the asset. 
The available options are those that have been configured using Maintenance > 
Location. See “Creating a new asset location” on page 327.
If you want to add another location, click the Click to add location option from 
the drop-down. The Add Location window opens for you to create another 
location. See “Creating a new asset location” on page 327. Once you have 
completed creating another location the drop-down will be refreshed with the 
new option(s) so that it can be selected at this stage.

8. Edit the Insurance details of the asset, if appropriate.

a. Edit the Insurer details.

The Insurer field is limited to a maximum of 50 alphanumeric characters.
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b. Enter a different Premium due date.

Enter the date in the format dd/mm/yyyy or select the date from the drop-
down calendar. A blank date (the None option) can be selected from the 
drop-down calendar.

c. Enter a different insurance Premium amount.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

d. Enter a different Insured value of the asset.

This is a numeric field of a maximum of 27 digits including 2 decimal places.

9. Edit any Notes or add more notes, as required.

10. Click OK.
The database is updated with any changes made to the asset. The Edit Asset 
window closes.

Related topics
Creating an asset
Setting taxation details for a General asset (GA)
Editing an asset
Editing the taxation details of a general asset
(Australia) Editing the taxation details for an immediate deductible asset

Deleting an asset

Note: You can only delete an active asset in the year it was created.

Deleting an asset removes the asset from the database for the current year and any 
subsequent years. 

You cannot delete an asset that is displayed as active in the current year but that has 
been sold in a subsequent year. An error message will be displayed if you attempt to 
do so.

To delete an asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the active asset to be deleted.
You must select the active asset in the year it was created.
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3. Click Delete asset on the Tasks bar.
or
Select Delete from the right-click menu.
The selected active asset is deleted in the current year and for all subsequent 
years.

To delete a sold asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Navigate to the year the selected asset was sold.

3. Unsell the sold asset.
See “Reversing the sale of an asset” on page 408.

4. Navigate to the year the selected asset was created.

5. Delete the selected asset.
See “To delete an asset” on page 397.

Related topics
Selling an asset
Reversing the sale of an asset
Moving an asset to another control group
Editing an asset
Managing assets
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Selling an asset
When you sell an asset, MYOB Assets Live:

 calculates the depreciation at the disposal date and updates any changes.

 debits the realisation account with the original cost of the asset.

 credits the asset control group with the original cost of the asset.

 debits the accumulated depreciation account by the total depreciation 
calculated for the asset.

 credits the realisation account with the total depreciation calculated for the 
asset.

 calculates the profit / loss on the sale and credits / debits the profit or loss on 
sale accounts as appropriate.

 debits or credits the realisation account with the profit or loss on sale.

 calculates the capital gain taxable (Australia) and non-taxable amounts and 
credits the appropriate accounts.

 debits the realisation account with the gross capital gain.

 the closing written down value for the asset at the end of the year is 0.00 
(except, in Australia, possibly for small business pool assets).

The disposal date of an asset sold under contract is taken to be the date on the legal 
binding contract. In circumstances where no legal contract is present, the disposal 
date is taken to be the date in which the asset changes ownership. When the asset is 
destroyed or lost, the date of disposal is the date when first compensation is received; 
or if there is no compensation, the disposal date is the date on which the asset was 
first discovered lost or destroyed.

Note: A sold asset is displayed as an active asset in any prior years from the year it 
was sold. 
A sold asset is not rolled forward to future years. 
A sold asset cannot be resold, edited or deleted in any prior years.
(New Zealand) In the year a Taxation Asset is sold, no depreciation for that 
year is applied.

(Australia) On selling an asset, you can select whether capital gains tax (CGT) is 
calculated for the sold asset. Capital gains tax can be calculated on a sold asset if:

 the acquisition date of the asset is greater than or equal to 20 September 1985.

 the private use amount of the asset is greater than 0% or the accumulated 
private use amount is greater than 0%.

Related topics
(Australia) Selling a general or immediate deductible asset
(Australia) Selling a small business pool asset
(Australia) CPI rates table



MYOB AO, AE, AU PM Client Accounting User Guide | 400

(Australia) Capital gains tax
Reversing the sale of an asset

Selling a general or immediate deductible asset

Immediate deductible assets are for Australia only.

To sell a general or immediate deductible asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the asset to be sold.
The row containing the selected asset will be highlighted.

3. Click Sell on the Tasks bar.
or
You can select Functions > Sell from the right-click menu.
The Sell Asset window opens displaying the Asset code and Asset name of the 
selected asset.

4. Enter the Disposal date of the asset.
Enter the Disposal date in the format dd/mm/yyyy or select it from the drop-
down calendar. You can also select Today’s date from the drop-down calendar.
The default Disposal date is the Year end date for the opened year.
The CAV (closing asset value) at disposal date is calculated based on the 
entered Disposal date. In New Zealand, this does not include any depreciation 
for the year the Asset is being sold in.
The Disposal date cannot be earlier than the asset start date, or later than the 
current financial year.

5. Enter the Termination value.
The termination value is the amount received for the asset when it was sold or 
disposed of, once balancing adjustments have been made.
The default value is 0.00. 
This is a numeric field of a maximum of 27 digits including 2 decimal places.

6. (Australia) Select the Calculate capital gains tax using checkbox, if required.
This checkbox is active if the depreciation calculation is for Taxation purposes. 

7. (Australia) Select the method to be used to calculate the capital gains tax.
If the Calculate capital gains tax using checkbox is selected the appropriate CGT 
Method option(s) will be available.
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Depending on various factors, two methods may be available:

 Discount

 Indexation.
See “Capital gains tax” on page 407.

8. Click OK.
The database is updated with the sold asset. On the Assets Listing page, the 
entry line for the sold asset will be greyed out.

Related topics
(Australia) Selling a small business pool asset
(Australia) CPI rates table
(Australia) Capital gains tax
Reversing the sale of an asset

Selling a low value pool asset

Australia only

To sell a low value pool asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the asset to be sold.
The row containing the selected asset will be highlighted.

3. Click Sell on the Tasks bar.
or
You can select Functions > Sell from the right-click menu.
The Sell Asset window opens displaying the Asset code and Asset name of the 
selected asset.

4. Enter the Disposal date of the low value pool asset.
The Disposal date must be within the current year.
Enter the Disposal date in the format dd/mm/yyyy or select it from the drop-
down calendar. You can also select Today’s date from the drop-down calendar.
The default Disposal date is the Year end date for the opened year.
The Current closing w.d.v is a read only field displaying the closing written down 
value immediately prior to selling the asset, i.e., the taxable value less the full 
year’s depreciation.
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5. Enter the Termination value.
The termination value is the amount received for the asset when it was sold or 
disposed of.
The default value is 0.00. 
This is a numeric field of a maximum of 27 digits including 2 decimal places.
The Taxable termination value is a calculated field and you cannot enter a 
value. 
Taxable termination value = Termination value x (1 - Average private use %)

6. Select the Calculate capital gain/loss checkbox, if required.
The Calculate capital gain/ loss checkbox will only be enabled if there is a 
private use % for the asset.
When an asset, which has been partly used for taxable purposes, is disposed of, 
a capital gain or loss may arise. Where there is a difference between the asset's 
cost and its termination value, a proportion of this difference is attributable to 
estimated non-taxable use of the asset that is treated as a capital gain or loss 
under the capital gain provisions. 
The shareholder will be charged the capital gains tax on their tax return (or 
receive a credit for capital loss). This can be different for each asset of the pool.
If the Calculate capital gain/loss checkbox is selected the capital gain is 
calculated as
(Termination value - cost) x Private use %
The Capital gain/loss field is a read-only field as the value is calculated.
As a capital gain/loss occurs only for a sale (not very often), it is displayed in the 
Sell Asset window rather than in the Edit Asset window.
The Shareholder’s current/drawings account will be charged the capital gain 
tax on their tax return and a journal is created.

Note: The Capital gain tax is different for each asset depending on the 
shareholder using the asset.

If the capital gain is not be applied, deselect the Calculate capital gain/loss 
checkbox. When the Calculate capital gain/loss checkbox is unchecked:

 All the fields in Shareholder’s capital gain/loss section will be disabled.

 No journal is created.

7. Click OK.
The database is updated with the sold low value pool asset. On the Assets 
Listing page, the entry line for the sold asset will be greyed out but the asset will 
still be visible.
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Related topics
Selling a general or immediate deductible asset
Selling a small business pool asset
CPI rates table
Capital gains tax
Reversing the sale of an asset
Consolidating sold pooled assets

Selling a small business pool asset

Australia only

To sell a small business pool asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the asset to be sold.
The row containing the selected asset will be highlighted.

3. Click Sell on the Tasks bar.
or
You can select Functions > Sell from the right-click menu.
The Sell Asset window opens displaying the Asset code and Asset name of the 
selected asset.

4. Enter the Disposal date of the small business pool asset.

The Disposal date must be within the current year.
Enter the Disposal date in the format dd/mm/yyyy or select it from the drop-
down calendar. You can also select Today’s date from the drop-down calendar.
The default Disposal date is the Year end date for the opened year.
The Current closing w.d.v is a read only field displaying the closing written down 
value immediately prior to selling the asset, i.e., the taxable value less the full 
year’s depreciation.

5. Enter the Termination value.
The termination value is the amount received for the asset when it was sold or 
disposed of.
The default value is 0.00. 
This is a numeric field of a maximum of 27 digits including 2 decimal places.

6. Enter the Average private use % of the small business pool asset.
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The Average private use % is calculated from the sum of all the previous year’s 
private use % divided by the number of years the asset was in the register. For 
example, if you originally loaded the asset from another accountant’s schedule, 
you will need adjust the value to take into account the years it was in the other 
accountant’s register.
The Taxable termination value is a calculated field and you cannot enter a 
value. 
Taxable termination value = Termination value x (1 - Average private use %)
If the assets is a motor vehicle that was over the relevant Cost limit when it was 
added to the small business pool, then the Taxable termination value is further 
adjusted to take into account the Cost limit.

7. Click OK.
The database is updated with the sold small business pool asset. On the Assets 
Listing page, the entry line for the sold asset will be greyed out but the asset will 
still be visible.

Related topics
Selling a general or immediate deductible asset
CPI rates table
Capital gains tax
Reversing the sale of an asset
Consolidating sold pooled assets
Writing off a small business pool

CPI rates table

Australia only

The Consumer Price Index (CPI) rates, that are used for the indexation method to 
calculate capital gains tax, are listed in the following table.

Rate Start date End date

71.3 01-Jul-85 30-Sept-85

72.7 01-Oct-85 31-Dec-85

74.4 01-Jan-86 31-Mar-86

75.6 01-Apr-86 31-Jun-86

77.6 01-Jul-86 30-Sept-86

79.8 01-Oct-86 31-Dec-86
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81.4 01-Jan-87 31-Mar-87

82.6 01-Apr-87 30-Jun-87

84 01-Jul-87 30-Sept-87

85.5 01-Oct-87 31-Dec-87

87 01-Jan-88 31-Mar-88

88.5 01-Apr-88 30-Jun-88

90.2 01-Jul-88 30-Sept-88

92 01-Oct-88 31-Dec-88

92.9 01-Jan-89 31-Mar-89

95.2 01-Apr-89 30-Jun-89

97.4 01-Jul-89 30-Sept-89

99.2 01-Oct-89 31-Dec-89

100.9 01-Jan-90 31-Mar-90

102.5 01-Apr-90 30-Jun-90

103.3 01-Jul-90 30-Sept-90

106 01-Oct-90 31-Dec-90

105.8 01-Jan-91 31-Mar-91

106 01-Apr-91 30-Jun-91

106.6 01-Jul-91 30-Sept-91

107.6 01-Oct-91 31-Dec-91

107.6 01-Jan-92 31-Mar-92

107.3 01-Apr-92 30-Jun-92

107.4 01-Jul-92 30-Sept-92

107.9 01-Oct-92 31-Dec-92

108.9 01-Jan-93 31-Mar-93

109.3 01-Apr-93 30-Jun-93

109.8 01-Jul-93 30-Sept-93

110 01-Oct-93 31-Dec-93

Rate Start date End date



MYOB AO, AE, AU PM Client Accounting User Guide | 406

Related topics
Selling an asset
Capital gains tax
Reversing the sale of an asset

110.4 01-Jan-94 31-Mar-94

111.2 01-Apr-94 30-Jun-94

111.9 01-Jul-94 30-Sept-94

112.8 01-Oct-94 31-Dec-94

114.7 01-Jan-95 31-Mar-95

116.2 01-Apr-95 30-Jun-95

117.6 01-Jul-95 30-Sept-95

118.5 01-Oct-95 31-Dec-95

119 01-Jan-96 31-Mar-96

119.8 01-Apr-96 30-Jun-96

120.1 01-Jul-96 30-Sept-96

120.3 01-Oct-96 31-Dec-96

120.5 01-Jan-97 31-Mar-97

120.2 01-Apr-97 30-Jun-97

119.7 01-Jul-97 30-Sept-97

120 01-Oct-97 31-Dec-97

120.3 01-Jan-98 31-Mar-98

121 01-Apr-98 30-Jun-98

121.3 01-Jul-98 30-Sept-98

121.9 01-Oct-98 31-Dec-98

121.8 01-Jan-99 31-Mar-99

122.3 01-Apr-99 30-Jun-99

123.4 01-Jul-99 30-Sept-99

Rate Start date End date
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Capital gains tax

Australia only

Capital gains tax (CGT) is payable on the capital gain made on the disposal of an asset 
which was acquired on or after 20 September 1985. A capital gain is the difference 
between the cost of your asset and the proceeds from its sale. A capital loss occurs 
when your proceeds are less than the total outlay of the asset.

There are 2 methods to calculate capital gains tax (CGT):

Discount

A discount of 50% for individuals or 33.3% for superannuation funds is applied before 
including the capital gain as taxable income.

You can use the discount method to calculate your capital gain if:

 you are an individual, trust or complying superannuation entity.

 a CGT event happens in relation to an asset you own.

 the CGT event occurred after 11:45am on 21 September 1999.

 you acquired the asset at least 12 months before the CGT event.

 you did not choose to use the indexation method.

Indexation

The indexation method increases each amount included in an element of the cost 
base (other than the costs of owning the asset) by an indexation factor. The 
indexation factor is calculated using the consumer price index (CPI).

You can use the indexation method to calculate your capital gain if:

 a CGT event happened to an asset you acquired before 11:45am on 21 
September 1999.

 you owned the asset for 12 months or more.

If you are not a company and you meet the criteria above, and you want to use the 
indexation method, you may choose to do so, otherwise the discount method will 
apply.

If you are a company (other than a listed investment company) and the capital gains 
meets the criteria above, you must use the indexation method to calculate the capital 
gain.

There are some exceptions to the requirement that you must have owned an asset 
for at least 12 months for indexation to apply. You can use the indexation method if 
you:

 acquired a capital gain tax asset as a legal personal representative or a 
beneficiary of a deceased estate. The 12-month requirement is satisfied if the 
deceased acquired the asset 12 months or more before you disposed of it.
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 acquired an asset as the result of a marriage or relationship breakdown. You will 
satisfy the 12-month requirement if the combined period your spouse and you 
owned the asset is more than 12-months.

Related topics
Selling a general or immediate deductible asset
Selling a small business pool asset
CPI rates table
Selling an asset
Reversing the sale of an asset

Reversing the sale of an asset

You can unsell an asset that has been incorrectly sold or part sold. All entries created 
by the sale of an asset will be reversed.

When you undo the sale of an asset, MYOB Assets Live will:

 debit the asset control group with the original cost of the asset.

 credit the Realisation account with the original cost of the asset.

 (Australia) debit the Realisation account with the calculated total depreciation.

 (Australia) credit the Accumulated depreciation account with the calculated 
total depreciation for the asset.

 calculate the profit / loss on sale and credits / debits the profit or loss on sale 
accounts as appropriate.

 debit or credit the Realisation account with the profit or loss on sale.

 calculate the capital gain taxable (Australia only) and non-taxable amounts and 
debit the appropriate accounts.

 credit the Realisation account with the gross capital gain.

 in integrated mode, the appropriate entries are posted to the general ledger 
depending on whether accounting or taxation depreciation calculations are 
integrated. The entries are dated with the disposal date.

Note: You can only undo the sale of an asset in the year it was sold.

To undo the sale of an asset

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the sold asset that is to be unsold.
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The row containing the selected asset is highlighted.

3. Click Unsell on the Tasks bar.
or
You can select Functions > Unsell from the right-click menu.
A message is displayed requesting confirmation to unsell the selected asset.

4. Click Yes.
The selected sold asset is unsold and reverts to an active asset for the current 
and subsequent years. All entries created by the sale of the asset are reversed.
or 
Click No.
The selected sold asset remains sold. No changes regarding the sold asset are 
made.

Related topics
Selling an asset
Moving an asset to another control group
Deleting an asset
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Pooled assets
Australia only

MYOB Assets Live caters for 2 types of pooled assets:

Low value

Depreciating assets that have GST credits or adjustment costs, or have an adjustable 
opening value / written down value of less than $20,000 may be added to a low value 
pool and depreciated at the relevant pool rate.

 When assets are first added to the low value pool they are depreciated at the 
rate of 18.75% for the current year.

 The rate is 37.5% for subsequent years.

Note: These rates will be used regardless of when you allocate the asset 
to the pool during the year.

The decline in value of an asset that you hold jointly with others is worked out on the 
cost of your interest in the asset. This means that if you hold an asset jointly and the 
cost of your interest in the asset or the opening adjustable value of your interest is 
less than $20,000, you can allocate your interest in the asset to your low value pool.

When you allocate an asset to the pool, you must make a reasonable estimate of the 
private use percentage that will be for a taxable purpose over its effective life (for a 
low cost asset) or the effective life remaining at the start of the income year for which 
it was allocated to the pool (for a low value asset). It is this taxable use percentage of 
the cost or opening adjustable value that is written off through the low value pool.

Once you choose to create a low value pool and a low cost asset is allocated to the 
pool, you must pool all other low cost assets that you start to hold in that income year 
and in later income years. However, this rule does not apply to low value assets. You 
can decide whether or not to allocate low-value assets to the pool on an asset-by-
asset basis.

Small business

If you are a small business entity with a aggregated turnover of less than $2 million 
you can choose to use the simplified depreciation rules. The simplified depreciation 
rules are an alternative way to the uniform capital allowances method, of calculating 
depreciation.

If you are using the simplified depreciation rules, you can add certain assets to a small 
business pool. 

If you choose to use the simplified depreciation rules, you must apply them to all the 
assets that the rules apply to.

Related topics
Low value pooled assets
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Small business pooled assets
Consolidating sold pooled assets
Selling a general or immediate deductible asset
CPI rates table
Capital gains tax
Reversing the sale of an asset
Selling a small business pool asset
Selling a low value pool asset
Transferring an asset to a pool

Low value pooled assets

Australia only

For a low value pool, you can:

 add depreciating assets with a cost or opening adjustable value of less than 
$20,000.

These can be assets purchased during the current year or assets that have been 
previously depreciated.

 add certain depreciating assets of primary producers, other landholders and 
rural land irrigation water providers used in landcare operations.

 only include one low-value pool.

Once you choose to allocate a low-cost asset to a low value pool, you must 
allocate to the pool all other low cost assets you hold in that year and in future 
years.

 The following assets cannot be allocate to a low-value pool:

 Assets for which you previously calculated depreciation deductions using 
the prime cost method.

 Horticultural plants, including grapevines.

 Assets for which you can claim deductions under the simpler depreciation 
rules.

 Certain assets you use to conduct research and development activities.

 Portable electronic devices.

See the ATO for more information.

Related topics
Pooled assets
Small business pooled assets

https://www.ato.gov.au/Business/Capital-allowances/In-detail/Low-value-pools/Uniform-capital-allowance-system--low-value-pools/
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Consolidating sold pooled assets
Selling a general or immediate deductible asset
CPI rates table
Capital gains tax
Reversing the sale of an asset
Selling a small business pool asset
Selling a low value pool asset
Transferring an asset to a pool

Small business pooled assets

Australia only

For a small business pool, you can:

 add assets more than $6,500 in value and acquired up to 31 December 2013 to 
the small business pool.

Add assets more than $1,000 in value and acquired between 1 January 2014 and 
11 May 2015 to the small business pool.
Add assets more than $20,000 in value and acquired on or after 12 May 2015 to 
the small business pool.
These can be either assets purchased in the current year or assets that have 
been previously depreciated. 
Any private use will be taken into account when the asset is added to the pool.
Certain assets do not qualify to be added to a small business pool. These may 
include:

 assets you rent or lease to others

 assets allocated to a low value pool

 horticultural plants

 software

 capital works.
See the ATO for further information.
For some assets, you can elect to add them to a small business pool or not. Once 
you make a choice you cannot change it. See the ATO for more information. 
Examples of these may include:

 assets used in primary produce

 software

 assets held before 1 July 2001.

https://www.ato.gov.au/business/small-business-entity-concessions/in-detail/income-tax/simplified-depreciation-rules/?page=13#Exclusions
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Tip: Assets under $6,500 and acquired up to 31 December 2013, can be 
immediately written off and should be added to the asset register 
as an immediate deductible asset instead of adding them to the 
small business pool. You will be prompted in MYOB Assets Live to 
do this, if you attempt to add an asset whose value is under $6,500 
to the pool.
For assets acquired between 1 January 2014 and 11 May 2015, an 
immediate write off of $1,000 applies. From 12 May 2015 the write 
off is $20,000. You will be prompted by MYOB Assets Live to add it 
as an immediate deductible asset.

 Newly acquired assets added to the pool will be depreciated at 15% in the first 
income year, regardless of when they were acquired during that year.

 Previously depreciated assets will be depreciated at 30%.

 For motor vehicles added to the pool, the first $5,000 will be written off. Any 
balance over this amount will be depreciated at 15% in the first year. 

Note: This only applies to motor vehicles added before 31 December 
2013.
If an asset is added on or after 1 January 2014, the $5,000 
immediate write off does not apply.

After the first year, the remaining value of the motor vehicle is depreciated at 
the rate of 30%.

 If the private use of the asset changes, an adjustment will be made to the pool 
so that the correct amount of depreciation is claimed.

Note: This is only done if the private use changes by more than 10% and 
only in the first 4 years after purchasing the asset.

 If you are loading assets from say another accountant’s schedule of assets, or 
from another accounting system, you can select the Asset came from an 
existing SB Pool checkbox. This will ensure that the pool total is not reduced 
again by the private use, and will also ensure that the correct journals are raised.

Writing off a small business pool

If the pool balance prior to depreciation for a year falls below the pool write off 
threshold, the entire small business pool will be written off.

MYOB Assets Live will take into account the Opening written down value, the Taxable 
value of the assets added to the pool and the Taxable termination value of assets that 
have been disposed of. If this is under the pool threshold for that tax year, (e.g., 
$6,500 up to 31 December 2014, $1,000 between 1 January 2014 and 11 May 2015, 
and $20,000 from 12 May 2015) the entire pool will be written off. The depreciation 
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will be adjusted appropriately so that the closing written down value of the pool (and 
all assets in the pool) is zero.

Related topics
Low value pooled assets
Pooled assets
Consolidating sold pooled assets
Selling a general or immediate deductible asset
CPI rates table
Capital gains tax
Reversing the sale of an asset
Selling a small business pool asset
Selling a low value pool asset
Transferring an asset to a pool

Consolidating sold pooled assets

Australia only

When an asset in a low value or small business pool is sold, the ATO requires that the 
pool total be reduced by the Taxable termination value. For pooled assets there is no 
profit or loss on sale. As a result, the Closing written down value of an individually 
sold asset is generally not zero. Consequently, the remaining balance of any sold 
assets must be carried forward as part of the pool total and continue to be 
depreciated.

Rather than have a lot of sold assets appear in the register in future years, the 
Opening written down value of all the individually sold assets are amalgamated into 
one Consolidated sold asset, which continues to be depreciated at 30% for a small 
business pool asset and at 37.5% for a low value pool asset (as it makes up a part of 
the pool total).

Although it may seem strange to carry the sold asset’s Opening written down value 
forward into future years and continue to depreciate them, this is just an anomaly of 
how the ATO have designed small business pools and low value pools (see the ATO). 
The Consolidated sold asset is also required in order that the columns of data in 
reports and onscreen continue to add up and that the correct amount of depreciation 
is claimed.

The Consolidated sold asset cannot be edited, sold, unsold or deleted. It does not 
belong to any particular control group. The Consolidated sold asset only appears 
when it is needed, e.g., it never appears in the first year register and will only appear 
in the year after assets are sold.

If the pool is under the threshold and is completely written off, then there will be no 
Consolidated sold asset in the subsequent year(s).

https://www.ato.gov.au/Business/Capital-allowances/In-detail/Low-value-pools/Uniform-capital-allowance-system--low-value-pools/
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Related topics
Low value pooled assets
Small business pooled assets
Selling a general or immediate deductible asset
CPI rates table
Capital gains tax
Reversing the sale of an asset
Selling a small business pool asset
Transferring an asset to a pool

Transferring an asset to a pool

Australia only

You can transfer a single general asset to a low value pool or small business pool.

An asset can be transferred in the year of purchase or in a subsequent year. If you 
transfer the asset in the year of purchase, the value contributed to the pool is the cost 
price. If you roll the asset over to next year and then transfer, the rolled over general 
asset is converted to sold one and a new pool asset is created (the general asset in 
the previous year can’t be edited or sold).

To transfer an asset to a pool

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select the asset that is to be transferred to pool.

The row containing the asset must highlighted.

3. Click Transfer to low value pool or Transfer to small business pool on the Tasks 
bar.
or
You can select Functions > Transfer to low value pool or Transfer to small 
business pool on the right-click menu. 

Note: These options will be greyed out if the selected asset is already in a 
pool.

A confirmation message displays.

4. Click OK.
The asset is transferred to the pool and the Assets Listing page is updated.
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Related topics
Selling an asset
Reversing the sale of an asset
Deleting an asset
Editing an asset
Managing assets
Deleting a control group
Control group templates
Moving an asset to another control group

Australia only
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Reports
The following reports can be generated for Taxation assets:

 (Australia) “Low value pool schedule” (see page 417)

 (Australia) “Small business pool schedule” (see page 418)

 “Tax schedule” (see page 419)

 “Journal summary - Taxation” (see page 421).

The following reports can be generated for Accounting assets:

 “Accounting schedule” (see page 422)

 “Journal summary - Accounting” (see page 424).

Reports are available for all asset years included in the asset register irrespective of 
their status. 

Related topics
Reports toolbar options

Low value pool schedule

Australia only

The Low Value Pool Schedule report contains a list of all the assets in the low value 
pool. This is a detailed report which can be simplified for clients by providing them 
with a Client Summary of the Low Value Pool Schedule report.

To generate a low value pool schedule report

1. Open the Assets Listing page
See “Opening an asset year” on page 304.

2. Select Reports > Low value pool schedule on the main menu.
The Report Options — Low value Pool Schedule window opens.
The Date range is automatically set to the current asset register year and cannot 
be changed.

3. Click OK.
To generate the report.
The Low value pool schedule report is displayed as a web html page.

To generate a client summary of low value pool report

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.
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2. Select Reports > Low value pool schedule on the main menu.
The Report Options — Low value Pool Schedule window opens.
The Date range is automatically set to the current asset register year and cannot 
be changed.

3. Select the Client summary checkbox.

4. Click OK.
To generate the report.

5. Use the toolbar options of the MYOB Assets: Low Value Pool Schedule Report 
window to search, print and/or save the report.
See “Reports toolbar options” on page 429.

Related topics
Small business pool schedule
Tax schedule
Journal summary - Taxation
Additions and disposals
Full schedule
Reports toolbar options
Printing a report
Saving a report
Searching in a report

Small business pool schedule

Australia only

The Small Business Pool Schedule report contains a list of all the assets in the small 
business pool. This is a detailed report which can be simplified for clients by providing 
them with a Client Summary of the Small Business Pool Schedule report.

To generate a small business pool schedule report

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Reports > Small business pool schedule on the main menu.
The Report Options — Small Business Pool Schedule window opens.
The Date range is automatically set to the current asset register year and cannot 
be changed.
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3. Click OK.
To generate the report.

4. Click OK.
The Small business pool schedule report is displayed as a web html page. 

To generate a client summary of the small business pool schedule report

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Reports > Small business pool schedule on the main menu.
The Report Options — Small Business Pool Schedule window opens.
The Date range is automatically set to the current asset register year and cannot 
be changed.

3. Select the Client summary checkbox.

4. Click OK.
To generate the report.

5. Use the toolbar options of the MYOB Assets: Small Business Pool Schedule 
Report window to search, print and/or save the report.
See “Reports toolbar options” on page 429.

Related topics
Tax schedule
Journal summary - Taxation
Reports toolbar options
Searching in a report
Printing a report
Saving a report

Tax schedule

The Tax Schedule report contains a list of all Taxation assets in an asset register which 
is Taxation only or Accounting and Taxation. In Australia, a summary of any assets in 
the small business and low value pool is provided. 

A Tax Schedule report is divided into 3 sections:

 header

 footer
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 content.

The report will be displayed in landscape orientation. The header of the Tax Schedule 
report displays the client name, ABN (Australia) / IRD (New Zealand), report name and 
date period of the report.

To generate a Tax schedule report

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Reports > Tax schedule on the main menu.
The Report Options — Tax Schedule Report window opens.

3. Select the Date range for the report.
By default, the Starting from and Ending on dates are those associated with the 
launched asset year. The Starting from date cannot be changed. The Ending on 
date can be changed, if required. The Ending on date must be within the current 
year.
To change the Ending on date, enter a date in the format dd/mm/yyyy or select 
a different date from the drop-down calendar. Click Today on the drop-down 
calendar to use the current date.

Note: (Australia) The Ending on date has no affect on assets in the small 
business pool section (at the bottom of the report). 
All assets in the small business pool are always reported on for the 
full tax year.

4. By default, the Include assets fully depreciated in prior year checkbox is 
selected.
Deselect the checkbox if you do not want to include assets that were fully 
depreciated in the prior year.

5. Click OK.
To generate the report.

6. Click OK.
The Tax Schedule report is displayed as a web html page. 

7. Use the toolbar options of the MYOB Assets: Tax Schedule Report window to 
search, print and/or save the report.
See “Reports toolbar options” on page 429.

Related topics
(Australia) Small business pool schedule
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Journal summary - Taxation
Reports toolbar options
Searching in a report
Printing a report
Saving a report

Journal summary - Taxation

The Journal Summary report contains a list of all the journals and their associated 
amounts that have been mapped to assets of a control group. 

A Journal Summary report is divided into 3 sections:

 header

 footer

 content.

The report will be displayed in portrait orientation. The header of the Journal 
Summary report displays the client name, ABN (Australia) / IRD (New Zealand), report 
name and date period of the report.

The Journal Summary report is divided into:

 General and Immediate deductible assets 

 (Australia) Small Business Pool Assets

 (Australia) Low Value Pool Assets. 

Note: (Australia) A Journal Summary report can be generated if you are in 
integrated or non-integrated mode and with mapped or non-mapped 
accounts.

To generate a Journal summary report

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Reports > Journal summary on the main menu.
The Report Options — Journal Summary window opens. 
The Date range is automatically set to the current asset register year and cannot 
be changed.

3. Click OK.
The Report: Journal Summary window opens for the client as a web html page. 
The columns displayed for a Journal Summary report are:
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 Account code

 Description

 Debits

 Credits.
If you have no linked account groups, no account code is listed in the Journal 
Summary report.

4. Use the toolbar options of the MYOB Assets: Journal Summary Report window 
to search, print and/or save the report.
See “Reports toolbar options” on page 429.

Related topics
(Australia) Small business pool schedule
Tax schedule
Reports toolbar options
Searching in a report
Printing a report
Saving a report

Accounting schedule

The Accounting Schedule report contains a list of all Accounting assets in the asset 
register. 

An Accounting Schedule report is divided into 3 sections:

 header

 footer

 content.

The report will be displayed in landscape orientation. The header of the Accounting 
Schedule report displays the client name, ABN (Australia) / IRD (New Zealand), report 
name and date period of the report.

To generate an Accounting schedule report

The Accounting Schedule report is generated for Accounting assets similar in a similar 
manner to the Taxation schedule. 

The report requires these Report Options: 

1. Start Date. This defaults to the beginning of the asset register year and cannot 
be changed.
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2. End Date. If the date entered is not within the financial year the error message 
‘Invalid date, Ending on date must be within the current financial year.’ will 
prompt you to make the necessary change.

The preview of the report identifies the:

 Client Name

 (Australia) ABN

 (New Zealand) IRD

 Report Name

 Starting from

 Ending on. 

For each asset the report lists:

 Asset Code

 Asset Description

 Acquisition Date

 Private Use %

 Original Cost

 Depreciation %

 Disposal Value

 Method

 Original Cost

 Opening w.d.v

 Profit (Loss on sale)

 Closing Written Down Value

 (Australia) YTD

 (New Zealand) YTD Depn.

The report lists totals for:

 Original Cost

 Opening W.D.V

 Assessable

 Deductible

 Closing Written Down Value

 (Australia) YTD

 (New Zealand) YTD Depn.

The report lists the Assessable (Profit) or Deductible (Loss):
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 If Termination Value is more than the Closing asset value (CAV) then

Assessable (Profit) = Termination Value - CAV

 If Termination Value is less than the CAV then

Deductible (Loss) = CAV - Termination Value 

Related topics
Reports
(Australia) Low value pool schedule
(Australia) Small business pool schedule
Tax schedule
Journal summary - Taxation
Journal summary - Accounting
Additions and disposals
Full schedule
(Australia) Small business pool schedule

Journal summary - Accounting 

The Journal Summary - Accounting report is the similar to the Journal Summary - 
Taxation report. The difference is that the assets and asset transactions included in 
the report must belong to an Asset Register set up for Accounting Depreciation. In 
Australia, none of these assets can belong to a pool.

The Journal Summary - Accounting report distinguishes between General and 
Immediate deductible assets and is divided into 3 sections:

 header

 footer

 content.

The report will be displayed in portrait orientation. The header of the report displays 
the client name, ABN (Australia) / IRD (New Zealand), report name and date period of 
the report.

The Journal Summary report is divided into General and Immediate deductible assets. 

The report identifies the:

 Client Name

 (Australia) ABN

 (New Zealand) IRD

 Report Name

 Starting from
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 Ending on. 

For each account with a non-zero balance the report lists:

 Account Code (listed in ascending order)

 Description (the name of the account)

 Debits 

 Credits 

Account balances for each account are derived as:

Related topics
Reports
(Australia) Low value pool schedule
(Australia) Small business pool schedule
Tax schedule
Journal summary - Taxation
Additions and disposals
Full schedule
Accounting schedule
(Australia) Small business pool schedule

Additions and disposals

This report lists the assets that have been acquired and/or disposed during the 
current financial year by Asset Control Group. It provides information on the 
following:

 Asset Code.

 Accounting Acquisition date.

 Disposal date.

 Termination value.

The data displayed will be dependent on the Register Settings (see Editing asset 
register settings for more information). If the setting is:

Debits (positive amounts) Credits (negative amounts)

Depreciation Accumulated depreciation 

Private Use Balance sheet a/c Private Use Profit & Loss a/c 

Realisation Profit on Sale

Loss on Sale Cost for all the sold assets
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 Accounting and Taxation, both sections will be displayed and the information 
will be based on the Accounting Acquisition date.

 Accounting only, only Accounting details are displayed and the information will 
be based on the Accounting Acquisition date.

 Taxation only, only Taxation details are displayed and the information will be 
based on the Taxation Acquisition date.

Accounting

 Original Cost: the amount is only displayed where the Accounting Acquisition 
Date is not in the current year, otherwise a nil amount is displayed.

 Profit or loss on sale: If loss on sale, the amount is enclosed in brackets. If profit 
on sale, the amount will not be enclosed in brackets.

Taxation

(Australia) The taxation details are left blank for assets in a Low Value Pool or SB 
Pools.

 Original Cost: displays the Taxation Original Cost and any Additional 
Expenditures. The amount is only displayed where the Accounting Acquisition 
Date is not in the current year, otherwise a nil amount is displayed.

 Profit or loss on sale: If loss on sale, the amount is enclosed in brackets. If profit 
on sale, the amount will not be enclosed in brackets.

To generate the Additions and disposals report

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Reports > Additions and disposals on the main menu.
The Report Options — Additions and disposals window opens.

3. Select the Date range for the report.
By default, the Starting from and Ending on dates are those associated with the 
launched asset year. The Starting from date cannot be changed. The Ending on 
date can be changed, if required. The Ending on date must be within the current 
year.
To change the Ending on date, enter a date in the format dd/mm/yyyy or select 
a different date from the drop-down calendar. Click Today on the drop-down 
calendar to use the current date.

4. The Additions and Disposals checkboxes are both selected by default. If you do 
not wish to display these in the report, deselect the corresponding checkbox.
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5. Click OK to generate the report.
The Additions and disposals report is displayed as a web html page.

6. Use the toolbar options of the MYOB Assets: Additions and Disposals Report 
window to search, print and/or save the report.
See “Reports toolbar options” on page 429.

Related topics
Reports
(Australia) Low value pool schedule
(Australia) Small business pool schedule
Tax schedule
Journal summary - Taxation
Journal summary - Accounting
Full schedule
Accounting schedule
(Australia) Small business pool schedule

Full schedule

The Full Schedule report lists the depreciation details for both Accounting and 
Taxation purposes for all assets by Asset Control Groups and (Australia) Pools.

This report provides the following information:

 Asset code: Followed by any applicable indicators (*) as described on the report.

 Asset description: Description of the Asset.

 Private use percentage: This displays the Accounting Private Use percentage.

 Acquisition / disposal date: If integration is for Accounting, then the Accounting 
Acquisition Date is displayed; otherwise the Taxation Acquisition Date is 
displayed.

OR
Disposal Date for assets disposed in the current year is displayed.

 Original cost: This displays the Accounting Original Cost.

 Additions or disposals: For an asset disposed in the current year, this column 
displays the difference between Accounting Original Cost and consideration 
amount if the assets Accounting Acquisition Date is in the current year, 
otherwise the consideration amount will be displayed.
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Accounting

 Opening written down value.

 Depreciation method.

 Year-to-date depreciation: displays Accounting depreciation.

 Closing written down value.

Taxation

 Opening adjustable value: displays the Taxation amount in the current year.

 Decline in value method or effective life: displays the Decline in Value method 
and effective life or depreciation rate.

 Year-to-date decline: displays the Taxation depreciation amount.

 Closing adjustable value.

Pool details (Australia)

 The details of the pool will be displayed only if one of the balances is not zero. In 
other words, the details of a specific pool will not be displayed if it is not set up 
or if all balances are zero.

 Details of a pool are always shown for the whole of the year.

To generate a full schedule report

1. Open the Assets Listing page.
See “Opening an asset year” on page 304.

2. Select Reports > Full schedule on the main menu.
The Report Options — Full Schedule window opens.
The Date range is automatically set to the current asset register year. The end 
date can be changed if required.

3. Click OK to generate the report.
The Full schedule report is displayed.

Related topics
Reports
(Australia) Low value pool schedule
(Australia) Small business pool schedule
Tax schedule
Journal summary - Taxation
Journal summary - Accounting
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Additions and disposals
Accounting schedule
Small business pool schedule

Reports toolbar options

Related topics
Searching in a report
Printing a report
Saving a report
Tax schedule
Journal summary - Taxation

Searching in a report

You can search the contents of a report for specific information. The search results 
are highlighted in the report.

To search the contents of a report

1. Open a report.
See “Tax schedule” on page 419 or “Journal summary - Taxation” on page 421.

2. Click  on the toolbar.
The Search window opens.

3. Enter the search text into the Find what field.

Option Description

Search the contents of the report. 
See “Searching in a report” on page 429.

Print the report.
See “Printing a report” on page 430.

Export the report in a specified format and save it.
See “Saving a report” on page 431.

Access help about the Reports toolbar options.
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4. Select the Match whole word only checkbox, if required.
If this option is selected, the search engine will look for items that match the 
entire word string entered in the Find what field.

5. Select the Match case checkbox, if required.
If this option is selected, the search engine will look for items that match the 
case of the search text entered in the Find what field.

6. Select whether the search will occur in ascending (Up) or descending (Down) 
order.

7. Click Find Next.
The search function highlights the results in the report. 

8. Click Find Next again to move to the next instance of the search text.

9. Click Cancel.
The Search window is closed.

Related topics
Reports toolbar options
Printing a report
Saving a report
(Australia) Small business pool schedule
Tax schedule
Journal summary - Taxation

Printing a report

To print the whole report

1. Open a report.
See “Tax schedule” on page 419 or “Journal summary - Taxation” on page 421.

2. Click  on the toolbar.
The whole report is printed to your connected printer.

Related topics
Reports toolbar options
Searching in a report
Saving a report
(Australia) Small business pool schedule
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Tax schedule
Journal summary - Taxation

Saving a report

You can save a report in one of the following formats:

 pdf

 xls

 xlsx

 mht

 txt

 csv.

To save a report

1. Open a report.
See “Tax schedule” on page 419 or “Journal summary - Taxation” on page 421.

2. From the format type toolbar drop-down, select the export format of the 
report.

3. Click  on the toolbar.
The File Download window opens.

4. Click Open to open the file in the corresponding application.

5. Click Save to save the file to a specified location.
Once saved the file can be opened in the corresponding application.

Related topics
Searching in a report
Printing a report
Reports toolbar options
(Australia) Small business pool schedule
Tax schedule
Journal summary - Taxation
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Migrating data
You are only able to migrate data into a newly created MYOB Assets Live asset 
register. The Migrate data option on the Tasks bar is only available when creating a 
new asset register in MYOB Assets Live.

Note: For AOGL, (New Zealand) AE AMS, and (Australia) Assets 2.4, if there are any 
journals posted in the migrated ledger, you may see duplicated journals 
posted if you resubmit journals via MYOB Assets Live. A warning message will 
be logged in Migration Log.
(New Zealand) For AE AMS, if there are any pooled assets, they will be 
migrated as general assets and will be depreciated individually.

MYOB Assets Live enables you to migrate:

MYOB AE Assets 2.4 data

Australia only

You are only able to migrate data from your MYOB AE Assets 2.4 asset register to 
MYOB Asset Live on an individual client basis.

Restrictions and conditions for migration

 You can only migrate MYOB AE Assets 2.4 data into a newly created MYOB 
Assets Live asset register. That is, you cannot migrate MYOB AE Assets 2.4 data 
into an existing MYOB Assets Live asset register which already contains data.

 Data can only be migrated from the year end 2013 or later.

What type of data can be migrated

 Small business pooled assets, low value pooled assets and non-pooled or 
general assets.

 Taxation data and accounting data.

Note: You cannot migrate assets created with accounting data as MYOB 
Assets Live does not support migration of accounting data.

 Integrated and non-integrated assets.

 Association types — only location is supported for migration. 

However, other association types like Asset type, Cost centre and Supplier data 
will be migrated to the Notes section of the asset in MYOB Assets Live.

What data and fields will not be migrated

 Control asset

 Part Sell

 Impairment loss
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 Balancing adjustment offset

 Additional depreciable expenditure

 Private Use Balance Sheet Account Code (this value needs to be manually added 
after migration).

What features are not included in migration

 Revalue

 Allocate and Deallocate.

Note: For Assets 2.4 and AOGL, if there are any journals posted in the migrated 
ledger, you may see duplicated journals posted if you resubmit journals via 
MYOB Assets Live. A warning message will be logged in Migration Log.

For more information on missing features during migration, see “Handling special 
transactions” on page 456.

What if...

 A client has an asset register with a single invalid asset?

This will still be migrated to Assets Live. 

 A client has a sub asset created under a Control asset?

The sub asset will be migrated as general asset.

MYOB AE AMS

New Zealand only

You are only able to migrate data from your MYOB AE AMS asset register to MYOB 
Asset Live on an individual client basis.

Restrictions and conditions for migration

 You can only migrate MYOB AE AMS data into a newly created MYOB Assets Live 
asset register. That is, you cannot migrate MYOB AE AMS data into an existing 
MYOB Assets Live asset register which already contains data.

 Data can only be migrated from the year end 2013 or later.

 Data can only be migrated from the beginning of a year period.

What type of data can be migrated

 General assets.

 Taxation data and accounting data.

 Integrated assets.
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 Location, serial number, units, premium due date and insured value are 
supported for migration.

What type of data will not be migrated

 Control asset

 Part Sell

 Depreciation Limit

 Capital Gain %

 The following depreciation methods are not supported in MYOB Assets Live, and 
will be migrated as Straight Line with 0% depreciation rate:

 Replacement

 Units of usage

 Incidental costs.

What features are not included in migration

 Revalue.

Note: For AE AMS, if there are any journals posted in the migrated ledger, you may 
see duplicated journals posted if you resubmit journals via MYOB Assets Live. 
A warning message will be logged in Migration Log.

If there are any pooled assets in AE AMS, these will be migrated as general 
assets and depreciated individually. A warning message for this action will be 
logged for all AE AMS migrations (even if there aren’t any pooled assets).

For more information on missing features during migration, see “Handling special 
transactions” on page 381.

What if

 A client has an asset register with a single invalid asset?

This will still be migrated to Assets Live.

 A client has a sub asset created under a Control asset?

The sub asset will be migrated as a general asset.

 A client has an asset register with a leased asset?

The asset will be migrated as a general asset with Diminishing value and 
Depreciation rate 0%, and a message is logged for this action.

 A client has assets with different depreciation rate year % values?

The rate year 2+% will be migrated. A warning message will also be logged.

 A client has a pooled control group with assets?
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The pooled assets will be migrated as general assets and depreciated 
individually. A warning message will also be logged.

MYOB AO Classic data

You are only able to migrate data from your MYOB AO Classic Fixed Assets register to 
MYOB Asset Live on an individual client basis.

Restrictions and conditions for migration

 You can only migrate MYOB AO Classic data into a newly created MYOB Assets 
Live asset register. That is, you cannot migrate MYOB AO Classic data into an 
existing MYOB Assets Live asset register which already contains data.

 Data can only be migrated from the year end 2013 or later.

 Data can only be migrated if it has been rolled over and finalised for the year.

 (Australia) All the small business pooled assets from MYOB AO Classic are linked 
to a temporary control group called Small Business Pool in MYOB Assets Live.

 (Australia) All the low value pooled assets from MYOB AO Classic are linked to a 
temporary control group called Low Value Pool in MYOB Assets Live.

 (Australia) MYOB AO Classic assets which have been classified as low value 
pooled assets will only be migrated as low value pooled assets to MYOB Assets 
Live, if the depreciation rate has been defined as 37.5%. If the depreciation rate 
is not 37.5%, then these assets will be migrated as small business pooled assets. 

Tip: (Australia) If you want to migrate MYOB AO Classic low value 
pooled assets to MYOB Assets Live, ensure that depreciation rate 
for these assets is set to 37.5%.

 General assets that are not originally part of a control group in MYOB AO Classic 
will be placed in a temporary control group when migrated to MYOB Assets Live. 

 (Australia) Assets that are not part of a small business pool, but appear as if they 
should be, are placed in a temporary small business pool control group when 
migrated to MYOB Assets Live.

 (New Zealand) Assets with Straight Line (years) having residual value will be 
migrated under Accounting in MYOB Assets Live. Straight Line method under 
Taxation in MYOB Assets Live does not support residual value.

What type of data can be migrated

 (Australia) Small business and low value pooled assets and non-pooled or 
general assets.

 (New Zealand) General assets.

 Assets that have been linked to unidentified pools.
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What data and fields will not be migrated

 Inactive transactions

 Assets without a purchase date.

What if...

 A client has a blank assets register?

The migration to MYOB Assets Live will fail.

 A client has an assets register with a single invalid asset?

This will still be migrated to MYOB Assets Live. 

 Client data has a singular asset entry?

The data is migrated as an orphan and linked to a temporary control group.

 Client data does not include groups, headers, defaults or totals and only 
includes assets?

The data is migrated to MYOB Assets Live. The assets are linked to a temporary 
control group.

 Client data contains a large range of used depreciation rates, where the method 
is diminishing value and groups exist? 

The data is imported as general assets.

 The asset has straight line depreciation with residual value?

Data will be migrated with residual value under Accounting, but not under 
Taxation.

Related topics
Migrating MYOB AO Classic data
(Australia) Migrating MYOB AE Assets 2.4 data
(New Zealand) Migrating MYOB AE AMS data

Migrating MYOB AE Assets 2.4 data

Australia only

To migrate MYOB AE Assets 2.4 data

1. Ensure that you are using a MYOB AE Assets 2.4 asset register that is from 2013 
onwards.

2. Exit MYOB AE Assets 2.4 before you start the migration process.
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3. In integrated mode, configure the client’s financial data source to be either a 
MAS ledger or Accounts ledger, as appropriate. 
See “Configuring a MAS ledger as the data source” on page 29 or “Configuring 
an Accounts ledger as the data source” on page 29.
The ledger codes associated with the MAS ledger or Accounts ledger in MYOB 
AE Assets 2.4 will be displayed in MYOB Assets Live.

4. In non-integrated mode, no configuration is required.
Ensure that you select the checkbox in Step 8.
You will be able to select your AST file in Step 9.

5. Access an asset register from MYOB Assets Live.
See “Accessing an asset register” on page 295.

6. Select Migrate data on the Tasks bar.
The Migrate Data window opens.

7. Select AE Assets 2.4 asset register from the Product drop-down.

8. If you are not integrated with a MAS or Accounts general ledger and have data 
in MYOB Assets 2,4 which you want to migrate to MYOB Assets Live, select the 
Browse for Non Integrated asset register (AST File only) checkbox.

9. Select your MYOB AE Assets 2.4 asset register.
If you are integrated with a MAS or Accounts ledger:

a. Click ellipsis button at the end of AE Assets 2.4 asset register field.

The list of existing ledger codes for the asset register will be displayed.

b. Select a ledger code.

c. Click OK.

If you are in non-integrated mode:

a. Click ellipsis button at the end of AE Assets 2.4 asset register field.

b. Browse for the appropriate AST file.

The following Ledger details are automatically filled from the selected MYOB AE 
Assets 2.4 asset register:

 Name

 Year end

 Start date

 End date.
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10. Click OK.
As the migration process starts a Migration details section will appear on the 
Assets tab, below the General ledger details section. You can view the status of 
migration process and see the results of the migration.

Related topics
Configuring a MAS ledger as the data source
Migrating data
Accessing an asset register
Migration results for MYOB AE Assets 2.4
Viewing information about MYOB AE Assets 2.4 migration

Migration results for MYOB AE Assets 2.4

Australia only

The results of migrating your MYOB AE Assets 2.4 asset register to MYOB Assets Live 
are listed in the Migration details section of the Assets tab. 

As the migration proceeds you will notice that the statistics for the Year, Control 
Group, Locations and Assets will be displayed in the migration results table. You can 
track the results as they are processed in the order listed in the table. As the results 
are displayed, compare the values in the Source column (data from your MYOB AE 
Assets 2.4 asset register) with the Destination column (data that has been migrated 
to MYOB Assets Live). If the values agree the status column will display a tick giving 
you confidence that the migration was successful for that part of the data. 

The control groups for migrating the data will be automatically created in the 
destination folder. Once all the data has been migrated, you can notice that all the 
assets to that particular control group will be migrated from the source control group 
to the destination control group.

If asset locations have been migrated, the list of locations can be viewed by accessing 
Maintenance > Associations > Locations from the main menu of the Assets Listing 
page.

If you have any Association types connected with your MYOB AE Assets 2.4 data, the 
Association types will be migrated. The Association types are displayed in the Notes 
section of the Edit Assets window General tab for the asset.

The Association types that will appear in Assets Live Notes are in the following table.
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Data for pooled assets is migrated to Assets Live as shown in the following table.

Assets 2.4 Assets Live 

PFAssetAssociateType table Notes section

AssetAssociateType PFAssetAssociate

Supplier Description
AddressLine1
AddressLine2
AddressLine3
AddressLine4
Contact
Number1
Number2
Number3

SUPPLIER - Code, Description, 
AddressLine1, AddressLine2, 
AddressLine3, AddressLine4, 
Contact, Number1,Number2, 
Number3 

Cost Centre Description
AddressLine1
AddressLine2
AddressLine3
AddressLine4
Contact
Number1
Number2
Number3

COSTCENTRE -  Code, Description, 
AddressLine1, AddressLine2, 
AddressLine3, AddressLine4, 
Contact, Number1,Number2, 
Number3

Asset type Description
AddressLine1
AddressLine2
AddressLine3
AddressLine4
Contact
Number1
Number2
Number3

ASSETTYPE - Code, Description, 
AddressLine1, AddressLine2, 
AddressLine3, AddressLine4, 
Contact, Number1,Number2, 
Number3

Taxation Asset Migration log and Comment

Asset code migrated as is 

Asset name migrated as is 
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Asset control group migrated as is 

Acquisition date migrated as is 

Cost migrated as is 

Opening adjustable value migrated as is 

Private use % % rounded to two decimal places

Pool contribution migrated as is 

Accounting Asset

Asset code migrated as is 

Asset name migrated as is 

Asset type - General Asset

Asset control group migrated as is 

Acquisition date migrated as is 

Start date migrated as is 

Depreciation method: migrated as is 

•   Replacement value Migration log: “Asset has been migrated 
as Prime Cost with 0% rate since Assets 
does not support Replacement Value.”

•   Units of usage Migration log: “Asset has been migrated 
as Prime Cost with 0% rate since Assets 
does not support Units of Usage.”

•  Immediate write off Prime cost 
Depreciation Rate Year 1 = 100%
Depreciation Rate Year 2 = 100%
Message log: “Asset has been migrated 
as an IDA Asset with 100% rate.”

•  Diminishing value Diminishing value retain depreciation 
rates 1 & 2+

•  Straight line

(AE)

Straight line retain depreciation 
rates 1 & 2+

Rate year 1 % rounded to two decimal places

Rate year 2+ % rounded to two decimal places

Taxation Asset Migration log and Comment
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If a warning icon is displayed in the migration results table for any data type, view the 
assets migration log for more details on the error. See “Viewing information about 
MYOB AE Assets 2.4 migration” on page 441. Errors should be corrected before 
proceeding to use MYOB Assets Live. In order to correct errors:

 delete the asset register that was created in MYOB Assets Live during the 
migration and return to MYOB AE Assets 2.4 to correct the errors. Then run the 
migration again.

or

 correct the errors in MYOB Assets Live.

Tip: As data is being migrated, you may see an Unknown migration status. This 
may occur if there is a temporary server disconnection. Please try the 
migration again after a short period. The connection should be restored.
If the error persists, please contact MYOB Support.

Related topics
Migrating data
Accessing an asset register
Migrating MYOB AE Assets 2.4 data
Viewing information about MYOB AE Assets 2.4 migration

Viewing information about MYOB AE Assets 2.4 migration

Australia only

Once the migration process is complete, you can view the migration log at any time 
in the future from the View migration log option on the Tasks bar. As this option will 
always be enabled for asset registers that contain migrated data. The migration builds 
a migration log of messages. 

Original cost migrated as is 

Salvage value migrated for Straight Line only

Opening written down value migrated as is 

Accumulated private use migrated as is 

Accumulated depreciation migrated as is 

Private use % % rounded to two decimal places

Private use balance sheet account migrated as is 

Taxation Asset Migration log and Comment
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The following situations cause the migration to fail and the Status to show a red X:

These conditions do not stop the migration from completing:

These situations do not stop the migration from completing and the Status shows a 
Green Tick:

Migration has failed Error written to the Migration log

Internet connection 
failure while doing 
migration

Unknown error occurred. 
Note: In this case the migration may have completed

Condition Warning written to the Migration log

If a sub Asset is migrated then there 
will be a difference in tally resulting 
in the warning.
For example, if the ledger has the 
following:
•  Asset 1 - Normal Asset
•  Asset 2 - Control Asset
•  Asset 3 - Sub Asset
•  Asset 4 - Sub Asset
Asset 2 control asset will not be 
migrated. But all the related sub 
Assets will migrate as normal assets.

In this case the Status shows a Yellow !.
Warning message recorded reads 
“Control asset has not been migrated but 
all it’s sub assets have been migrated.” 

No action is required.

Condition Message written to the Migration log

Assets that have been sold in the 
prior year will cause a difference in 
the tally of the assets. 

In this case the Status shows a green tick. 
No warning is recorded in the log.
No action is required.

Ledger has Normal Asset In this situation no message is written. 

Ledger has Control Group with 
Replacement Value (Depreciation 
Method)

Control Group has been migrated as Prime 
Cost with 0% rate since Assets does not 
support Replacement Value.

Ledger has Control Group with Units 
of Usage (Depreciation Method)

Control Group has been migrated as Prime 
Cost with 0% rate since Assets does not 
support Units of Usage.

Ledger has Control Group with 
Immediate write off (Depreciation 
Method)

Control Group has been migrated as Prime 
Cost with 100% rate since Assets does not 
support Immediate write off.
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To view the migration log

1. Click View migration log on the Tasks bar.
The Assets migration log window for the client opens.
The migration log lists any errors and warnings that you should correct or take 
into consideration.

2. To export the migration log to Microsoft Excel, click the Export to excel button.
The contents of the migration log table are exported to Microsoft Excel.

3. Once you have finished viewing the migration log, click Close.
The Assets migration log window closes.

Errors / warnings in the migration log

Errors in the migration log indicate that the data was not migrated.

Warnings in the migration log indicate that some data was not migrated. This is 
usually for the reason that MYOB Assets Live does not support migration for such 
features, e.g.,

 Control asset has not been migrated but all the related sub assets inside it has 
been migrated.

 Asset sold in prior year will not be migrated.

Error concerning Microsoft Access Driver

If you receive the following error message related to the Microsoft Access Driver not 
being installed on your system:

The ‘Microsoft.ACE.OLEDB.12.0’provider is not registered on the local machine.

when migrating MYOB AE Assets 2.4 data to MYOB Assets Live, you will need to 
download the Microsoft OLE DB Driver.

Ledger has Asset with Replacement 
Value (Depreciation Method)

Asset has been migrated as Prime Cost 
with 0% rate since Assets does not 
support Replacement Value.

Ledger has Asset with Units of Usage 
(Depreciation Method)

Asset has been migrated as Prime Cost 
with 0% rate since Assets does not 
support Units of Usage.

Ledger has Asset with Immediate 
write off (Depreciation Method)

Asset has been migrated as PC with 100% 
rate.

Ledger has the following Asset with 
IDA (Asset type)

Asset has been migrated as IDA type with 
100% rate in Accounting.

Condition Message written to the Migration log
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To download the Microsoft OLE DB Driver:

1. Access the Microsoft website.

2. Select English as the language.

3. Click the Download link.
You will be navigated to a new screen.

4. Select AccessDatabaseEngine.exe.

5. Click the Next button.
You will be prompted to run or save the file.

6. Run the file and install Microsoft OLE DB Driver for Microsoft Access.

7. Access MYOB Assets Live and restart the migration again.

Related topics
Accessing an asset register
Migrating MYOB AE Assets 2.4 data
Migration results for MYOB AE Assets 2.4

Migrating MYOB AE AMS data

New Zealand only

To migrate MYOB AE AMS data

Note: If there are any journals posted in the migrated ledger, you may see 
duplicated journals posted if you resubmit journals via MYOB Assets Live. A 
warning message will be logged in Migration Log.

If there are any pooled assets, they will be migrated as general assets and will 
be depreciated individually.

Note: Ensure that you are using a MYOB AE AMS asset register that is from 2013 
onwards.

1. Exit MYOB AE AMS before you start the migration process.

2. In integrated mode, configure the client’s financial data source to be a MAS 
ledger.
See “Configuring a MAS ledger as the data source” on page 29.

http://www.microsoft.com/en-in/download/details.aspx?id=13255
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The ledger codes associated with the MAS ledger in MYOB AE AMS will be 
displayed in MYOB Assets Live.

3. Access an asset register from MYOB Assets Live.
See “Accessing an asset register” on page 295.

4. Select Migrate data on the Tasks bar.
The Migrate Data window opens.

5. Select AE AMS asset register from the Product drop-down.
Only the asset registered integrated with MAS are supported for migration.

6. Select your MYOB AE AMS asset register.
If you are integrated with a MAS:

a. Click ellipsis button at the end of AE AMS asset register field.

The list of existing ledger codes for the asset register will be displayed.

b. Select a ledger code.

c. Click OK.

The following Ledger details are automatically filled from the selected MYOB AE 
AMS asset register:

 Name

 Year end

 Start date

 End date.

7. Click OK.
As the migration process starts a Migration details section will appear on the 
Assets tab, below the General ledger details section. You can view the status of 
migration process and see the results of the migration.

Related topics
Configuring a MAS ledger as the data source
Migrating data
Accessing an asset register
Migration results for MYOB AE AMS
Viewing information about MYOB AE AMS migration
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Migration results for MYOB AE AMS

New Zealand only

The results of migrating your MYOB AE AMS asset register to MYOB Assets Live are 
listed in the Migration details section of the Assets tab. 

As the migration proceeds, you will notice that the statistics for the Year, Control 
Group, Locations and Assets will be displayed in the migration results table. You can 
track the results as they are processed in the order listed in the table. As the results 
are displayed, compare the values in the Source column (data from your MYOB AE 
AMS asset register) with the Destination column (data that has been migrated to 
MYOB Assets Live). If the values agree the status column will display a tick giving you 
confidence that the migration was successful for that part of the data. 

The control groups for migrating the data will be automatically created in the 
destination folder. Once all the data has been migrated, you can notice that all the 
assets to that particular control group will be migrated from the source control group 
to the destination control group.

If asset locations have been migrated, the list of locations can be viewed by accessing 
Maintenance > Associations > Locations from the main menu of the Assets Listing 
page.

The Association types that will appear in Assets Live Notes are in the following table.

AE AMS Assets Live
Notes section

Supplier Description
AddressLine1
AddressLine2
AddressLine3
AddressLine4
Contact
Number1 
(Telephone)
Number2 (Fax)

SUPPLIER - Code, Description, 
AddressLine1, AddressLine2, 
AddressLine3, AddressLine4, 
Contact, Number1,Number2



MYOB AO, AE, AU PM Client Accounting User Guide | 447

Data for General assets is migrated to Assets Live as shown in the following table.

Cost Centre Description
AddressLine1
AddressLine2
AddressLine3
AddressLine4
Contact
Number1 
(Telephone)
Number2 (Fax)

COSTCENTRE -  Code, Description, 
AddressLine1, AddressLine2, 
AddressLine3, AddressLine4, 
Contact, Number1,Number2

Asset type Description ASSETTYPE - Code, Description

Taxation Asset Migration log and Comment

Asset code migrated as is
For sub-assets - control asset
code<space>sub-asset code

Asset name migrated as is 

Asset Type General migrated as is
Leased migrated as General
Pool migrated as General

Asset control group migrated as is 

Acquisition date migrated as is 

Start date migrated as is
If Start Dt < Acquisition Dt, the start 
date is migrated as Acq date

Cost migrated as is 

Opening written down value migrated as is 

Private use % % rounded to two decimal places

Accounting Asset

Asset code migrated as is 
For sub-assets - control asset
code<space>sub-asset code

Asset name migrated as is 

AE AMS Assets Live
Notes section
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If a warning icon is displayed in the migration results table for any data type, view the 
assets migration log for more details on the error. See “Viewing information about 

Asset Type General migrated as is
Leased migrated as General
Pool migrated as General

Asset control group migrated as is 

Acquisition date migrated as is 

Start date migrated as is 
If Start Dt < Acquisition Dt, the start 
date is migrated as Acq date

Depreciation method: migrated as is 

•   Replacement value Migration log: “Asset has been migrated 
as Straight Line with 0% rate since 
Assets does not support Replacement 
Value.”

•   Units of usage Migration log: “Asset has been migrated 
as Straight Line with 0% rate since 
Assets does not support Units of 
Usage.”

•  Immediate write off Immediate write off with depreciation 
rate as 100%

•  Diminishing value Diminishing value retain depreciation 
rate 2+

•  Straight line Straight line retain depreciation rate 2+

Rate year 1 not migrated

Rate year 2+ % rounded to two decimal places

Original cost migrated as is 

Opening written down value migrated as is 

Accumulated private use migrated as is 

Accumulated depreciation migrated as is 

Private use % % rounded to two decimal places

Private use balance sheet account migrated as is 

Taxation Asset Migration log and Comment
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MYOB AE AMS migration” on page 449. Errors should be corrected before proceeding 
to use MYOB Assets Live. In order to correct errors:

 delete the asset register that was created in MYOB Assets Live during the 
migration and return to MYOB AE Assets 2.4 to correct the errors. Then run the 
migration again.

or

 correct the errors in MYOB Assets Live.

Tip: As data is being migrated, you may see an Unknown migration status. This 
may occur if there is a temporary server disconnection. Please try the 
migration again after a short period. The connection should be restored.
If the error persists, please contact MYOB Support.

Related topics
Migrating data
Accessing an asset register
Migrating MYOB AE AMS data
Viewing information about MYOB AE AMS migration

Viewing information about MYOB AE AMS migration

New Zealand only

Once the migration process is complete, you can view the migration log at any time 
in the future from the View migration log option on the Tasks bar. As this option will 
always be enabled for asset registers that contain migrated data. The migration builds 
a migration log of messages. 

The following situations cause the migration to fail and the Status to show a red X:

Migration has failed Error written to the Migration log

Internet connection 
failure while doing 
migration

Unknown error occurred. 
Note: In this case the migration may have completed
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These conditions do not stop the migration from completing:

These situations do not stop the migration from completing and the Status shows a 
Green Tick:

Condition Warning written to the Migration log

If a sub Asset is migrated then there 
will be a difference in tally resulting 
in the warning.
For example, if the ledger has the 
following:
•  Asset 1 - Normal Asset
•  Asset 2 - Control Asset
•  Asset 3 - Sub Asset
•  Asset 4 - Sub Asset
Asset 2 control asset will not be 
migrated. But all the related sub 
Assets will migrate as normal assets.

In this case the Status shows a Yellow !.
Warning message recorded reads 
“Control asset has not been migrated but 
all its sub assets have been migrated.” 

No action is required.

Condition Message written to the Migration log

Assets that have been sold in the 
prior year will cause a difference in 
the tally of the assets. 

In this case the Status shows a green tick. 
No warning is recorded in the log.
No action is required.

Ledger has Normal Asset In this situation no message is written. 

Ledger has Control Group with 
Replacement Value (Depreciation 
Method)

Control Group has been migrated as 
Straight Line with 0% rate since Assets 
does not support Replacement Value.

Ledger has Control Group with Units 
of Usage (Depreciation Method)

Control Group has been migrated as 
Straight Line with 0% rate since Assets 
does not support Units of Usage.

Ledger has Asset with Replacement 
Value (Depreciation Method)

Asset has been migrated as Straight Line 
with 0% rate since Assets does not 
support Replacement Value.

Ledger has Asset with Units of Usage 
(Depreciation Method)

Asset has been migrated as Straight Line 
with 0% rate since Assets does not 
support Units of Usage.

Ledger has Asset with different rate 
year 1% and rate year 2+%

Asset has different Dep rate year 1% and 
2+% and has been migrated with Dep rate 
year 2+%.
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To view the migration log

1. Click View migration log on the Tasks bar.
The Assets migration log window for the client opens.
The migration log lists any errors and warnings that you should correct or take 
into consideration.

2. To export the migration log to Microsoft Excel, click the Export to excel button.
The contents of the migration log table are exported to Microsoft Excel.

3. Once you have finished viewing the migration log, click Close.
The Assets migration log window closes.

Errors / warnings in the migration log

Errors in the migration log indicate that the data was not migrated.

Warnings in the migration log indicate that some data was not migrated. This may be 
due to MYOB Assets Live not supporting migration for such features, for example:

 Control asset has not been migrated but all the related sub assets inside it has 
been migrated.

 Asset sold in prior year will not be migrated.

Related topics
Accessing an asset register
Migrating MYOB AE AMS data
Migration results for MYOB AE AMS

Migrating MYOB AO Classic data

Note: If there are any journals posted in the migrated ledger, you may see 
duplicated journals posted if you resubmit journals via MYOB Assets Live. A 
warning message will be logged in Migration Log.

Ledger has Leased Assets Asset has been migrated as Diminishing 
value with 0% rate since Assets does not 
support Leased Assets.

Ledger has sold Assets in the current 
year with “Depreciate in the year of 
sale” flag selected

For Asset, no depreciation in the year of 
sale has been applied as this is not 
supported.

Condition Message written to the Migration log
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To migrate MYOB AO Classic data

1. Ensure that using a MYOB AO Classic asset register that is from 2013 onwards.

2. Exit MYOB AO Classic before you start the migration process.

3. Configure the client’s financial data source to be an MYOB AO Classic general 
ledger.
See “Configuring an AO Classic general ledger as the data source” on page 30.

4. Access an asset register.
See “Accessing an asset register” on page 295.

5. Select Migrate data on the Tasks bar.
The Migrate Data window opens.

6. Select AO Classic asset register from your Product drop-down.

7. Select your MYOB AO Classic asset register.
Enter the path of the MYOB AO Classic asset register, if it is known.
If you wish to search for the MYOB AO Classic asset register:

a. Click the ellipsis button at the end of the AO Classic asset register field.

b. Browse to the location of your MYOB AO classic asset register.

c. Select the file and click OK.

The Year details are automatically filled from the selected MYOB AO Classic 
asset register.

8. Click OK.
As the migration process starts a Migration details section will appear on the 
Assets tab, below the General ledger details section. You can view the status 
migration process and see the results of the migration.

Related topics
Migrating data
Configuring an AO Classic general ledger as the data source
Accessing an asset register
Migration results for MYOB AO Classic
Viewing information about the MYOB AO Classic migration
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Migration results for MYOB AO Classic

The results of migrating your MYOB AO Classic asset register to MYOB Assets Live are 
listed in the Migration details section of the Assets tab. 

As the migration proceeds you will notice that the statistics for the Year, Control 
Group, Locations and Assets will be displayed in the migration results table. You can 
track the results as they are processed in the order listed in the table. As the results 
are displayed, compare the values in the Source column (data from your MYOB AO 
Classic asset register) with the Destination column (data that has been migrated to 
MYOB Assets Live). If the values agree the Status column will display a tick giving you 
confidence that the migration was successful for that part of the data. 

You will notice that you have a discrepancy of 1 between the number of your Source 
and Destination control groups. This is because, when you migrate a MYOB AO Classic 
asset register to MYOB Asset Live, a temporary control group is automatically 
created: non-linked general assets.

This captures all assets that were not originally assigned to a control group in your 
MYOB AO Classic asset register. Once all the data has been migrated, you should 
transfer the assets from this temporary control group to control groups that you have 
created. See “Moving an asset to another control group” on page 325. This temporary 
control group can then be deleted.

If the original asset register contains any assets without a purchase date, then the 
asset count in the Destination column of the migration results will be less than the 
Source. However, no error will be recorded for this.

If asset Locations have been migrated, the list of locations can be viewed by accessing 
Maintenance > Associations > Locations from the main menu of the Assets Listing 
page.

If a warning icon is displayed in the migration results table for any data type, view the 
assets migration log for more details on the error. See “Viewing information about 
the MYOB AO Classic migration” on page 454. Errors should be corrected before 
proceeding to use MYOB Assets Live. You can correct errors by, either:

 delete the asset register that was created in MYOB Assets Live during the 
migration and return to MYOB AO Classic to correct the errors. Then run the 
migration again.

or

 correct the errors in MYOB Assets Live.

Tip: As data is being migration, you may receive an Unknown migration status. 
This may occur if there is a temporary server disconnection. Please try the 
migration again after a short period. The connection should be restored.
If the error persists, please contact MYOB Support.
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Related topics
Configuring an AO Classic general ledger as the data source
Accessing an asset register
Migration results for MYOB AO Classic
Viewing information about the MYOB AO Classic migration
Migrating data

Viewing information about the MYOB AO Classic migration 

Once the migration process is complete, you can view the migration log. You can view 
the migration log at any time in the future from the View migration log option on the 
Tasks bar. As this option will always be enabled for asset registers that contain 
migrated data.

To view the migration log

1. Click View migration log on the Tasks bar.
The Assets migration log window for the client opens.
The migration log lists any errors and warnings that you should correct or take 
into consideration.

2. To export the migration log to Microsoft Excel, click the Export to excel button.
The contents of the migration log table are exported to Microsoft Excel.

3. Once you have finished viewing the migration log, click Close.
The Assets migration log window closes.

Errors / warnings in the migration log

Errors in the migration log indicate that the data was not migrated. 

Warnings in the migration log indicate that the data should be corrected prior to 
using MYOB Assets Live. Some examples:

 The original asset is not linked to any control group. The asset is migrated to the 
temporary control group - non-linked general assets.

 (Australia) The original asset is linked to an unidentified pool. The assets is 
migrated as a small business pool.

If you do not agree with how the data was allocated, then delete the asset register 
and correct the data allocation in MYOB AO Classic and migrate the data again in 
MYOB Assets Live.

Related topics
Configuring an AO Classic general ledger as the data source
Accessing an asset register
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Migration results for MYOB AO Classic
Migrating data
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Handling special transactions
This section will provide some instructions on how to consider certain transactions in 
MYOB Assets Live.

Accounting basis depreciation, impairment losses and revaluations

 Calculating depreciation on an accounting basis rather than a taxation basis is 
currently not supported.

 Impairment losses and revaluations are only relevant for accounting 
depreciation, so are currently no supported.

Additional expenses

Additional expenses (also called second element expenses) are additions to an 
existing asset in the year(s) following the year of purchase.

These are depreciated at the Year 1 rate (in the year they are added), while the 
existing / main asset is depreciated at the Year 2+ rate.

For example, if you purchased a car in year 1 and in year 2 you added mag wheels, the 
car would be depreciated at the Year 2+ rate and the mag wheels would be 
depreciated at the Year 1 rate.

Note: Attaching additional expenses to an existing assets is not supported in MYOB 
Assets Live.

To record additional expenses:

Create a new asset under the existing / main asset by using an appropriate Asset Code 
structure, e.g.,

1.00 Ford Falcon
1.0.1 Mag Wheels
1.02 After Market Stereo
1.03 Bluetooth hands-free kit

Note: An advantage of adding these as individual assets rather than additional 
expenses to an existing asset, is that you can easily sell them at a later date 
(e.g., selling the mag wheels).

Balancing offset adjustments

A balancing offset adjustment is where you offset the profit resulting from the sale of 
an asset against the cost of the replacement asset. The profit on sale is not accessible, 
but you are required to reduce the cost of the replacement asset, thereby also 
reducing the depreciation (which thereby offsets the tax free profit made on the 
sale).

Balancing offset adjustments only apply:
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 to tax depreciation

 if the disposal was involuntary (e.g., lost, destroyed or acquired by the 
government as a compulsory acquisition).

The offset can only be assigned to certain classes of assets:

 assets with no private use

 not fully depreciated

 (Australia) not pooled

 not sold.

A balancing offset adjustment should not be required very often (as it only occurs 
when it is an involuntary disposal and a profit is made on the disposed asset). It is 
therefore not supported in MYOB Assets Live.

If you want to account for a balancing offset adjustment, when the replacement 
asset is added, create 2 assets instead of 1;

 one with the reduced cost - which is depreciated normally.

 one for the difference between the actual cost and the reduced cost. This 
should be depreciated at a zero depreciation rate.

This way the cost of all the assets in the asset register will match cost according to the 
balance sheet / general ledger and the correct amount of depreciation will also be 
claimed.

Incidental costs

Incidental costs are costs such as the cost of advertising relating to the disposal of an 
asset. These are not included when calculating depreciation or capital loss / gain, etc.

Note: Incidental costs are not supported in MYOB Assets Live.

If you wish to record any incidental costs, enter it in the Notes section for each asset.

Other associations - suppliers, cost centres, asset types

Note: Other associations - suppliers, cost centres, asset types are not supported in 
MYOB Assets Live.

If you wish to record this data, enter it in the Notes section for each asset.

Part selling an asset

Note: Part selling an asset is not currently supported in MYOB Assets Live.

If you want to part sell an asset:
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1. Split the original asset into 2 assets and sell the one being sold:

a. In the year the assets was added, edit the asset and reduce the cost by the 
cost value of the part of the asset being sold.

b. In the year the asset was added, create a new asset with the cost value of 
the part being sold. Ensure that the depreciation rate, method and private 
use %, etc., are the same as the main asset.

c. The net effect on depreciation and total closing written down value should 
be the same as before you split the asset into 2.

2. Navigate to the year in which the part sale is being made:

a. Sell the relevant asset.

Allocate and deallocate

The features allocate and deallocate are currently not supported in MYOB Assets Live.

Multiple account periods

Depreciation calculation using multiple account periods is currently not supported by 
MYOB Assets Live.

By default, MYOB Assets Live only calculates depreciation for one complete year.
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Troubleshooting

Accessing an asset register
Getting started
Creating an asset
Managing assets
Selling an asset
Reports

Error Solution

The internet 
connection timed 
out.

You have lost your internet connection.
Try the following to establish your connection:
•  Retry the last action you were doing.
•  If the previous suggestion does not work, check your 

internet connection and then retry your last action.
•  If the previous 2 suggestions fail, contact your IT 

support.

You have lost your 
connection —the 
internet connection 
timed out or the 
online server is not 
responding.

You have lost your internet connection and/or the online 
server is not responding.
Try the following to establish your connections:
•  Retry the last action you were doing.
•  If the previous suggestion does not work, check your 

internet connection and then retry your last action.
•  If the previous 2 suggestions fail, contact MYOB Support.

The online server is 
not responding.

The online server is not responding.
Try the following to establish your connection:
•  Retry the last action you were doing.
•  If the previous suggestion does not work, check your 

internet connection and then retry your last action.
•  If the previous 2 suggestions fail, contact MYOB Support.
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Statutory Reporter
Statutory Reporter is used to produce professional quality statutory reports for non-reporting 
entities. It works directly over client data from the:

 MYOB AccountRight range of SME accounting products, or 

 Essentials Accounting, Cashbook or Practice Ledger. 

Report settings can be configured to suit the reporting requirements of each client. Financial 
statements for the selected client can be previewed and generated. 

There are a number of stages involved in configuring and generating financial statements using 
Statutory Reporter:

 “Accessing Statutory Reporter” (see page 461)

 “Configuring practice report settings” (see page 462)

 “Configuring client report settings” (see page 479)

 Configuring “Account groups” (see page 488)

 Configuring “Non-transaction data” (see page 512)

 Selecting “Paragraphs” (see page 524)

 Configuring “Report options” (see page 540)

 “Producing financial statements” (see page 551).
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Accessing Statutory Reporter
Access the Client Accounting > Reports tab to configure the client report settings and produce 
financial statements for a selected client. 

To access Statutory Reporter

1. Click .
The Find Clients page opens.

2. Enter search criteria in the Search for field.
The search criteria can be based on Name and Code, Tax File Number or ABN (Australia), or IRD 
Number or New Zealand Business Number (New Zealand). Click the appropriate search criteria 
option and type in the details.
Alternatively, if you can easily navigate to the client, double-click on the client entry. Proceed 
to Step 5.

3. Click Search or press [Enter]. 
The search results are displayed.

4. Double-click the client entry.
The Client page opens.

5. Click the Client Accounting tab.

6. Click the Reports tab.
Financial statements for the selected client can be produced from the Reports tab.

Related topics
Configuring practice report settings
Configuring client report settings
Producing financial statements
Account groups
Non-transaction data
Paragraphs
Report options
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Configuring practice report settings
Statutory Reporter comes with a set of default report definitions. These are red to as the Master 
Level Report Definitions. These Master Level Report Definitions can be edited across all client 
reports and entity types to reflect the reporting requirements of your practice. Any modifications 
made to the Practice Report Settings will apply to all clients and client reports.

Each year MYOB will provide updated versions of the Master Level Report Definitions. Installing 
these updates will not overwrite the custom configurations that you have made to your Practice 
Report Settings. 

Before using Statutory Reporter it is recommended that the settings for your practice be 
investigated and configured. 

The practice report settings are configured using Maintenance > Maintenance Map (AO) > Client 
Accounting > Practice Report Settings.

Note: Access to Practice Report Settings is controlled by the system administrator. If you do not 
have sufficient permission, a warning is displayed stating that You do not have permission to 
access the Practice Report Settings tab. Contact your System Administrator.

When configuring the practice settings consider:

Accounting product locations 

Configure the accounting product locations (see “Configuring accounting product locations” on 
page 37) for the client’s associated accounting application if these products are not installed in the 
default locations. This is only required for AccountRight 19 or earlier ledgers.

Default report selections

For clients of each entity type, the reports that will be available in the report list and the order in 
which they will be displayed in the financial statements can be controlled. After configuring the 
reports for each entity type, the default report settings should be checked using the Preview 
Reports option. At any stage the reports can be reset to remove the custom report settings and 
returned to the Statutory Reporter default settings. See “Selecting default practice reports” on 
page 468.

To configure the default report selections:

 Access the Practice Report Settings — the default report selections are configured using 
Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.

 Select the default reports — for each entity type, the reports that are available for clients of 
that type can be configured. The reports selected here are listed on the Client Accounting > 
Report tab for all clients of that type.

See “Selecting default practice reports” on page 468.

 Change the report order — the order of the reports in the Reports table can be modified. 
When the financial statements are created the reports are displayed in the order that they are 
listed in the Reports table.

See “Changing the order of practice reports” on page 469.
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 Preview the reports — check the default report settings that have been configured for each 
entity type. 

See “Previewing practice reports” on page 470.

 Reset the reports — remove any customisation that have been applied to the default reports 
and to the report order. The configuration returns to the Master Level Report Definition 
defaults.

See “Resetting practice reports” on page 471.

Account groups

Statutory Reporter uses account groups to determine which account balances to display in each 
section of the financial statements and which notes to include by default.

Account Groups allow modification of the contents of a report without modifying the report 
definition itself. This means that the same Master Level Report Definition can be used to generate 
reports for a variety of client charts.

These default account group allocations can be edited and assigned to individual accounts and 
account ranges at a practice or client level. When account groups at a practice level are configured, 
account group allocations affect all clients of a selected industry type. See “Account groups” on 
page 488.

To configure the account groups:

 Access the practice account groups — the Account Groups option must be accessed from the 
Practice Report Settings to allocate accounts at a practice level.

See “To access the practice account group configuration” on page 488.

 Select the industry type and sample client — at a practice level, account groups are configured 
for each industry type. The account groups configuration affects all clients of the selected 
industry type. A sample client must be searched and selected. The selected client’s chart of 
accounts will be used as an example in the Chart of Accounts table. 

 Allocate accounts using drag-and-drop — drag-and-drop to allocate individual accounts to an 
account group. 

See “Allocating individual accounts” on page 497.

 Allocate accounts using account ranges — a range of accounts can be allocated to a selected 
account group. To allocate the range, specify the account code of the first account in the range 
and the account code of the last account in the range. 

See “Allocating account ranges to account groups” on page 499.

 Delete account allocations — at a practice level, the deletion of account allocations affects all 
clients of a selected industry type. That is, the account group allocation is removed for all 
clients of that industry type. 

See “Deleting account group allocations” on page 509.

 Restore default settings — at any time, custom account group allocations can be removed and 
the default account group configurations restored. At a practice level, the custom account 
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group allocations can be removed and the master set of default account group allocations 
which come with Statutory Reporter can be restored.

See “Restoring default settings for account groups” on page 510.

Non-transaction data

Non-Transaction Data s to client specific data values that are required for the financial statements 
but are not derived from account balances in the client ledger.

Practices that use the Associations feature in MYOB AE/AO to track the relationships between 
clients and partners, directors and trustees can choose to nominate the association types that 
represent these three relationships. For those clients with associations configured on the Associated 
tab, the partners, directors and trustees are automatically added to the Directors data field in the 
client’s non-transaction data. See “Non-transaction data” on page 512.

Note: Non-transaction data preferences rely on the associations created on the Associated tab in 
MYOB AE/AO. Therefore, only set the non-transaction data preferences if the Associations 
feature in MYOB AE/AO is used. See information on the Associations feature. 

See “Practice non-transaction data preferences” on page 512.

Paragraphs

Statutory Reporter uses Paragraphs to define sections of text that are displayed in the financial 
statements. MYOB provides default paragraph content as part of the Master Level Report 
Definitions. The content and format of these default paragraphs can be modified for your entire 
practice or for an individual client. See “Paragraphs” on page 524.

To configure the paragraphs for your practice:

 Access practice paragraphs — to define default paragraphs for all clients within the practice 
you must access the Paragraphs option from within Practice Report Settings.

See “Accessing practice paragraphs” on page 524.

 Edit paragraph text — edit the content of the paragraph. 

See “Editing static text” on page 528.

 Insert and edit variables — insert and edit the variable text within the paragraphs. The value of 
variable text, that is the text displayed on the report, is provided by data recorded within 
Statutory Reporter.

See “Inserting and editing variables” on page 529.

 Format paragraph — control how the text of a paragraph is formatted within the report.

See “Formatting paragraphs” on page 535.

 Insert logos into Compilation Report — insert logos or different content in the top margins of 
the Compilation Report. See “Inserting logos into the Compilation Report” on page 536.

../Practice_Manager/Associated_tab.htm
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Report options

The report style and page layout can be controlled using the Report Options. From the Practice 
Report Settings tab, the report formatting for all clients in the practice can be configured. See 
“Report options” on page 540.

Report Options enables the configuration of:

 Style Options — modify how the headers, footers and balances are displayed in the report. 
Statutory Reporter has a number of pre-configured styles that can be selected.

 Display Options — control whether the report includes a cover page, a table of contents, page 
numbers, a company logo, watermarks and other details.

 Page Margins — configure the page layout by setting the top, bottom, left and right margins.

To set the report options for the practice:

 “Accessing report options” (see page 540) 

 “Selecting style options” (see page 541) 

 “Setting display options” (see page 542) 

 “Setting page margins” (see page 549).

Rename reports

Highlight a report, then click Rename Reports in the Tasks bar to it change to a different name. This 
change will affect all clients, except where a report name has been renamed in a specific client’s 
Reports tab, then the name used in the client will take precedence. Click the Refresh icon to change 
back to the master report name.

See Renaming practice reports for more information.

Related topics
Selecting default practice reports
Changing the order of practice reports
Previewing practice reports
Resetting practice reports
Renaming practice reports
Customising your practice styles
To access the practice account group configuration
Allocating individual accounts
Allocating account ranges to account groups
Deleting account group allocations
Restoring default settings for account groups
Practice non-transaction data preferences
Accessing practice paragraphs
Editing static text
Inserting and editing variables
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Formatting paragraphs
Accessing Statutory Reporter
Configuring client report settings
Producing financial statements

Practice Report Settings page

The Practice Report Settings page is accessed from Maintenance > Maintenance Map (AO) > Client 
Accounting > Practice Report Settings. Within the Practice Report Settings page, reports can be 
configured to reflect the reporting requirements of your practice. The Practice Report Settings page 
is divided into two main areas:

Practice Reports

For clients of an entity type, the reports will be available in the report list and their order in the 
financial statements can be controlled. 

Option Description

Entity Type drop-
down

The entity type must be selected on the Entity Type drop-
down in order to configure reports.

Default Report 
Selections table

The table lists the report name, whether the report will be 
displayed in the client’s report list, whether the report will 
be selected and whether the user can edit the report 
inclusion at a client level.
See “Selecting default practice reports” on page 468.

Up and Down 
buttons

Use the up and down buttons to control the order the 
reports are displayed in the financial statements.
See “Changing the order of practice reports” on page 469.

Preview Reports Check the default report settings that have been configured 
for each entity type. 
See “Previewing practice reports” on page 470.

Reset Reports Remove any customisation that has been applied to the 
default reports and to the report order. The configuration 
returns to the Master Level Report Definition defaults.
See “Resetting practice reports” on page 471.

Save Settings After making changes to the Default Report Selections it is 
important to click Save Settings to save the changes. You 
will be prompted to save any changes, if you try to close the 
Practice Report Settings tab without saving the changes. 
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Tasks bar option 

Related topics
Selecting default practice reports
Selecting default practice reports
Changing the order of practice reports
Previewing practice reports
Resetting practice reports
Renaming practice reports
Customising your practice styles
Updating master report definitions
Account groups
Non-transaction data

Option Description

Account Groups Account Groups are used to determine which account 
balances to display in each section of the financial 
statements and which notes to include by default. 
See “Account groups” on page 463.

Non-Transaction Data If the Associations feature in MYOB AE/AO is used to 
track the relationships between clients and partners, 
directors and trustees, the association types that 
represent these relationships can be nominated.
See “Non-transaction data” on page 464.

Paragraphs Paragraphs modify the content and format of the 
paragraph text which is displayed in the financial 
statements.
See “Paragraphs” on page 464.

Report Options Control the report style and page layout.
See “Report options” on page 465.

Update Report 
Definitions

This option is used to update the Statutory Report 
Master Level Report Definitions into additional 
databases. This is only required if you use multiple 
databases. 
See “Updating master report definitions” on page 473.

About To view information about your version of Statutory 
Reporter. You may be asked to provide this information 
to MYOB Support when requesting assistance.
See “What version of Statutory Report do I have?” on 
page 574.
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Paragraphs
Report options
What version of Statutory Report do I have?

Selecting default practice reports

For clients of each entity type, the reports that are available in the report list and their order in the 
financial statements can be controlled. After configuring the reports for each entity type, the default 
report settings can be checked using the Preview Reports option. At any stage, the custom report 
settings can be removed and the Statutory Reporter default settings restored. 

For each entity type, the reports that are available for clients of that type can be configured. The 
reports selected here are listed on the Client Accounting > Reports tab for all clients of that type. 

The reports selected for inclusion can also be modified at a client level, if required. See “Previewing 
financial statements” on page 551.

To select the default practice reports

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select the entity type from the Entity Type drop-down. 

3. In the Default Report Selections table configure the settings for each report. 
For each report, the following can be configured:

a. Period Type — control the reporting period for statements and notes. See “Producing 
periodic reports” on page 556 for more information.

b. Display in List — select or deselect the checkbox to display or hide the report in the list of 
available reports for all clients of the selected entity type. If the Display List checkbox is 
selected, a tick is displayed in the checkbox and the report is displayed in the list on the 
Reports table. By default, all reports are selected.

c. Select by Default — control whether the report will be automatically selected for 
inclusion. Click the cell to display the drop-down options:

 Always — the report is always selected for inclusion.

 Never — the report is never selected for inclusion.

 If Data Exists — the report is selected for inclusion if data exists for the selected report.

d. Prevent Override — select or deselect the checkbox. If the checkbox is selected, users will 
not be able to edit the practice configuration for the selected report at a client level. If the 
checkbox is not selected, users will be able to edit the practice configuration of the 
selected report at a client level.
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4. Click Save Settings. 

5. Repeat Step 2. to Step 4. to select the default reports for each entity type that applies to the 
clients in your practice.

Related topics
Changing the order of practice reports
Previewing practice reports
Resetting practice reports
Renaming practice reports
Customising your practice styles
Updating master report definitions
Previewing financial statements

Changing the order of practice reports

For each entity type, the order of the reports in the Reports table can be modified. When the reports 
are exported to Microsoft Word or PDF, they will be displayed in the order that they are listed in the 
Reports table. 

The order of the reports in the Default Report Selections table determines the report order for all 
clients of that entity type. The report order can also be modified on a client-by-client basis if 
necessary. See “Previewing financial statements” on page 551.

To change the order of reports

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select the Entity Type from the drop-down. 

3. Find and select the report in the Default Report Selections table. 
The report is highlighted.

4. Click  to move the selected report up in the report order. 

Click  to move the selected report down in the report order. 

5. Click Save Settings. 

6. Repeat Step 2. to Step 5. to modify the report order for each entity type which applies to 
clients in your practice.
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Related topics
Selecting default practice reports
Previewing practice reports
Customising your practice styles
Resetting practice reports
Renaming practice reports
Updating master report definitions
Previewing financial statements

Previewing practice reports

The Preview Reports option is used to check the default report settings that have been configured 
for each entity type. Using a sample client, the report selections — the reports that will be included 
— the report order, the account group configuration and the paragraph formats can be checked.

Note: Ensure that the selected sample client has a configured valid financial data source.

To preview the reports

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select the Entity Type from the drop-down. 

3. Click Preview Reports. 
The Select Sample Client window opens.

4. Click the ellipse button located at the end of the Sample Client field to search for a sample 
client.
The Find Clients window opens.

5. Find and select the sample client.
The selected client’s data is used to populate the preview report.

6. Click OK.
A warning is displayed if the selected client does not have a financial data source configured. 
A financial data source for the selected client must be configured. 
You can configure the financial data source for the client by clicking Yes. The Client 
Configuration window opens. See “Configuring the client” on page 23. 
Or select another client who already has their financial data source configured. 
You can also select the client and configure their financial data source from the Select Sample 
Client window by clicking Configure Client.
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7. Click OK. 
A Generating Report progress bar is displayed.
The Report Preview window opens. 
The displayed default report settings for the selected entity type are used to produce the 
report. 

8. Close the Report Preview window.

Related topics
Selecting default practice reports
Changing the order of practice reports
Customising your practice styles
Resetting practice reports
Renaming practice reports
Updating master report definitions

Resetting practice reports

The Reset Reports option is used to remove any customisation that have been applied to the Default 
Report Selections. Any modifications made to the default report selections and report order are 
removed and the configuration returns to the master level defaults.

Note: Ensure that the correct entity type is selected when resetting the practice reports.

To reset the reports

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select the Entity Type from the drop-down. 

3. Click Reset Reports.
The Reset Reports confirmation dialog is displayed. 
The confirmation message states that the report settings for selected entity type are being 
reset. 

4. Click Yes to reset the default report selection settings. Click No to cancel.

5. Click Save Settings.

Related topics
Selecting default practice reports
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Changing the order of practice reports
Previewing practice reports
Renaming practice reports
Customising your practice styles
Updating master report definitions

Renaming practice reports

If you wish to rename a report across a practice, you can use the Rename Reports task to do so. This 
is useful if you wish to rename a report that is being used for multiple clients. It also ensures 
consistency across the practice when naming reports.

The report name can also be restored to the value at the foundation level.

Note: Any report name changes at the client level will take precedence over name changes made 
here. If there are any open clients, close and re-open them for the change to take effect.

To rename a report at the practice level

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select the required entity type.

3. In the Reports table, select a report that you wish to rename.

4. In the Tasks menu, click Rename Reports.
The Rename Report window displays. The Report Name field contains the name of the selected 
report.

5. Click OK.

6. Click Save Settings.
The report’s name is updated across the practice.

To restore a report name to the value at foundation level

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. In the Reports table, select a report that you wish to rename.

3. In the Tasks menu, click Rename Reports.
The Rename Report window displays. The Report Name field contains the name of the selected 
report.
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4. Click the Refresh icon to the right of the Report Name field.

5. A confirmation window displays. Click Yes to restore the report name to the value set at 
foundation level; otherwise click No to close the message.

6. Click Save Settings.

Related topics
Selecting default practice reports
Changing the order of practice reports
Previewing practice reports
Resetting practice reports
Customising your practice styles
Updating master report definitions

Updating master report definitions

If you are using multiple database and you want to update the master report definitions to the most 
recent, use Update Report Definitions. The Update Report Definitions window lists the current 
version and the available version. Master report definitions of the main database are normally 
updated during an installation of the software.

To update the master report definitions

1. Install the master report definitions to your main database.

2. Access another database.

3. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

4. Click Update Report Definitions on the Tasks bar.
The Update Report Definitions window opens.
The current report definition version and the available report definition version are listed. 
Database details are also listed.

5. Click Update Definitions.
A message is displayed requesting confirmation to upgrade the report definitions.

6. Click Yes.
A progress bar is displayed.
When finished, a message is displayed in the text area informing you that the upgrade was 
successful.
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7. Click Close.
The Update Report Definitions window closes.

8. Repeat the procedure for all other databases.

Related topics
Selecting default practice reports
Changing the order of practice reports
Previewing practice reports
Customising your practice styles

Customising your practice styles

Statutory Reporter comes with a set of default report style options, or style sets. These options 
control the look of your reports, including fonts, colour, spacing and ruled lines. You can set up your 
own style sets so that your reports have a consistent look-and-feel that reflects your practice.

You can either clone an existing style set (which will allow you to create a style set based on an 
existing style set), or you can create a new style set from the default settings.

To create a new style set by cloning an existing style set

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select Practice Style Sets from the Tasks bar.
The Practice Style Sets window opens.

Note: For MYOB AO, if you don’t have the Practice Style Sets option on your Tasks bar, 
contact Support to enable this feature.

3. Click Clone Style Set.
The Practice Style Set – Clone window opens.

4. Select a style set to clone from the drop-down list. The list will include all master style sets as 
well as your saved practice style sets.

5. Click OK.
The selected style set displays in the Practice Style Sets window.

6. Click Style Set Name in the right panel, and type a name for your new style set in the 
corresponding field.
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Note: The name must be unique.

7. For each style that you want to change:

a. Select the style name style in the left panel.

The style’s settings will display in the right panel. 

b. Update the settings. 

Note: For information on the style settings, see Report styles.

8. When you have finished the settings for your new style set, click OK to save the changes.
The Practice Style Sets window will close, and your changes will be saved.

To create a new style set from the default settings

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select Practice Style Sets from the Tasks bar.
The Practice Style Sets window opens.

Note: For MYOB AO, if you don’t have the Practice Style Sets option on your Tasks bar, 
contact Support to enable this feature.

3. Click New Style Set button.
The default style set is displayed on the Practice Style Sets window.

4. Click Style Set Name in the right panel, and type a name for your new style set in the 
corresponding field.

Note: The name must be unique.

5. For each style that you want to change:

a. Select the style name style in the left panel.

The style’s settings will display in the right panel. 

b. Update the settings. 

Note: For information on the style settings, see Report styles.
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6. When you have finished the settings for your new style set, click OK to save the changes.
The Practice Style Sets window will close, and your changes will be saved.

To edit a style set

Note: Any changes you make to a style set only affect reports you generate from this point on.

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select Practice Style Sets from the Tasks bar.
The Practice Style Sets window opens.

Note: For MYOB AO, if you don’t have the Practice Style Sets option on your Tasks bar, 
contact Support to enable this feature.

3. In the left panel, click + next to the name of the style set you want to edit.
The list of styles for this style set will display.

4. For each style that you want to change:

a. Select the style name style in the left panel.

The style’s settings will display in the right panel. 

b. Update the settings. 

Note: For information on the style settings, see Report styles.

5. When you have finished the settings for your new style set, click OK to save the changes.
The Practice Style Sets window will close, and your changes will be saved.

Report styles

Each part of each report has an associated style. For example, there are styles for page headings, 
section headings, descriptions, balances, total lines and so on. These styles are grouped by Style 
types, which define the properties that make up the style.

The following table lists the styles and describes the way they are used in the reports.

Note: Styles are not used in the same way across all reports. Some trial and error may be required 
to identify the exact style used for each report component.
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Style type Style Used for...

Page Header Page Header 01 Highest level page header.
Usually for the Client Name at the top of each 
report page.

Page Header 02 Second level page header.
Usually for the ABN (where required) and the 
report name near the top of each page.

Page Header 03 Third level page header.
The second line of the report heading, usually ‘for 
year ended….’ text.

Page Header Page Header 
Compilation Report 
01
Page Header 
Compilation Report 
02
Page Header 
Compilation Report 
03

As per descriptions above.
Changes made to these fields will only affect the 
Compilation Report. 
See “Defining the top margin of the Compilation 
Report” on page 550.

Heading Note Heading Notes on the Notes report pages

Section Heading Section headings in various tabular reports, such 
as account groups in Balance Sheets and Income 
Statements

Section Heading with 
normal text

Not currently used

Sub-Heading Heading text in some reports – mainly in the Notes 
section.

Balance Balance with space 
before

Not currently used

Normal balance Regular balance lines on reports

Normal balance – 
Indent description

Regular balance lines on reports where the 
description text is indented to the right

Total Grand Total Grand total lines for report sections

Sub-Total Secondary total lines for report sub-sections.
This is rarely used.

Total Regular total lines for report sub-sections.
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Related topics
Configuring practice report settings
Practice Report Settings page
Selecting default practice reports
Changing the order of practice reports
Previewing practice reports
Resetting practice reports
Updating master report definitions

Paragraph Cover Page First part of the report cover page containing the 
client’s name

Cover Page 02 Second part of the report cover page containing 
the report name

Heading Heading text in some reports – mainly in the Notes 
section.

Paragraph All general paragraph text is reports

Table of Contents 
Heading

The heading for the Table of Contents page

Page Footer Page Footer Text in the page footer at the bottom of each 
report page

Table Of Contents Table of Contents Lines in the Table of Contents

Column Heading Column Heading The row of column headings at the top of most 
tables of balance data.
This is usually the year for the reported balances.

Table Header Table Header 01 Table headers in the Schedule of Property, Plant 
and Equipment reports

Style type Style Used for...
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Configuring client report settings
Statutory Reporter has a set of default report definitions. These are red to as the Master Level 
Report Definitions. At a practice level, these Master Level Report Definitions may be edited and 
configured for all clients within the practice. Further custom configuration can be performed at a 
client level. The Report Definitions for each individual client can be edited and configured to reflect 
the reporting requirements of the selected client. 

The client must be configured before generating any financial statements. As part of the client 
configuration, record a location for the client’s general ledger file on your system. When the client 
sends a new general ledger file, it is this file on your system that must be updated and replaced.

A warning message is displayed on the Client Accounting > Ledger tab if a financial data source is not 
configured for the client. Use the Edit Configuration Details Tasks bar option to configure the client. 
See “Configuring the client” on page 23 and “Configuring accounting product locations” on page 37 
for more information.

Any changes made to the Practice Level Report Definitions will not overwrite the custom 
configurations that have been made for a selected client. 

Before generating the financial statements for a client it is recommended that the report settings 
for the selected client are investigated and configured.

Each client’s reports settings can be accessed from and configured on the client’s Client Accounting 
> Reports tab.

Note: The Reports tab is disabled if a financial data source for the client has not been configured. 

When configuring the client report settings consider:

Client reports

For each selected client, the reports to be included and the order in which they are displayed in the 
financial statements can be controlled. At any stage, the reports can be reset to remove the custom 
report settings and return to the practice default settings. 

To configure the default report selections:

 Access the Client Report Settings — a client’s report settings are accessed and configured on 
the client’s Client Accounting > Reports tab. 

 Select the Default Reports — select reports that will be included in the financial statements for 
each client.

See “Selecting client reports” on page 485.

 Change the report order — the order of the reports in the financial statements can be 
modified. When the financial statements are created the reports will be displayed in the order 
that they are listed in the Reports table.

See “Changing the order of client reports” on page 485.

 Preview the reports — check the report settings that have been configured for the selected 
client. The reports must be previewed before the financial statement can be printed, exported 
or emailed.
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See “Previewing financial statements” on page 551.

 Reset the reports — remove any customisation that has been applied to the report selection 
and to the report order. The configuration returns to the practice level defaults.

See “Resetting client reports” on page 486.

Client account groups

Statutory Reporter uses Account Groups to determine which account balances to display in each 
section of the financial statements and which notes to include by default.

Account groups enable modification of the contents of a report without modifying the report 
definition itself. This means that the same Master Level Report Definitions can be used to generate 
reports for a variety of client charts.

These default account group allocations can be edited and assigned individual accounts and account 
ranges at a practice or client level. When account groups are configured at a client level, account 
group allocations affect only the selected client. 

To configure the client account groups:

 Access the client account groups — the Account Groups option must be accessed from the 
client’s Client Accounting > Reports tab to allocate accounts at a client level.

See “To access the client account group configuration” on page 490.

 Allocate accounts using drag-and-drop — drag-and-drop to allocate individual accounts to an 
account group. 

See “Allocating individual accounts” on page 497.

 Allocate accounts using account ranges — a range of accounts can be allocated to a selected 
Account Group. To allocate the range, specify the account code of the first account in the 
range and the account code of the last account in the range. 

See “Allocating account ranges to account groups” on page 499.

 Create new custom groups — group accounts according to your requirements.

See “Creating custom account groups” on page 505.

 Delete account allocations — at a client level, the deletion of account allocations will affect 
only the selected client. That is, the account group allocation is removed for the selected client 
only. 

See “Deleting account group allocations” on page 509.

 Restore default settings — at any time, custom account group allocations can be removed and 
the default account group configurations restored. At a client level, the custom account group 
allocations can be removed and the practice level account group allocations can be restored. 

See “Restoring default settings for account groups” on page 510.
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Non-transaction data

Non-Transaction Data s to client specific data values that are required for the financial statements 
but are not derived from account balances in the client ledger. See “Non-transaction data” on 
page 512.

The client’s non-transaction data fields can be edited. The client’s non-transaction data contains 
information from MYOB AE/AO or can be entered by you. See “Data categories and data fields” on 
page 513 for more information on the data fields and to find out what fields they are linked to in 
MYOB AE/AO. 

To configure the client’s non-transaction data:

 Access the client’s non-transaction data — find and select the client for which non-transaction 
data is to be edited and then access the Non-Transaction Data option. 

See “Accessing client non-transaction data” on page 521.

 Edit the client non-transaction data — edit the client’s non-transaction data fields. 

See “Editing client non-transaction data” on page 522.

Paragraphs

Statutory Reporter uses Paragraphs to define sections of text that will be displayed in the financial 
statements. MYOB provides default paragraph content as part of the Master Level Report 
Definitions. The content and format of these default paragraphs can be modified for your entire 
practice or for an individual client. See “Paragraphs” on page 524.

To configure the paragraphs for a selected client:

 Access client paragraphs — to define custom paragraphs for selected clients you must access 
the Paragraphs option from the client’s Client Accounting > Reports tab.

See “Accessing client paragraphs” on page 525.

 Edit paragraph text — edit the content of the paragraph.

See “Editing static text” on page 528.

 Insert and edit variables — insert and edit the variable text within the paragraphs. The value of 
variable text, that is the text that is displayed on the report, is provided by data recorded within 
Statutory Reporter.

See “Inserting and editing variables” on page 529.

 Format paragraph — control how the text of a paragraph is formatted within the report.

See “Formatting paragraphs” on page 535.

Report options

The report style and page layout can be controlled using the Report Options. Access the Report 
Options from the client’s Client Accounting > Reports tab to configure custom report options for a 
selected client. See “Report options” on page 540.

Report Options enables the configuration of:
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 Style Options — modify how the headers, footers and balances are displayed in the report. 
Statutory Reporter has a number of pre-configured styles that can be selected.

 Display Options — control whether the report includes a cover page, a table of contents, page 
numbers, a company logo, watermarks and other details.

 Page Margins — configure the page layout by setting the top, bottom, left and right margins.

To set the report options for a client:

 “Accessing report options” (see page 540) 

 “Selecting style options” (see page 541) 

 “Setting display options” (see page 542) 

 “Setting page margins” (see page 549).

Rename reports

Highlight a report, then click Rename Reports in the Tasks bar to change it to a different name. Click 
Refresh to revert to the Practice report name, if one exists; otherwise, the name is reverted to the 
master report name.

Assets Depreciation Schedule

Click Assets Depreciation Schedule in the Tasks bar to open the Assets Depreciation Schedule 
window, which contains the checkbox Include Fully Depreciated Assets. This value is selected by 
default.

When reporting on Assets data, having this checkbox selected will include any assets that have been 
fully depreciated in the previous register year.

Related topics
Selecting client reports
Changing the order of client reports
Previewing financial statements
Resetting practice reports
To access the client account group configuration
Allocating account ranges to account groups
Deleting account group allocations
Restoring default settings for account groups
Accessing client non-transaction data
Editing client non-transaction data
Accessing client paragraphs
Editing static text
Inserting and editing variables
Formatting paragraphs
Selecting style options
Setting display options
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Setting page margins

Client’s Reports tab

The client’s Client Accounting > Reports tab is used to configure the report settings that reflect the 
reporting requirements of each client. The financial statements for the selected client can also be 
previewed and generated.

For each selected client, the reports to be included and the order in which they are displayed in the 
financial statements, can be controlled. 

Features of the Reports tab

Feature Description

Reports table The table lists the report name and whether the report will 
be included in the financial statements.
See “Selecting client reports” on page 485.

Up and Down 
buttons

Use the up and down buttons to control the order of the 
reports in the financial statements. 
See “Changing the order of client reports” on page 485.

Report Set The report set allows you to select a particular group of 
reports. The available options are:

 All — displays all reports relevant to the entity type.

 Minutes — displays only the Minutes reports available 
when the client is a company or trust. No reports will 
display when the option is selected for any other entity 
type.

When selected the settings for the first four Display 
options will be ignored. See Setting display options.

Filter Reports Use the drop-down at the bottom of the table to filter the 
list of reports in the table based on the Report Set selected. 
The available options are: 
•  Display only reports where client has related data
•  Display selected reports only 
•  Display all reports.

Reset Reports Remove any customisation have been applied to the report 
selection and to the report order. The configuration returns 
to the practice level defaults.
See “Resetting client reports” on page 486.



MYOB AO, AE, AU, NZ PM Client AccountingUser Guide | 484

Tasks bar options

Related topics
Selecting client reports
Changing the order of practice reports
Resetting client reports
Previewing financial statements
Client account groups
Non-transaction data
Paragraphs
Report options

Period Select the financial period to report on the Period drop-
down before previewing the reports. For periodic reporting, 
you can select the appropriate start and end month and the 
financial year.
You can also select 1 future period from the Period drop-
down.
See “Previewing financial statements” on page 551.

Preview Reports Check the report settings that have been configured for the 
selected client. The reports must be previewed before the 
financial statements can be printed, exported or emailed. 
See “Previewing financial statements” on page 551.

Option Description

Account Groups Account groups are used to determine which account 
balances to display in each section of the financial 
statements and which notes to include by default.
See “Account groups” on page 488.

Non-Transaction 
Data

If the Associations feature in MYOB AE/AO is used to track 
the relationships between clients and partners, directors 
and trustees, the association types that represent these 
relationships can be nominated.
See “Non-transaction data” on page 512.

Paragraphs Modify the content and format of the paragraph text which 
is displayed in the financial statements. 
See “Paragraphs” on page 524.

Report Options Control the report style and page layout. 
See “Report options” on page 540.

Feature Description
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Selecting client reports

For each selected client, the reports to be included and the order in which they are displayed in the 
financial statements, can be controlled.

The reports list and their inclusion is configured at a practice level. Some reports may have been 
determined to be mandatory by your practice. If these reports are deselected a warning is displayed. 

Note: All the reports listed in the Reports table are selected by default, to be included in a report.

Note: (New Zealand) If you are preparing reports for a company that has paid a dividend, the 
Dividends Paid account in AccountRight will most likely be classified as Other Expense (an 
account code beginning with 9). Dividends need to be journalled to an account in the Equity 
section (beginning with 3), otherwise they are included in Profit & Loss account and not in 
Movements in Equity. 

To deselect client reports

1. Open the client’s Client Accounting > Reports tab.

2. Find the report in the Reports table, to be excluded from the financial report. 
Filter the list of reports in the table using the filter drop-down located at the bottom of the 
Reports table. 

3. Click the checkbox to deselect an individual report. 
Click the checkbox in the column heading to select or deselect all the reports.

Related topics
Changing the order of client reports
Resetting client reports
Producing financial statements

Changing the order of client reports

For each client, the order of the reports in the Reports table can be modified. When the financial 
statements are produced, the reports will be displayed in the order that they are listed in the 
Reports table. 

The default order of the reports in the table, i.e., the order in which they are displayed when you 
first access the Client Accounting > Reports tab, is configured at a practice level. See “Configuring 
practice report settings” on page 462.
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To change the order of reports

1. Open the client’s Client Accounting > Reports tab.

2. Find and select the report.
The report is highlighted.

3. Click  to move the selected report up in the report order. 

Click  to move the selected report down in the report order. 
The report order is automatically saved for future use.

Related topics
Selecting client reports
Resetting client reports
Client’s Reports tab
Producing financial statements

Resetting client reports

At any stage, the reports can be reset to remove any custom report settings and the practice default 
settings are restored. Any changes that have been made to the report selections or report order will 
be lost and the practice default settings restored. 

To reset the reports

1. Open the client’s Client Accounting > Reports tab.

2. Click Reset Reports.
The Reset Reports confirmation dialog is displayed. 

3. Click Yes to reset the reports in the table to the practice report settings. 
A Reset Reports confirmation dialog is displayed to confirm that the client report settings have 
been reset. 
Click No to cancel and retain the previous practice report settings.

4. Click OK.
The Reset Reports confirmation dialog closes.

Related topics
Selecting client reports
Changing the order of client reports
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Client’s Reports tab
Producing financial statements
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Account groups
Statutory Reporter uses Account Groups to determine which account balances to display in each 
section of the financial statements and which notes to include by default.

Account groups allow modification of the contents of a report without modifying the report 
definition itself. This means that the same Master Level Report Definitions can be used to generate 
reports for a variety of client charts.

For example, if the Balance Sheet > Assets and Liabilities > Assets > Current Assets > Cash and Cash 
equivalents account group contain any accounts with non-zero balances, these account balances 
will be included in the Current Assets section of the Balance Sheet, as well as the Cash and Cash 
Equivalents Note. In addition, the Cash and Cash Equivalents accounting policy note will be displayed 
in the Statement of Significant Accounting Policies. 

Related topics
Accessing account groups
Account Groups window
Configuring account groups

Accessing account groups

Statutory Reporter comes with a set of default account group allocations. These default account 
group allocations can be edited and individual accounts and account ranges can be assigned at a 
practice or client level. 

When you configure account groups at a practice level, account group allocations affect all clients of 
a selected industry type. Account group allocations at a practice level are marked with an  in the 
Account Group Details tree.

Note: You must access the Account Groups option from the Practice Report Settings to allocate 
accounts at a practice level.

When account groups are configured at a client level, account group allocations affect only the 
selected client. Account group allocations at a client level are marked with an  in the Account 
Group Details tree.

Note: You must access the Account Groups option from the client’s Client Accounting > Reports 
tab to allocate accounts at a client level. 

To access the practice account group configuration

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Click Account Groups on the Tasks bar.
The Statutory Reporter - Account Groups window opens.
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3. Select the appropriate Product from the drop-down.

Note: The selected Product must be identical to the configured financial data source. If 
it is not an error message is displayed.

The available Product options are:

 AccountRight 2013.0 or later

 AccountRight 19 or earlier

 Essentials.

4. Select the Industry Type from the drop-down.
At a practice level, account groups are configured for each Industry Type. The configuration of 
account groups will affect all clients of the selected industry type. 
If you have selected Essentials as the Product type, you can then further select:

 All - Essentials Accounting

 All - Essentials Cashbook.

5. If you have selected Essentials as the Product type, you can also configure the financial data 
source from the Statutory Reporter - Account Groups window by pressing the Configure 
button. 
See “Configuring an Essentials general ledger as the data source” on page 32.

6. Find and select a Sample Client.

a. Click the ellipse button located at the end of the Sample Client field to search for a sample 
client. 

The Find Clients window opens. 

Note: If you have selected an AccountRight product there is no distinction in the Find 
Clients window between an AccountRight 2013.0 or later client and an 
AccountRight 19 or earlier client. Both are displayed as AccountRight in the 
Product column. 
You should be aware of which product your clients are using.

b. Search for the client.

c. Click OK. 

The Find Clients window closes and the Sample Client field updates with the selection 
made.

The selected client’s chart of accounts will be used as an example in the Chart of Accounts 
table. 
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To access the client account group configuration

1. Open the client’s Client Accounting > Reports tab.

2. Click Account Groups on the Tasks bar.
The Statutory Reporter - Account Groups window opens.

Related topics
Account Groups window
Configuring client report settings
Accessing Statutory Reporter
Configuring account groups

Account Groups window

The Account Groups window is divided into the:

 “Chart of Accounts” (see page 490)

 “Account Group Details” (see page 493).

If practice level account groups are being configured, the Account Groups window also includes the 
Industry Type and Sample Client drop-downs. See “To access the practice account group 
configuration” on page 488.

Related topics
Chart of Accounts
Account Group Details
Configuring account groups
Accessing account groups

Chart of Accounts

The Chart of Accounts lists the accounts from the selected client’s general ledger. The table lists the 
account code, the account description and indicates whether the account has been allocated to an 
account group.

You can:

 “Searching the Chart of Accounts” (see page 491)

 “Filtering the Chart of Accounts” (see page 491)

 “Hiding or showing the Chart of Accounts” (see page 492)

 “Finding account groups in the Chart of Accounts” (see page 493)
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 “Allocating individual accounts” (see page 497).

Searching the Chart of Accounts

Use the Search field at the top of the Chart of Accounts to find and select a specific account. 

To search the Chart of Accounts

1. Open the Statutory Reporter — Account Groups window.
See “Accessing account groups” on page 488.

2. Enter search criteria into the Search field at the top of the Chart of Accounts table. 
The search criteria can be all or part of the account code or description.

3. Press [Enter].
The list of accounts in the table filters to show only those accounts which match the search 
criteria.

To clear the search

1. Click . 
The search criteria clears. 

Related topics
Account Group Details
Configuring account groups
Accessing account groups
Filtering the Chart of Accounts
Hiding or showing the Chart of Accounts
Allocating individual accounts
Listing account allocations
Account Group Details tree right-click menu
Finding account groups in the Chart of Accounts

Filtering the Chart of Accounts

A filter can be used to display certain accounts in the Chart of Accounts table. The filtering menu is 
located at the bottom of the Chart of Accounts table. 

The available filter options are:

 Display all accounts — show all accounts regardless of whether they have been allocated. 

 Display unallocated accounts only — show only those accounts which have not been allocated 
to an account group. 
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 Display duplicated accounts only — show only those accounts which have mistakenly been 
allocated to more than one account group. This filter is used to correct the allocation. 

Click the Include zero balances checkbox to include those accounts with zero balances. 

Related topics
Account Group Details
Configuring account groups
Accessing account groups
Searching the Chart of Accounts
Hiding or showing the Chart of Accounts
Allocating individual accounts
Listing account allocations
Account Group Details tree right-click menu
Finding account groups in the Chart of Accounts

Hiding or showing the Chart of Accounts

When allocating accounts to account groups you may choose to use the Account Group Details 
view. Use the Hide Chart of Accounts or Show Chart of Accounts option to hide and show the Chart 
of Accounts table. 

To hide or show the Chart of Accounts

1. Open the Statutory Reporter — Account Groups window.
See “Accessing account groups” on page 488.

2. Click Hide Chart of Accounts.
This is located at the bottom of the Chart of Accounts table.
The Chart of Accounts will be hidden and the Account Group Details section will expand across 
the window for a more detailed view.

3. Click Show Chart of Accounts.
This is located at the bottom of the Account Group Details table.
The Chart of Accounts table is displayed.

Related topics
Account Group Details
Configuring account groups
Accessing account groups
Filtering the Chart of Accounts
Searching the Chart of Accounts
Allocating individual accounts
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Listing account allocations
Account Group Details tree right-click menu
Finding account groups in the Chart of Accounts

Finding account groups in the Chart of Accounts

To find account groups in the Chart of Accounts

1. Access the Statutory Reporter — Account Groups window.
See “Accessing account groups” on page 488.

2. In the Chart of Accounts table, select the account. 

3. Right-click on the account and select Find in Account Groups. 
The Account Group Details tree filters to show the location of the selected account. 

4. Click  in the search field at the top of the Account Group Details tree.
To clear the search. 

Related topics
Account Group Details
Configuring account groups
Accessing account groups
Filtering the Chart of Accounts
Hiding or showing the Chart of Accounts
Allocating individual accounts
Listing account allocations
Account Group Details tree right-click menu
Searching the Chart of Accounts

Account Group Details

The Account Group Details section of the Statutory Reporter — Account Groups window is divided 
into two areas: 

Account Group Details tree

The Account Group Details tree utilises a standard windows folder structure. Each folder lists the 
account ranges or individual accounts which have been assigned to the account group. Click  to 
expand and view the contents of a folder. Click  to collapse and hide the contents of a folder. 

Statutory Reporter comes with a set of default Account Group allocations. These master account 
group allocations are marked with an  in the Account Group Details tree. 
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The default account group allocations can be edited and assigned individual accounts and account 
ranges at a practice or client level:

 Practice Level — Account group allocations affect all clients of a selected industry type. 
Account Group allocations at a practice level are marked with an  in the Account Group 
Details tree. The Account Group option must be accessed from the Practice Report Settings to 
allocate accounts at a practice level.

See “To access the practice account group configuration” on page 488.

 Client Level — Account group allocations affect only the selected client. Account group 
allocations at a client level are marked with an  in the Account Group Details tree. The 
Account Group option must be accessed from the client’s Client Accounting > Reports tab to 
allocate accounts at a client level.

See “To access the client account group configuration” on page 490.

A (DR) or a (CR) may be displayed after an account range. This indicates that the debits and credits 
have been allocated separately. See “Allocating account ranges to account groups” on page 499.

A number of Account Group configuration options can also be accessed from the right-click popup 
menu. See “Account Group Details tree right-click menu” on page 495.

Account Group Details table

When an account group is selected in the Account Group Details tree, the Account Group Details 
table displays information about accounts allocated to the selected account group. 

The table has two views which can be selected from the drop-down located at the bottom of the 
table:

 Display account codes — lists the individual accounts which have been allocated to the 
selected account group. The account code is detailed in the Code column and the account 
name in the Description column. If an account range has been allocated to the account group, 
the accounts within the account range are listed individually. 

 Display account ranges — lists the account ranges which have been allocated to the selected 
account group. The account code of the first account in the range is detailed in the Starting 
Code column. The account code of the last account in the range is detailed in the Ending Code 
column. 

Above the table is a description which outlines the effects the account group configuration will have 
on the report. Click View full description to view a more detailed description. 

Use the Edit Range Settings option to allocate accounts separately to different account groups 
depending on whether the account is in credit or debit. See “Allocating account ranges to account 
groups” on page 499.

A number of Account Group configuration options can also be accessed from the right-click menu. 

Related topics
Account Group Details tree right-click menu
Searching account groups
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Chart of Accounts
Allocating account ranges to account groups
Deleting account group allocations
To access the client account group configuration
To access the practice account group configuration
Configuring account groups
Restoring default settings for account groups

Account Group Details tree right-click menu

The available options in the right-click menu will vary depending on what and where you right-click.

Option Description

Expand To expand and view the contents of a selected account group 
folder. 
This is the same as clicking  on the Account Group Details 
tree.

Collapse To collapse and hide the contents of a selected account group 
folder.
This is the same as clicking  on the Account Group Details 
tree.

Expand All in 
Group

To expand and view all the sub-folders and contents of a 
selected account group folder.

Collapse All in 
Group

To collapse and hide all the sub-folders and contents of a 
selected account group folder.

Expand All To expand all the account groups listed in the Account Group 
Details tree, so that you can view all the sub-folders and con-
tents of the account group structure.

Collapse All To collapse and hide all the account groups listed in the 
Account Group Details tree so that only the top level account 
group folders are listed.

Cut To remove and make a copy of an account so that it can be 
pasted into another account group.

Paste Paste an account that was Cut into another account group.

Create New Cus-
tom Group

To add a new summary account group under the selected 
account group. 
See “Creating custom account groups” on page 505.

Edit Custom 
Group

To change the name of a selected summary account group.
See “Creating custom account groups” on page 505.
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Related topics
Chart of Accounts
Allocating account ranges to account groups
Deleting account group allocations
To access the practice account group configuration
To access the client account group configuration
Configuring account groups
Restoring default settings for account groups

Searching account groups

Use the Search field at the top of the Account Group Details tree to search and locate a specific 
account group.

To search for an account group

1. Access the Statutory Reporter — Account Groups window.
See “Accessing account groups” on page 488.

1. Enter search criteria into the Search field at the top of the Account Group Details tree.
A search can use all or part of the account group name.

2. Press [Enter].

Delete To delete an account group allocation.

Edit Range Set-
tings

To allocate accounts within an account range separately to dif-
ferent account groups depending on whether the account is in 
credit or debit. 
See “Allocating account ranges to account groups” on 
page 499.

Restore Practice 
Report Settings

At any time, custom account group allocations can be removed 
and the default account group configurations restored. 
Use Restore Master Settings to remove practice level account 
group allocations and revert to the Statutory Reporter master 
default account group allocation. 
Use Restore Practice Report Settings to remove client level 
account group allocations and revert to the practice level 
account group allocations.
See “Restoring default settings for account groups” on 
page 510.

Option Description
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The list of account groups in the Account Group Details tree filters to show only those account 
groups which match the search criteria.

To clear the search

1. Click . 
The search criteria clears. 

Related topics
Chart of Accounts
Allocating account ranges to account groups
Deleting account group allocations
To access the client account group configuration
To access the practice account group configuration
Configuring account groups
Restoring default settings for account groups

Configuring account groups

Individual accounts or account ranges can be allocated to account groups. Allocations can be deleted 
and the default settings for account groups can be restored.

Configuring account groups may involve:

 “Allocating individual accounts” (see page 497)

 “Allocating account ranges to account groups” (see page 499)

 “Creating custom account groups” (see page 505)

 “Listing account allocations” (see page 508)

 “Deleting account group allocations” (see page 509)

 “Restoring default settings for account groups” (see page 510).

Allocating individual accounts 

You can allocate unallocated accounts to an account group in a number of ways:

 Use drag-and-drop to allocate individual accounts to account groups. The account must be 
dragged from the Chart of Accounts table to the appropriate account group in the Account 
Group Details tree.

 Using the Allocate to Group button on the Statutory Reporter — Account Groups window.

 The Chart of Accounts right-click menu option, Allocate to Group, is used to allocate a selected 
account to an account group in the Account Group Details tree.
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To allocate individual accounts using drag-and-drop

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488. 
The Statutory Reporter — Account Groups window opens.

2. Locate the account in the Chart of Accounts table.
Select Display unallocated accounts on the drop-down at the bottom of the Chart of Accounts 
table, to view only those accounts which have not been allocated to an account group. 

3. Locate the account group in the Account Group Details tree. 

4. Click the account entry in the Chart of Accounts table and drag-and-drop it into the account 
group in the Account Group Details tree.
The account is displayed in the account group in the Account Group Details tree. 
The account within the account group is identified with an  if it is configured at a practice 
level. The account within the account group is identified with an  if it is configured at a client 
level. 

5. Repeat Step 2.to Step 4. to allocate all the accounts in the Chart of Accounts table as 
necessary. 

6. Click OK.
To save the changes made in allocating individual account to the account groups. 

To allocate individual accounts using the Allocate to Group button

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Select an account from the Chart of Accounts table. 

3. Select the account group from the Account Group Details tree.
See “Account Group Details tree” on page 493.

4. Click Allocate to Group. 
The account is allocated to the selected account group. 
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5. Click OK.
The Statutory Reporter — Account Groups window closes and any allocations are saved.

To allocate individual accounts using the right-click menu

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488. 
The Statutory Reporter — Account Groups window opens.

2. In the Chart of Accounts table, select the account to be allocated to an account group.

3. In the Account Group Details tree, select the account group to which the account is to be 
allocated. 

4. Right-click on the account in the Chart of Accounts table and select Allocate to Group. 

5. Click OK.
The Statutory Reporter — Account Groups window closes and any allocations are saved.

Related topics
Account Group Details
Configuring account groups
Accessing account groups
Filtering the Chart of Accounts
Hiding or showing the Chart of Accounts
Searching the Chart of Accounts
Listing account allocations
Finding account groups in the Chart of Accounts
To access the practice account group configuration
Allocating account ranges to account groups
Deleting account group allocations
Restoring default settings for account groups

Allocating account ranges to account groups

A range of accounts can be allocated to a selected account group. To allocate the range, specify the 
account code of the first account in the range and the account code of the last account in the range. 

The Edit Range Settings option is used to allocate accounts separately to different Account Groups 
depending on whether the account is in credit or debit. For example, bank accounts must be 
displayed in the Current Assets section of the Balance Sheet report if they have a debit balance and 
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the Current Liabilities section of the Balance Sheet report if they have a credit balance. Any account 
ranges that have been allocated to a custom account groups will behave in a similar way.

To allocate an account range to an account group

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Find and select the account group in the Account Group Details tree.

3. Select Display account ranges.
Select this option from the drop-down located at the bottom of the Account Group Details 
table.

4. Click the final row in the Account Group Details table to add a new entry. 

The beginning of the row is identified by an  and a Click here to add an account range 
statement.

5. Enter the account code for the first account in the account range into the Starting Code 
column. 

6. Enter the account code for the last account in the account range into the Ending Code column. 
The account range is displayed in the account group in the Account Group Details tree. 
The account range within the account group is identified with an  if it is configured at a 
practice level. The account range within the account group is identified with an  if it is 
configured at a client level. 

7. Repeat Step 2. to Step 6. to allocate further account ranges. 

8. Click OK.
To save the changes made in configuring the account groups. 

Related topics
Accessing account groups
To access the practice account group configuration
Allocating individual accounts
Deleting account group allocations
Restoring default settings for account groups
Editing allocated accounts ranges
Separating debits and credits
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Removing debit/credit separation
Including all balances in an account range

Editing allocated accounts ranges

To edit an allocated account range

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Find and select the account range in the Account Group Details tree to be edited. 

3. Select Display account ranges. 
Select this option from the drop-down located at the bottom of the Account Group Details 
table.

4. Edit the account code in the Starting Code or Ending Code fields. 

5. Click OK.
To save the changes made in configuring the Account Groups. The Statutory Reporter — 
Account Groups window closes.

Related topics
Accessing account groups
To access the practice account group configuration
Allocating individual accounts
Deleting account group allocations
Restoring default settings for account groups
Allocating account ranges to account groups
Separating debits and credits
Removing debit/credit separation
Including all balances in an account range

Including all balances in an account range

You can either include all balances in an account range or separate debits and credits. See 
“Separating debits and credits” on page 502.
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To include all balances in an account range

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Find and select the account range in the Account Group Details tree for which to include all 
balances. 

3. Select Display account ranges. 
Select this option from the drop-down located at the bottom of the Account Group Details 
table.

4. Click Edit Range Setting.
The Range Settings window opens. 
The account range for which all balances are to be included is identified at the top of the 
window.

5. Select the Include All Balances option.

6. Click OK.
The Range Settings window closes. You are returned to the Statutory Reporter — Account 
Groups window.

7. Click OK.

Related topics
Accessing account groups
To access the practice account group configuration
Allocating individual accounts
Deleting account group allocations
Restoring default settings for account groups
Allocating account ranges to account groups
Separating debits and credits
Removing debit/credit separation

Separating debits and credits 

To separate debits and credits using Edit Range Settings

1. Access the account groups for the practice or for a selected client. 
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See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Find and select the account range in the Account Group Details tree for which debits and 
credits are to be separated. 

3. Select Display account ranges. 
Select this option from the drop-down located at the bottom of the Account Group Details 
table.

4. Click Edit Range Setting.
The Range Settings window opens. 
The account range for which debits and credits are to be separated is identified at the top of 
the window.

5. Select the Separate Debits and Credits option.
Configure the range settings:

a. Separate based on — two options are available from the drop-down to separate based on: 

 If debits and credits are to be separated based on Individual account balances, each 
individual account within the range is examined and allocated based on its balance.

 If debits and credits are to be separate based on Header account balances, the header 
account balance is examined and all accounts within the range are allocated based on the 
balance of the header account. 

b. Display in this group — select whether to display debits or credits, from the drop-down, in 
the currently selected account group. If Debits is selected the next field changes to Display 
credits in. If Credits is selected the next field changes to Display debits in. 

c. Display debits / credits in — click the ellipse button to select an Account Group to allocate 
the debits (if credits have already been allocated) or credits (if debits have already been 
allocated). 

The Select Account Group window opens.

6. Select the appropriate account group.

7. Click OK.
The Select Account Group window closes and you are returned to the Range Settings window.

8. Click OK.
The range settings are saved and the Range Settings window closes. You are returned to the 
Statutory Reporter — Account Groups window.
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In the Account Group Details tree, the account range is displayed marked with a (DR) in the 
account group to which debits have been allocated and a (CR) in the account group to which 
credits have been allocated. 

Related topics
Accessing account groups
To access the practice account group configuration
Allocating individual accounts
Deleting account group allocations
Restoring default settings for account groups
Editing allocated accounts ranges
Removing debit/credit separation
Including all balances in an account range

Removing debit/credit separation

To remove debit / credit separation and include all balances

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Find and select the account range in the Account Group Details tree for which debit / credits 
separation is to be removed. 

3. Select Display account ranges. 
Select this option from the drop-down located at the bottom of the Account Group Details 
table.

4. Click Edit Range Setting.
The Range Settings window opens. 
The account range for which debits / credit separation is to be removed is identified at the top 
of the window.

5. Select the Include All Balances option.

6. Click OK.
The Range Settings window closes and you are returned to the Statutory Reporter — Account 
Groups window.
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Related topics
Accessing account groups
To access the practice account group configuration
Allocating individual accounts
Deleting account group allocations
Restoring default settings for account groups
Including all balances in an account range

Creating custom account groups

Statutory Reporter contains a set of pre-defined practice account groups. Custom account groups 
can be created within a selected account group to summarise group detail accounts specific for a 
particular client. This grouping provides a summary of the account which is displayed as a single line 
entry in the financial reports. For example, it may be useful to group certain expense accounts that 
will be included in the financial report as a single line entry. Within financial reports, custom account 
groups are sorted appropriately, by account code or description, depending on the properties of the 
parent account group folder.

You cannot summarise header accounts within a custom account group.

The addition of a custom account group is identified by an  icon in the Account Group Details tree.

Note: You cannot create another custom account group within an existing custom account group.

To group accounts into a custom account group

1. Access the account groups for the client. 
See “To access the client account group configuration” on page 490.
The Statutory Reporter — Account Groups window opens.

2. Select the account group folder from the Account Group Details tree that contains the account 
groups that are to be grouped into a custom account group.
The accounts are listed in the Account Group Details table.

3. Select the Display account codes option from the drop-down.
This option is located at the bottom of the Account Group Details table.

4. Select accounts in the Account Group Details table that will be included in a new custom 
account group.
To select consecutive accounts, click the accounts and press [Shift].
To select non-consecutive accounts, click the accounts and press [Ctrl].

5. Right-click on the account(s) in the Account Group Details table and select Add to New Custom 
Group. 
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The Add to New Custom Group window opens.
The selected account(s) are listed in the Accounts selected section.

6. Enter a Custom group name.
The Custom group name field is limited to a maximum of 100 alphanumeric characters.

Note: The Custom group name must be unique. You cannot name a new custom account 
group with an existing account group name under the same parent account group. 
An error message will be displayed.
This is a mandatory field and cannot be blank.

7. Select the Show detail accounts with custom group checkbox, if required.
If this checkbox is selected, the custom group will be listed in reports as a heading with the 
detailed accounts that are included as part of the custom group, listed immediately below.

8. Click OK.
The selected accounts are grouped into the new custom account group. The Add to New 
Custom Group window closes and the custom account group is added to the Account Group 
Details tree. The Account Group Details tree updates to reflect the changes.
When financial reports are produced a single line entry will be displayed for these accounts 
that have been grouped 

To create a new custom account group without selecting accounts

1. Access the account groups for the client. 
See “To access the client account group configuration” on page 490.
The Statutory Reporter — Account Groups window opens.

2. Select an account group folder in the Account Group Details tree.

3. Right-click on the account group and select Create New Custom Group.
The Create New Custom Group window opens.

4. Enter the Custom group name.
The Custom group name field is limited to a maximum of 100 alphanumeric characters.

Note: The Custom group name must be unique. You cannot name a new custom account 
group with an existing account group name under the same parent account group. 
An error message will be displayed if you attempt to do so.
This is a mandatory field and cannot be blank.

5. Select the Show detail accounts with custom group checkbox, if required.
If this checkbox is selected, the custom group will be listed in reports as a heading with the 
detailed accounts that are included as part of the custom group, listed immediately below.
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6. Click OK.
The Create New Custom Group window closes and the new custom account group is created 
within the selected account group folder. The new custom account group is identified with an 

 icon in the Account Group Details tree.

7. Allocate individual accounts to the custom account group.
See “Allocating individual accounts” on page 497.

8. Click OK.
The custom account group and associated accounts are added to the Account Group Details 
tree. The Account Group Details tree updates to reflect the changes.
When financial reports are produced a single line entry will be displayed for these accounts 
that have been grouped.

To edit a custom account group name

1. Access the account groups for the client. 
See “To access the client account group configuration” on page 490.
The Statutory Reporter — Account Groups window opens.

2. Select a custom account group folder in the Account Group Details tree.
A custom account group folder is identified by an icon.

3. Right-click on the selected custom account group and select Edit Custom Group.
The Edit Custom Group window opens.

4. Change the Custom group name.

Note: The Custom group name must be unique. You cannot name a new custom account 
group with an existing account group name under the same parent account group. 
An error message will be displayed.
This is a mandatory field and cannot be blank.

5. Click OK.
The Edit Custom Group window closes and the name of the custom account group is changed. 

Related topics
Allocating individual accounts
Allocating account ranges to account groups
Listing account allocations
Deleting account group allocations
Restoring default settings for account groups
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Listing account allocations 

The List Account Allocation button is used to generate a text file which lists the account codes and 
account descriptions for all client or practice accounts and how they have been allocated. The 
Account Allocation list can be sorted by account or account group. 

To list the account allocations

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
If Account Groups are to be configured for the practice, then select the Industry Type and 
nominate a Sample Client. 
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Click List Account Allocation. 
The List Account Allocation window opens.

3. Select the sort order to list the account allocations.
Select either Sort by Account or Sort by Account Group. 

4. Click OK.
A text file is generated which lists the account allocations. 
If Sort by Account is selected, the text file lists each account, the account code and description 
and the account group to which it has been allocated. 
If Sort by Account Group is selected, the text file lists each account group and the accounts, the 
account codes and descriptions, which have been allocated to the group. 

Related topics
Account Group Details
Configuring account groups
Accessing account groups
Filtering the Chart of Accounts
Hiding or showing the Chart of Accounts
Allocating individual accounts
Searching the Chart of Accounts
Account Group Details tree right-click menu
Finding account groups in the Chart of Accounts
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Deleting account group allocations

Account group allocations can be deleted at a practice or client level. When you delete an account 
group allocation, the account is unallocated from the account group and returned to the Chart of 
Accounts table to be re-allocated to another account group.

At a practice level, a deleted account group allocation will affect all clients of a selected industry 
type. That is, the account group allocation is removed for all clients of that industry type. The 
Account Groups option must be accessed from the Practice Report Settings to delete account group 
allocations at a practice level. See “To access the practice account group configuration” on page 488.

At a client level, a deleted account group allocation will affect only the selected client. That is, the 
account group allocation is removed for the selected client only. The Account Groups option must 
be selected from the client’s Client Accounting > Reports tab to delete account group allocations at 
a client level. See “To access the client account group configuration” on page 490. You can also 
unallocate accounts that have been allocated to any custom account groups.

Note: Pre-defined account groups cannot be deleted.

To delete (or unallocate) account group allocations

1. Access the account groups for the practice or for a selected client. 
See “Accessing account groups” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Find the account in the Account Group Details tree. 

3. Right-click on the account and select Delete. 
A Statutory Reporter confirmation dialog is displayed. 

4. Click Yes to delete the account allocation. Click No to cancel. 
If Yes is selected, the account allocation is removed from the account group folder in the 
Account Group Details tree and returned to the Chart of Accounts table where it can be re-
allocated to the appropriate account group.

To delete (or unallocate) account group allocations to a custom group 

Note: You cannot delete a custom account group that contains allocated accounts. To delete the 
custom account group, first unallocated the accounts then delete the custom account group.

1. Access the custom account groups for the selected client. 
See “Accessing account groups” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Unallocate accounts from a selected custom account group.
See “To delete (or unallocate) account group allocations to a custom group” on page 509.
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The account allocation is removed from the custom group folder in the Account Group Details 
tree and returned to the Chart of Accounts table.

3. Select the custom account group folder in the Account Group Details tree. 

4. Right-click on the custom account group folder and select Delete. 
A Statutory Reporter confirmation dialog is displayed. 

5. Click Yes to delete. Click No to cancel. 
If Yes is selected, the custom account group folder is removed from the account group folder in 
the Account Group Details tree. 

Related topics
Accessing account groups
To access the practice account group configuration
To access the client account group configuration
Allocating individual accounts
Allocating account ranges to account groups
Restoring default settings for account groups

Restoring default settings for account groups

Any account group allocations that you have made in the Statutory Reporter — Account Groups 
window can be removed and the default master or practice account group configurations restored. 

At a practice level, any customised practice level account group allocations can be removed and the 
master set of default account group allocations which come with Statutory Reporter can be 
restored. 

At a client level, any customised client level account group allocations can be removed and the 
practice level account group allocations can be restored. 

At the client level, if a custom account group is selected to be restored to the practice settings, then 
all accounts within the custom account group are removed and the custom group itself is deleted 
from the Account Group Details tree.

To restore the master settings

1. Access the account groups for the practice.
See “To access the practice account group configuration” on page 488.
The Statutory Reporter — Account Groups window opens.

2. Select the Industry Type from the drop-down.

3. Click the ellipse button located at the end of the Sample Client field to find a sample client.
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4. Find the account group in the Account Group Details tree for which the default master account 
group configuration is to be restored.

5. Right-click and select Restore Master Settings. 
The Statutory Reporter confirmation dialog is displayed. 

6. Click Yes to remove the practice level account group modifications for the selected account 
group. Click No to cancel. 
The practice level account group allocations are removed for the selected account group. If the 
account group has sub-account groups, the practice level account group allocations are also 
removed for these. For example, if you select the Balance Sheet account group, the practice 
level account group allocations are also removed from the Assets and Liabilities and Equity 
account groups. 

To restore practice report settings

1. Access the account groups for the client. 
See “To access the client account group configuration” on page 490.
The Statutory Reporter — Account Groups window opens.

2. Select the account group in the Account Group Details tree for which the practice level account 
group configuration is to be restored.

3. Right-click and select Restore Practice Report Settings. 
The Statutory Reporter confirmation dialog is displayed. 

4. Click Yes to remove the client level account group allocations for the selected account group. 
Click No to cancel. 
The client level account group allocations are removed for the selected account group. If the 
account group has sub-account groups, the client level account group allocations are also 
removed for these. For example, if you select the Balance Sheet account group, the client level 
account group allocations are also removed from Assets and Liabilities and Equity account 
groups.

Related topics
To access the practice account group configuration
To access the client account group configuration
Allocating individual accounts
Allocating account ranges to account groups
Deleting account group allocations
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Non-transaction data
Non-Transaction Data s to client specific data values that are required for the financial statements 
but are not derived from account balances in the client ledger. For example, names and dates. 

There are two types of non-transaction data that can be configured:

 Practice non-transaction data preferences.

 Client-specific data values.

Related topics
Practice non-transaction data preferences
Client non-transaction data

Practice non-transaction data preferences

There are three relationship types that are used to identify the signatories on the declaration report: 

 directors for companies and trusts

 partners for partnerships 

 trustees for trusts that do not have directors. 

Practices that use the Associations feature in MYOB AE/AO to track the relationships between 
clients and partners, directors and trustees can choose to nominate the association types that 
represent these three relationships. For those clients with associations configured on the 
Associated tab, the partners, directors and trustees will automatically be added to the 
corresponding data category in the client’s non-transaction data.

Note: Non-transaction data preferences relies on the associations created on the Associated tab 
in MYOB AE/AO. Therefore, the non-transaction data preferences should only be set, if the 
Associate feature in MYOB AE/AO is used. See information on the Associations feature. 

The non-transaction data preferences are configured on the Practice Report Settings tab.

To access the practice non-transaction data preferences

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Click Non-Transaction Data on the Tasks bar.
The Non-Transaction Data Preferences window opens. 

To configure the non-transaction data preferences

1. Access the practice Non-Transaction Data Preferences window.

2. For each relationship type, select the association type that is used in your practice. 

../Practice_Manager/Associated_tab.htm
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a. Select the director association type using the Directors drop-down.

b. Select the partner association type using the Partners drop-down.

c. Select the trustees association type using the Trustees drop-down.

3. Click OK.
The Non-Transaction Data Preferences window closes.

Related topics
Client non-transaction data

Client non-transaction data

Non-transaction data s to client specific data values that are required for the financial statements 
but are not derived from account balances in the client ledger. Non-transaction data is organised 
into data fields and data categories which can be viewed and edited.

An  indicates that the data field is linked to the client’s details in MYOB AE/AO. These linked fields 
can be edited in Non-Transaction Data in Statutory Reporter. Any changes made in Statutory 

Reporter are not updated to MYOB AE/AO. Click  to reset the changes to the field and return to 
the MYOB AE/AO data. 

Related topics
Data categories and data fields
Accessing client non-transaction data
Searching for a data field
Editing client non-transaction data
Practice non-transaction data preferences

Data categories and data fields

Client non-transaction data is organised into: 

 Data Fields — to the specific data values that are required for the financial statements. These 
include fields such as the client name and address.

 Data Category — data fields are grouped using Data Categories. These categories allow quick 
and easy searching of the data field to be viewed or edited. 

Available data fields

The following table lists the data categories, the data fields which belong to each category, the data 
type of each field and a description of the field / what field it is linked to in MYOB AE/AO.
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Data field Data type Description

Data Category: Client Details

Client Name Text Linked to Main Name

(Australia) ABN Number Linked to ABN field on the Main tab.

(New Zealand) Company 
No.

Text

(New Zealand) NZBN Text

(New Zealand) Nature of 
business

Text

(New Zealand) Issued 
Capital

Text

(New Zealand) Bankers Text

(New Zealand) Regis-
tered Office 1

Text

(New Zealand) Regis-
tered Office 2

Text

(New Zealand) Regis-
tered Office 3

Text

(New Zealand) Solicitors Text

(New Zealand) Reporting 
Basis

List

(New Zealand) Look 
through company?

Checkbox

(New Zealand) Forma-
tion Date

Date

(New Zealand) Regis-
tered for GST?

Checkbox

Data Category: Compilation Report

Firm Name Text Linked to name of the company on 
the Responsibility tab.

Firm Address - Line 1 Text Linked to Address (Address field 1) 
of the office on the Responsibility 
tab. 
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Firm Address - Line 2 Text Linked to Address (Address field 2) 
of the office on the Responsibility 
tab.

Firm Address - Line 3 Text Linked to Address (Address field 3) 
of the office on the Responsibility 
tab.

Firm Address - Suburb Text Linked to Address (Town field) of the 
office on the Responsibility tab.

Firm Address - State Text Linked to Address (County field) of 
the office on the Responsibility tab.

Firm Address - Post Code Number Linked to Address (Postcode field) of 
the office on the Responsibility tab.

Firm Address - Country Text Linked to Address (Country field) of 
the office on the Responsibility tab.

Signed By Text Linked to latest Partner name on the 
Responsibility tab.

Signed Date Date

No. of Partners in Firm Number

(New Zealand) Independ-
ence

Text

(New Zealand) Departure 
from Framework

Text

Data Category: Shareholders
(New Zealand)

Shareholder’s Name Text

Class of Shares Text

Number of Shares Number

Include? Checkbox

Data Category: Declaration

Signed Date Date

Data Category: Directors
Entity Type: Company, Unit Trust, Other Trust

Data field Data type Description



MYOB AO, AE, AU, NZ PM Client AccountingUser Guide | 516

Director’s Name Text Linked to name of the Director from 
the Associated tab*.

Signatory Checkbox

(New Zealand) Director 
Sign Date

Date

(New Zealand) Include? Checkbox

Data Category: Directory
Entity Type: Company, Partnership, Trust, Sole Trader
(New Zealand)

NZBN Number

Company number Number Applies to Company

IRD number Number

Nature of business Text

Formation date Date Applies to Partnership, Trust, Sole 
Trader

Settlement date Date Applies to Trust

Settlor Date Applies to Trust

Incorporated date Date Applies to Company

Issued capital Number Applies to Company

Bankers Text

Solicitors Text

Registered office 1 Text Applies to Company

Registered office 2 Text Applies to Company

Registered office 3 Text Applies to Company

Business address - line 1 Text

Business address - line 2 Text

Business address - line 3 Text

Business address - suburb Text

Bsuiness address - 
postcode

Number

Data field Data type Description
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Auditors name Text

Data Category: Partners
Entity Type: Partnership

Partner’s Name Text Linked to name of the Partner from 
the Associated tab*.

Signatory Checkbox

(New Zealand) Include? Checkbox

Data Category: Trustees

Trustee’s Name Text Linked to name of the Director from 
the Associated tab*.

Signatory Checkbox

(New Zealand) Include? Checkbox

Data Category: Authorisation Date

Authorisation Date Date

Data Category: Auditors
(New Zealand)

Auditors Name Text

Data Category: Notes - disclosures
Entity type: Company, Partnership, Trust, Sole Trader
(New Zealand)

Taxation Note - Tax rate Text

ICA- opening balance Currency

ICA - closing balance Currency

Securities Guarantees Checkbox

Data Category: Notes - Related party
Entity type: Company, Partnership, Trust, Sole Trader
(New Zealand)

Name Text

Relationship Text

Type of Transaction Text

This Year Currency

Data field Data type Description
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Last Year Currency

Data Category: Notes - Borrowings
Entity type: Company, Partnership, Trust, Sole Trader
(New Zealand)

Description Text

Interest Rate Number

Term of the loan Number

Security Number

Data Category: Accounting Policy - Depreciation Rates
Entity type: Company, Partnership, Trust, Sole Trader
(New Zealand)

Asset Class Text

Depreciation Rates Number

Depreciation Method Text

Data Category: Income Statement Options
Entity type: Company, Association, Other Trusts, Unit Trusts

Separate Appropriation 
Statement?

Checkbox Prints the Appropriation ledger bal-
ances in a separate report (the 
'Appropriations Statement Report').
Note that this is limited to Compa-
nies, Associations, Other Trusts, and 
Unit Trusts.

Change net profit 
description

Text

Data Category: Minutes of Meeting
Entity type: Company, Other Trust, Unit Trust

Meeting Address Text Single line, free formatting

Meeting Date Date

Meeting Time Date

Trustee Type Text “Individual” or “Corporate”

Number of Directors Number

Client Audited Checkbox Unchecked by default

Data field Data type Description
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Number of Auditors Number

Listed Entity Checkbox Unchecked by default

Remuneration Report 
Received

Checkbox Unchecked by default

Distribution of Income Text “Minutes” or “Resolution”

Data Category: Directors Table
Entity type: Company, Other Trust, Unit Trust

Directors Name Text

Present Checkbox

Apology Checkbox

Chairperson Checkbox

Elected AGM Checkbox

Data Category: Dividends
Entity type: Other Trust, Unit Trust

Dividend Date Date

Franking Rate Decimal

Data Category: Beneficiary Details
Entity type: Other Trust, Unit Trust

Beneficiary Name Text

Net Income Decimal

Income Percentage Decimal

Capital Gain Decimal

Interest Decimal

Investment Amount Decimal

Remaining Amount Decimal

Percentage Disclosure Decimal

Data Category: Trustee Table
Entity type: Other Trust, Unit Trust

Trustee’s Name (see field above under “Trustees”)

Trustee Company Name

Data field Data type Description
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* - these fields are linked to the MYOB AE/AO fields only if the practice non-transaction data 
preferences have been configured and the Associations feature in MYOB AE/AO is used. See “Practice 
non-transaction data preferences” on page 512 for more information. 

An  indicates that the data field is linked to the client’s details in MYOB AE/AO. These linked fields 
can be edited in Non-Transaction Data in Statutory Reporter. The changes made in Statutory 

Reporter are not updated to MYOB AE/AO. Click  to reset the changes to the field and return to 
the MYOB AE/AO data. 

Each data field is a certain data type. The data type controls the type of information that can be 
entered into the data field. 

Data types and parameters

Related topics
Accessing client non-transaction data
Searching for a data field
Editing client non-transaction data
Practice non-transaction data preferences

Trustee Company ABN

Trustee is Signatory

Data Type Parameters

Checkbox Click to select or deselect.

(New Zea-
land) Cur-
rency

Enter the monetary value into this field.

Date The format of the date reflects the computer settings. Select a 
date from the calendar popup.

(New Zea-
land) List

Select an option from the available list in the drop-down.

Number Enter any numerical values into this field to a maximum of 13 
characters.

Text Text fields accept any standard keyboard characters.

Data field Data type Description
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Accessing client non-transaction data

Each client’s non-transaction data fields can be edited. The client’s non-transaction data is 
populated with information from MYOB AE/AO or it can be entered. 

To access the client non-transaction data

1. Search and select the client whose non-transaction data is to be edited. 

2. Open the client’s Client Accounting > Reports tab.

3. Click Non-Transaction Data on the Tasks bar.
The Statutory Reporter — Non-Transaction Data window opens. 

Related topics
Data categories and data fields
Searching for a data field
Editing client non-transaction data

Searching for a data field

Use the Search field at the top of the Non-Transaction Data window to search for and locate a 
specific data field. 

To search for a data field

1. Access the client’s non-transaction data.
See “Accessing client non-transaction data” on page 521.
The Statutory Reporter — Non-Transaction Data window opens.

2. Enter the search criteria in the Search field.
All or part of the data field name can be entered.
As text is entered, Data Categories and Data Fields filter dynamically to list the data categories 
which contain data fields that match the search criteria.
If more than one data category is listed, click each category until the data field is found.

To clear the search

1. Click . 
The search criteria clears. 

Related topics
Data categories and data fields
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Accessing client non-transaction data
Editing client non-transaction data

Editing client non-transaction data

Each client’s non-transaction data fields can be edited. The client’s non-transaction data is 
populated with information from MYOB AE/AO or it can be manually entered. 

An  indicates that the data field is linked to the client’s details in MYOB AE/AO. These linked fields 
can be edited in Non-Transaction Data of Statutory Reporter. The changes made in Statutory 

Reporter are not updated to MYOB AE/AO. Click  to reset the changes to the field and return to 
the MYOB AE/AO data.

Directors, Partners or Trustees cannot be added or removed in client non-transaction data if the 
Associations feature in MYOB AE/AO is used and if the practice Non-Transaction Data Preferences 
have been configured. To add or remove a Director, Partner or Trustee, the information must be 
edited on the Associated tab in MYOB AE/AO. See “Practice non-transaction data preferences” on 
page 512 and the MYOB AE help for more information.

To edit the client’s non-transaction data

1. Access the client’s non-transaction data.
See “Accessing client non-transaction data” on page 521.
The Statutory Reporter — Non-Transaction Data window opens.

2. Find the data field to be edited. 
Use the Search field to search and locate the data field easily and quickly.
See “Searching for a data field” on page 521.

3. Edit the data fields as required.

On the MYOB AE/AO linked fields, click  to reset the changes made to the field and return to 
the MYOB AE/AO data.

4. Click OK. 
The changes are saved.

To edit directors, partners or trustees

Note: If the Associations feature in MYOB AE/AO is being used and the Practice Non-Transaction 
Data Preferences have been configured, then you will not be able to edit the Directors, 
Partners or Trustees in the client’s non-transaction data. See “Practice non-transaction data 
preferences” on page 512 and the MYOB AE helpMYOB AO helpMYOB AO helpMYOB AE help 
for more information. 

1. Access the client’s non-transaction data.

../Practice_Manager/Associated_tab.htm
../Practice_Manager/Associated_tab.htm
../MYOB_AO/Client_or_Contact_page_Associated_tab.htm
../Practice_Manager/Associated_tab.htm
../MYOB_AO/Client_or_Contact_page_Associated_tab.htm
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See “Accessing client non-transaction data” on page 521.
The Statutory Reporter — Non-Transaction Data window opens.

2. Select the Directors / Partners / Trustees data category. 

3. To add a director, partner or trustee:

a. Click  to create a new record.

b. Enter the contact name and select whether the contact is a signatory. 

4. To edit a director, partner or trustee:

a. Select the director / partner / trustee in the list.

b. Edit the contact name and /or whether the contact is a signatory. 

5. To delete a directory, partner or trustee:

a. Select the contact in the list.

b. Click  to remove the contact from the list. 

6. Click OK to save the changes. 

Related topics
Data categories and data fields
Accessing client non-transaction data
Searching for a data field
Practice non-transaction data preferences
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Paragraphs
Statutory Reporter uses Paragraphs to define sections of text that are displayed in financial 
statements. 

MYOB provides default paragraph content as part of the Master Level Report Definitions. The 
content and format of these default paragraphs can be modified for your entire practice or for an 
individual client. 

The following can be defined:

 Practice Paragraphs — default paragraphs for all clients within the practice.

 Client Paragraphs — custom paragraphs for selected clients.

Related topics
Accessing practice paragraphs
Accessing client paragraphs
Paragraphs window
Editing paragraphs
Searching paragraphs
Paragraphs in the Report Preview window

Accessing practice paragraphs

To define default paragraphs for all clients within the practice, the Paragraphs option must be 
accessed from within Practice Report Settings. Any changes made to the paragraphs from within 
Practice Report Settings will apply to all reports for all clients.

The Report Preview window can also be used to view and edit the practice Paragraphs. See 
“Paragraphs in the Report Preview window” on page 538.

To access the practice paragraphs

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Click Paragraphs on the Tasks bar.
The Statutory Reporter — Paragraphs window opens.

Related topics
Accessing client paragraphs
Paragraphs window
Editing paragraphs
Searching paragraphs
Paragraphs in the Report Preview window
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Accessing client paragraphs

To define custom paragraphs for selected clients, the Paragraphs option must be accessed from the 
client’s Client Accounting > Reports tab. Any changes made to the client’s paragraphs will only apply 
to the selected client. 

The client paragraphs can also be viewed and edited from the Report Preview window. See 
“Paragraphs in the Report Preview window” on page 538.

To access client paragraphs

1. Open the client’s Client Accounting > Reports tab. 

2. Click Paragraphs on the Tasks bar.
The Statutory Reporter — Paragraphs window opens.

Related topics
Accessing practice paragraphs
Paragraphs window
Editing paragraphs
Searching paragraphs
Paragraphs in the Report Preview window

Paragraphs window

The Paragraphs window is divided into the following sections:

 Search — this field is used to find a specific paragraph or report. 

See “Searching paragraphs” on page 526.

 Paragraphs list — the Paragraphs list provides an index of all the reports and the paragraphs 
within each report. Double-click a paragraph to view and edit the paragraph content. 

See “Editing static text” on page 528 and “Inserting and editing variables” on page 529.

 Toggle Groups — change the view of the Paragraphs list. By default, the paragraphs are 
grouped by report. Click to display a list of paragraphs in alphabetical order.

 Preferences button — to display the cents for all currency values in the paragraph.

 Edit Paragraph button — view and edit paragraph content. 

See “Editing static text” on page 528 and “Inserting and editing variables” on page 529.

Related topics
Editing paragraphs
Editing static text
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Searching paragraphs
Inserting and editing variables
Paragraphs in the Report Preview window

Searching paragraphs

Use the Search field at the top of the Paragraphs window to search and locate a specific paragraph 
or report. 

To search for a paragraph

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on page 525

2. Enter the search criteria for a paragraph in the Search field.
All or part of the paragraph name can be searched.
As text is entered, the Paragraphs list filters dynamically to show paragraphs that match the 
search criteria. The list shows the paragraphs and the reports in which the paragraphs are used. 

To search for a report

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on page 525

2. Enter the search criteria for a report in the Search field.
All or part of the report name can be searched.
As text is entered, the Paragraphs list filters dynamically to show reports which match the 
search criteria. Also listed are those reports which share common paragraphs with the 
nominated report. 
This feature can be used to see the effects of editing a common paragraph. Editing a shared 
paragraph in one report will also affect the same paragraph in other reports.

To clear the search

1. Click . 
The search criteria clears. 

Related topics
Accessing practice paragraphs
Accessing client paragraphs
Paragraphs window
Editing paragraphs
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Paragraphs in the Report Preview window

Editing paragraphs

Practice Paragraphs — default paragraphs for all clients within the practice — and Client Paragraphs 
— custom paragraphs for selected clients, can be edited. 

To edit Practice Paragraphs, access the Paragraphs option from the Practice Report Settings. See 
“Accessing practice paragraphs” on page 524.

To edit Client Paragraphs, search and select the client before accessing the Paragraphs option from 
the client’s Client Accounting > Reports tab. See “Accessing client paragraphs” on page 525.

Paragraphs can be composed of two types of text:

 Static text — is displayed on the report as it is entered when editing the paragraphs.

 Variable text — the value of variable text, that is the text that is displayed on the report, is 
provided by data recorded within Statutory Reporter. For example, a date variable may display 
the year start date, year end date or the date on which the report is printed. See “Editing static 
text” on page 528 and “Inserting and editing variables” on page 529. 

Related topics
Accessing practice paragraphs
Accessing client paragraphs
Searching paragraphs
Paragraphs in the Report Preview window
Edit Paragraph Content window
Editing static text
Inserting and editing variables
Formatting paragraphs
Inserting logos into the Compilation Report
Restoring default content

Edit Paragraph Content window

The Edit Paragraph Content window enables the contents of a paragraph to be edited. Static text 
can be edited, variables can be inserted and edited, and the static and variable text in the paragraph 
can be formatted.

To access the Edit Paragraph Content window

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.
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2. Find the paragraph to be edited.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

Related topics
Paragraphs
Editing static text
Inserting and editing variables
Formatting paragraphs
Inserting logos into the Compilation Report
Restoring default content

Editing static text

Static text is displayed on the report as it is entered when editing the paragraph content. Use the 
formatting tools to change the text style, indent and to spell check the text. 

To edit static text

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. Find the paragraph to be edited.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

5. Edit the text as required in the Paragraph Content text area. 
Text can be inserted, edited or deleted. The text is displayed on the report as it is entered here. 
See “Inserting and editing variables” on page 529.
Use the formatting tools to format and check the text. See “Formatting paragraphs” on 
page 535.

6. Click OK.
To save the changes. 

Related topics
Paragraphs
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Edit Paragraph Content window
Inserting and editing variables
Formatting paragraphs
Restoring default content

Inserting and editing variables

The value of variable text, that is the text that is displayed on the report, is provided by data recorded 
within Statutory Reporter.

There are 4 types of paragraph variables. The following table details each variable type and how the 
variable are displayed in the Paragraph Content text area.

Related topics
Paragraphs
Edit Paragraph Content window
Formatting paragraphs
Inserting logos into the Compilation Report

Paragraph variable Description

Account Group 
Value

The Account Group value variable displays the sum of val-
ues of all accounts which belong to a selected account 
group. 
There are 2 options:
•  this year (TY)
•  last year (LY).
See “Account groups” on page 488.
Format <<AccountGroup>>

Conditional Text Conditional Text variables enable you to provide alternate 
wording for a paragraph.
Format ((condition1/condition2))

Date Use the Date variable to insert the year start, year end for 
this year (TY) or last year (LY), or current date into the 
paragraph. There are number of pre-configured date 
formats from which to select.
Format [(DateType as DateFormat)]

Non-Transaction 
Data

Non-Transaction Data s to client specific data values that are 
required for the financial statements but are not derived 
from account balances in the client ledger. 
See “Non-transaction data” on page 512.
Format [[DataCategory.DataField]]
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Restoring default content
Inserting an account group value in a paragraph
Inserting non-transaction data in a paragraph
Inserting conditional text in a paragraph
Inserting a date in a paragraph
Editing a variable

Inserting an account group value in a paragraph

To insert an account group value

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. Find the paragraph to be edited.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

5. In the Paragraph Content text area, click to place the cursor at the point where the Account 
Group Value variable is to be inserted.

6. Click Account Group Value.
This is located on the Insert menu. 
You can insert an Account Group Value for this year (TY) or last year (LY).
The Insert Account Group Reference window opens. 

7. Select the Account Group Value to be inserted.

8. Click OK.
The Account Group Value variable is displayed at the insertion point in the Paragraph Content 
text area. 
Use the formatting tools to format the variable as required. See “Formatting paragraphs” on 
page 535.

9. Click OK.
To save the changes to the paragraph content. 

Related topics
Paragraphs
Edit Paragraph Content window
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Formatting paragraphs
Restoring default content
Inserting non-transaction data in a paragraph
Inserting conditional text in a paragraph
Inserting a date in a paragraph
Editing a variable

Inserting conditional text in a paragraph

To insert conditional text

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. Find the paragraph to be edited.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

5. In the Paragraph Content text area, click to place the cursor at the point where the Conditional 
Text is to be inserted.

6. Click Conditional Text.
This is located on the Insert menu.
The Insert Conditional Text window opens. 
The conditional text variables are displayed on a drop-down menu. The Summary text area 
provides a brief description of each variable — what wording is used when certain conditions 
apply. 

7. Select the Conditional Text variable on the drop-down. 

8. Click OK.
The Conditional Text variable is displayed at the insertion point in the Paragraph Content text 
area. 
Use the formatting tools to format the variable as required. See “Formatting paragraphs” on 
page 535.

9. Click OK.
To save the changes to the paragraph content. 
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Related topics
Paragraphs
Edit Paragraph Content window
Formatting paragraphs
Restoring default content
Inserting an account group value in a paragraph
Inserting non-transaction data in a paragraph
Inserting a date in a paragraph
Editing a variable

Inserting a date in a paragraph

To insert a date

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. Find the paragraph to be edited.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

5. In the Paragraph Content text area, click to place the cursor at the point where the Date is to 
be inserted.

6. Click Date.
This is located on the Insert menu.
The Date Format window opens.

7. Select the:

a. Date — select the date to be inserted from the drop-down. The available options are:

 Year Start Date (TY)

 Year Start Date (LY) 

 Year End Date (TY) 

 Year End Date (LY) 

 Today’s Date - the date on which the report is produced

 Period Type Start Date (TY) 

 Period Type Start Date (LY) 
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 Period Type End Date (TY) 

 Period Type End Date (LY).

b. Format — there are a number of pre-configured date formats which can be used. Select an 
appropriate format on the Format drop-down. 

The Sample text field displays an example of the selected format.

8. Click OK.
The Date variable is displayed at the insertion point in the Paragraph Content text area. 
Use the formatting tools to format the variable as required. See “Formatting paragraphs” on 
page 535.

9. Click OK.
To save the changes to the paragraph content. 

Related topics
Paragraphs
Edit Paragraph Content window
Formatting paragraphs
Restoring default content
Inserting an account group value in a paragraph
Inserting non-transaction data in a paragraph
Inserting conditional text in a paragraph
Editing a variable

Inserting non-transaction data in a paragraph

To insert non-transaction data

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. Find the paragraph to be edited.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

5. In the Paragraph Content text area, click to place the cursor at the point where the Non-
Transaction field variable is to be inserted.
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6. Click Non-Transaction Data.
This is located on the Insert menu.
The Insert Non-Transaction Data Reference window opens. 
The data fields are grouped using Data Categories to enable quick and easy searching for the 
Non-Transaction Data field to be inserted. 

7. Select the Non-Transaction Data field variable to be inserted.

8. Click OK.
The Non-Transaction Data variable is displayed at the insertion point in the Paragraph Content 
text area. 
Use the formatting tools to format the variable as necessary. See “Formatting paragraphs” on 
page 535.

9. Click OK.
To save the changes to the paragraph content. 

Related topics
Paragraphs
Edit Paragraph Content window
Formatting paragraphs
Restoring default content
Inserting an account group value in a paragraph
Inserting conditional text in a paragraph
Inserting a date in a paragraph
Editing a variable

Editing a variable

To edit a variable

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. Find the paragraph to be edited.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

5. Locate the variable to be edited in the Paragraph Content text area. 
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6. Double-click to select the variable.

7. Insert a new variable or highlight the variable and use the formatting tools to format the 
variable as required.
See “Formatting paragraphs” on page 535.

8. Click OK.
To save the changes.

Related topics
Paragraphs
Edit Paragraph Content window
Formatting paragraphs
Restoring default content
Inserting an account group value in a paragraph
Inserting non-transaction data in a paragraph
Inserting conditional text in a paragraph
Inserting a date in a paragraph
Editing a variable
Inserting logos into the Compilation Report

Formatting paragraphs

Use the options on the formatting tool bar to format the paragraph text.

To format a paragraph

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. Select the text.

3. Format the text using the available options as required.

4. Click OK.
To save the changes made to the text.

Related topics
Edit Paragraph Content window
Editing static text
Inserting and editing variables
Inserting logos into the Compilation Report
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Restoring default content

Inserting logos into the Compilation Report

You can use the “Custom Paragraph - Compilation Report” paragraph, located in the Compilation 
Report paragraph section, to add a customised logo or additional content into the top margin of this 
report.

To add a header logo to the Compilation Report

1. Access the practice’s paragraphs. 
See “Accessing practice paragraphs” on page 524 for more information.

2. In the Paragraphs window, select Compilation Report > Custom Paragraph - Compilation 
Report.

3. In the paragraph content window, copy and paste your desired logo image.

Note: Do not drag and drop the image into the window. The logo resolution should be 
no more than 199 pixels wide and 99 pixels high, and no more than 25 KB in size. 
Logos greater than 25 KB in size may result in an error when previewing the report. 
Using a compressed image format, such as JPEG or PNG, is recommended.

4. Click OK in the paragraph window, and then in Practice Report Settings, click Save Settings to 
save your changes.

5. Navigate to a client and click Preview Reports to verify that the logo is displayed correctly.

Related topics
Edit Paragraph Content window
Editing static text
Inserting and editing variables
Formatting paragraphs
Restoring default content

Inserting a signature into the Compilation Report

An image of a signature can be inserted into the footer of Compilation Reports.

Note: Adding a large number of images can increase the time it takes to generate the report.
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To add a signature image to the Compilation Report

1. Access the practice or client’s paragraphs.
See “Accessing practice paragraphs” on page 524 or “Accessing client paragraphs” on 
page 525.

2. In the Paragraphs window, select Compilation Report > Compilation Report - Signed and then 
click Edit Paragraph.

3. Copy and paste the image into the paragraph.

Note: Do not drag and drop the image into the window.

4. Click OK in the paragraph window, and then in Practice Report Settings, click Save Settings to 
save your changes.

5. Navigate to a client and click Preview Reports to verify that the logo is displayed correctly.

Related topics
Edit Paragraph Content window
Editing static text
Inserting and editing variables
Formatting paragraphs
Restoring default content

Restoring default content

At any time, a custom paragraph that has been defined for a selected client can be replaced with the 
default paragraph defined for the practice. If changes have been made to the client paragraphs, a 
Restore Default Content option is displayed at the bottom of the Edit Paragraph Content window. 
This can be used to restore the paragraph to the practice default. 

To restore default content

1. Access the client’s paragraphs.
See “Accessing client paragraphs” on page 525.

2. Find the paragraph to be restored to the practice default.

3. Click to select it. 

4. Click Edit Paragraph.
The Edit Paragraph Content window opens. 

5. Click Restore Default Content. 
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The paragraph content is restored to the default paragraph defined for the practice. 

6. Click OK.
To save the changes to the paragraph content. 

Related topics
Edit Paragraph Content window
Editing static text
Inserting and editing variables
Formatting paragraphs

Paragraphs in the Report Preview window

Paragraphs can be viewed and edited from the Report Preview window. 

At a practice level, the Preview Reports option is used to check the default report settings that have 
been configured for each entity type. From the Report Preview window, the practice paragraphs can 
be viewed and edited. See “Selecting default practice reports” on page 468.

At a client level, the Preview Reports option is used to check the client’s reports before printing, 
exporting or emailing the financial statements. From the Report Preview window, the client 
paragraphs can be viewed and edited. See “Previewing financial statements” on page 551.

To access the practice Report Preview window

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Select the Entity Type from the drop-down. 

3. Click Preview Reports. 
The Select Sample Client window opens.

4. Click the ellipse button to search and select a sample client. 
The selected client’s data will be used to populate the preview report.

Note: A warning is displayed if the selected client does not have a financial data source 
configured. A financial data source must be configured for the selected client. 

5. Click OK. 
The Report Preview window opens. 
The default report settings for the selected entity type are used to produce the report. 
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To access the client Report Preview window

1. Search and select a client. 

2. Open the client’s Client Accounting > Reports tab.

3. Select the financial period for the report on the Period drop-down. 

4. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts, accounts which have not 
been allocated to an account group, or duplicated accounts, accounts which have 
been added to more than one account group. Click Yes to edit the account groups. 
See “Configuring account groups” on page 497. Click No to continue and preview 
the financial statements. Depending on your level of access you may not be able 
to preview the report.

The Report Preview window opens.

To view and edit the paragraphs

1. In the Report Preview window, place the cursor over a paragraph. 

The pointer changes to .

2. Click the paragraph.
The Edit Paragraph Content window opens. 

3. Edit the paragraph content in the Paragraph Content text area, as required.
See “Editing paragraphs” on page 527.

4. Click OK to save the changes or click Cancel to close the window. 
If changes have been made, the financial statements will be regenerated. The Report Preview 
window closes and reopens showing the financial statements with the changes applied. 

Related topics
Selecting default practice reports
Client’s Reports tab
Configuring account groups
Paragraphs
Previewing financial statements
Editing paragraphs
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Report options
Report Options is used to control the report style and page layout. Default report options can be set 
for all clients within the practice and custom report options can be specified for selected clients. 

Report options enable configuration of:

 Style Options — modify how the headers, footers and balances are displayed in the report. 
Statutory Reporter has a number of pre-configured styles for selection.

 Display Options — control whether the report includes a cover page, a table of contents, page 
numbers, a company logo, watermarks and other details.

 Page Margins — configure the page layout by setting the top, bottom, left and right margins.

Related topics
Accessing report options
Configuring report options
Selecting style options
Setting display options
Setting display options

Accessing report options

Practice Report Options can be set using default report options for all clients within the practice. To 
set default Report Options for all clients within the practice you must access the Report Options 
from within Practice Report Settings. Any changes made to practice Report Options will apply to all 
reports for all clients.

Client Report Options can be specified using custom report options for selected clients. To set 
custom Report Options for selected clients you must access the Report Options from the client’s 
Client Accounting > Reports tab. Any changes made to the client’s Report Options will only apply to 
the selected client.

To access practice report options

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Click Report Options on the Tasks bar.
The Report Options window opens. 

To access client report options

1. Search and select a client. 

2. Open the client’s Client Accounting > Reports tab.

3. Click Report Options on the Tasks bar.
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The Report Options window opens. 

Related topics
Client’s Reports tab
Configuring report options
Selecting style options
Setting display options
Setting page margins

Configuring report options

Report Options can be used to control the report style and page layout. The default report options 
can be set for all clients within the practice and custom report options can be specified for selected 
clients. 

The available options are:

 “Selecting style options” (see page 541)

 “Setting display options” (see page 542)

 “Setting page margins” (see page 549).

Selecting style options

Styles can be used to set the font and configure how the headers, footers and balances are displayed 
in the financial statements. 

The available options are:

 Style Set — pre-configured styles which determine how the headers, footers and balances are 
displayed in the financial statements. 

 Font — select the font to use in the financial statements. 

To select the style options

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 

2. Select the pre-configured style set on the Style Set drop-down. 

Note: You can select either a master style sets or one of your custom practice style sets.

3. Select the font on the Font drop-down. 
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4. Click OK.
To save the changes. 

To preview the style options

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 

2. Click Preview Style Options.
After selecting a style set and / or font on the Report Options window.
The Preview a style set window opens. 
The style set and font can be changed and previewed from the Preview a style set window. 

3. Select a new style set on the Style set drop-down 

4. Select a font on the Font drop-down. 
The preview updates to show the style and font of the new selection. 

5. Click OK to save any changes. Click Cancel to close the window without saving changes. 

Related topics
Accessing report options
Setting display options
Setting page margins

Setting display options

Display Options are used to control whether the report includes a cover page, a table of contents, 
page numbers, a company logo, watermarks and other details.

Note: The first four options are disabled if the “Minutes” report set is selected. See Client’s Reports 
tab.

Available options

Option Description

Cover Page To include a cover page at the beginning of the financial 
statements, click the Display Cover Page checkbox. The 
cover page details the client name and the financial period.
See “Defining cover page settings” on page 544 for more 
information.
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Click OK to save any changes. Click Cancel to close the window without saving changes.

Related topics
Defining cover page settings
Specifying rounding accounts

Table of Contents To include a table of contents in the financial statements, 
click the Display Table of Contents checkbox. 

Page Number To include page numbers in the financial statements, click 
the Display Page Numbers checkbox. The page numbers are 
displayed in the format: Page 1, Page 2 etc.

Account Codes To include account codes in the financial statements, click 
the Display Account Codes checkbox. If selected the account 
codes are displayed to the left of the account description in 
the financial statements. 

Rounded Balances Click the Display Rounded Balances checkbox to round 
detail and header accounts to the nearest dollar. Sub-totals 
and totals throughout the reports are set to the sums of 
these rounded balances. This may result in rounding errors. 
See “Specifying rounding accounts” on page 545 for 
information on how to adjust for rounding errors.

Image To display an image such as a company logo on the financial 
statements, click the Display Image checkbox. Images are 
not included in Microsoft Word or Excel financial 
statements. The image file must be selected and the image 
properties configured.
See “Defining image settings” on page 546.

Watermark To display a watermark, such as Confidential, on the financial 
statements, click the Display Watermark checkbox. 
Watermarks are not included in Microsoft Word or Excel 
financial statements. The watermark must be selected and 
the watermark properties configured. 
See “Defining watermark settings” on page 548. 

Column Header To display one column header for the page(s) which contain 
multiple reports of the same type, click the Display one 
column header for the page checkbox. If the checkbox is 
selected then column headers, such as Year and $ in the 
notes section of the financial statement, are only displayed 
once for the whole page. This option is selected by default 
for the practice.

Option Description
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Defining image settings
Defining watermark settings

Defining cover page settings

The Display Cover Page option enables you to include a cover page as part of the financial 
statements. You can then further define the formatting of the text included on the cover page.

To define the cover page settings

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 

2. Click the Display Cover Page checkbox.
This is located within the Display Options on the Report Options window. 

3. Click Define Cover Page Settings.
The Define Cover Page Settings window opens.

4. Enter the Space Before the paragraph text in millimetres.

5. Select the Horizontal Alignment of the paragraph text from the drop-down.
The available options are:

 Left

 Right

 Centre 

 Justify

6. Enter the paragraph Indent from the left hand side of the page, in millimetres.

7. Click OK.
To save any changes and return to the Report Options window.

8. Click OK.
Changes are saved to your report options and the Report Options window closes.

To restore the practice cover page default settings

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 
The Display Cover Page checkbox should already be selected.
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2. Click Define Cover Page Settings.
The Define Cover Page Settings window opens.

3. Click the Restore Practice Defaults button.
A message is displayed requesting confirmation to restore the practice cover page settings.

4. Click Yes on the message.
You will notice that the paragraph position options on the Define Cover Page Settings window 
have reverted to the default values. 

5. Click OK.
You are returned to the Report Options window.

6. Click OK.
Changes are saved to your report options and the Report Options window closes.

Related topics
Specifying rounding accounts
Defining image settings
Defining watermark settings

Specifying rounding accounts

When the Display Rounded Balances option is selected, detail and header accounts are rounded to 
the nearest dollar. Sub-totals and totals throughout the reports are set to the sums of these rounded 
balances. This may result in rounding errors. For example, the Net Assets/Liabilities value in the 
Balance Sheet might not equal the total equity, putting the Balance Sheet out of balance; or the Net 
Profit/Loss value in the Profit and Loss Statement might not match the Current Year Earnings 
amount in the Balance Sheet.

Statutory Reporter can calculate the rounding error adjustments to bring the Balance Sheet back 
into balance and to correct the Net Profit/Loss value. These rounding error adjustments need to be 
allocated to specific accounts in the Balance Sheet and Profit and Loss Statement.

To specify the rounding accounts

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 

2. Click the Display Rounded Balances checkbox.
This is located within the Display Options on the Report Options window. 

3. Click Specify Rounding Accounts.
The Specify Rounding Accounts window opens. 
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4. Click the Calculate Rounding Error Adjustments checkbox. 

5. Specify the accounts to which the rounding error adjustments are to be applied for each 
section:

 Profit and Loss Statement — enter an account code into the Profit and Loss Statement 
field to which the rounding error adjustments are to be allocated in the Profit and Loss 
Statement report.

 Balance Sheet — to apply all rounding error adjustments required for the Balance Sheet to 
one account:

a. Enter the account code into the Balance Sheet field to which the rounding error 
adjustments are to be allocated in the Balance Sheet report.

b. Leave the Adjust the Equity section separately deselected. 

 Adjust the Equity section separately — to apply rounding error adjustments for the Assets 
and Liabilities section separately to the Equity section in the Balance Sheet:

a. Click the Adjust the Equity section separately checkbox.

b. Enter the account code into the Assets and Liabilities field to which the rounding error 
adjustments are to be allocated for net assets.

c. Enter the account code into the Equity field to which the rounding error adjustments are 
to be allocated for the equity section. 

6. Click OK to save any changes. 
or
Click Cancel to close the window without saving changes. 

7. Click OK.
To save the Report Options and close the Report Options window. 

Related topics
Setting display options
Defining cover page settings
Defining image settings
Defining watermark settings

Defining image settings

The Display Image option enables you to select how and where an image, such as a company logo, 
is displayed in the financial statements. The following image file types can be used: JPG, BMP, GIF or 
PNG. Images should be no more than 25 KB in size; images that are greater than this size may result 
in errors when previewing the report.
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Before selecting the image ensure that it is set to your desired size and resolution, as it cannot be 
edited in Statutory Reporter. The image file is imported and stored in Statutory Reporter.

To define the image settings

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 

2. Click the Display Image checkbox.
This is located within the Display Options on the Report Options window. 

3. Click Define Image Settings.
The Define Image Settings window opens. 

4. Click the ellipse button at the end of the Image File field.

5. Navigate to the location of the image to be included. 

6. Click Open to select the file. 

7. In the Position section, set the placement of the image on the page:

a. Select the Horizontal Alignment on the drop-down. 

b. Select the Vertical Alignment on the drop-down. 

8. In the Page Range section, select how often the image will be displayed in the financial 
statements. The image can be displayed on:

 All Pages 

 Cover Page Only 

 Pages. 

9. If configuring the Report Options for a selected client, click Restore Practice Defaults to remove 
any custom image settings for the client. The image settings will be restored to the image 
settings configured for the practice. 

10. Click OK to save any changes. 
or
Click Cancel to close the window without saving changes. 

11. Click OK.
To save the Report Options and close the Report Options window.
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Related topics
Specifying rounding accounts
Setting display options
Defining cover page settings
Defining watermark settings

Defining watermark settings

The Display Watermark option enables you to include watermarked text, such Draft or Confidential, 
in the financial statements. 

To define the watermark settings

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 

2. Click the Display Watermark checkbox.
This is located within the Display Options on the Report Options window. 

3. Click Define Watermark Settings.
The Define Watermark Settings window opens. 

4. Select the text to be displayed as a watermark on Watermark Text drop-down.
The pre-defined options are - DRAFT, CONFIDENTIAL or DO NOT COPY - or click and enter 
custom text in the Watermark Text field.

5. Select the font properties for the watermark in the Font section. 

6. Select the position of the watermark on the page.
This is done on the Direction drop-down in the Position section. 

7. In the Page Range section, select how often the watermarked text will be displayed in the 
financial statements. The watermarked text can be displayed on:

 All Pages 

 First Page Only 

 Pages.

8. If configuring the report options for a selected client, click Restore Practice Defaults to remove 
any custom watermark text settings for the client. 
The watermark text settings will be restored to the watermark text settings configured for the 
practice. 

9. Click OK to save any changes. 
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or
Click Cancel to close the window without saving changes. 

10. Click OK.
To save the Report Options and close the Report Options window. 

Related topics
Accessing report options
Selecting style options
Setting page margins
Specifying rounding accounts
Defining cover page settings
Defining image settings
Setting display options

Setting page margins

Page Margins are the blank space around the edges of the page. The Top, Bottom, Left and Right 
page margins can be edited. These margins will be applied to all pages in the financial statements. 

To set the page margins

1. Access the practice or client’s report options.
See “Accessing report options” on page 540.
The Report Options window opens. 

2. Edit the Top, Bottom, Left and Right page margin fields as necessary. 

In each field, click the up / down arrows to increase / decrease the margin. Alternatively, click 
the field and enter a value or edit an existing value. 

3. If configuring the report options for a selected client, click Restore Practice Margins to remove 
any custom page margins for the client. 
The page margins will be restored to the page margins settings configured for the practice. 

4. Click OK to save any changes. 
or
Click Cancel to close the window without saving changes. 

Related topics
Accessing report options
Selecting style options
Setting display options
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Defining the top margin of the Compilation Report

The three heading styles of the Compilation Report can be modified to add more space for additional 
content, such as a company letterhead. Changes can be made to these Compilation Report 
properties without affecting other reports.

To update the top margin of the Compilation Report

1. Create or modify a Practice Style set. 
See “Customising your practice styles” on page 474.

2. In the style set, select either Page Header Compilation report 01, Page Header Compilation 
report 02, or Page Header Compilation report 03. 
These control the style of three page header lines at the top of the Compilation Report, and can 
be modified without affecting any other report.

3. Increase the space of the margin by entering a value in the Space Before (units) property.

Note: 1 unit is equal to 0.25mm.

4. Click OK to save your changes.
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Producing financial statements
Financial statements for each client will be generated at the end of each financial period. 

To generate financial statements for a client, consider the following options:

 Configure the client reports — for each selected client configure which reports are to be 
included and their order in the financial statements.

 Preview the reports — preview the financial statements to ensure that they are correct. The 
financial statements must be previewed before they can be printed, exported or emailed.

 Print, email, export or share the financial statements — after the financial statements have 
been previewed, they can be printed, exported or emailed. If Document Manager is installed, 
the file can be imported into Document Manager.

There are a number of stages for producing financial statements for a client:

 “Selecting client reports” (see page 485)

 “Changing the order of client reports” (see page 485)

 “Previewing financial statements” (see page 551)

 “Producing periodic reports” (see page 556)

 “Exploring and editing financial statements” (see page 562)

 “Printing financial statements” (see page 570).

Previewing financial statements

The Preview Reports option is used to preview the financial statements. From the Preview Report 
window, the financial statements can be printed, emailed, exported and imported to Document 
Manager. 

Reports must be previewed before the financial statements can be printed, exported or emailed. 

To preview the reports

1. Open the client’s Client Accounting > Reports tab.

2. Select the list of reports to be included and modify the report order as necessary.
See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. Select the financial reporting period. 
See “Producing periodic reports” on page 556.

4. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 
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A generating reports progress bar is displayed.
The Report Preview window opens. 

Related topics
Selecting client reports
Changing the order of client reports
Exploring and editing financial statements
Printing financial statements
Producing periodic reports

Report Preview window

Financial statements are displayed in the Report Preview window. From this window the report can 
be previewed, checked for accuracy, some report options can be edited and the report can be 
shared by printing, emailing or exporting it. 

The Report Preview window is divided into two main areas:

 Toolbar — use the buttons to print, email and export. For a full list of the toolbar options, see 
“Report Preview window toolbar options” on page 552.

 Report Preview Area — displays the report as it will be displayed when printed. Account 
balances can be investigated, paragraph content can be viewed and edited and value properties 
can be viewed. See “Exploring and editing financial statements” on page 562 and “Printing 
financial statements” on page 570.

Related topics
Selecting client reports
Changing the order of client reports
Exploring and editing financial statements
Printing financial statements
Report Preview window toolbar options
Producing periodic reports

Report Preview window toolbar options

The following table lists the options that are available on the Report Preview window toolbar.

Icon Name Function

Print Prints the report to the selected printer or 
to the MYOB PDF Manager if it is installed.
See “Printing financial statements” on 
page 570.
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Document Map Launches the Document Map pane which 
lists the contents of the financial 
statements. Click the heading to quickly 
navigate to a particular section in the 
financial statements.

First page Go to the first page of the financial 
statement.

Previous page Go to the previous page of the financial 
statement.

Next page Go to the next page of the financial 
statement.

Last page Go to the last page of the financial 
statement.

Zoom out Click to zoom out.

Zoom Select a pre-defined zoom ratio or view 
the entire page width, entire text width, 
the whole page or two pages.

Zoom in Select to zoom in.

Report Options Click to edit the Report Options.
See “Configuring report options” on 
page 541.

Refresh Preview Click to regenerate the report. Changes 
made to the client’s balances or client 
configuration will be reflected in the 
report preview.

Page break Counts the number of manual page breaks 
inserted into a financial statement. You 
can also remove all manual page breaks. 
See “Adding and removing manual page 
breaks” on page 566.

Export document Export the financial statements as a PDF, 
Microsoft Word or Excel document. 
See “Exporting financial statements” on 
page 570.

Icon Name Function
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Related topics
Report Preview window
Configuring report options
Exploring and editing financial statements
Printing financial statements
Exporting financial statements
Emailing financial statements
Adding financial statements to Document Manager
Producing periodic reports

Sharing financial statements

The Share It feature enables you to easily save files to your client document folder and transfer files 
directly to your MYOB Portal.

Before you use Share It, ensure that you have:

 set the default folder where documents will be saved for your client

You can do this in Maintenance > Maintenance Map (AO) > Documents > Mail Settings > 
Document Startup Path.

 created your client portals.

Send via email Email the financial statements as a PDF, 
Microsoft Word or Excel file attachment.
See “Emailing financial statements” on 
page 571.

Share It Export the financial statements to Docu-
ment Manager as a PDF file or, if you don’t 
have Document Manager, save the finan-
cial statement in your client’s assigned 
folder. Directly publish the financial state-
ment to your MYOB Portal by selecting the 
appropriate option.
See “Adding financial statements to Docu-
ment Manager” on page 572 and “Sharing 
financial statements” on page 554.

Add item Add a file to a report.
See “Adding a file to a report” on 
page 567.

Icon Name Function
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The Share It button is only available when you preview reports.

To publish a statutory report to your MYOB Portal if you don’t have Document Manager

1. Open your Client > Client Accounting > Reports tab.

2. Select your reporting period.

3. Click Preview Reports.
The report is generated in the Report Preview window.

4. Click .
The Share document dialog displays.

Your client’s details are automatically filled in the Contact field.
The Save to client document folder checkbox is selected by default and the Client document 
folder field is a read-only field that displays the Document Startup Path previously set for each 
client in Maintenance > Maintenance Map (AO) > Documents > Mail Settings.

5. Select the Publish to client portal checkbox to publish the statutory report to your client portal.

Tip: This option will only be available if a client portal has been created for your client.

6. Click OK.
The document is saved to the client document folder and the Publish to Client Portal Name 
portal page in MYOB Accountants Enterprise/Accountants Office Live opens where Client Portal 
Name is the name of the client portal that you are publishing documents to.
See MYOB AE Live help for more information.

To publish a statutory report to your MYOB Portal if you have Document Manager

1. Click ShareIt from the toolbar of the preview window, you will receive the following message:
The document has been saved into Document Manager.
Do you also want to publish it to the client portal?

http://adhelp.myob.com/ONLINE/ACC/AU/AE/index.htm#page/Practice_Portal/What_can_I_do_in_my_portal_3f.htm
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Note: This message will only appear if:
- the status of the document is Completed or Approved, and
- you have created the client portal.

If you click No, the document won’t be published to the portal, but will be saved in Document 
Manager.

2. Click Yes to publish the document to the portal.
Your document will be saved into Document Manager and the Publish to Client Portal Name 
portal page in MYOB Accountants Enterprise/Accountants Office Live opens where Client Portal 
Name is the name of the client portal that you are publishing documents to.

Related topics
Previewing financial statements
Producing periodic reports
Printing financial statements
Exporting financial statements
Emailing financial statements
Adding financial statements to Document Manager

Producing periodic reports

Default period types

To produce a report for the financial year 

When you produce a report for the financial year, you will be comparing this year’s and last year’s 
financial results.

1. Open the client’s Client Accounting > Reports tab.
See “Accessing Statutory Reporter” on page 461.

2. Select the list of reports to be included and modify the report order as necessary.

Period type Description

TY / LY This Year / Last Year

YTD / LYTD Year to Date / Last Year to Date

PTD / YTD Period to Date / Year to Date

PTD / LYPTD Period to Date / Last Year Period to Date

TY This Year
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See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. For each report type, note or policy that is listed in the Reports table and that is to be included 
in the financial report, select the Period Type to be TY/LY.

4. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 

A generating reports progress bar is displayed.
The Report Preview window opens. 

5. Preview your report.

To produce a report for a selected period of the current financial year

When you produce a report for a period of the current financial year, you can compare it with the 
same period in the previous financial year.

1. Open the client’s Client Accounting > Reports tab.
See “Accessing Statutory Reporter” on page 461.

2. Select the list of reports to be included and modify the report order as necessary.
See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. For each report type, note or policy that is listed in the Reports table and that is to be included 
in the financial report, select the Period Type to be YTD/LYTD.

4. From the Period selector, located at the bottom of the Reports tab, select the:

 end month 

 financial year.
For example, to generate a report from the beginning of the financial year to December, select 
the end month to be December. The start month is ignored in this case. The report will then 
display the figures from the start of the financial year to December. A comparison column will 
be available in the generated report with the figures from the start of the previous financial 
year to the previous December.

5. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 
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A generating reports progress bar is displayed.
The Report Preview window opens. 

6. Preview your report.

To produce a report for a previous year

You can generate reports for prior years beyond the previous year.

1. Open the client’s Client Accounting > Reports tab.
See “Accessing Statutory Reporter” on page 461.

2. Select the list of reports to be included and modify the report order as necessary.
See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. From the Period selector, located at the bottom of the Reports tab, select the:

 start month 

 end month 

 prior financial year.
For example, to generate a report for a 3-month period (a quarter), select the start month to be 
July and the end month to be September. The report will then display the figures for the 
quarter. A comparison column will be available in the generated report with the figures from 
the start of the financial year to the month of September.

4. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 

A generating reports progress bar is displayed.
The Report Preview window opens. 

5. Preview your report.

To produce a quarterly report

When you produce a quarterly report, you can compare the selected quarter’s results with those of 
the current financial year up until the selected end month of the quarter.

1. Open the client’s Client Accounting > Reports tab.
See “Accessing Statutory Reporter” on page 461.

2. Select the list of reports to be included and modify the report order as necessary.
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See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. For each report type, note or policy that is listed in the Reports table and that is to be included 
in the monthly financial report, select the Period Type to be PTD/YTD.

Note: The Balance Sheet will only generate year to date amounts.

4. From the Period selector, located at the bottom of the Reports tab, select the:

 start month 

 end month 

 financial year.
For example, to generate a report for a 3-month period (a quarter), select the start month to be 
July and the end month to be September. The report will then display the figures for the 
quarter. A comparison column will be available in the generated report with the figures from 
the start of the financial year to the month of September.

5. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 

A generating reports progress bar is displayed.
The Report Preview window opens. 

6. Preview your report.

To produce a monthly report with a comparison of the current financial year

When you produce a monthly report, you can compare the selected month’s results with those of 
the current financial year up until the selected end month.

1. Open the client’s Client Accounting > Reports tab.
See “Accessing Statutory Reporter” on page 461.

2. Select the list of reports to be included and modify the report order as necessary.
See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. For each report type, note or policy that is listed in the Reports table and that is to be included 
in the monthly financial report, select the Period Type to be PTD/YTD.

Note: The Balance Sheet will only generate year to date amounts.
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4. From the Period selector, located at the bottom of the Reports tab, select the:

 start month 

 end month 

 financial year.
For example, to generate a report for the month of July, select the start month to be July and 
the end month to be July. The report will then display the figures for the month of July. A 
comparison column will be available in the generated report with the figures from the start of 
the financial year to the month of July.

5. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 

A generating reports progress bar is displayed.
The Report Preview window opens. 

6. Preview your report.

To produce a monthly report with a comparison of the same month last year

When you produce a monthly report, you can compare the selected month’s results with those of 
the previous financial year period.

1. Open the client’s Client Accounting > Reports tab.
See “Accessing Statutory Reporter” on page 461.

2. Select the list of reports to be included and modify the report order as necessary.
See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. For each report type, note or policy that is listed in the Reports table and that is to be included 
in the monthly financial report, select the Period Type to be PTD/LYPTD.

Note: The Balance Sheet will only generate year to date amounts.

4. From the Period selector, located at the bottom of the Reports tab, select the:

 start month 

 end month 

 financial year.
For example, to generate a report for the month of October, select the start month to be 
October and the end month to be October and the year to be 2013-2014. The report will then 
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display the figures for the month of October for 2014. A comparison column will be available in 
the generated report with the figures for October 2012.

5. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 

A generating reports progress bar is displayed.
The Report Preview window opens. 

6. Preview your report.

To produce a report for this year only

You can produce a report for this year’s results only.

1. Open the client’s Client Accounting > Reports tab.
See “Accessing Statutory Reporter” on page 461.

2. Select the list of reports to be included and modify the report order as necessary.
See “Selecting client reports” on page 485 and “Changing the order of client reports” on 
page 485.

3. For each report type, note or policy that is listed in the Reports table and that is to be included 
in the financial report, set the Period Type to TY.

4. Click Preview Reports. 

Note: A warning is displayed if there are unallocated accounts (accounts which have not 
been allocated to an account group) or duplicated accounts (accounts which have 
been added to more than one account group). 

A generating reports progress bar is displayed.
The Report Preview window opens. 

5. Preview your report.

Related topics
Report Preview window
Configuring report options
Exploring and editing financial statements
Printing financial statements
Exporting financial statements
Emailing financial statements
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Adding financial statements to Document Manager

Exploring and editing financial statements

Various features of the financial statements can be viewed and edited from the Report Preview 
window. For example:

 “Drilling down on an account balance” (see page 562)

 “Viewing and editing paragraphs” (see page 563)

 “Viewing value properties” (see page 564)

 “Editing Report Options” (see page 565)

 “Adding and removing manual page breaks” on page 566

 “Adding a file to a report” (see page 567).

Drilling down on an account balance

The Drill Down option is used to view a breakdown of the individual account balances which make 
up the selected value. It groups together individual account balances under the account groups to 
which they are allocated.

From the Drill Down window, one or more account codes can be reallocated to a different account 
group.

To drill down on an account balance

1. Preview the financial statement for the client.

See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Find the paragraph to be viewed and edited.

3. Place the cursor over a balance. 

The pointer changes to .

4. Click the balance.
The Drill Down window opens. 

5. Expand any entries and view the balances.

To reallocate accounts

1. Select the account to be reallocated in the list of the Drill Down window.

2. Click Reallocate Accounts.
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The Select Account Group window opens.

3. Select the account group to which the account is to be reallocated.

4. Click OK.
The financial statements are regenerated. The Report Preview window updates showing the 
financial statements with the changes applied.

Related topics
Previewing practice reports
Printing financial statements
Previewing financial statements
Selecting client reports
Viewing and editing paragraphs
Viewing value properties
Editing Report Options
Adding and removing manual page breaks
Producing periodic reports

Viewing and editing paragraphs

Paragraphs are used to define sections of text that will be displayed in the financial statements. 
Paragraphs can be viewed and edited from the Report Preview window. 

To view and edit the paragraphs

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Find the paragraph to be viewed and edited.

3. Place the cursor over a paragraph. 

The pointer changes to .

4. Click the paragraph.
The Edit Paragraph Content window opens. 

5. Edit the paragraph content, in the Paragraph Content text area, as required.
See “Editing paragraphs” on page 527.

6. Click OK to save the changes.
or
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Click Cancel to close the window. 
If changes have been made, the financial statements are regenerated. The Report Preview 
window updates showing the financial statements with the applied changes.

Related topics
Previewing practice reports
Printing financial statements
Previewing financial statements
Selecting client reports
Drilling down on an account balance
Viewing value properties
Editing Report Options
Adding and removing manual page breaks
Editing paragraphs

Viewing value properties

The properties of report variables — account group balances and paragraph text — can be viewed 
in the Value Properties window. If the variable’s inclusion in the report is conditional, the 
condition(s) which have been satisfied are also displayed.

To view the value properties

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Find the variable for which properties are to be viewed.

3. Place the cursor over the value. 

The pointer changes to .

4. Right-click on the variable. 
The Value Properties window opens. 

Related topics
Previewing practice reports
Printing financial statements
Previewing financial statements
Selecting client reports
Viewing and editing paragraphs



MYOB AO, AE, AU, NZ PM Client AccountingUser Guide | 565

Drilling down on an account balance
Adding and removing manual page breaks
Editing Report Options

Editing Report Options

Report Options can be used to control the report style and page layout. See “Configuring report 
options” on page 541.

To edit report options

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Find the report whose options are to be edited.

3. Select the report. 

4. Click Report Options. 
The Report Options window opens. 

5. Change the Style Options, Display Options and /or Page Margins as required.
See “Configuring report options” on page 541.

6. Click OK.
The Report Options window closes and the financial statement is regenerated. The Report 
Preview window updates showing the financial statements with the applied changes.

Related topics
Previewing practice reports
Printing financial statements
Previewing financial statements
Selecting client reports
Accessing Statutory Reporter
Viewing and editing paragraphs
Drilling down on an account balance
Viewing value properties
Adding and removing manual page breaks
Configuring report options
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Adding and removing manual page breaks

Sometimes when financial statements are generated, information that should be kept together is 
separated by page breaks. You can insert a manual page break to keep related information together. 
When you insert a manual page break, the financial statement is regenerated to include the page 
break.

You cannot remove any system-defined page breaks. Manual page breaks can only be inserted into 
a financial statement during preview. When the financial statement is closed, any manual page 
breaks that have been inserted are saved for future use.

You can remove all page breaks that were manually inserted using the Remove All toolbar option. 
You will revert to the original page settings. Manual page breaks that you have inserted can also be 
removed individually.

If you have already inserted a manual page break in a certain section of the financial statement, you 
cannot insert another manual page break at that location. The Insert page break right-click option 
is not available.

You cannot insert a manual page break in the following sections of a financial statement:

 cover page

 table of contents

 page header or footer

 the Declaration and Compilation Report.

To add a manual page break

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Decide where a page break should be inserted.

3. Place the cursor at the account header level of the paragraph or the title.
If you want to insert a manual page break in a Balance Sheet or Profit and Loss Statement, the 
page break will occur at the row where your cursor is placed.
If you want to insert a manual page break in the Accounting Policies or Other Notes section, the 
page break will occur from the header paragraph or note where your cursor is placed.

4. Right-click and select Insert page break.
A page break is inserted above the selected account header and the financial statement is 
regenerated to include the manual page break.
The Page Break icon on the toolbar keeps a tally of the number of page breaks you have 
inserted into the whole report. 
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To remove a manual page break

1. In the Report Preview window, select the section where the manual page break was inserted.

2. Right-click and select Remove page break.
The page break is removed and the financial statement is regenerated.

To remove all manual page breaks

1. In the Report Preview window, click Page Break > Remove All on the toolbar.
A Statutory Reporter message is displayed requesting that you confirm the removal of all 
manual page breaks.

2. Click Yes.
All page breaks inserted by you are removed and the financial statement is regenerated. The 
Page break count on the toolbar reverts to zero.

Related topics
Previewing practice reports
Printing financial statements
Previewing financial statements
Selecting client reports
Accessing Statutory Reporter
Viewing and editing paragraphs
Drilling down on an account balance
Viewing value properties
Adding and removing manual page breaks
Configuring report options

Adding a file to a report

You can add a file or a Document Manager file (if you have Document Manager) to a report, including 
Word documents (.RTF or .DOCX), Excel spreadsheets, PDF files, and image files.

There is a constraint in the size of the file that can be added to a report. The file size of the Microsoft 
Word document is dependent on its content and on the inclusion of any graphics. So it is difficult to 
say exactly what the maximum file size is.

Microsoft Excel spreadsheets can also be added to a report if they are first converted to a Microsoft 
Word document.

You are able to select exactly where the file is inserted into the report.

Note: When you add a file to a report, only a link to the file is saved within the report.
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Tip: When you add a file to a report, and the file is only located on your computer, then other 
people will not be able to view the added file. If you require other team members to be able 
to view the added file, then ensure that its location is accessible to all people that will need 
to view it.

To add a file to a report

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Click the Insert Item drop-down on the main menu and select the From File option.
or
Click the Insert Item option on the main menu.
The Open window opens.

3. Browse and select the appropriate file.
The Insert Item window opens.
The Title field automatically displays the file name, although this can be changed if necessary. 

4. Select whether to Insert the file Before or After.

5. Then from the drop-down, select the appropriate place in the report where to insert the file.

6. Select the appropriate Page orientation of the inserted file - Portrait or Landscape.

7. Click OK.
The file is inserted into the report and the report is re-generated to include the inserted file. 
When you close the report you are previewing, you can choose to save the inserted 
document(s) in the report. All saved documents will be made available to all team members 
who have access to this report.

Tip: When you add a file to a report, and the file is only located on your computer, then 
other people will not be able to view the inserted file. If you require other team 
members to be able to view the inserted file, then ensure that its location is 
accessible to all people that will need to view it.

To add a Document Manager file to a report

Note: You will only be able to add a Document Manager file to a report if you have Document 
Manager installed.

1. Preview the financial statement for the client.
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See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Click the Insert Item drop-down on the main menu and select the Document Manager option.
The Document Manager Search for a document window opens.

3. Search and select the appropriate file.
The Insert Item window opens.
The Title field automatically displays the file name, although this can be changed if necessary. 

4. Select whether to Insert the file Before or After.

5. Then from the drop-down, select the appropriate place in the report where to insert the file.

6. Select the appropriate Page orientation of the inserted file - Portrait or Landscape.

7. Click OK.
The Document Manager file is inserted into the report and the report is re-generated to include 
the inserted Document Manager file.
When you close the report you are previewing, you can choose to save the inserted 
document(s) in the report. All saved documents will be made available to all team members 
who have access to this report.

To remove an added file from a report

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Click the Insert Item drop-down on the main menu and select the Remove File option.
The Remove Item window opens listing the items that have been inserted into the report.

3. Click the checkbox for the appropriate file that is to be removed from the report.

4. Click Remove.
The inserted item is removed from the report and the report is re-generated and will no longer 
include the previously inserted file.

Related topics
Previewing practice reports
Printing financial statements
Previewing financial statements
Selecting client reports
Accessing Statutory Reporter
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Viewing and editing paragraphs
Drilling down on an account balance
Viewing value properties
Adding and removing manual page breaks
Configuring report options

Printing financial statements

After previewing the financial statements, they can be printed, exported or emailed. If Document 
Manager is installed, the file can be imported into Document Manager.

The financial statements can be printed from the Report Preview window. 

To print the financial statements

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Click .
This is located on the Report Preview window toolbar. 
The Print window opens. 

3. Select the printer and edit the printing preferences as necessary. 

4. Click Print.

Related topics
Previewing financial statements
Exploring and editing financial statements
Previewing financial statements
Setting display options
Exporting financial statements
Emailing financial statements
Adding financial statements to Document Manager

Exporting financial statements

From the Report Preview window, the financial statements can be exported to a PDF, Microsoft 
Word or Excel file. 
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To export the financial statements

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

2. Click .
This is located on the Report Preview window toolbar. 
The Export Report window opens. The file name indicates the client name and financial period 
of the financial statements.

3. Navigate to the location where the file is to be saved.

4. Click Save.
By default, the financial statements are exported as a PDF file. Files can exported to a Microsoft 

Word or Excel document by clicking the  drop-down and selecting Microsoft Word or 
Excel from the menu. 
Watermarks and images are not included when exporting to Microsoft Word or Excel 
documents. See “Setting display options” on page 542.

Related topics
Previewing financial statements
Exploring and editing financial statements
Previewing financial statements
Setting display options
Printing financial statements
Emailing financial statements
Adding financial statements to Document Manager

Emailing financial statements

Financial statements can be emailed as a PDF, Microsoft Word or Excel attachment from the Report 
Preview window. Statutory Reporter allows you to edit the recipient, subject and email body before 
sending the email. 

To email the financial statements

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.
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1. Click .
This is located on the Report Preview window toolbar. 
The email is opened in the associated email program.

2. Review and edit the email as necessary.

3. Click Send. 
If an email address is defined for the client in MYOB AE/AO it will be automatically added to the 
To field. The Subject of the email identifies the client name and financial period for which the 
financial statements have been produced.
By default the financial statements are attached to the email as a PDF. The financial statements 

can be sent as a Microsoft Word or Excel attachment by clicking the  drop-down and 
selecting Microsoft Word or Excel from the menu. 
Watermarks and images are not included when emailing Microsoft Word or Excel attachments. 
See “Setting display options” on page 542.

Related topics
Previewing financial statements
Exploring and editing financial statements
Previewing financial statements
Setting display options
Printing financial statements
Exporting financial statements
Adding financial statements to Document Manager

Adding financial statements to Document Manager

If Document Manager is installed, then the financial statements can be added to Document 
Manager. 

To add the financial statements to Document Manager

1. Preview the financial statement for the client.
See “Previewing financial statements” on page 551.
The Report Preview window opens.

1. Click Share it.
This is located on the Report Preview window toolbar. 
The Create Document Wizard opens. 

2. On the Details tab, review and edit the information as required:
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a. Contact — the contact associated with the financial statements is automatically selected. 

b. Title — the title provides a short description which can be used to identify the document. 
The title indicates the client name and financial period the financial statements have been 
produced for.

c. Author — the username of the user currently logged in. Click the ellipse button to change 
the author. 

d. Status — the status of the document. 

e. Document Type — the type of document being imported into Document Manager. The 
default document type is PDF.

f. Date Created — the date the financial statements were created. To change the date, 
select a new date from the drop-down calendar. 

g. Source — the Outbound option is used if the document is being sent from the practice and 
the Inbound option is used if it has been received. 

3. Click Next to go to the Profiling tab.

4. On the Profiling tab, review and edit the information as required:

a. Filing Cabinet — from the drop-down, select a Filing Cabinet in which to store the new 
document.

b. Assignment — if the selected Filing Cabinet has assignments, select an assignment from 
the drop-down. If the selected Filing Cabinet does not have assignments, the Assignment 
field will be inactive. 

c. Category — Click the ellipse button to select Category fields for the PDF report. Enter the 
Value for each category. 

5. Click Finish to close the wizard.
The financial statements will be imported into Document Manager.

See the Document Manager help for more information on importing files into Document Manager.

Related topics
Previewing financial statements
Exploring and editing financial statements
Previewing financial statements
Setting display options

../Document_Manager/Importing.htm
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What version of Statutory Report do I have?
To find out what version of Statutory Reporter you have, use the About option on the Practice 
Report Settings page. You may require this information when requesting information or help from 
MYOB Support.

To find out your Statutory Reporter version

1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
The Practice Report Settings page opens.

2. Click About on the Tasks bar.
The About Statutory Reporter window opens.
The Statutory Reporter Version, Database Version, Report Definition Version and Application 
Mode are listed in the window.

3. Click OK.
The About Statutory Reporter window closes.

Related topics
Statutory Reporter
Accessing Statutory Reporter
Configuring practice report settings
Configuring client report settings
Configuring client report settings
Producing financial statements
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	4. Select the account row.
	5. Click on Manage Account Type Group.
	6. Select the row with the account type you want to delete. You can use the search field at the top of the window to search for values in the Account Type Group field.
	7. Click the Delete button.
	8. In the Delete window, click Yes.
	9. Click OK.
	10. In the Manage Accounts window, click Submit.


	Adding header and detail accounts
	To add a header account
	1. Open the workpapers period.
	2. Click Add account on the Tasks bar.
	3. Select the Header option.
	4. Select the classification for the account from the Account Type drop-down.
	5. Enter the account number into the Account Number field.
	6. Enter the Account Name.
	7. Click OK.

	To add a detail account
	1. Open the workpapers period.
	2. Click Add account on the Tasks bar.
	3. Select the Detail option.
	4. Select the classification for the account from the Account Type drop-down.
	5. Enter the Account Number.
	6. Enter the Account Name.
	7. Click OK.

	Related topics

	Adding accounts to an Essentials general ledger
	1. Open the workpapers period.
	2. Click Add account on the Tasks bar.
	3. Select the classification for the account from the Account Classification drop-down.
	4. Select the Account Type from the drop-down.
	5. Enter the account number into the Account Number field.
	6. Enter the Account Name.
	7. Click OK.
	Related topics

	Editing an added account
	To edit an added account
	1. Open the workpapers period.
	2. Select the account in the table.
	3. Click Edit account on the Tasks bar.
	4. Edit the Account Name as required.
	5. Click OK.

	Related topics

	Deleting an added account
	To delete an added account
	1. Open the workpapers period.
	2. Select the account in the table.
	3. Click Delete account on the Tasks bar.
	4. Click Yes to delete the account. Click No to cancel.


	Viewing transactions
	To view transactions
	1. Open the Workpapers period.
	2. Select one account in the table.
	3. To display the transactions, either:

	To group transactions by field
	1. In the View Transactions window, click and drag a column header (field) into the grouping bar “Drag a column header here to group by that column”.
	2. To remove grouping, drag the column name from the grouping bar back into the transaction table.
	3. If you want to further group transactions within each group, that is grouping within a group, drag a second column header into the grouping bar.

	To filter transactions
	1. In the View Transactions window, click in the filter bar just below the column header that you want to sort transactions for.
	2. In the filter bar field, either:
	3. To remove the filter and display all transactions, click on the icon on the field in the filter bar.

	To display transactions by period
	1. In the View Transactions window, enter the From date and To date.
	2. Click on the Search button.

	To move columns
	1. In the View Transactions window, click and drag a column header to the left or right to change the order in which the columns are displayed.

	To export transactions to Excel
	1. In the View Transactions window, click on the Export to Excel button.
	2. Save the spreadsheet.

	Related topics

	Defining Balance Forward Accounts
	To define a balance forward account
	1. Open the Workpapers period.
	2. In the workpaper, select the accounts to update.
	3. Right-click the selection, and then click Set Balance forward account in the right-click menu. The “Balance forward” window appears.
	4. In the To Account field, select the balance forward account. You can select the account in the dropdown list, or you can type in this field to search the list of available accounts.
	5. Click OK to save your changes.

	To view and modify balance forward accounts
	1. Open the Workpapers period.
	2. In the task bar, click Define Balance Forward Accounts. The Define Balance Forward Accounts window will appear.
	3. Define the source account and balance forward account by clicking in the empty fields. You can select the account in the dropdown list, or you can type in this field to search the list of available accounts.
	4. Click Save to save your changes.

	To remove a balance forward account
	1. In the “Define Balance Forward Accounts” window, select the account you wish to remove.
	2. Click Delete. The row will be removed from the table.
	3. Click Save to keep your changes.

	To generate a journal
	1. Open the Workpapers period.
	2. In the task bar, click Define Balance Forward Accounts. The Define Balance Forward Accounts window will appear.
	3. In the “Define Balance Forward Accounts” window, click Generate Journal.
	4. A journal will be automatically created based on the first day of the workpaper period, based on the closing balances of the previous year. Descriptions for these journal entries will be blank.



	Adding workpapers and source documents
	Related topics
	Adding workpapers
	To add a workpaper to an account
	1. Open the workpapers period.
	2. Select the account in the table.
	3. Click Add workpaper on the Tasks bar.
	4. In the Select workpaper template section, select the:
	5. Enter a new Workpaper name.
	6. Set the Rollover options, if available:
	7. Click Add.

	To add a workpaper to the period
	1. Open the workpapers period.
	2. Select Non-account specific documents in the table.
	3. Click Add workpaper on the Tasks bar.
	4. Leave the Account field blank.
	5. In the Select workpaper template section select:
	6. Enter a new Workpaper name.
	7. Set the Rollover options:
	8. Click Add.

	Related topics
	Linking clients in a workpaper
	1. Click Link Client.
	2. Click [...] beside the Select Client field to select the client to link.
	3. Type part of the name of the client in the Search for field and click Search.
	4. Select the client to link to and click OK.
	5. Select a period from the Select period dropdown.
	6. Select the account and click OK.

	Related topics

	Linking Document Manager source documents
	Related topics
	Linking a Document Manager file to an account
	To link a Document Manager file to an account
	1. Open the workpapers period.
	2. Select the detail or header account in the table.
	3. Click Link document on the Tasks bar.
	4. Ensure that the correct account is displayed in the Account field.
	5. Click Search.
	6. When the Search for a document window displays, a default search is carried out, showing documents sorted in order of last reference.
	7. By default, the Current option is selected in Search Contacts.
	8. Enter criteria into the Search Criteria fields to refine the search.
	9. To sort or filter the search results:
	a. Click any column heading to sort the results alphabetically or numerically.
	b. Use the first row in the table to filter the search results.

	10. Find the document to be linked to the account in the table.
	11. Click the file checkbox.
	12. Click OK.
	13. Ensure that the correct file name is displayed in the Name field.
	14. Click Link.


	Related topics
	Linking a Document Manager file to a period
	To link a Document Manager file to a period
	1. Open the workpapers period.
	2. Click the Non-account specific documents checkbox.
	3. Click Link document on the Tasks bar.
	4. Leave the Account field blank.
	5. Click the Document Manager File option.
	6. When the Search for a document window displays, a default search is carried out, showing documents sorted in order of last reference.
	7. Enter criteria into the Search Criteria fields to refine the search.
	8. To sort or filter the search results:
	a. Click any column heading to sort the results alphabetically or numerically.
	b. Use the first row in the table to filter the search results.

	9. Click OK.
	10. Ensure that the correct file name is displayed in the Name field.
	11. Click the Rollover this document to the next period checkbox.
	12. Click Link.


	Related topics
	Linking a Document Manager file containing references
	To link a Document Manager file (containing references) to an account
	1. Open the workpapers period.
	2. Select the detail or header account in the table.
	3. Click Link document on the Tasks bar.
	4. Ensure that the correct account is displayed in the Account field.
	5. When the Search for a document window displays, a default search is carried out, showing documents sorted in order of last reference.
	6. By default, the Current option is selected in Search Contacts.
	7. Enter criteria into the Search Criteria fields to refine the search.
	8. To sort or filter the search results:
	a. Click any column heading to sort the results alphabetically or numerically.
	b. Use the first row in the table to filter the search results.

	9. Find the document to be linked to the account in the table.
	10. Click the file checkbox.
	11. Click OK.
	12. If the file contains bookmarks/worksheets, select the appropriate option from the Reference column drop-down.
	13. If you have made an error and want to delete a document link in the Link Document window:
	a. Select the row containing the document link.
	b. Press [Delete], or click Delete.

	14. Select the Roll Forward checkbox, if the linked document bookmarks will be rolled forward.
	15. Click Link.


	Related topics

	Linking external source documents
	Related topics
	Linking an external file to an account
	To link an external file to an account
	1. Open the workpapers period.
	2. Select the detail or header account in the table.
	3. Click Link document on the Tasks bar.
	4. Ensure that the correct account is displayed in the Account field.
	5. Click Browse in the Select external file section.
	6. Navigate to the location where the file is stored and find the file.
	7. Click Open.
	8. Ensure that the path and filename in the File field are correct.
	9. Enter a new unique name for the external file in the Document name field.
	10. Click the Rollover this document to the next period checkbox.
	11. Click Link.


	Related topics
	Linking an external file to a period
	To link an external file to a period
	1. Open the workpapers period.
	2. Click the Non-account specific documents checkbox.
	3. Click Link document on the Tasks bar.
	4. Leave the Account field blank.
	5. Click Browse in the Select external file section.
	6. Navigate to the location where the file is stored and find the file.
	7. Click Open.
	8. Ensure that the path and file name in the File field are correct.
	9. Enter a new unique name for the external file in the Document name field.
	10. Click the Rollover this document to the next period checkbox.
	11. Click Link.


	Related topics
	Linking to references in an external file
	To link to specific references in an external document
	1. Open the workpapers period.
	2. Select the detail or header account in the table.
	3. Click Link document on the Tasks bar.
	4. Ensure that the correct account is displayed in the Account drop-down field.
	5. Click Browse in the Select external file section.
	6. Navigate to the location where the PDF file is stored and find the file.
	7. Click Open.
	8. Ensure that the path and filename in the File field are correct.
	9. If you are linking to a specific PDF bookmark or Excel worksheet, select the reference from the Reference drop-down.
	10. Select the Rollover this document to the next period checkbox.
	11. Click Preview.
	12. Click Link.


	Related topics

	Viewing a list of all workpapers and source documents
	To view a list of all workpapers and source documents
	1. Open the workpapers period.
	2. Click View all workpapers on the Tasks bar.
	3. Click Close.

	Related topics


	Account comments
	Related topics
	Adding comments to an account
	To add comments to a selected account in the Prepare Trial Balance (Workpapers) table
	1. Open the workpapers period.
	2. Select an account in the table.
	3. Click Add comment on the Tasks bar.
	4. Enter comments in the text area.
	5. Click the Add button.

	To add comments to the Trial Balance (Workpapers) table
	1. Open the workpapers period.
	2. Click Add comment on the Tasks bar.
	3. Select an account from the Account field drop-down.
	4. Enter comments in the text area.
	5. Click the Add button.

	Related topics

	Editing comments on an account
	To edit comments
	1. Open the workpapers period.
	2. Right-click the comment icon for the selected account.
	3. Select Edit comments.
	4. Edit the comment as necessary.
	5. Click OK.

	To add more comments to an existing comment
	1. Open the workpapers period.
	2. Right-click the comment icon for the selected account.
	3. Select Edit comments.
	4. Click Insert time.
	5. Enter your comments.
	6. Click OK.

	Related topics

	Deleting comments from an account
	To delete comments from an account
	1. Open the workpapers period.
	2. Right-click the comment icon for the selected account.
	3. Select Delete comments.
	4. Click Yes.

	Related topics


	Opening workpapers
	To open a workpaper
	1. Open the workpapers period.
	2. Find the account with the associated workpaper in the table.
	3. Click to expand the account and view the documents.
	4. Double-click the workpaper.

	To open a workpaper using the Tasks bar
	1. Open the workpapers period.
	2. Find the account with the associated workpaper in the table.
	3. Select the workpaper.
	4. Click Open workpaper on the Tasks bar.

	To open multiple workpapers
	1. Open the workpapers period.
	2. Click the checkboxes of all the workpapers or documents to be opened.
	3. Click Open workpaper on the Tasks bar.

	Related topics

	Opening source documents
	Related topics
	Opening Document Manager files
	To open a Document Manager file
	1. Open the workpapers period.
	2. If the Document Manager file is linked to an account, find the account in the table.
	3. Double-click the linked Document Manager file.
	4. Click Open.
	5. Close the Document Manager file.

	Related topics

	Opening external files
	To open an external file
	1. Open the workpapers period.
	2. If the external file is linked to an account, find the account in the table.
	3. Double-click the linked external file.
	4. Click the Open button.
	5. Close the external file.

	Related topics

	Opening multiple documents
	To open multiple documents
	1. Open the workpapers period.
	2. Click the checkboxes of all the workpapers or documents to be opened in the table.
	3. Click Open workpaper on the Tasks bar.

	Related topics

	Using the source document cover page
	To use the source document cover page
	1. Open the workpapers period.
	2. Find the source document in the table.
	3. Double-click the source document to open it.
	4. Click Open to open the document.
	5. To enter additional information about the document:
	a. Click the text field in the Notes table.
	b. Type text into the field.

	6. Click Save to save the changes to the document cover page.

	Related topics

	Viewing and editing the source document properties
	To view and edit the source document properties
	1. Open the source document cover page.
	2. Click Properties on the toolbar.
	3. Edit the source document properties as necessary.
	4. Click OK to save the changes or Cancel to close the window without saving.

	Related topics


	Moving a workpaper
	To move a workpaper
	1. Open the workpapers period.
	2. Select the workpaper or document in the table.
	3. Click the checkbox next to the workpaper or document.
	4. Click Move workpaper on the Tasks bar.
	5. Select an account from the To account dropdown. The workpaper will be moved to this account.
	6. If you want to rename the workpaper, change the text in the Workpaper name field.
	7. Set the Rollover options:
	8. Click OK.

	Related topics

	Deleting workpapers and source documents
	To delete a workpaper or document from the Prepare Trial Balance (Workpapers) table
	1. Open the workpapers period.
	2. Select the workpaper or document in the table.
	3. Click the checkbox next to the workpaper or document.
	4. Click Delete workpaper on the Tasks bar.
	5. Click Yes to confirm the deletion. Click No to cancel the deletion.

	To delete a workpaper or document using View all workpapers
	1. Open the workpapers period.
	2. Click View all workpapers on the Tasks bar.
	3. Click the checkboxes of the workpaper(s) and / or document(s) to be deleted.
	4. Click Delete.
	5. Click Yes to confirm the deletion. Click No to cancel the deletion.

	To delete multiple workpapers or documents from the Prepare Trial Balance (Workpapers) table
	1. Open the workpapers period.
	2. Select the workpapers and/or documents in the table.
	3. Click the checkboxes next to the documents/workpapers to be deleted.
	4. Click Delete.
	5. Click Yes to confirm the deletion. Click No to cancel the deletion.

	Related topics

	Rolling data over from a prior period
	To roll over workpaper data from a prior period
	1. Roll over all data from a completed period.
	2. Open the new workpapers period.
	3. Select the workpaper in the table.
	4. Add the same workpaper to the same account code.
	5. Select the newly added workpaper.
	6. Click Rollover from the prior period on the Tasks bar.
	7. Click Yes to continue.

	If you have made an error and wish to revert to the original workpaper
	1. Open the workpapers period.
	2. Delete the workpaper that is in error.
	3. Add the same workpaper to the same account code.
	4. Select the newly added workpaper.
	5. Click Rollover from the prior period on the Tasks bar.
	6. Click Yes to continue.

	Related topics

	Updating your workpaper template
	To update a workpaper template
	1. Open the workpapers period.
	2. Select the workpaper in the table.
	3. Click Update to latest template on the Tasks bar.
	4. Click Yes.
	5. Click OK.

	Related topics

	Adjustment journals
	Related topics
	Adding a new adjustment journal
	To add an adjustment journal
	1. Open the workpapers period.
	2. Select the account in the table.
	3. Click Journals > Add on the Tasks bar.
	4. Enter a Date.
	5. Enter a note for the adjustment journal on the Journal note field.
	6. (Australia) If you want to use quantities for this journal (for example, for farm accounting), tick the Enter quantities checkbox.
	7. If this journal needs to be reversed (that is, if it is for a transaction that will occur in the future), tick the To be reversed checkbox.
	8. Select an account code from the Account dropdown.
	9. To add GST, select Apply GST. This value is saved per workpaper. The GST Code and GST Type fields become editable. Modify these values as necessary.
	10. Enter the quantity for the selected account in the Quantity field.
	11. Enter the debit or credit adjustment amount for the selected account in the DR Amount and CR Amount fields respectively.
	12. If required, enter a description for the adjustment in the Description field. (This field is optional.) As you type, any matching descriptions will appear in the field — press [Enter] or [Tab] to use the highlighted text.
	13. Press [Enter].
	14. Enter the account number into the Account field or select the account number from the drop- down.
	15. Ensure the amount in the DR Amount or CR Amount field is correct.
	16. Add further rows until the amounts have been correctly distributed between the accounts.
	17. Click Add.
	18. Add further adjustment journals as necessary.
	19. Click Close when you have finished adding adjustment journals.

	Related topics

	Viewing adjustment journals
	To view all adjustment journals
	1. Open the workpapers period.
	2. Click Journals > View all on the Tasks bar.
	3. Click Cancel.

	To view adjustment journals for a selected account
	1. Open the workpapers period.
	2. Click the checkbox for the selected account in the table.
	3. Click Journals > View for account on the Tasks bar.
	4. Click Cancel.

	Related topics

	Editing adjustment journals
	To edit adjustment journals
	1. Open the workpapers period.
	2. Click Journals > View all on the Tasks bar.
	3. Click the checkbox of the journal entry to be edited.
	4. Click Edit.
	5. Edit the journal entry, as necessary.
	6. (Australia) If you want to use quantities for this journal (for example, for farm accounting), tick the Enter quantities checkbox.
	7. If this journal needs to be reversed (that is, if it is for a transaction that will occur in the future), tick the To be reversed checkbox.
	8. To add GST, select Apply GST. This value is saved per workpaper. The GST Code and GST Type fields become editable. Modify these values as necessary.
	9. Ensure that edited journal entry is balanced and the total reads 0.00.
	10. If you wish to delete any lines in the Journal, select the line item and click Delete.
	11. Click Save to save the details in the Journals window. The Journals window updates to show the edited journal entry.
	12. When you are done, click Cancel to close the Journals window.

	Related topics

	Deleting adjustment journals
	To delete adjustment journals
	1. Open the workpapers period.
	2. Click Journals > View all on the Tasks bar.
	3. Click the checkbox of the journal entry to be deleted.
	4. Click Delete.
	5. Click Yes to confirm the deletion. Click No to cancel the deletion.

	Related topics

	Deleting journals posted to a legacy ledger
	To delete journals posted to a legacy ledger
	1. After deleting the journal in Workpapers, log into your legacy ledger (MAS, Accounts, or AOGL).
	2. Open the ledger containing the poster journal.
	3. Manually delete the posted journal entry.

	Related topics



	Completing workpapers
	Workpaper field types
	To complete the workpaper
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Enter information in the workpaper.
	4. Click Save.

	Related topics
	Comments in workpapers
	To add a new comment
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Click to place the cursor where the comment is to be added.
	4. Click New comment on the toolbar.
	5. Enter the information for the comment.
	6. To close the comment box, click outside of the comment box in the workpaper area.
	7. Click Save.

	Related topics
	Viewing comments in a workpaper
	To view a comment
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Find the comment to be viewed in the workpaper.
	4. Place the cursor over the icon.

	To show or hide all comments
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Click Show all comments on the toolbar.
	4. Click Hide all comments on the toolbar.

	Related topics

	Editing a comment in a workpaper
	To edit a comment
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Click the comment in the workpaper to be edited.
	4. Click Edit comment on the toolbar.
	5. Edit the comment in the Reference section of the comment box.
	6. Close the comment.
	7. Click Save.

	Related topics

	Moving comments in a workpaper
	To move a comment
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Add a comment.
	4. Drag and drop the icon to a different location within the workpaper where necessary.
	5. Click Save.

	Related topics

	Deleting a comment in a workpaper
	To delete a comment
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Click the comment in the workpaper to be deleted.
	4. Click Delete comment on the toolbar.
	5. Click Save.

	Related topics


	Adding an adjustment journal within a workpaper
	To add an adjustment journal from a workpaper
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Complete the workpaper.
	4. Click Add journal on the toolbar.
	5. Enter a Date.
	6. Enter a note for the adjustment journal on the Journal Note field.
	7. Enter the adjustment amount for the selected account on the Amount field.
	8. Press [Enter].
	9. Enter the account number into the Code field or select the account number from the drop- down.
	10. Ensure the amount in the Amount field is correct.
	11. Add further rows until the amounts have been correctly distributed between the accounts.
	12. Click Add.
	13. Add further adjustment journals as necessary.
	14. Click Cancel when you have finished adding adjustment journals.

	Related topics

	Linking documents in a workpaper
	Related topics
	Linking a Document Manager file within a workpaper
	To link to a Document Manager file within a workpaper
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Click on the Link document in the taskbar option of workpapers.
	4. When the Search for a document window displays, a default search is carried out, showing documents sorted in order of last reference.
	5. By default, the Current option is selected in Search Contacts.
	6. Enter criteria into the Search Criteria fields to refine the search.
	7. To sort or filter the search results:
	a. Click any column heading to sort the results alphabetically or numerically.
	b. Use the first row in the table to filter the search results.

	8. Find the document to be linked to the workpaper.
	9. Click the file checkbox.
	10. Click OK.
	11. If a PDF or Excel document is selected and it contains bookmarks/worksheets, select the appropriate option from the Reference column drop-down.
	12. If you have made an error and want to delete a document link in the Link Document window:
	a. Select the row containing the document link.
	b. Press [Delete] or click Delete.

	13. Click Link.
	14. Click Save.

	Related topics

	Linking an external file within a workpaper
	To link to an external document within a workpaper
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Click on the Link document in the taskbar option of workpapers.
	4. Click Browse in the Select external file section.
	5. Navigate to the location where the file is stored and find the file.
	6. Click Open.
	7. Ensure that the path and filename in the File field are correct.
	8. If you are linking to a specific PDF bookmark or Excel worksheet, select it from the Reference drop-down.
	9. Click Preview.
	10. Click Link.
	11. Click Save.

	Related topics

	Opening a linked document in a workpaper
	To open a linked document in the Document Links table
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Link a document.
	4. To view the document in read-only mode, click View.
	5. Close the document.

	To open a linked document using the document icon
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Link a document.
	4. Right-click on the icon.
	5. Close the document.

	Related topics

	Moving linked documents within a workpaper
	To move a document link within a workpaper
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Link a document.
	4. Drag and drop the icon to a location within the workpaper where it will be used as a reference.
	5. Click Save.

	Related topics

	Deleting a document link
	To delete a document from the Document Links table
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Select either the Description cell or Link cell of the document link to be removed.
	4. Click the icon.
	5. Click Save.

	To delete a document using the document icon
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Select the icon of the document to be deleted.
	4. Right-click on the document and select Delete document.
	5. Click Save.

	Related topics


	Workpaper To Do items
	Related topics

	Viewing and editing the workpaper properties
	To view and edit the workpaper properties
	1. Open the workpapers period.
	2. Open a workpaper.
	3. Click Properties on the toolbar.
	4. Edit the workpaper properties as necessary.
	5. Click OK to save the changes or Cancel to close the window without saving.

	Related topics

	Managing, tracking and approving workpapers
	Related topics
	Setting the status on a workpaper or document
	To set the status on a selected workpaper or document
	1. Open the workpapers period.
	2. Find the workpaper or document in the table.
	3. Click the checkbox next to the workpaper or document.
	4. Click the relevant status option on the Tasks bar.
	5. Set the Status information for the workpaper:
	a. Select the status of the workpaper on the Status drop-down.
	b. Assign the approvals task to a staff member.
	c. Edit the subject as required.
	d. Information regarding the approvals task can be entered into the Comment field.

	6. Set the Notification options for the approvals task:
	a. Click the Send email checkbox to send an email to the responsible staff member to notify them that they have been assigned the approvals task.
	b. Click the Edit email before sending checkbox to review the email before sending it to the assigned staff member.

	7. Review the information in the Other section:
	a. The staff member who is requesting the review or approval.
	b. Click the Priority drop-down to set the priority to Low, Medium or High.
	c. The required completion date for the approvals task.

	8. Click Next to go to the History tab.
	9. Click Finish to save the status and assign the approvals task.

	To set the status on multiple workpapers or documents
	1. Open the workpapers period.
	2. Find the workpapers or documents in the table.
	3. Click the checkboxes of all the workpapers or documents.
	4. Click the relevant status option on the Tasks bar.
	5. Edit the approvals task as necessary.
	6. Set the Status information for the workpaper:
	a. Select the status of the workpaper using the Status drop-down.
	b. Assign the approvals task to a staff member.
	c. Edit the subject as required.
	d. Information regarding the approvals task can be entered into the Comment field.

	7. Set the Notification options for the approvals task:
	a. Click the Send email checkbox to send an email to the responsible staff member to notify them that they have been assigned the approvals task.
	b. Click the Edit email before sending checkbox to review the email before sending it to the assigned staff member.

	8. Review the information in the Other section:
	a. The staff member who is requesting the review or approval.
	b. Click the Priority drop-down to set the priority to Low, Medium or High.
	c. The required completion date for the approvals task.

	9. Click Next to go to the History tab.
	10. Click Finish.
	11. Click Finish to save the approvals task.

	Related topics

	Viewing the status of a workpaper or document
	To view the current status of a workpaper or document
	1. Open the workpapers period.
	2. Find the workpaper or document in the table.
	3. Click the checkbox next to the workpaper or document.
	4. Click Current status on the Tasks bar.
	5. If necessary, edit the Subject, Comment, Requested By, Priority and Due Date fields.
	6. Click Finish to save any changes made and close the window.

	Related topics

	Viewing the audit trail
	To view the audit trail for selected account or workpaper
	1. Open the workpapers period.
	2. Find the account, workpaper or document in the table.
	3. Click the checkbox next to the workpaper or document.
	4. Click View audit trail on the Tasks bar.
	5. Sort the information, if required.
	6. Click Export to Excel to export the audit records to a Microsoft Excel spreadsheet.
	a. Navigate to the location where the file is to be saved and enter a name for the file.
	b. Click the Save button to export and save the file.

	7. Click OK.

	Related topics


	Posting journals and exporting new accounts
	To post the journals and accounts if you have an AccountRight general ledger
	1. Open the workpapers period.
	2. Click Post journals and accounts on the Tasks bar.
	3. Click the Include previously posted journals checkbox to post all journals including those which have been posted previously.
	4. Click Yes.
	5. Click OK.

	To export journals for a MAS, Accounts or AO Classic general ledger
	1. Open the workpapers period.
	2. Click Create journal export file on the Tasks bar.
	3. Enter the location of the Export Journal file.
	4. Click OK.

	To post journals to an AO Classic general ledger
	1. Open the workpapers period.
	2. Click Create journal export file on the Tasks bar.
	3. Enter the location of the Export Journal file.
	4. Click Post.

	To post the journals and accounts if you have an Essentials Accounting or Cashbook general ledger
	1. Open the workpapers period.
	2. Click Post journals and accounts on the Tasks bar.
	3. Click Yes.
	4. Click OK.

	Related topics
	Removing exported journals
	To mark journals as not exported
	1. Open the workpapers period.
	2. Click View all on the Tasks bar.
	3. Select the journals that have not been exported.
	4. Click Mark as not exported.
	5. Click Close.

	Related topics


	Creating the PDF report
	To create the PDF report
	1. Open the workpapers period.
	2. Click Create PDF on the Tasks bar.
	3. In the bottom left corner of the window, select one of the following:
	4. Deselect the checkboxes of the reports, workpapers and linked documents that will not be included in the PDF report.
	5. Click Preview.
	6. Close the PDF report.

	To import the PDF report into Document Manager
	1. Open the workpapers period.
	2. Click Create PDF on the Tasks bar.
	3. In the bottom left corner of the window, select one of the following:
	4. Deselect the checkboxes of the reports, workpapers and linked documents that will not be included in the PDF report.
	5. Click Share It.
	6. On the Details tab review and edit the information as required:
	a. The contact associated with the workpapers period is automatically selected.
	b. The title defaults to the Workpapers File and includes the client name and workpaper period dates.
	c. The username of the currently logged in staff member.
	d. The Status drop-down defaults to a status of Complete.
	e. The type of document being imported into Document Manager.
	f. The Date Created drop-down defaults to the system date.
	g. The Outbound option is used if the document is being sent from the accountant and the Inbound option is used if it has been received.

	7. Click Next.
	8. On the Profiling tab review and edit the information as required:
	a. Select a Filing Cabinet in which to store the new document.
	b. If the selected Filing Cabinet has assignments, select an assignment from the drop-down.
	c. Click to select Category fields for the PDF report.
	d. Enter the Value for each category.

	9. Click Finish.

	Related topics

	Completing the period
	To complete the period
	1. Open the workpapers period.
	2. Click Complete the period on the Tasks bar.
	3. Click Yes to complete the period. Click No to cancel.
	4. The workpapers period is marked as complete.

	Related topics

	Printing reports and workpapers
	To preview reports and workpapers
	1. Open the workpapers period.
	2. Click on the Tasks bar.
	3. Click the checkboxes of the reports and / or workpapers to be printed.
	4. Click Preview.

	To print reports and workpapers
	1. Open the workpapers period.
	2. Click on the Tasks bar.
	3. Click the checkboxes of the reports and / or workpapers to be printed.
	4. Click Print.
	5. Select the printer and edit the printing preferences as necessary.
	6. Click OK.

	Related topics


	To Do items
	Workpapers homepage
	To Do Workpaper window
	1. Find the To Do item in the table.
	2. Double-click the To Do item.

	Workpaper window
	1. Find the To Do item in the table.
	2. Double-click the To Do item.

	Trial Balance (Workpapers) tab
	1. Find the To Do item in the table.
	2. Double-click the To Do item.

	To Do tab (AE)
	1. Search for the client.
	2. Select the client.
	3. Navigate to Client page > To Do tab.
	4. Click the link in the Subject column to open the To Do item for the workpaper period.

	My Homepage (AE)
	1. Navigate to the Homepage tab.
	2. Click the To Do homepage link on the Tasks bar.

	Related topics
	Working with To Do items
	To add a To Do item to a period
	1. Open the workpapers period.
	2. Click To Do item on the Tasks bar.
	3. Click Add.
	4. Enter the details of the To Do item on the Main tab.
	5. Click Next.
	6. Click Next.
	7. Click Finish.

	To add a To Do item to a workpaper
	1. Open the workpapers period.
	2. Select and open a workpaper in the table.
	3. Click New To Do on the toolbar.
	4. Enter the details of the To Do item on the Main tab.
	5. Click Next.
	6. Click Next.
	7. Click Finish.

	Related topics

	Opening and editing a To Do item
	To open and edit a To Do item from the To Do Workpaper window
	1. Open the workpapers period.
	2. Click To Do item on the Tasks bar.
	3. Edit any fields on the Main tab in the To Do window.
	4. Click Finish.

	To open and edit a To Do item from the Trial Balance (Workpapers) window
	1. Open the workpapers period.
	2. Select and open the workpaper in the table.
	3. Click to show the table.
	4. Find the To Do item.
	5. Double-click to open the To Do Item.
	6. Edit any fields on the Main tab in the To Do window.
	7. Click Finish.

	Related topics

	Printing To Do items
	To print a selected To Do item
	1. Find the To Do item.
	2. Double-click to open the To Do item.
	3. Click Print.
	4. Click the History checkbox.
	5. Click the Notes History checkbox.
	6. Click Print or Print Preview.
	a. Click Print to print the To Do item.
	b. Click Print Preview to view the output on-screen before sending it to a printer.

	7. Click Finish.

	Related topics


	Ledgers
	Related topics
	Launching a ledger
	To open the general ledger application
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Launch ledger on the Tasks bar.

	If you have a MYOB AO Classic general ledger
	If you have an Essentials Accounting general ledger
	If you have an Essentials Cashbook general ledger
	Related topics

	Creating and viewing your client’s AE/AO ledger
	To create an AE/AO ledger for your client
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Create new AE/AO Ledger on the Tasks bar. The Create Ledger window is displayed.
	3. Enter the Ledger name.
	4. Select the Chart template by clicking the Browse button in this field, and searching for your ledger template file. The Client Accounting Templates Folder is shown by default.
	5. Select the Entity Type and Chart Type.
	6. Enter the Financial year end date.
	7. Review the values in System Account Mapping, and modify any values if required. The mapped Account code values displayed here vary depending on the Entity and Chart Type.
	8. Click OK.

	To create a Practice Chart
	1. A chart template (Chart_Template.csv) can be found in Deploy/Client Accounting Templates/ MYOB Standard Templates. Open this template in Excel.
	2. In the template, fill in the following values:
	3. Save the CSV file using the following naming convention:

	To view your client’s ledger
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click View AE Ledgers/View AO Ledgers on the Tasks bar.
	3. Click Select file to view the ledger.

	Related topics

	Perform an opening review
	Related topics
	Accessing the Opening Review Wizard
	Accessing the Open Review Wizard for unconfigured client data
	1. Configure the client.
	2. Click OK.
	3. Click Yes.

	Accessing the Open Review Wizard for configured client data
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Perform Opening Review on the Tasks bar.

	Related topics

	Using the Opening Review Wizard
	Select the general ledger product
	1. Access the Opening Review Wizard.
	2. Select the general ledger product that is used for this client.
	3. A ledger is automatically selected if a match is determined between the client ledger code and the client code in MYOB AE/AO.
	a. Search for a new ledger by clicking the ellipses (...) button. The Select Ledger window appears.
	b. Enter the ledger Code or Name on the Search field.
	c. Click to clear the search.
	d. Select the appropriate ledger in the table.
	e. Click OK.
	a. Ensure the correct option is selected in Select General Ledger Product.
	b. Select the CSV file that contains the accountant’s balances.
	c. The Select File window opens.
	d. Click the ellipse button at the end of the File to import field.
	e. The Select File to Import window opens.
	f. Navigate to the location where the CSV text file is stored.
	g. Click Open.

	4. Select the balances that are to be used for comparison:
	5. Click Next.

	Related topics
	Mapping accounts
	Map Accounts window options
	Searching for an account on the accountant’s chart
	1. Type a value on the Search field.
	2. Click to clear the search.

	Including zero balances
	1. Select Include zero balances.

	Viewing and editing automatic mappings
	1. Click the drop-down arrow in the Map to column.
	2. Select the View suggested accounts option at the bottom of the list.
	3. Select the View all accounts option to return to the full list of accounts.
	4. Ensure that the Show unmapped accounts only checkbox is selected.
	5. Clear Include zero balances if it is selected to hide accounts with zero balances.
	6. Select an account from the list.

	Viewing and editing suggested mappings
	1. Click the drop-down arrow in the Map to column.
	2. Select the View all accounts option at the bottom of the list.
	3. Select the View suggested accounts option.
	4. Ensure that the Show unmapped accounts only checkbox is cleared.
	5. Clear the Include zero balances checkbox, if it is selected, to hide accounts with zero balances.
	6. Select an account from the list.

	Mapping across multiple accounts
	1. Open the Split Account window.
	2. Select all of the required client accounts.
	3. The Journal amount field is used to distribute the variance across the selected client accounts.
	1. Select the client account in the Map to column for the first accountant’s account.
	2. Select the same client in the Map to column for the second accountant’s account.
	3. Click the Keep existing mappings button.

	Mapping other accounts
	1. Click the drop-down arrow in the Map to column.
	2. Ensure that the Show unmapped accounts only checkbox is selected.
	3. Clear the Include zero balances checkbox, if it is selected, to hide accounts with zero balances.
	4. Select an account from the list.

	Viewing the client chart of accounts
	1. Click Show Client Balances.
	1. Type a value in the Search field.
	2. Click to clear the search.
	3. Ensure that the Show unmapped accounts only checkbox is selected.
	4. Ensure that the Include zero balances checkbox is selected.

	Adding a new client account
	1. Click Add client account or Add account.
	2. Specify the Account Classification, Account Code and Account Name of the new account.
	3. Click OK.
	1. Type an account code or account that does not already exist.
	2. Specify the Account Name.
	3. Click Yes.
	1. Type a new value in the Client account name field on the Map Accounts window.

	Other features of mapping accounts
	1. Click the Map to field for the specific entry.
	2. Delete the contents.
	3. Press [Enter] to clear all mappings:
	1. Click Clear all mappings.
	1. Click Restore default mappings.

	Completing Map Accounts
	1. Click Next.


	Related topics
	Confirming the opening review
	To complete the opening review
	1. Click View modified closing balances.
	2. Click Finish.

	Resuming an opening review
	1. Click Resume Opening Review on the Trial Balance (Workpapers) tab.


	Related topics
	Format of CSV text file
	A three column file
	A four column file

	Related topics


	Modify prior year balances
	To access the Modify Prior Year Balances feature
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Modify Prior Year Balances on the Tasks bar.
	3. Select the required year for which account balances are to modified.
	4. Click OK.

	Related topics
	Modifying account balances
	To modify the balance of an account
	1. Open the Modify Prior Year Balances window.
	2. Select the appropriate Debit or Credit cell for the account.
	3. Type the modified balance into the cell.
	4. Click OK.

	Related topics
	Adding and editing an account
	To add a new account
	1. Open the Modify Prior Year Balances window.
	2. Click Add account.
	3. Enter an Account Code, Account Name and amount into the blank row.
	4. Click OK.

	To edit an existing account name
	1. Open the Modify Prior Year Balances window.
	2. Type a new account name in the specific cell in the Account Name column.
	3. Click OK.

	Saving modifications
	1. Open the Modify Prior Year Balances window.
	2. Make the changes as required.
	3. Click OK.


	Related topics
	Searching accounts
	To search for an account
	1. Open the Modify Prior Year Balances window.
	2. Type an Account Code or Account Name in the Search field.

	Including zero balances
	1. Click the Include zero balances checkbox.


	Related topics


	Defining income allocation
	To define income allocation
	1. Open the client’s Client Accounting > Trial Balance (Workpapers) tab.
	2. Click Ledger > Define Income Allocation on the Tasks bar.

	Related topics

	Deleting a ledger
	To delete a ledger
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Ledger > Delete ledger on the Tasks bar.
	3. Click Yes.

	Related topics

	Removing Configuration Details from a ledger
	To remove configuration details
	1. Open the Client Accounting > Workpapers tab for a client.
	2. Under the Ledger section in the Tasks bar, click Remove Configuration Detail.
	3. A confirmation message displays. Click Yes to proceed with the removal.
	4. A information message displays stating the details have been removed. Click OK.

	Related topics

	Exporting Ledger Data to Tax
	To populate Tax Return fields from the online ledger
	1. Create a new Tax workpaper on the ledger for the current year. See “Adding workpapers” (see page 85) for more information.
	2. Once the workpaper is completed (see “Completing workpapers” (see page 130)) and any reports have been generated (see “Printing reports and workpapers” (see page 169)), navigate to the Tax homepage by clicking the Tax Button menu.
	3. In the Tasks bar, click Import Ledger Data to import fields from the ledger via the workpaper.
	4. In the Tax return, manually update any values as necessary.



	Importing a client file
	To import an MYE client file
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Ledger > Import client file on the Tasks bar.
	3. In the Import Wizard window, Select the .MYE option under Choose file type.
	4. In the Select file to import field, browse for the .MYE file to import.
	5. Click Next.
	6. If the details are correct, click Yes.
	7. Continue to Selecting account mapping options.

	To import a TXT client file
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Ledger > Import client file on the Tasks bar.
	3. In the Import Wizard window, Select the .TXT option under Choose file type.
	4. In the Select file to import field, browse for the .TXT file to import.
	5. Click Next.
	6. If the details are correct, click Yes.
	7. Continue to Selecting account mapping options.

	To import a CSV client file
	1. Open the client’s Client Accounting > Trial Balance tab (called the Workpapers tab if you are licensed for Workpapers).
	2. Click Ledger > Import client file on the Tasks bar.
	3. In the Import Wizard window, Select the .CSV option under Choose file type.
	4. In the Select file to import field, browse for the .CSV file to import.
	5. Select the type of mapping to use from the Select template dropdown.
	6. Click Next.
	7. Continue to Selecting account mapping options.
	Related topics

	Selecting account mapping options
	To select account mapping options
	1. Tick the The chart of accounts in the file being imported is different to the chart in the ledger – I want to specify how to map the accounts to the ledger checkbox if you want to map the client’s chart of accounts to the ledger chart of accounts
	2. When you are importing a client’s file, you can choose whether to consolidate the transactions so that you have one transaction per account on a monthly or annual basis. Alternatively you can import all the transactions in the file.
	3. If you ticked the checkbox to consolidate imported transactions, you can then select one of the radio buttons, as follows:
	4. Click Next to accept these settings.
	5. If you ticked the first checkbox (to map the client accounts), continue to Selecting account mapping. If you left it empty, continue to Previewing mapped accounts.

	Related topics

	Selecting account mapping
	Map Accounts window options
	Viewing and editing automatic mappings
	1. Select the account and click the drop-down arrow in the Map to column.
	2. Select the View suggested accounts option at the bottom of the list.
	3. Select the View all accounts option to return to the full list of accounts.
	4. Ensure that the Show unmapped accounts only checkbox is selected.
	5. Deselect the Include zero balances checkbox if it is selected.
	6. Select an account from the list.

	Viewing and editing suggested mappings
	1. Click the drop-down arrow in the Map to column.
	2. Select the View all accounts option at the bottom of the list.
	3. Select the View suggested accounts option.
	4. Ensure that the Show unmapped accounts only checkbox is deselected.
	5. Deselect the Include zero balances checkbox if it is selected.
	6. Select an account from the list, or add a new account (see Adding a new client account).

	Mapping other accounts
	1. Click the drop-down arrow in the Map to column.
	2. Ensure that the Show unmapped accounts only checkbox is selected.
	3. Deselect the Include zero balances checkbox if it is selected.
	4. Select an account from the list.

	Adding a new client account
	1. Click Add account.
	2. Specify the Account type, Account type group, Account number, Account name and Tax Code for the new account.
	3. Click OK.

	Edit an existing client account code on the client’s Chart of Accounts
	1. Type a new value in the Client account code field on the Map Accounts window.

	Completing account mapping
	1. Click Next.
	2. Click Finish to post the accounts to the ledger.
	3. Continue to Previewing mapped accounts.


	Previewing mapped accounts
	1. To export the data, click on Export to Excel.
	2. When you have reviewed the data, click on Finish.
	Related topics


	Migrating to an AE/AO ledger
	MAS classifications (Australia)
	MAS classifications (New Zealand)
	Accounts classifications (Australia)
	Related topics
	Migrating an existing ledger
	To migrate an existing ledger to an AE/AO ledger
	1. Open the client’s Client Accounting > Trial Balance (Workpapers) tab.
	2. Click Migrate to AE/AO Ledger on the Tasks bar.
	3. The Migrate Data window opens.
	4. If you are using MYOB standard chart, the Ledger account values displayed in the table at the bottom of the window will be correct.
	5. Click OK.
	6. Click Close on the Migration Summary window when the migration is complete.
	7. Click View migration log on the Tasks bar.
	8. Click Close on the Ledger migration log window when you have finished viewing the details.

	Possible errors in the migration log
	Possible warnings in the migration log
	Related topics
	Migrating from AE Accounts – creating a partnership (individual)
	System accounts
	Manage Accounts
	1. Set up Income Allocation using the Tasks bar item in Client Accounting (first partner/individual)
	2. During the migration process, the system will automatically create Account Type Groups based on the partner names, and allocate the Account Type Groups to the existing accounts.

	Related topics

	Migrating from AE Accounts – creating a trust
	1. System accounts
	2. If you don’t use account 565, under Manage Accounts, create a new account to be used for the distribution journal.
	3. Create a journal for the distribution
	Related topics


	Importing balances for previous years
	To import prior year balances
	1. Open the client’s Client Accounting > Trial Balance (Workpapers) tab.
	2. Click Import Prior Year Balances on the Tasks bar.
	3. The Select Ledger window opens.
	4. Select the type of general ledger you’re migrating from the Product field.
	5. Under Data connection details, browse for the file containing the data to import.
	6. Click OK.



	Balances from the previous four years are imported and an ' Import Successful' message displays.
	Workpaper template designer
	To access the Designer
	1. Obtain a configuration key for the Designer from MYOB and set the security task permissions.
	2. Open and log on to MYOB AE.
	3. Select Maintenance > Client Accounting > Workpaper Templates on the main menu.

	Related topics
	Overview of customising a master template
	1. Add a practice template, by either:
	2. Open the newly added practice template for editing.
	3. Plan what changes you would like to make to the existing practice template.
	4. Insert fields and/or edit and format existing content.
	5. Save the changes to the practice template.
	6. Change the status of the practice template from In progress to Approved.
	7. Use the practice template in Workpapers.
	Related topics

	Master workpaper templates
	To access the master templates
	1. Open and log on to MYOB AE.
	2. Select Maintenance > Client Accounting > Workpaper Templates on the main menu.
	3. Select the MYOB master templates option.

	To view a master template
	1. Access the MYOB master templates.
	2. Select the master template to be viewed.
	3. Click View document on the Tasks bar.

	Layout of a template
	To view the properties of a master template
	1. Access the MYOB master templates.
	2. Select the master template whose properties are to be viewed.
	3. Click View properties on the Tasks bar.

	Related topics
	Available master templates
	Related topics


	Practice workpaper templates
	To access practice templates
	1. Access the Designer.
	2. Select the Practice templates option.

	Related topics
	Customising the list of practice templates
	To customise the displayed list of practice templates
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Sort the list of practice templates.
	4. Re-order the list columns.

	Related topics

	Viewing practice templates
	To view a practice template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Ensure that the practice template to be viewed has a status of In progress.
	4. Double-click the practice template to be viewed.

	Related topics

	Adding a practice template
	To add a practice template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Click Add on the Tasks bar.
	4. Enter a unique Template description.
	5. You can add a new template by:
	6. Select the template from the corresponding drop-down. If you know the name of the template, you can type in this field to search for it.
	7. Select the practice template Category from the drop-down.
	8. (Australia) If you have selected the Tax category, the Tax form type field is editable. Select the appropriate Tax Return Form for this workpaper template.
	9. Select the Rollover workpaper to next accounting period option, if required.
	10. Select the Show a link in the Prepare Workpapers screen to all referenced account codes option, if required.
	11. Click OK.

	Related topics
	Editing the practice template properties
	To edit the properties of a practice template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Select the practice template.
	4. Click Properties on the Tasks bar.
	5. Edit the Template description, if required.
	6. Change the Template status, if required.
	7. Change the practice template Category, if required.
	8. (Australia) If you have selected the Tax category, the Tax form type field is editable. Select the appropriate Tax Return Form for this workpaper template.
	9. Select or deselect the Rollover workpaper to next accounting period option, if required.
	10. Select or deselect the Show a link in the Prepare Workpapers screen to all referenced account codes option, if required.
	11. Click OK.


	Related topics

	Changing the status of a practice template
	To change the status of a practice template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Select the practice template.
	4. If the practice template has a status of Approved, click In Progress on the Tasks bar.
	5. If the practice template has a status of In progress, click Approved on the Tasks bar.

	Related topics

	Deleting a practice template
	To delete a practice template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Select the practice template to be deleted.
	4. Click Delete on the Tasks bar.
	5. Click Yes.

	Related topics

	Importing templates
	To import a workpaper template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Click Import on the Tasks bar.
	4. Select the template to be imported.
	5. Enter a Template description.
	6. Click OK.

	Related topics

	Exporting templates
	To export a practice template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Click Export on the Tasks bar.
	4. Navigate to the location where the template will be exported (or saved) to.
	5. Enter a File name for the template.
	6. The only option available for Save as type is MYOB Workpaper Template definitions (*.xml).
	7. Click Save.

	Related topics

	Reverting to MYOB master
	To revert a practice template to a MYOB master template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Select the practice template to be reverted to the master template.
	4. Click Revert to MYOB master on the Tasks bar.
	5. Read the warning notice on the Revert template to MYOB Master window.
	6. Click Yes.

	Related topics
	Updating a practice template to an updated MYOB master template
	Related topics


	Opening a practice template for editing
	To open a practice template
	1. Access the Designer.
	2. Select the Practice templates option.
	3. Ensure that the practice template to be edited has a status of In progress.
	4. Double-click the practice template to be edited.

	Related topics

	Main menu and toolbar options
	Main menu options
	Toolbar options
	Related topics

	Customising practice templates
	To insert a new field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select the field type to be inserted.
	5. Click OK.
	6. Configure the field type.
	7. Click OK.
	8. Format the field type as necessary.

	Related topics
	Inserting an account amount
	To insert an account amount field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Account amount.
	5. Click OK.
	6. Enter a Field name for the Account Amount field.
	7. Select the account code.
	a. Show details for the linked account code.
	b. Show details for an account code in this workpaper.

	8. Select the Account balance display details.
	a. Select the appropriate Display option from the drop-down.
	b. Select the appropriate Format option from the drop-down for how the account balance is to be displayed.
	c. Tick the Include comma separators checkbox if you want to include a comma as a thousands separator.
	d. Select the Show this number when zero option, if required.

	9. Select the Display a red flag icon in the Prepare Workpapers list if a discrepancy exists option, if required.
	10. Click OK.

	Related topics

	Inserting an account code or description
	To insert an account code or description field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Account code or description.
	5. Click OK.
	6. Enter a Field name for the Account Code or Description field.
	7. Select the account code.
	8. Select the Account name display details.
	9. If the User enters account code in the workpaper option is selected, then the Rollover value to next period checkbox is selected by default.
	10. Click OK.

	Related topics

	Inserting an Account group amount
	To insert an account group amount field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Account group amount.
	5. Click OK.
	6. Enter a Field name for the Account Amount field.
	7. Select the account group by clicking the Select account group button. The Select Account Group dialog box is displayed.
	a. Search for the account group by entering the name in the search field, or browsing through the folder tree.
	b. Highlight the group you wish to select.
	c. Click OK. The Account group is displayed under the button.

	8. Select the Expected amount sign. The amount will be displayed as a positive number if it has the selected amount type.
	9. Select the Account group display details.
	d. Select the appropriate Format option from the drop-down for how the account balance is to be displayed.
	e. Tick the Include comma separators checkbox if you want to include a comma as a thousands separator.
	f. Select the Show this number when zero option, if required.

	10. Select Allow manual override on Workpaper if you wish to have this value overwritten on the workpaper.
	11. (Australia) If this calculation is to be mapped to a Tax Return field, select Field to be mapped to Tax Return.
	12. Click OK.

	Related topics

	Inserting a calculation
	Functions
	To insert a column sum calculation field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Calculation.
	5. Click OK.
	6. Enter a Field name for the Calculation field.
	7. Select the Calculation type to be Column sum of number field.
	8. Select the Format of the displayed calculation result from the drop-down.
	9. Tick the Include comma separators checkbox if you want to include a comma as a thousands separator.
	10. Select the Show this number when zero option, if required.
	11. Select the This calculation is part of the Workpaper’s journal option, if required.
	12. If you have selected the This calculation is part of the Workpaper’s journal option, and you want to include quantities rather than an actual balance (for example, for farm accounting):
	a. Click the Edit journal settings... button.
	b. In the Account section, select the Post to the linked account option or select an account from the Post to the account selected in this field dropdown, depending on where you want the amount to be posted.
	c. Select the Post as quantity option in the Balance type section.
	d. Click OK.

	13. Select the Rollover value to next period option, if required.
	a. Select the appropriate field that will display the calculated amount in the next period from the drop-down.

	14. Select the This calculation is the number to balance the linked account against option, if required.
	15. Select the Display a red flag icon in the Prepare Workpapers list if a discrepancy exists option, if required.
	16. (Australia) If this calculation is to be mapped to a Tax Return field, select Field to be mapped to Tax Return.
	17. Click OK.

	To use a calculation result from another workpaper in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Calculation.
	5. Click OK.
	6. Enter a Field name for the Calculation field.
	7. Select the Calculation type to be Calculation result from another Workpaper.
	a. Click Setup.
	b. Expand the Field Name by clicking the + adjacent to the Field Name.
	c. Select the appropriate calculation.
	d. Click OK.

	8. Select the Format of the displayed calculation result from the drop-down.
	9. Select the Show this number when zero option, if required.
	10. Select the This calculation is part of the Workpaper’s journal option, if required.
	11. Select the Rollover value to next period option, if required.
	a. Select the appropriate field that will display the calculated amount in the next period from the drop-down.

	12. Select the This calculation is the number to balance the linked account against option, if required.
	13. Select the Display a red flag icon in the Prepare Workpapers list if a discrepancy exists option, if required.
	14. If this calculation is to be mapped to a Tax Return field, select Field to be mapped to Tax Return.
	15. Click OK.

	To insert a customised calculation field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Calculation.
	5. Click OK.
	6. Enter a Field name for the Calculation field.
	7. Select the Calculation type to be Other calculation.
	a. Consider the formula you would like to use.
	b. Select the field to be included in the calculation using the drop-down.
	c. Click Insert to place the field in the formula.
	d. Continue creating your calculation formula and inserting fields as required.

	8. Select the Format of the displayed calculation result from the drop-down.
	9. Select the Show this number when zero option, if required.
	10. Select the This calculation is part of the Workpaper’s journal option, if required.
	11. Select the Rollover value to next period option, if required.
	a. Select the appropriate field that will display the calculated amount in the next period from the drop-down.

	12. Select the Display a red flag icon in the Prepare Workpapers list if a discrepancy exists option, if required.
	13. If this calculation is to be mapped to a Tax Return field, select Field to be mapped to Tax Return.
	14. Click OK.
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	Related topics


	Inserting a check box
	To insert a check box field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Check box.
	5. Click OK.
	6. Enter a Field name for the Check box field.
	7. Select the Display values.
	8. Select the Default value of the check box.
	9. The Rollover value to next period checkbox is selected by default.
	10. Click OK.

	Related topics

	Inserting a data entry table
	To insert a data entry table in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new table is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Data entry table.
	5. Click OK.
	6. Enter a Table name for the Data Entry Table field.
	7. Select the Top row is header option, if required.
	8. Enter the Table column details.
	a. Edit the default entry that exists in the Table column details:
	b. To add another column:
	c. To delete an entry:
	d. To view and edit the properties of a field:
	e. To organise the columns:

	9. The Rollover to next period checkbox is selected by default.
	10. Click OK.

	Related topics

	Inserting a date
	To insert a date field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Date.
	5. Click OK.
	6. Enter a Field name for the Date field.
	7. Select how the date will be entered.
	8. If the User entered date option is selected, then the Rollover value to next period checkbox is selected by default.
	9. Click OK.

	Related topics

	Inserting a document link
	To insert a document link field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Document link.
	5. Click OK.
	6. Enter a Field name for the Document link field.
	7. The Rollover value to next period checkbox is selected by default.
	8. Click OK.

	Related topics

	Inserting a number
	To insert a number field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Number.
	5. Click OK.
	6. Enter a Field name for the Number field.
	7. Enter the Default value for the number field.
	8. Select the Format of the displayed number field from the drop-down.
	9. Tick the Include comma separators checkbox if you want to include a comma as a thousands separator.
	10. Select the Show this number when zero option, if required.
	11. Select the This number is part of the Workpaper’s journal option, if required.
	12. If you have selected the This number is part of the Workpaper’s journal option, and you want to include quantities rather than an actual balance (for example, for farm accounting):
	a. Click the Edit journal settings... button.
	b. In the Account section, select the Post to the linked account option or select an account from the Post to the account selected in this field dropdown, depending on where you want the amount to be posted.
	c. Select the Post as quantity option in the Balance type section.
	d. Click OK.

	13. Select the Rollover value to next period checkbox, if required.
	14. Select the appropriate Rollover value to next period option:
	a. Same number field
	b. Select another number field

	15. (Australia) If this calculation is to be mapped to a Tax Return field, select Field to be mapped to Tax Return.
	16. Click OK.

	Related topics

	Inserting text
	To insert a text field in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new field is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Select Text.
	5. Click OK.
	6. Enter a Field name for the Text field.
	7. Select how the text will be entered.
	8. The Rollover value to next period checkbox is selected by default.
	9. Click OK.

	Related topics

	Inserting a text display table
	To insert a text display table in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new table is to be inserted.
	3. Select Table > Insert > Table on the main menu.
	4. Enter the number of rows of the text display table.
	5. Enter the number of columns of the text display table.
	6. Click OK.
	7. Additional rows and columns can be added to the text display table using Table > Insert on the main menu.
	8. Insert other fields into the cells of the text display table, as required.
	9. Save the practice template.
	10. Close the practice template.

	Related topics
	Adding columns or rows to a text display table
	To add a column to a text display table
	1. Open the practice template for editing.
	2. Insert a text display table.
	3. Place the cursor in a cell of the table where the column is to added either to the left or right.
	4. Insert a column:
	a. Select Table > Insert > Column to the left, if the column is to be added to the left of the selected cell.
	b. Select Table > Insert > Column to the right, if the column is to be added to the right of the selected cell.


	To add a row to a text display table
	1. Open the practice template for editing.
	2. Insert a text display table.
	3. Place the cursor in a cell of the table where the row is to added either below or above.
	4. Insert a row:
	a. Select Table > Insert > Row above, if the row is to be inserted above the selected cell.
	b. Select Table > Insert > Row below, if the row is to be insert below the selected cell.



	Related topics
	Deleting a text display table
	To delete a text display table
	1. Open the practice template for editing.
	2. Position the mouse cursor in a text display table.
	3. Select Table > Delete > Table on the main menu.


	Related topics
	Deleting columns or rows from a text display table
	To delete a column or row from a text display table
	1. Open the practice template for editing.
	2. Position the mouse cursor in a cell of a text display table that is to be deleted.
	3. To delete a column:
	a. Select Table > Delete > Column on the main menu.

	4. To delete a row:
	a. Select Table > Delete > Row on the main menu.



	Related topics

	Inserting an Assets - GL reconciliation table
	To insert an Assets - GL reconciliation table in a practice template
	1. Open the practice template for editing.
	2. Position the mouse cursor in the practice template where the new table is to be inserted.
	3. Click Insert Field on the toolbar.
	4. Click the Other components tab.
	5. Select Assets - GL reconciliation.
	6. Click OK.
	7. The Rollover to next period checkbox is selected by default.
	8. Click OK.

	Related topics

	Formatting tables
	Aligning a data entry table using a text display table
	1. Open the practice template for editing.
	2. Position the mouse cursor below the data entry table.
	3. Press [Enter].
	4. Select Table > Insert > Table on the main menu.
	5. Change the number of Rows and Columns to what is required for your data entry table.
	6. Click OK.
	7. Resize each of the columns so that they align with the columns of the blank text display table.
	8. Save the template.
	9. Position the mouse cursor inside the text display table that was used as a ruler to format the data entry table.
	10. Select Table > Delete > Table on the main menu.
	11. Save the template.

	Adding table borders
	1. Open the practice template for editing.
	2. Select all the cells of the table.
	3. Select Format > Table on the main menu.
	4. Select the All borders option in the Frame section.
	5. Click OK.
	6. Save the template.

	Using colours in tables
	1. Open the practice template for editing.
	2. Position the mouse cursor in the cell of the table that is to be coloured.
	3. Select Format > Table on the main menu.
	4. Click the Other button in the Background section.
	5. Make your selection.
	6. Click OK.
	7. Click OK.
	8. Save the template.

	Related topics

	Deleting fields
	To delete a field from a practice template
	1. Open the practice template for editing.
	2. Select the field to be deleted.
	3. Click Delete Field on the toolbar.
	4. Click Yes.
	5. Save the template

	Related topics

	Viewing and editing field properties
	To view and edit field properties
	1. Open the practice template for editing.
	2. Select the field to be viewed or edited.
	3. Click Field Properties on the toolbar.
	4. View the field properties and edit as required.
	5. Click OK.

	Related topics



	Assets
	General ledgers compatible with MYOB Assets Live
	Related topics

	About depreciation
	What MYOB Assets Live does
	Depreciation is calculated when you
	Related topics

	Accessing an asset register
	To access a client asset register
	1. Find and select the client.
	2. Click the Client Accounting tab.
	3. If necessary, configure the financial data source for the client.
	4. Click the Asset tab.

	Related topics
	Assets tab
	Select year
	General ledger details
	Related topics


	Getting started
	1. Accessing an asset register
	2. Configuring the asset register settings
	3. Adding the first asset year
	4. Creating a control group
	5. Opening an asset year
	6. Creating a new asset location
	7. Creating an asset
	8. Adding successive asset years
	Configuring the asset register settings
	To configure the asset register settings
	1. Open the client’s Client Accounting > Assets tab.
	2. Click Register settings on the Tasks bar.
	3. Select the appropriate start of the financial year from the Start month drop- down.
	4. Select the type of depreciation calculation by ticking the relevant checkbox:
	5. Select whether the asset register will Integrate with the supported general ledger by ticking the checkbox.
	6. Select what entries will be generated from depreciation calculations. If the type of depreciation is:
	7. Click OK.

	Related topics
	Editing asset register settings
	To edit the asset register settings
	1. Open the Register Settings window.
	2. Make the changes as required. See “Configuring the asset register settings” (see page 298).
	3. If the type of depreciation is changed from Taxation only or Accounting only to Accounting and Taxation then:
	4. Click OK.

	Related topics

	Deleting an asset register
	To delete an asset register
	1. Open the client’s Client Accounting > Assets tab.
	2. Click Delete register on the Tasks bar.
	3. Two options are available:
	a. Click Yes.
	b. Click No.


	Related topics


	Asset years
	Adding the first asset year
	To add the first asset year
	1. Open the client’s Client Accounting > Assets tab.
	2. Click Add year on the Tasks bar.
	3. Enter the Year end.
	4. Click Add.

	Related topics

	Adding successive asset years
	To add successive asset years
	1. Open the client’s Client Accounting > Assets tab.
	2. Click Add year on the Tasks bar.

	Related topics

	Opening an asset year
	1. Double-click a year entry in the Select year table of the Assets tab.
	2. Select the year in the Select year table of the Asset Register, then click Open year on the Tasks bar.
	Related topics

	Deleting an asset year
	To delete an asset year
	1. Open the client’s Client Accounting > Assets tab.
	2. Select the year from the Select year table.
	3. Click Delete year on the Tasks bar.
	4. Click Yes.

	Related topics


	Control groups
	Control group template
	Rules when creating control groups

	Control group templates
	Related topics

	Maintain Control Group window - Control group fields
	Buttons
	Related topics

	Maintain Control Group window - Taxation tab fields
	Depreciation defaults fields
	Calculate depreciation using fields
	Integrated account fields
	Related topics

	Maintain Control Group window - Accounting tab fields
	Depreciation default fields
	Calculate depreciation using fields
	Integrated account fields
	Related topics

	Creating a control group
	To create a control group
	1. Open the client’s Client Accounting > Assets tab.
	2. Click Maintain control group on the Tasks bar.
	3. Click the first cell of the Account code column in the table.
	4. The row displays the text Click here to add new control groups in the Account code column.Enter the Account code of the control group.
	a. Type the Account code into the Account code cell.
	b. Click the Account code cell.

	5. Enter the account Name.
	a. If you are in non-integrated mode, type the Name of the control group.
	b. If you are integrated mode and have selected an Account code, the Name field is automatically filled.

	6. Enter the Private use % to be used by the assets within the control group.
	7. Press [Enter].
	8. On the Taxation tab:
	a. Select the Depreciation defaults.
	b. Select the appropriate options for Calculate depreciation using.
	c. Select the Integrated accounts for the control group.

	9. On the Accounting tab:
	a. Select the Depreciation defaults.
	b. Select the appropriate options for Calculate depreciation using.
	c. Select the Integrated accounts for the control group.

	10. Click Save.
	11. Create another control group, if required, and Save the changes.
	12. Click OK to save and close the window.

	Related topics

	Editing a control group
	To edit a control group
	1. Open the Maintain Control Group window.
	2. Select the control group to be edited.
	3. Edit the Account code of the control group.
	a. If you are in non-integrated mode, highlight the Account code and overtype the existing text.
	b. If you are in integrated mode, click the cell. The magnifying glass icon is displayed. Click the magnifying glass icon to open the Find Chart of Accounts window from where you can search for the account. See “Searching accounts” on page 324.

	4. Edit the Name.
	a. If you are in non-integrated mode, highlight the Name of the control group and overtype the existing text.
	b. If you are in integrated mode and have selected an Account code, the Name field is automatically filled.

	5. Edit the Private use % to be used by the assets within the control group.
	6. Press [Enter].
	7. Edit the Depreciation defaults.
	8. Edit the appropriate option for Calculate depreciation using.
	9. Change the Integrated accounts to be used for the control group, if necessary.
	10. Click Save.
	11. Click OK to save and close the window.

	Related topics

	Deleting a control group
	To delete a control group that has no allocated assets
	1. Open the client’s Client Accounting > Assets tab.
	2. Open the Maintain Control Group window.
	3. Select the control group to be deleted.
	4. Click Delete.
	5. Click Yes.

	To delete a control group that has allocated assets
	1. Open the client’s Client Accounting > Assets tab.
	2. Open the Assets Listing page.
	3. Transfer the asset(s) to another control group.
	4. Select Maintenance > Maintain control group on the main menu.
	5. Select the control group to be deleted.
	6. Click Delete.
	7. Click Yes.

	Related topics

	Control group templates
	To save the details of a control group in a template
	1. Create a control group.
	2. Click Save as template.
	3. Enter a descriptive Template name.
	4. Click OK.

	To update a template with the details of an edited control group
	1. Edit the control group.
	2. Click Save as template.
	3. Enter the Template name that had been previously used with this control group.
	4. Click OK.
	5. Click Yes.

	To use a control group template
	1. Open the client’s Client Accounting > Assets tab.
	2. Open the Maintain Control Group window.
	3. Click Load template.
	4. From the list, select the control group template required.
	5. Click OK.

	To delete a control group template
	1. Open the client’s Client Accounting > Assets tab.
	2. Open the Maintain Control Group window.
	3. Click Load template.
	4. From the list, select the control group template to be deleted.
	5. Click Delete.

	Related topics

	Searching accounts
	To search the Find Chart of Accounts window
	1. Open the Find Chart of Accounts window.
	2. In the search type field, select Account code or Account name from the drop- down.
	3. In the Search field, type at least the first 2 characters of the Account code.
	4. Click Search.

	Related topics

	Moving an asset to another control group
	To transfer an asset to another control group
	1. Open the Assets Listing page.
	2. Select the asset that is to be transferred to another control group.
	3. Click Move to another control group on the Tasks bar.
	4. Select the New control group from the drop-down.
	5. Click OK.

	Related topics


	Creating a new asset location
	To create an asset location
	1. Open the Assets Listing page.
	2. Select Maintenance > Association > Location on the main menu.
	3. In the first blank cell of the table, enter the Location of an asset.
	4. Press [Enter].
	5. Enter another asset location, if required.
	6. Click Close.

	Related topics
	Editing an asset location
	To edit an asset location
	1. Open the Assets Listing page.
	2. Select Maintenance > Association > Location on the main menu.
	3. Select the location to be edited.
	4. Edit the specific text.
	5. Click Close.

	Related topics

	Deleting an asset location
	To delete an asset location that has no associations
	1. Open the Assets Listing page.
	2. Select Maintenance > Association > Location on the main menu.
	3. Select the asset location to be deleted.
	4. Press [Delete].
	5. Click Yes.

	To delete an asset location that has been associated with assets
	1. Open the Assets Listing page.
	2. Create a new asset location, if required.
	3. Re-assign the assets that are associated with the location to be deleted, to a different location.
	4. Delete the asset location.

	Related topics


	Assets Listing page
	Main menu options
	Other options
	Tasks bar options
	Right-click menu options
	1. Right- click anywhere on the Assets Listing page.

	Field Chooser options
	1. Right-click anywhere on the Assets Listing page.
	2. Select Field Chooser.

	Related topics
	Customising the Assets Listing page
	To add columns to the Assets Listing page
	1. Open the Assets Listing page.
	2. Select Field Chooser from the right-click menu.
	3. Select one of the list of field chooser options.
	4. Drag the selected option to the required location on the column heading row.

	To remove columns from the Assets Listing page
	1. Open the Assets Listing page.
	2. Select Field Chooser from the right-click menu.
	3. Select a column heading on the Assets Listing page that is no longer required.
	4. Drag the selected column heading to the Field Chooser menu or away from the table.

	To rearrange columns on the Assets Listing page
	1. Open the Assets Listing page.
	2. Drag and drop selected column headings where required within the column heading row.

	Related topics

	Sorting, filtering and grouping your assets
	To sort assets in the Assets Listing page
	To filter assets in the Assets Listing page
	1. Click on a column in the Filter bar.
	2. The Filter bar is identified by the in the left most column.
	3. Select a value from the drop-down list for the column.
	4. You can use wildcards when entering filters:
	5. Click to remove the filter.

	To group assets in the Assets Listing page
	Related topics



	Creating an asset
	Refreshing the data
	Related topics

	Taxation Assets
	Accounting Assets
	Accounting and Taxation Assets
	Related topics

	Creating a new general asset
	Taxation asset
	Accounting asset
	Accounting and Taxation
	Related topics
	Setting asset details
	To enter the details for a new general asset
	1. Open the Assets Listing page.
	2. Click Create new asset on the Tasks bar.
	3. Enter the Asset code.
	4. Enter the Asset name.
	5. Select the Asset type from the drop-down.
	6. Select whether the depreciation calculated will be reported for Accounting or Taxation. This selection only applies where the asset is an Accounting and Taxation asset.
	7. Select control group for the asset from the drop-down.
	8. Click Next.


	Related topics
	Setting taxation details for a General asset (GA)
	1. In the first step for Asset details you have selected General asset from the Asset type drop-down.
	2. Enter the Acquisition date of the asset.
	3. Enter the Start date for the asset.
	4. Select the Depreciation method from the drop-down.
	5. Enter the Cost of the asset.
	6. Enter the Opening written down value of the asset.
	7. (Australia) Select the Motor vehicle checkbox, if your asset is a motor vehicle.
	8. (Australia) Enter the Cost limit of the motor vehicle.
	9. Select the appropriate options in the Calculate decline in value section.
	a. (Australia) Effective life
	b. Depreciation rate

	10. Select the appropriate options in the Other values section.
	a. (Australia) Enter the Adjusted base cost.
	b. Enter the Private use % for the asset.
	c. Select the Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.

	11. Click Next.

	Related topics
	Setting accounting details for a General asset (GA)
	To enter the accounting details for a general asset
	1. In the first step for Asset details you selected:
	2. Enter the Acquisition date of the asset.
	3. Enter the Start date for the asset.
	4. Select the Depreciation method from the drop-down.
	5. Enter the Original Cost of the asset.
	6. Enter the Opening written down value of the asset.
	7. Select the appropriate options in the Calculate decline in value section.
	a. Enter the number of years for Useful life. Useful life is applicable if the asset is being depreciated using the Straight line method only.
	b. Enter the Depreciation rate as a percentage for Rate year 1% (Australia) / Rate year% (New Zealand)

	8. Select the appropriate options in the Other values section.
	a. Enter the Private use % for the asset.
	b. Select the Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.
	c. The Accumulated depreciation and Accumulated private use fields are calculated fields and are read only.
	d. The Accumulated private use field is enabled if you create an asset where the Start date is prior to the Year start date.

	9. Click Next.


	Related topics
	Setting general details
	To enter the asset’s general details
	1. Ensure that you have completed “Setting taxation details for a General asset (GA)” on page 348 and “Setting accounting details for a General asset (GA)” on page 351.
	2. Enter the Serial number.
	3. Enter the Units.
	4. Select the appropriate Location of the asset from the drop-down.
	5. Enter the Insurance details of the asset, if appropriate.
	a. Enter the Insurer details.
	b. Enter the Premium due date.
	c. Enter the insurance Premium amount.
	d. Enter the Insured value of the asset.

	6. Enter any Notes.
	7. Click Finish.


	Related topics

	Creating a low value pool asset
	1. Map the relevant general ledger account codes for the low value pool using the Low value pool summary window.
	2. Create the low value pool asset using the Create New Asset Wizard.
	Related topics
	Setting asset details for a low value pool (LVP) asset
	To enter the details for a new low value pool (LVP) asset
	1. Open the Assets Listing page.
	2. Click Create new asset on the Tasks bar.
	3. Enter the Asset code.
	4. Enter the Asset name.
	5. Select the Asset type from the drop-down.
	6. Select whether the depreciation calculated will be reported for Accounting or Taxation. This selection only applies where the asset is an Accounting and Taxation asset.
	7. Select control group for the asset from the drop-down.
	8. Click Next.


	Related topics
	Setting taxation details for a low value pool (LVP) asset
	To enter the taxation details for a new low value pool asset
	1. In the first step for Asset details you selected Low value pool from the Asset type drop-down.
	2. Enter the Acquisition date of the asset.
	3. Enter the Cost of the low value pool asset.
	4. Enter the Opening written down value of the asset.
	5. Select the Asset came from an existing LV Pool checkbox, if required.
	6. Enter the Private use % for the asset.
	7. Click Next.


	Related topics
	Setting accounting details for a low value pool (LVP) asset
	To enter the accounting details for an asset
	1. In the first step for Asset details you selected:
	2. Enter the Acquisition date of the asset.
	3. Enter the Start date for the asset.
	4. Select the Depreciation method from the drop-down.
	5. Enter the Original Cost of the asset.
	6. Enter the Opening written down value of the asset.
	7. Select the appropriate options in the Calculate decline in value section.
	a. Enter the number of years for Useful life. Useful life is applicable if the asset is being depreciated using the Straight line method only.
	b. Enter the Depreciation rate as a percentage for Rate year 1%

	8. Select the appropriate options in the Other values section.
	a. Enter the Private use % for the asset.
	b. Select the Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.
	c. The Accumulated depreciation and Accumulated private use fields are calculated fields and are read only.
	d. The Accumulated private use field is enabled if you create an asset where the Start date is prior to the Year start date.

	9. Click Next.


	Related topics
	Setting general details for a low value pool (LVP) asset
	To enter the asset’s general details
	1. Ensure that you have completed “Setting taxation details for a low value pool (LVP) asset” on page 357 and “Setting accounting details for a low value pool (LVP) asset” on page 360.
	2. Enter the Serial number.
	3. Enter the Units.
	4. Select the appropriate Location of the asset from the drop-down.
	5. Enter the Insurance details of the asset, if appropriate.
	a. Enter the Insurer details.
	b. Enter the Premium due date.
	c. Enter the insurance Premium amount.
	d. Enter the Insured value of the asset.

	6. Enter any Notes.
	7. Click Finish.


	Related topics

	Creating a small business pool asset
	Taxation only asset
	1. Configure the control group using the Maintain Control Group window and see “Creating a control group” on page 314.
	2. Map the relevant general ledger account codes for the small business pool using the Small business pool summary window.
	3. Create the small business pool asset using the Create New Asset Wizard.

	Accounting and Taxation asset
	1. Configure the control group using the Maintain Control Group window and see “Creating a control group” on page 314.
	2. Map the relevant general ledger account codes for the small business pool using the Small business pool summary window.
	3. Create the small business pool asset using the Create New Asset Wizard.
	Related topics
	Setting asset details for a small business pool (SBP) asset
	To enter the details for a new small business pool (SBP) asset
	1. Open the Assets Listing page.
	2. Click Create new asset on the Tasks bar.
	3. Enter the Asset code.
	4. Enter the Asset name.
	5. Select the Asset type from the drop-down.
	6. Select whether the depreciation calculated will be reported for Accounting or Taxation. This selection only applies where the asset is an Accounting and Taxation asset.
	7. Select control group for the asset from the drop-down.
	8. Click Next.


	Related topics
	Setting taxation details for a small business pool (SBP) asset
	To enter the taxation details for a new small business pool asset
	1. In the first step for Asset details you selected Small business pool from the Asset type drop-down.
	2. Enter the Acquisition date of the asset.
	3. Enter the Cost of the small business pool asset.
	4. Enter the Opening written down value of the asset.
	5. Select the Asset came from an existing SB Pool checkbox, if required.
	6. Select the Motor vehicle checkbox, if the asset is a motor vehicle.
	7. Enter the Private use % for the asset.
	8. Click the Private use adjustment ellipsis button.
	a. Select the Asset was first used under the ATO’s “simplified depreciation” rules checkbox, if required.
	b. Enter the Tax year the asset was allocated to a pool.
	c. Enter the Private use last year %.
	d. Enter the Private use this year %.
	e. Enter the Asset value.
	f. Click OK.

	9. Click Next.


	Related topics
	Setting accounting details for a small business pool (SBP) asset
	To enter the accounting details for an asset
	1. In the first step for Asset details you selected:
	2. Enter the Acquisition date of the asset.
	3. Enter the Start date for the asset.
	4. Select the Depreciation method from the drop-down.
	5. Enter the Original Cost of the asset.
	6. Enter the Opening written down value of the asset.
	7. Select the appropriate options in the Calculate decline in value section.
	a. Enter the number of years for Useful life. Useful life is applicable if the asset is being depreciated using the Straight line method only.
	b. Enter the Depreciation rate as a percentage for Rate year 1%

	8. Select the appropriate options in the Other values section.
	a. Enter the Private use % for the asset.
	b. Select the Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.
	c. The Accumulated depreciation and Accumulated private use fields are calculated fields and are read only.
	d. The Accumulated private use field is enabled if you create an asset where the Start date is prior to the Year start date.

	9. Click Next.


	Related topics
	Setting general details for a small business pool (SBP) asset
	To enter the asset’s general details
	1. Ensure that you have completed “Setting taxation details for a small business pool (SBP) asset” on page 366 and “Setting accounting details for a small business pool (SBP) asset” on page 371.
	2. Enter the Serial number.
	3. Enter the Units.
	4. Select the appropriate Location of the asset from the drop-down.
	5. Enter the Insurance details of the asset, if appropriate.
	a. Enter the Insurer details.
	b. Enter the Premium due date.
	c. Enter the insurance Premium amount.
	d. Enter the Insured value of the asset.

	6. Enter any Notes.
	7. Click Finish.


	Related topics


	Low value pool summary
	To map a general ledger account to a low value pool
	1. Open the Assets Listing page.
	2. Click Low value pool on the Tasks bar.
	3. If the general ledger is not integrated, enter the general ledger account code and name for each relevant account.
	4. If the general ledger is integrated, click the magnifying glass icon associated with the selected integrated account.
	a. You can search, filter and/or sort the Chart of Accounts. The default sorting in the Find Charts of Accounts window is in ascending account code order.
	b. Select the account and click OK.

	5. Repeat the above step to add or change another integrated account, as required.
	6. Click Close.

	To view the low value pool summary
	1. Open the Assets Listing page.
	2. Click Low value pool on the Tasks bar.
	3. Click Close.

	Related topics

	Small business pool summary
	To map a general ledger account to a small business pool
	1. Open the Assets Listing page.
	2. Click Small business pool on the Tasks bar.
	3. If the general ledger is not integrated, enter the general ledger account code and name for each relevant account.
	4. If the general ledger is integrated, click the magnifying glass icon associated with the selected integrated account.
	a. You can search, filter and/or sort the Chart of Accounts. The default sorting in the Find Charts of Accounts window is in ascending account code order.
	b. Select the account and click OK.

	5. Repeat the above step to add or change another integrated account, as required.
	6. Click Close.

	To view the small business pool summary
	1. Open the Assets Listing page.
	2. Click Small business pool on the Tasks bar.
	3. Click Close.

	Related topics

	Submitting journals to Workpapers
	To submit a journal
	1. Open the Client Accounting > Assets tab.
	2. Click Submit journals on the Tasks bar.
	3. In the window Submit assets journals for posting? click Yes.
	4. In the window Asset journals have been submitted successfully, click OK.
	5. To view the Assets accounts, open the Workpapers trial balance sheet.
	6. Click View all in the Tasks bar.

	Related topics


	Managing assets
	Viewing assets
	To view assets in multiple years
	Related topics

	Editing an asset
	To edit an asset
	1. Open the Assets Listing page.
	2. Select the asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Edit the Asset code.
	5. Edit the Asset name.
	6. Edit the fields within the Taxation tab, as required. This tab will be available Taxation only or Accounting and Taxation assets.
	7. Click the Accounting tab, as required. This tab will be available Accounting only or Accounting and Taxation assets.
	8. Click the General details tab.
	9. Edit the fields within the General details tab as required.
	10. Click OK.

	Related topics
	Editing the taxation details of a general asset
	To edit the taxation details for a general asset
	1. Open the Assets Listing page.
	2. Select the general asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Edit the asset Acquisition date, if necessary.
	5. Edit the Start date for the asset.
	6. Select a different Depreciation method from the drop-down, if necessary.
	7. Edit the Cost of the asset.
	8. Edit the Opening written down value of the asset.
	9. (Australia) Select the Motor vehicle checkbox, if your asset is a motor vehicle.
	10. (Australia) Edit the Cost limit of the motor vehicle.
	11. (Australia) Select different options for the Calculate decline in value section.
	a. Effective life
	b. Depreciation rate

	12. (New Zealand) In the Calculate decline in value section, enter the percentage depreciation in Rate year %.
	13. Select the appropriate options in the Other values section.
	a. (Australia) Edit the Adjusted base cost.
	b. Edit the Private use % for the asset.
	c. Select a different Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.

	14. Edit the General details of the asset.
	15. Click OK.

	Related topics

	Editing the taxation details for an immediate deductible asset
	To edit the taxation details for an immediate deductible asset
	1. Open the Assets Listing page.
	2. Select the immediate deductible asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Edit the asset Acquisition date, if necessary.
	5. Edit the Start date for the asset.
	6. Edit the Cost of the asset.
	7. Edit the Private use % for the asset.
	8. Select a different Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.
	9. Edit the General details of the asset.
	10. Click OK.

	Related topics

	Editing the taxation details for a low value pool asset
	To edit the taxation details for a low value pool asset
	1. Open the Assets Listing page.
	2. Select the low value pool asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Edit the asset Acquisition date, if necessary.
	5. Edit the Cost of the asset.
	6. Edit the Opening written down value of the asset, as required.
	7. Select the Asset came from an existing LV Pool checkbox, if required.
	8. Edit the Private use % for the asset.
	9. Edit the General details of the asset.
	10. Click OK.

	Related topics

	Editing the taxation details for a small business pool asset
	To edit the taxation details for a small business pool asset
	1. Open the Assets Listing page.
	2. Select the small business pool asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Edit the asset Acquisition date, if necessary.
	5. Edit the Cost of the asset.
	6. Edit the Opening written down value of the asset, as required
	7. Select the Asset came from an existing SB Pool checkbox, if required.
	8. Select or deselect the Motor vehicle checkbox, as required.
	9. Edit the Private use % for the asset.
	10. Edit the Private use adjustment.
	a. Click the Private use adjustment ellipsis button.
	b. Select or deselect the Asset was first used under the ATO’s “simplified depreciation” rules checkbox, as required.
	c. Edit the Tax year the asset was allocated to a pool.
	d. Edit the Private use last year %.
	e. Edit the Private use this year %.
	f. Edit the Asset value.
	g. Click OK.

	11. Edit the General details of the asset.
	12. Click OK.

	Related topics

	Editing the accounting details of a general asset
	To edit the accounting details of a general asset
	1. Open the Assets Listing page.
	2. Select the general asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Edit the asset Acquisition date, if necessary.
	5. Edit the Start date for the asset.
	6. Select a different Depreciation method from the drop-down, if necessary.
	7. Edit the Original Cost of the asset.
	8. Edit the Opening written down value of the asset.
	9. Select the options for the Calculate decline in value section.
	a. Edit the number of years for Useful life. Useful life is applicable if the asset is being depreciated using the Straight line method only.
	b. Edit the Depreciation rate as a percentage for Rate year 1%

	10. Select the appropriate options in the Other values section.
	a. Edit the Private use % for the asset.
	b. Select a different Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.
	c. The Accumulated depreciation and Accumulated private use fields are calculated fields and are read only.
	d. The Accumulated private use field is enabled if you create an asset where the Start date is prior to the Year start date.

	11. Edit the General details of the asset.
	12. Click OK.

	Related topics

	Editing the accounting details for an immediate deductible asset
	To edit the accounting details of an immediate deductible asset
	1. Open the Assets Listing page.
	2. Select the immediate deductible asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Edit the asset Acquisition date, if necessary.
	5. Edit the Start date for the asset.
	6. Edit the Original Cost of the asset.
	7. Edit the Private use % for the asset.
	8. Select a different Private use bal sheet a/c to be used, if a portion of the asset is to be used for private use.
	9. The Accumulated private use field is a calculated field and is read only.
	10. The Accumulated private use field is enabled if you created an asset where the Start date is prior to the Year start date.
	11. Edit the General details of the asset.
	12. Click OK.

	Related topics

	Editing the general details of an asset
	To edit the asset’s general details
	1. Open the Assets Listing page.
	2. Select the asset to be edited.
	3. Click Edit asset on the Tasks bar.
	4. Click the General details tab.
	5. Edit the Serial number of the asset, if available.
	6. Edit the Units.
	7. Select a different Location for the asset from the drop-down, if necessary.
	8. Edit the Insurance details of the asset, if appropriate.
	a. Edit the Insurer details.
	b. Enter a different Premium due date.
	c. Enter a different insurance Premium amount.
	d. Enter a different Insured value of the asset.

	9. Edit any Notes or add more notes, as required.
	10. Click OK.

	Related topics


	Deleting an asset
	To delete an asset
	1. Open the Assets Listing page.
	2. Select the active asset to be deleted.
	3. Click Delete asset on the Tasks bar.

	To delete a sold asset
	1. Open the Assets Listing page.
	2. Navigate to the year the selected asset was sold.
	3. Unsell the sold asset.
	4. Navigate to the year the selected asset was created.
	5. Delete the selected asset.

	Related topics


	Selling an asset
	Related topics
	Selling a general or immediate deductible asset
	To sell a general or immediate deductible asset
	1. Open the Assets Listing page.
	2. Select the asset to be sold.
	3. Click Sell on the Tasks bar.
	4. Enter the Disposal date of the asset.
	5. Enter the Termination value.
	6. (Australia) Select the Calculate capital gains tax using checkbox, if required.
	7. (Australia) Select the method to be used to calculate the capital gains tax.
	8. Click OK.

	Related topics

	Selling a low value pool asset
	To sell a low value pool asset
	1. Open the Assets Listing page.
	2. Select the asset to be sold.
	3. Click Sell on the Tasks bar.
	4. Enter the Disposal date of the low value pool asset.
	5. Enter the Termination value.
	6. Select the Calculate capital gain/loss checkbox, if required.
	7. Click OK.

	Related topics

	Selling a small business pool asset
	To sell a small business pool asset
	1. Open the Assets Listing page.
	2. Select the asset to be sold.
	3. Click Sell on the Tasks bar.
	4. Enter the Disposal date of the small business pool asset.
	5. Enter the Termination value.
	6. Enter the Average private use % of the small business pool asset.
	7. Click OK.

	Related topics

	CPI rates table
	Related topics

	Capital gains tax
	Discount
	Indexation
	Related topics

	Reversing the sale of an asset
	To undo the sale of an asset
	1. Open the Assets Listing page.
	2. Select the sold asset that is to be unsold.
	3. Click Unsell on the Tasks bar.
	4. Click Yes.

	Related topics


	Pooled assets
	Low value
	Small business
	Related topics
	Low value pooled assets
	Related topics

	Small business pooled assets
	Writing off a small business pool
	Related topics

	Consolidating sold pooled assets
	Related topics

	Transferring an asset to a pool
	To transfer an asset to a pool
	1. Open the Assets Listing page.
	2. Select the asset that is to be transferred to pool.
	3. Click Transfer to low value pool or Transfer to small business pool on the Tasks bar.
	4. Click OK.

	Related topics


	Reports
	Related topics
	Low value pool schedule
	To generate a low value pool schedule report
	1. Open the Assets Listing page
	2. Select Reports > Low value pool schedule on the main menu.
	3. Click OK.

	To generate a client summary of low value pool report
	1. Open the Assets Listing page.
	2. Select Reports > Low value pool schedule on the main menu.
	3. Select the Client summary checkbox.
	4. Click OK.
	5. Use the toolbar options of the MYOB Assets: Low Value Pool Schedule Report window to search, print and/or save the report.

	Related topics

	Small business pool schedule
	To generate a small business pool schedule report
	1. Open the Assets Listing page.
	2. Select Reports > Small business pool schedule on the main menu.
	3. Click OK.
	4. Click OK.

	To generate a client summary of the small business pool schedule report
	1. Open the Assets Listing page.
	2. Select Reports > Small business pool schedule on the main menu.
	3. Select the Client summary checkbox.
	4. Click OK.
	5. Use the toolbar options of the MYOB Assets: Small Business Pool Schedule Report window to search, print and/or save the report.

	Related topics

	Tax schedule
	To generate a Tax schedule report
	1. Open the Assets Listing page.
	2. Select Reports > Tax schedule on the main menu.
	3. Select the Date range for the report.
	4. By default, the Include assets fully depreciated in prior year checkbox is selected.
	5. Click OK.
	6. Click OK.
	7. Use the toolbar options of the MYOB Assets: Tax Schedule Report window to search, print and/or save the report.

	Related topics

	Journal summary - Taxation
	To generate a Journal summary report
	1. Open the Assets Listing page.
	2. Select Reports > Journal summary on the main menu.
	3. Click OK.
	4. Use the toolbar options of the MYOB Assets: Journal Summary Report window to search, print and/or save the report.

	Related topics

	Accounting schedule
	To generate an Accounting schedule report
	1. Start Date. This defaults to the beginning of the asset register year and cannot be changed.
	2. End Date. If the date entered is not within the financial year the error message ‘Invalid date, Ending on date must be within the current financial year.’ will prompt you to make the necessary change.

	Related topics

	Journal summary - Accounting
	Related topics

	Additions and disposals
	Accounting
	Taxation
	To generate the Additions and disposals report
	1. Open the Assets Listing page.
	2. Select Reports > Additions and disposals on the main menu.
	3. Select the Date range for the report.
	4. The Additions and Disposals checkboxes are both selected by default. If you do not wish to display these in the report, deselect the corresponding checkbox.
	5. Click OK to generate the report.
	6. Use the toolbar options of the MYOB Assets: Additions and Disposals Report window to search, print and/or save the report.

	Related topics


	Full schedule
	Accounting
	Taxation
	Pool details (Australia)
	To generate a full schedule report
	1. Open the Assets Listing page.
	2. Select Reports > Full schedule on the main menu.
	3. Click OK to generate the report.

	Related topics


	Reports toolbar options
	Related topics
	Searching in a report
	To search the contents of a report
	1. Open a report.
	2. Click on the toolbar.
	3. Enter the search text into the Find what field.
	4. Select the Match whole word only checkbox, if required.
	5. Select the Match case checkbox, if required.
	6. Select whether the search will occur in ascending (Up) or descending (Down) order.
	7. Click Find Next.
	8. Click Find Next again to move to the next instance of the search text.
	9. Click Cancel.

	Related topics

	Printing a report
	To print the whole report
	1. Open a report.
	2. Click on the toolbar.

	Related topics

	Saving a report
	To save a report
	1. Open a report.
	2. From the format type toolbar drop-down, select the export format of the report.
	3. Click on the toolbar.
	4. Click Open to open the file in the corresponding application.
	5. Click Save to save the file to a specified location.

	Related topics



	Migrating data
	MYOB AE Assets 2.4 data
	Restrictions and conditions for migration
	What type of data can be migrated
	What data and fields will not be migrated
	What features are not included in migration
	What if...

	MYOB AE AMS
	Restrictions and conditions for migration
	What type of data can be migrated
	What type of data will not be migrated
	What features are not included in migration
	What if

	MYOB AO Classic data
	Restrictions and conditions for migration
	What type of data can be migrated
	What data and fields will not be migrated
	What if...
	Related topics

	Migrating MYOB AE Assets 2.4 data
	To migrate MYOB AE Assets 2.4 data
	1. Ensure that you are using a MYOB AE Assets 2.4 asset register that is from 2013 onwards.
	2. Exit MYOB AE Assets 2.4 before you start the migration process.
	3. In integrated mode, configure the client’s financial data source to be either a MAS ledger or Accounts ledger, as appropriate.
	4. In non-integrated mode, no configuration is required.
	5. Access an asset register from MYOB Assets Live.
	6. Select Migrate data on the Tasks bar.
	7. Select AE Assets 2.4 asset register from the Product drop-down.
	8. If you are not integrated with a MAS or Accounts general ledger and have data in MYOB Assets 2,4 which you want to migrate to MYOB Assets Live, select the Browse for Non Integrated asset register (AST File only) checkbox.
	9. Select your MYOB AE Assets 2.4 asset register.
	a. Click ellipsis button at the end of AE Assets 2.4 asset register field.
	b. Select a ledger code.
	c. Click OK.
	a. Click ellipsis button at the end of AE Assets 2.4 asset register field.
	b. Browse for the appropriate AST file.

	10. Click OK.

	Related topics
	Migration results for MYOB AE Assets 2.4
	Related topics

	Viewing information about MYOB AE Assets 2.4 migration
	To view the migration log
	1. Click View migration log on the Tasks bar.
	2. To export the migration log to Microsoft Excel, click the Export to excel button.
	3. Once you have finished viewing the migration log, click Close.

	Errors / warnings in the migration log
	Error concerning Microsoft Access Driver
	1. Access the Microsoft website.
	2. Select English as the language.
	3. Click the Download link.
	4. Select AccessDatabaseEngine.exe.
	5. Click the Next button.
	6. Run the file and install Microsoft OLE DB Driver for Microsoft Access.
	7. Access MYOB Assets Live and restart the migration again.

	Related topics


	Migrating MYOB AE AMS data
	To migrate MYOB AE AMS data
	1. Exit MYOB AE AMS before you start the migration process.
	2. In integrated mode, configure the client’s financial data source to be a MAS ledger.
	3. Access an asset register from MYOB Assets Live.
	4. Select Migrate data on the Tasks bar.
	5. Select AE AMS asset register from the Product drop-down.
	6. Select your MYOB AE AMS asset register.
	a. Click ellipsis button at the end of AE AMS asset register field.
	b. Select a ledger code.
	c. Click OK.

	7. Click OK.

	Related topics
	Migration results for MYOB AE AMS
	Related topics

	Viewing information about MYOB AE AMS migration
	To view the migration log
	1. Click View migration log on the Tasks bar.
	2. To export the migration log to Microsoft Excel, click the Export to excel button.
	3. Once you have finished viewing the migration log, click Close.

	Errors / warnings in the migration log
	Related topics


	Migrating MYOB AO Classic data
	To migrate MYOB AO Classic data
	1. Ensure that using a MYOB AO Classic asset register that is from 2013 onwards.
	2. Exit MYOB AO Classic before you start the migration process.
	3. Configure the client’s financial data source to be an MYOB AO Classic general ledger.
	4. Access an asset register.
	5. Select Migrate data on the Tasks bar.
	6. Select AO Classic asset register from your Product drop-down.
	7. Select your MYOB AO Classic asset register.
	a. Click the ellipsis button at the end of the AO Classic asset register field.
	b. Browse to the location of your MYOB AO classic asset register.
	c. Select the file and click OK.

	8. Click OK.

	Related topics
	Migration results for MYOB AO Classic
	Related topics

	Viewing information about the MYOB AO Classic migration
	To view the migration log
	1. Click View migration log on the Tasks bar.
	2. To export the migration log to Microsoft Excel, click the Export to excel button.
	3. Once you have finished viewing the migration log, click Close.

	Errors / warnings in the migration log
	Related topics



	Handling special transactions
	Accounting basis depreciation, impairment losses and revaluations
	Additional expenses
	Balancing offset adjustments
	Incidental costs
	Other associations - suppliers, cost centres, asset types
	Part selling an asset
	1. Split the original asset into 2 assets and sell the one being sold:
	a. In the year the assets was added, edit the asset and reduce the cost by the cost value of the part of the asset being sold.
	b. In the year the asset was added, create a new asset with the cost value of the part being sold. Ensure that the depreciation rate, method and private use %, etc., are the same as the main asset.
	c. The net effect on depreciation and total closing written down value should be the same as before you split the asset into 2.

	2. Navigate to the year in which the part sale is being made:
	a. Sell the relevant asset.


	Allocate and deallocate
	Multiple account periods

	Troubleshooting
	Statutory Reporter
	Accessing Statutory Reporter
	To access Statutory Reporter
	1. Click .
	2. Enter search criteria in the Search for field.
	3. Click Search or press [Enter].
	4. Double-click the client entry.
	5. Click the Client Accounting tab.
	6. Click the Reports tab.

	Related topics

	Configuring practice report settings
	Accounting product locations
	Default report selections
	Account groups
	Non-transaction data
	Paragraphs
	Report options
	Rename reports
	Related topics
	Practice Report Settings page
	Practice Reports
	Tasks bar option
	Related topics

	Selecting default practice reports
	To select the default practice reports
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select the entity type from the Entity Type drop-down.
	3. In the Default Report Selections table configure the settings for each report.
	a. Period Type — control the reporting period for statements and notes. See “Producing periodic reports” on page 556 for more information.
	b. Display in List — select or deselect the checkbox to display or hide the report in the list of available reports for all clients of the selected entity type. If the Display List checkbox is selected, a tick is displayed in the checkbox and the r...
	c. Select by Default — control whether the report will be automatically selected for inclusion. Click the cell to display the drop-down options:
	d. Prevent Override — select or deselect the checkbox. If the checkbox is selected, users will not be able to edit the practice configuration for the selected report at a client level. If the checkbox is not selected, users will be able to edit the...

	4. Click Save Settings.
	5. Repeat Step 2. to Step 4. to select the default reports for each entity type that applies to the clients in your practice.

	Related topics

	Changing the order of practice reports
	To change the order of reports
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select the Entity Type from the drop-down.
	3. Find and select the report in the Default Report Selections table.
	4. Click to move the selected report up in the report order.
	5. Click Save Settings.
	6. Repeat Step 2. to Step 5. to modify the report order for each entity type which applies to clients in your practice.

	Related topics

	Previewing practice reports
	To preview the reports
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select the Entity Type from the drop-down.
	3. Click Preview Reports.
	4. Click the ellipse button located at the end of the Sample Client field to search for a sample client.
	5. Find and select the sample client.
	6. Click OK.
	7. Click OK.
	8. Close the Report Preview window.

	Related topics

	Resetting practice reports
	To reset the reports
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select the Entity Type from the drop-down.
	3. Click Reset Reports.
	4. Click Yes to reset the default report selection settings. Click No to cancel.
	5. Click Save Settings.

	Related topics

	Renaming practice reports
	To rename a report at the practice level
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select the required entity type.
	3. In the Reports table, select a report that you wish to rename.
	4. In the Tasks menu, click Rename Reports.
	5. Click OK.
	6. Click Save Settings.

	To restore a report name to the value at foundation level
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. In the Reports table, select a report that you wish to rename.
	3. In the Tasks menu, click Rename Reports.
	4. Click the Refresh icon to the right of the Report Name field.
	5. A confirmation window displays. Click Yes to restore the report name to the value set at foundation level; otherwise click No to close the message.
	6. Click Save Settings.

	Related topics

	Updating master report definitions
	To update the master report definitions
	1. Install the master report definitions to your main database.
	2. Access another database.
	3. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	4. Click Update Report Definitions on the Tasks bar.
	5. Click Update Definitions.
	6. Click Yes.
	7. Click Close.
	8. Repeat the procedure for all other databases.

	Related topics

	Customising your practice styles
	To create a new style set by cloning an existing style set
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select Practice Style Sets from the Tasks bar.
	3. Click Clone Style Set.
	4. Select a style set to clone from the drop-down list. The list will include all master style sets as well as your saved practice style sets.
	5. Click OK.
	6. Click Style Set Name in the right panel, and type a name for your new style set in the corresponding field.
	7. For each style that you want to change:
	a. Select the style name style in the left panel.
	b. Update the settings.

	8. When you have finished the settings for your new style set, click OK to save the changes.

	To create a new style set from the default settings
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select Practice Style Sets from the Tasks bar.
	3. Click New Style Set button.
	4. Click Style Set Name in the right panel, and type a name for your new style set in the corresponding field.
	5. For each style that you want to change:
	a. Select the style name style in the left panel.
	b. Update the settings.

	6. When you have finished the settings for your new style set, click OK to save the changes.

	To edit a style set
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select Practice Style Sets from the Tasks bar.
	3. In the left panel, click + next to the name of the style set you want to edit.
	4. For each style that you want to change:
	a. Select the style name style in the left panel.
	b. Update the settings.

	5. When you have finished the settings for your new style set, click OK to save the changes.
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	Paragraphs
	Report options
	Rename reports
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	Related topics
	Client’s Reports tab
	Features of the Reports tab
	Tasks bar options
	Related topics

	Selecting client reports
	To deselect client reports
	1. Open the client’s Client Accounting > Reports tab.
	2. Find the report in the Reports table, to be excluded from the financial report.
	3. Click the checkbox to deselect an individual report.

	Related topics

	Changing the order of client reports
	To change the order of reports
	1. Open the client’s Client Accounting > Reports tab.
	2. Find and select the report.
	3. Click to move the selected report up in the report order.

	Related topics

	Resetting client reports
	To reset the reports
	1. Open the client’s Client Accounting > Reports tab.
	2. Click Reset Reports.
	3. Click Yes to reset the reports in the table to the practice report settings.
	4. Click OK.

	Related topics


	Account groups
	Related topics
	Accessing account groups
	To access the practice account group configuration
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Click Account Groups on the Tasks bar.
	3. Select the appropriate Product from the drop-down.
	4. Select the Industry Type from the drop-down.
	5. If you have selected Essentials as the Product type, you can also configure the financial data source from the Statutory Reporter - Account Groups window by pressing the Configure button.
	6. Find and select a Sample Client.
	a. Click the ellipse button located at the end of the Sample Client field to search for a sample client.
	b. Search for the client.
	c. Click OK.


	To access the client account group configuration
	1. Open the client’s Client Accounting > Reports tab.
	2. Click Account Groups on the Tasks bar.

	Related topics

	Account Groups window
	Related topics
	Chart of Accounts
	Searching the Chart of Accounts
	To search the Chart of Accounts
	1. Open the Statutory Reporter — Account Groups window.
	2. Enter search criteria into the Search field at the top of the Chart of Accounts table.
	3. Press [Enter].

	To clear the search
	1. Click .


	Related topics
	Filtering the Chart of Accounts
	Related topics
	Hiding or showing the Chart of Accounts
	To hide or show the Chart of Accounts
	1. Open the Statutory Reporter — Account Groups window.
	2. Click Hide Chart of Accounts.
	3. Click Show Chart of Accounts.


	Related topics
	Finding account groups in the Chart of Accounts
	To find account groups in the Chart of Accounts
	1. Access the Statutory Reporter — Account Groups window.
	2. In the Chart of Accounts table, select the account.
	3. Right-click on the account and select Find in Account Groups.
	4. Click in the search field at the top of the Account Group Details tree.


	Related topics

	Account Group Details
	Account Group Details tree
	Account Group Details table
	Related topics
	Account Group Details tree right-click menu
	Related topics
	Searching account groups
	To search for an account group
	1. Access the Statutory Reporter — Account Groups window.
	1. Enter search criteria into the Search field at the top of the Account Group Details tree.
	2. Press [Enter].

	To clear the search
	1. Click .


	Related topics


	Configuring account groups
	Allocating individual accounts
	To allocate individual accounts using drag-and-drop
	1. Access the account groups for the practice or for a selected client.
	2. Locate the account in the Chart of Accounts table.
	3. Locate the account group in the Account Group Details tree.
	4. Click the account entry in the Chart of Accounts table and drag-and-drop it into the account group in the Account Group Details tree.
	5. Repeat Step 2.to Step 4. to allocate all the accounts in the Chart of Accounts table as necessary.
	6. Click OK.

	To allocate individual accounts using the Allocate to Group button
	1. Access the account groups for the practice or for a selected client.
	2. Select an account from the Chart of Accounts table.
	3. Select the account group from the Account Group Details tree.
	4. Click Allocate to Group.
	5. Click OK.

	To allocate individual accounts using the right-click menu
	1. Access the account groups for the practice or for a selected client.
	2. In the Chart of Accounts table, select the account to be allocated to an account group.
	3. In the Account Group Details tree, select the account group to which the account is to be allocated.
	4. Right-click on the account in the Chart of Accounts table and select Allocate to Group.
	5. Click OK.

	Related topics

	Allocating account ranges to account groups
	To allocate an account range to an account group
	1. Access the account groups for the practice or for a selected client.
	2. Find and select the account group in the Account Group Details tree.
	3. Select Display account ranges.
	4. Click the final row in the Account Group Details table to add a new entry.
	5. Enter the account code for the first account in the account range into the Starting Code column.
	6. Enter the account code for the last account in the account range into the Ending Code column.
	7. Repeat Step 2. to Step 6. to allocate further account ranges.
	8. Click OK.

	Related topics
	Editing allocated accounts ranges
	To edit an allocated account range
	1. Access the account groups for the practice or for a selected client.
	2. Find and select the account range in the Account Group Details tree to be edited.
	3. Select Display account ranges.
	4. Edit the account code in the Starting Code or Ending Code fields.
	5. Click OK.


	Related topics
	Including all balances in an account range
	To include all balances in an account range
	1. Access the account groups for the practice or for a selected client.
	2. Find and select the account range in the Account Group Details tree for which to include all balances.
	3. Select Display account ranges.
	4. Click Edit Range Setting.
	5. Select the Include All Balances option.
	6. Click OK.
	7. Click OK.


	Related topics
	Separating debits and credits
	To separate debits and credits using Edit Range Settings
	1. Access the account groups for the practice or for a selected client.
	2. Find and select the account range in the Account Group Details tree for which debits and credits are to be separated.
	3. Select Display account ranges.
	4. Click Edit Range Setting.
	5. Select the Separate Debits and Credits option.
	a. Separate based on — two options are available from the drop-down to separate based on:
	b. Display in this group — select whether to display debits or credits, from the drop-down, in the currently selected account group. If Debits is selected the next field changes to Display credits in. If Credits is selected the next field changes t...
	c. Display debits / credits in — click the ellipse button to select an Account Group to allocate the debits (if credits have already been allocated) or credits (if debits have already been allocated).

	6. Select the appropriate account group.
	7. Click OK.
	8. Click OK.


	Related topics
	Removing debit/credit separation
	To remove debit / credit separation and include all balances
	1. Access the account groups for the practice or for a selected client.
	2. Find and select the account range in the Account Group Details tree for which debit / credits separation is to be removed.
	3. Select Display account ranges.
	4. Click Edit Range Setting.
	5. Select the Include All Balances option.
	6. Click OK.


	Related topics

	Creating custom account groups
	To group accounts into a custom account group
	1. Access the account groups for the client.
	2. Select the account group folder from the Account Group Details tree that contains the account groups that are to be grouped into a custom account group.
	3. Select the Display account codes option from the drop-down.
	4. Select accounts in the Account Group Details table that will be included in a new custom account group.
	5. Right-click on the account(s) in the Account Group Details table and select Add to New Custom Group.
	6. Enter a Custom group name.
	7. Select the Show detail accounts with custom group checkbox, if required.
	8. Click OK.

	To create a new custom account group without selecting accounts
	1. Access the account groups for the client.
	2. Select an account group folder in the Account Group Details tree.
	3. Right-click on the account group and select Create New Custom Group.
	4. Enter the Custom group name.
	5. Select the Show detail accounts with custom group checkbox, if required.
	6. Click OK.
	7. Allocate individual accounts to the custom account group.
	8. Click OK.

	To edit a custom account group name
	1. Access the account groups for the client.
	2. Select a custom account group folder in the Account Group Details tree.
	3. Right-click on the selected custom account group and select Edit Custom Group.
	4. Change the Custom group name.
	5. Click OK.

	Related topics

	Listing account allocations
	To list the account allocations
	1. Access the account groups for the practice or for a selected client.
	2. Click List Account Allocation.
	3. Select the sort order to list the account allocations.
	4. Click OK.

	Related topics

	Deleting account group allocations
	To delete (or unallocate) account group allocations
	1. Access the account groups for the practice or for a selected client.
	2. Find the account in the Account Group Details tree.
	3. Right-click on the account and select Delete.
	4. Click Yes to delete the account allocation. Click No to cancel.

	To delete (or unallocate) account group allocations to a custom group
	1. Access the custom account groups for the selected client.
	2. Unallocate accounts from a selected custom account group.
	3. Select the custom account group folder in the Account Group Details tree.
	4. Right-click on the custom account group folder and select Delete.
	5. Click Yes to delete. Click No to cancel.

	Related topics

	Restoring default settings for account groups
	To restore the master settings
	1. Access the account groups for the practice.
	2. Select the Industry Type from the drop-down.
	3. Click the ellipse button located at the end of the Sample Client field to find a sample client.
	4. Find the account group in the Account Group Details tree for which the default master account group configuration is to be restored.
	5. Right-click and select Restore Master Settings.
	6. Click Yes to remove the practice level account group modifications for the selected account group. Click No to cancel.

	To restore practice report settings
	1. Access the account groups for the client.
	2. Select the account group in the Account Group Details tree for which the practice level account group configuration is to be restored.
	3. Right-click and select Restore Practice Report Settings.
	4. Click Yes to remove the client level account group allocations for the selected account group. Click No to cancel.

	Related topics



	Non-transaction data
	Related topics
	Practice non-transaction data preferences
	To access the practice non-transaction data preferences
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Click Non-Transaction Data on the Tasks bar.

	To configure the non-transaction data preferences
	1. Access the practice Non-Transaction Data Preferences window.
	2. For each relationship type, select the association type that is used in your practice.
	a. Select the director association type using the Directors drop-down.
	b. Select the partner association type using the Partners drop-down.
	c. Select the trustees association type using the Trustees drop-down.

	3. Click OK.

	Related topics

	Client non-transaction data
	Related topics
	Data categories and data fields
	Available data fields
	Data types and parameters
	Related topics

	Accessing client non-transaction data
	To access the client non-transaction data
	1. Search and select the client whose non-transaction data is to be edited.
	2. Open the client’s Client Accounting > Reports tab.
	3. Click Non-Transaction Data on the Tasks bar.

	Related topics

	Searching for a data field
	To search for a data field
	1. Access the client’s non-transaction data.
	2. Enter the search criteria in the Search field.

	To clear the search
	1. Click .

	Related topics

	Editing client non-transaction data
	To edit the client’s non-transaction data
	1. Access the client’s non-transaction data.
	2. Find the data field to be edited.
	3. Edit the data fields as required.
	4. Click OK.

	To edit directors, partners or trustees
	1. Access the client’s non-transaction data.
	2. Select the Directors / Partners / Trustees data category.
	3. To add a director, partner or trustee:
	a. Click to create a new record.
	b. Enter the contact name and select whether the contact is a signatory.

	4. To edit a director, partner or trustee:
	a. Select the director / partner / trustee in the list.
	b. Edit the contact name and /or whether the contact is a signatory.

	5. To delete a directory, partner or trustee:
	a. Select the contact in the list.
	b. Click to remove the contact from the list.

	6. Click OK to save the changes.

	Related topics



	Paragraphs
	Related topics
	Accessing practice paragraphs
	To access the practice paragraphs
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Click Paragraphs on the Tasks bar.

	Related topics

	Accessing client paragraphs
	To access client paragraphs
	1. Open the client’s Client Accounting > Reports tab.
	2. Click Paragraphs on the Tasks bar.

	Related topics

	Paragraphs window
	Related topics

	Searching paragraphs
	To search for a paragraph
	1. Access the practice or client’s paragraphs.
	2. Enter the search criteria for a paragraph in the Search field.

	To search for a report
	1. Access the practice or client’s paragraphs.
	2. Enter the search criteria for a report in the Search field.

	To clear the search
	1. Click .

	Related topics

	Editing paragraphs
	Related topics
	Edit Paragraph Content window
	To access the Edit Paragraph Content window
	1. Access the practice or client’s paragraphs.
	2. Find the paragraph to be edited.
	3. Click to select it.
	4. Click Edit Paragraph.

	Related topics

	Editing static text
	To edit static text
	1. Access the practice or client’s paragraphs.
	2. Find the paragraph to be edited.
	3. Click to select it.
	4. Click Edit Paragraph.
	5. Edit the text as required in the Paragraph Content text area.
	6. Click OK.

	Related topics

	Inserting and editing variables
	Related topics
	Inserting an account group value in a paragraph
	To insert an account group value
	1. Access the practice or client’s paragraphs.
	2. Find the paragraph to be edited.
	3. Click to select it.
	4. Click Edit Paragraph.
	5. In the Paragraph Content text area, click to place the cursor at the point where the Account Group Value variable is to be inserted.
	6. Click Account Group Value.
	7. Select the Account Group Value to be inserted.
	8. Click OK.
	9. Click OK.


	Related topics
	Inserting conditional text in a paragraph
	To insert conditional text
	1. Access the practice or client’s paragraphs.
	2. Find the paragraph to be edited.
	3. Click to select it.
	4. Click Edit Paragraph.
	5. In the Paragraph Content text area, click to place the cursor at the point where the Conditional Text is to be inserted.
	6. Click Conditional Text.
	7. Select the Conditional Text variable on the drop-down.
	8. Click OK.
	9. Click OK.


	Related topics
	Inserting a date in a paragraph
	To insert a date
	1. Access the practice or client’s paragraphs.
	2. Find the paragraph to be edited.
	3. Click to select it.
	4. Click Edit Paragraph.
	5. In the Paragraph Content text area, click to place the cursor at the point where the Date is to be inserted.
	6. Click Date.
	7. Select the:
	a. Date — select the date to be inserted from the drop-down. The available options are:
	b. Format — there are a number of pre-configured date formats which can be used. Select an appropriate format on the Format drop-down.

	8. Click OK.
	9. Click OK.


	Related topics
	Inserting non-transaction data in a paragraph
	To insert non-transaction data
	1. Access the practice or client’s paragraphs.
	2. Find the paragraph to be edited.
	3. Click to select it.
	4. Click Edit Paragraph.
	5. In the Paragraph Content text area, click to place the cursor at the point where the Non- Transaction field variable is to be inserted.
	6. Click Non-Transaction Data.
	7. Select the Non-Transaction Data field variable to be inserted.
	8. Click OK.
	9. Click OK.


	Related topics
	Editing a variable
	To edit a variable
	1. Access the practice or client’s paragraphs.
	2. Find the paragraph to be edited.
	3. Click to select it.
	4. Click Edit Paragraph.
	5. Locate the variable to be edited in the Paragraph Content text area.
	6. Double-click to select the variable.
	7. Insert a new variable or highlight the variable and use the formatting tools to format the variable as required.
	8. Click OK.


	Related topics

	Formatting paragraphs
	To format a paragraph
	1. Access the practice or client’s paragraphs.
	2. Select the text.
	3. Format the text using the available options as required.
	4. Click OK.

	Related topics

	Inserting logos into the Compilation Report
	To add a header logo to the Compilation Report
	1. Access the practice’s paragraphs.
	2. In the Paragraphs window, select Compilation Report > Custom Paragraph - Compilation Report.
	3. In the paragraph content window, copy and paste your desired logo image.
	4. Click OK in the paragraph window, and then in Practice Report Settings, click Save Settings to save your changes.
	5. Navigate to a client and click Preview Reports to verify that the logo is displayed correctly.

	Related topics

	Inserting a signature into the Compilation Report
	To add a signature image to the Compilation Report
	1. Access the practice or client’s paragraphs.
	2. In the Paragraphs window, select Compilation Report > Compilation Report - Signed and then click Edit Paragraph.
	3. Copy and paste the image into the paragraph.
	4. Click OK in the paragraph window, and then in Practice Report Settings, click Save Settings to save your changes.
	5. Navigate to a client and click Preview Reports to verify that the logo is displayed correctly.

	Related topics

	Restoring default content
	To restore default content
	1. Access the client’s paragraphs.
	2. Find the paragraph to be restored to the practice default.
	3. Click to select it.
	4. Click Edit Paragraph.
	5. Click Restore Default Content.
	6. Click OK.

	Related topics


	Paragraphs in the Report Preview window
	To access the practice Report Preview window
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Select the Entity Type from the drop-down.
	3. Click Preview Reports.
	4. Click the ellipse button to search and select a sample client.
	5. Click OK.

	To access the client Report Preview window
	1. Search and select a client.
	2. Open the client’s Client Accounting > Reports tab.
	3. Select the financial period for the report on the Period drop-down.
	4. Click Preview Reports.

	To view and edit the paragraphs
	1. In the Report Preview window, place the cursor over a paragraph.
	2. Click the paragraph.
	3. Edit the paragraph content in the Paragraph Content text area, as required.
	4. Click OK to save the changes or click Cancel to close the window.

	Related topics


	Report options
	Related topics
	Accessing report options
	To access practice report options
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Click Report Options on the Tasks bar.

	To access client report options
	1. Search and select a client.
	2. Open the client’s Client Accounting > Reports tab.
	3. Click Report Options on the Tasks bar.

	Related topics

	Configuring report options
	Selecting style options
	To select the style options
	1. Access the practice or client’s report options.
	2. Select the pre-configured style set on the Style Set drop-down.
	3. Select the font on the Font drop-down.
	4. Click OK.

	To preview the style options
	1. Access the practice or client’s report options.
	2. Click Preview Style Options.
	3. Select a new style set on the Style set drop-down
	4. Select a font on the Font drop-down.
	5. Click OK to save any changes. Click Cancel to close the window without saving changes.

	Related topics

	Setting display options
	Available options
	Related topics
	Defining cover page settings
	To define the cover page settings
	1. Access the practice or client’s report options.
	2. Click the Display Cover Page checkbox.
	3. Click Define Cover Page Settings.
	4. Enter the Space Before the paragraph text in millimetres.
	5. Select the Horizontal Alignment of the paragraph text from the drop-down.
	6. Enter the paragraph Indent from the left hand side of the page, in millimetres.
	7. Click OK.
	8. Click OK.

	To restore the practice cover page default settings
	1. Access the practice or client’s report options.
	2. Click Define Cover Page Settings.
	3. Click the Restore Practice Defaults button.
	4. Click Yes on the message.
	5. Click OK.
	6. Click OK.


	Related topics
	Specifying rounding accounts
	To specify the rounding accounts
	1. Access the practice or client’s report options.
	2. Click the Display Rounded Balances checkbox.
	3. Click Specify Rounding Accounts.
	4. Click the Calculate Rounding Error Adjustments checkbox.
	5. Specify the accounts to which the rounding error adjustments are to be applied for each section:
	a. Enter the account code into the Balance Sheet field to which the rounding error adjustments are to be allocated in the Balance Sheet report.
	b. Leave the Adjust the Equity section separately deselected.
	a. Click the Adjust the Equity section separately checkbox.
	b. Enter the account code into the Assets and Liabilities field to which the rounding error adjustments are to be allocated for net assets.
	c. Enter the account code into the Equity field to which the rounding error adjustments are to be allocated for the equity section.

	6. Click OK to save any changes.
	7. Click OK.


	Related topics
	Defining image settings
	To define the image settings
	1. Access the practice or client’s report options.
	2. Click the Display Image checkbox.
	3. Click Define Image Settings.
	4. Click the ellipse button at the end of the Image File field.
	5. Navigate to the location of the image to be included.
	6. Click Open to select the file.
	7. In the Position section, set the placement of the image on the page:
	a. Select the Horizontal Alignment on the drop-down.
	b. Select the Vertical Alignment on the drop-down.

	8. In the Page Range section, select how often the image will be displayed in the financial statements. The image can be displayed on:
	9. If configuring the Report Options for a selected client, click Restore Practice Defaults to remove any custom image settings for the client. The image settings will be restored to the image settings configured for the practice.
	10. Click OK to save any changes.
	11. Click OK.


	Related topics
	Defining watermark settings
	To define the watermark settings
	1. Access the practice or client’s report options.
	2. Click the Display Watermark checkbox.
	3. Click Define Watermark Settings.
	4. Select the text to be displayed as a watermark on Watermark Text drop-down.
	5. Select the font properties for the watermark in the Font section.
	6. Select the position of the watermark on the page.
	7. In the Page Range section, select how often the watermarked text will be displayed in the financial statements. The watermarked text can be displayed on:
	8. If configuring the report options for a selected client, click Restore Practice Defaults to remove any custom watermark text settings for the client.
	9. Click OK to save any changes.
	10. Click OK.


	Related topics

	Setting page margins
	To set the page margins
	1. Access the practice or client’s report options.
	2. Edit the Top, Bottom, Left and Right page margin fields as necessary.
	3. If configuring the report options for a selected client, click Restore Practice Margins to remove any custom page margins for the client.
	4. Click OK to save any changes.

	Related topics
	Defining the top margin of the Compilation Report
	To update the top margin of the Compilation Report
	1. Create or modify a Practice Style set.
	2. In the style set, select either Page Header Compilation report 01, Page Header Compilation report 02, or Page Header Compilation report 03.
	3. Increase the space of the margin by entering a value in the Space Before (units) property.
	4. Click OK to save your changes.





	Producing financial statements
	Previewing financial statements
	To preview the reports
	1. Open the client’s Client Accounting > Reports tab.
	2. Select the list of reports to be included and modify the report order as necessary.
	3. Select the financial reporting period.
	4. Click Preview Reports.

	Related topics
	Report Preview window
	Related topics
	Report Preview window toolbar options
	Related topics


	Sharing financial statements
	To publish a statutory report to your MYOB Portal if you don’t have Document Manager
	1. Open your Client > Client Accounting > Reports tab.
	2. Select your reporting period.
	3. Click Preview Reports.
	4. Click .
	5. Select the Publish to client portal checkbox to publish the statutory report to your client portal.
	6. Click OK.

	To publish a statutory report to your MYOB Portal if you have Document Manager
	1. Click ShareIt from the toolbar of the preview window, you will receive the following message:
	2. Click Yes to publish the document to the portal.

	Related topics

	Producing periodic reports
	Default period types
	To produce a report for the financial year
	1. Open the client’s Client Accounting > Reports tab.
	2. Select the list of reports to be included and modify the report order as necessary.
	3. For each report type, note or policy that is listed in the Reports table and that is to be included in the financial report, select the Period Type to be TY/LY.
	4. Click Preview Reports.
	5. Preview your report.

	To produce a report for a selected period of the current financial year
	1. Open the client’s Client Accounting > Reports tab.
	2. Select the list of reports to be included and modify the report order as necessary.
	3. For each report type, note or policy that is listed in the Reports table and that is to be included in the financial report, select the Period Type to be YTD/LYTD.
	4. From the Period selector, located at the bottom of the Reports tab, select the:
	5. Click Preview Reports.
	6. Preview your report.

	To produce a report for a previous year
	1. Open the client’s Client Accounting > Reports tab.
	2. Select the list of reports to be included and modify the report order as necessary.
	3. From the Period selector, located at the bottom of the Reports tab, select the:
	4. Click Preview Reports.
	5. Preview your report.

	To produce a quarterly report
	1. Open the client’s Client Accounting > Reports tab.
	2. Select the list of reports to be included and modify the report order as necessary.
	3. For each report type, note or policy that is listed in the Reports table and that is to be included in the monthly financial report, select the Period Type to be PTD/YTD.
	4. From the Period selector, located at the bottom of the Reports tab, select the:
	5. Click Preview Reports.
	6. Preview your report.

	To produce a monthly report with a comparison of the current financial year
	1. Open the client’s Client Accounting > Reports tab.
	2. Select the list of reports to be included and modify the report order as necessary.
	3. For each report type, note or policy that is listed in the Reports table and that is to be included in the monthly financial report, select the Period Type to be PTD/YTD.
	4. From the Period selector, located at the bottom of the Reports tab, select the:
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	2. Click Reallocate Accounts.
	3. Select the account group to which the account is to be reallocated.
	4. Click OK.

	Related topics

	Viewing and editing paragraphs
	To view and edit the paragraphs
	1. Preview the financial statement for the client.
	2. Find the paragraph to be viewed and edited.
	3. Place the cursor over a paragraph.
	4. Click the paragraph.
	5. Edit the paragraph content, in the Paragraph Content text area, as required.
	6. Click OK to save the changes.

	Related topics

	Viewing value properties
	To view the value properties
	1. Preview the financial statement for the client.
	2. Find the variable for which properties are to be viewed.
	3. Place the cursor over the value.
	4. Right-click on the variable.

	Related topics

	Editing Report Options
	To edit report options
	1. Preview the financial statement for the client.
	2. Find the report whose options are to be edited.
	3. Select the report.
	4. Click Report Options.
	5. Change the Style Options, Display Options and /or Page Margins as required.
	6. Click OK.

	Related topics

	Adding and removing manual page breaks
	To add a manual page break
	1. Preview the financial statement for the client.
	2. Decide where a page break should be inserted.
	3. Place the cursor at the account header level of the paragraph or the title.
	4. Right-click and select Insert page break.

	To remove a manual page break
	1. In the Report Preview window, select the section where the manual page break was inserted.
	2. Right-click and select Remove page break.

	To remove all manual page breaks
	1. In the Report Preview window, click Page Break > Remove All on the toolbar.
	2. Click Yes.

	Related topics

	Adding a file to a report
	To add a file to a report
	1. Preview the financial statement for the client.
	2. Click the Insert Item drop-down on the main menu and select the From File option.
	3. Browse and select the appropriate file.
	4. Select whether to Insert the file Before or After.
	5. Then from the drop-down, select the appropriate place in the report where to insert the file.
	6. Select the appropriate Page orientation of the inserted file - Portrait or Landscape.
	7. Click OK.

	To add a Document Manager file to a report
	1. Preview the financial statement for the client.
	2. Click the Insert Item drop-down on the main menu and select the Document Manager option.
	3. Search and select the appropriate file.
	4. Select whether to Insert the file Before or After.
	5. Then from the drop-down, select the appropriate place in the report where to insert the file.
	6. Select the appropriate Page orientation of the inserted file - Portrait or Landscape.
	7. Click OK.

	To remove an added file from a report
	1. Preview the financial statement for the client.
	2. Click the Insert Item drop-down on the main menu and select the Remove File option.
	3. Click the checkbox for the appropriate file that is to be removed from the report.
	4. Click Remove.

	Related topics


	Printing financial statements
	To print the financial statements
	1. Preview the financial statement for the client.
	2. Click .
	3. Select the printer and edit the printing preferences as necessary.
	4. Click Print.

	Related topics

	Exporting financial statements
	To export the financial statements
	1. Preview the financial statement for the client.
	2. Click .
	3. Navigate to the location where the file is to be saved.
	4. Click Save.

	Related topics

	Emailing financial statements
	To email the financial statements
	1. Preview the financial statement for the client.
	1. Click .
	2. Review and edit the email as necessary.
	3. Click Send.

	Related topics

	Adding financial statements to Document Manager
	To add the financial statements to Document Manager
	1. Preview the financial statement for the client.
	1. Click Share it.
	2. On the Details tab, review and edit the information as required:
	a. Contact — the contact associated with the financial statements is automatically selected.
	b. Title — the title provides a short description which can be used to identify the document. The title indicates the client name and financial period the financial statements have been produced for.
	c. Author — the username of the user currently logged in. Click the ellipse button to change the author.
	d. Status — the status of the document.
	e. Document Type — the type of document being imported into Document Manager. The default document type is PDF.
	f. Date Created — the date the financial statements were created. To change the date, select a new date from the drop-down calendar.
	g. Source — the Outbound option is used if the document is being sent from the practice and the Inbound option is used if it has been received.

	3. Click Next to go to the Profiling tab.
	4. On the Profiling tab, review and edit the information as required:
	a. Filing Cabinet — from the drop-down, select a Filing Cabinet in which to store the new document.
	b. Assignment — if the selected Filing Cabinet has assignments, select an assignment from the drop-down. If the selected Filing Cabinet does not have assignments, the Assignment field will be inactive.
	c. Category — Click the ellipse button to select Category fields for the PDF report. Enter the Value for each category.

	5. Click Finish to close the wizard.

	Related topics


	What version of Statutory Report do I have?
	To find out your Statutory Reporter version
	1. Select Maintenance > Maintenance Map (AO) > Client Accounting > Practice Report Settings.
	2. Click About on the Tasks bar.
	3. Click OK.

	Related topics


